Product Information

This document applies to IBM Cognos Planning Version 10.2.0 and may also apply to subsequent releases.

Licensed Materials - Property of IBM

© Copyright IBM Corporation 1999, 2016.

US Government Users Restricted Rights – Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
# Contents

**Introduction** ................................................................. xi

**Chapter 1. What’s New?** .................................................. 1  
New features in version 10.2.0 ............................................. 1  
  Bundled Cognos BI upgraded to version 10.2.2.5 .......................... 1  
  Compatibility with Cognos Analytics 11 .................................. 1  
  WebSphere Liberty Profile is the default application server .......... 1  
  SSL connections to IBM Cognos Planning databases ...................... 1  
  New security standards in IBM Cognos Planning ......................... 2  
  32-bit Cognos Planning gateway ............................................ 2  
  Compatibility with Microsoft Office 2016 ............................... 2  
  Option to initialize Cognos Configuration from a different file .... 2  
New Features in Version 10.1.1 ............................................. 2  
  Additional installation kits improve Cognos Planning deployment and maintenance ................................................. 2  
  New LDIF sample file for IBM Tivoli Directory Server ................ 3  
New Features in Version 10.1.0 ............................................. 4  
  Creating and Configuring a Planning Store ................................ 4  
Deprecated Features in Version 10.1.0 .................................... 4  
  Planning Classic Client ................................................... 4

**Chapter 2. Components Used by IBM Cognos Planning** ............... 5  
Server Components .............................................................. 5  
  IBM Cognos Planning Contributor ........................................ 5  
  IBM Cognos Planning Contributor Administration ......................... 5  
  IBM Cognos Planning Manager ............................................. 5  
  IBM Cognos Connection ................................................... 5  
  Cognos Viewer .............................................................. 6  
  IBM Cognos Configuration ................................................ 6  
  Gateway ................................................................. 6  
  IBM Cognos for Microsoft Office ........................................ 6  
  Content Manager .......................................................... 6  
  IBM Cognos Virtual View Manager ...................................... 6  
Modeling Components ............................................................ 6  
Other Components ............................................................... 7

**Chapter 3. Installation Options** ......................................... 9  
Installing All Server Components on One Computer ..................... 9  
Installing the Gateway on a Separate Computer ......................... 10  
Installing the Planning Server and Content Manager on Separate Computers ......................................................... 12  
  Multiple Installations of Content Manager ................................ 13  
Installing Multiple Planning Servers ...................................... 13  
  Distributed Installation in a Small Environment ....................... 14  
  Distributed Installation in a Medium or Large Environment ....... 15  
Installing Planning Clients .................................................. 17  
Installing Framework Manager .............................................. 17  
Installing IBM Cognos Planning with IBM Cognos Business Intelligence ................................................................. 19

**Chapter 4. Workflow for IBM Cognos Planning** ....................... 25  
Prepare for Implementation ................................................. 25  
Install IBM Cognos Planning ............................................... 25  
Configure IBM Cognos Planning ............................................ 26  
  Monitor Configuration Changes .......................................... 26  
  Configure Security ....................................................... 27  
Administer IBM Cognos ....................................................... 27

© Copyright IBM Corp. 1999, 2016
Chapter 5. Setting Up Your Environment ................................................. 29
Review the Release Notes Before You Install ......................................... 29
Review Supported Environments ............................................................. 29
Verify System Requirements .................................................................. 30
Guidelines for Creating the Content Store and Planning Store .................. 31
- Suggested Settings for Creating the Content Store in DB2 on Linux, Windows and UNIX ................................. 32
- Suggested Settings for Creating the Content Store in Oracle ....................... 34
- Suggested Settings for Creating the Content Store in Microsoft SQL Server .......... 35
- Suggested Settings for Creating the Content Store in Sybase ....................... 36
Configure a User Account for IBM Cognos ........................................... 36
Configure Web Browsers ......................................................................... 37
Set Up the Data Source or Import Source Environment ........................... 39

Chapter 6. Upgrading to IBM Cognos Planning ...................................... 41
Upgrading IBM Cognos Business Intelligence ....................................... 42
Choosing the Upgrade Tool .................................................................... 42
Planning the Upgrade ............................................................................. 43
- Review the Documentation ................................................................... 44
- Assess Applications in the Source Environment ..................................... 44
- Perform a Trial Upgrade ...................................................................... 45
- Create the Test Environment ................................................................ 46
- Plan Your Deployment ......................................................................... 46
- Create an Export Deployment Specification ......................................... 47
- Copy the Deployment Specification to the Test Environment ................. 48
- Import to the Test Environment .......................................................... 48
- Recommendation - Test the Upgraded Content .................................... 50
- Moving to the Production Environment ............................................... 51
Upgrading Planning Administration Domains ......................................... 52
Upgrading Planning Applications ........................................................... 52
Upgrading Planning Analyst Security and Library Files ............................ 52
- Upgrade Planning Analyst Libraries, User Classes, Users, and Groups. .... 52
Upgrading a Test or Development Environment ...................................... 53
Upgrading From Versions 7.2, 7.3, or 8.1 .................................................. 53
Upgrading Planning Contributor web client ........................................... 54

Chapter 7. Installing and Configuring IBM Cognos Planning for a Small Environment ................................................................. 55
Install IBM Cognos Planning .................................................................. 55
JDBC Driver Options for Using DB2 Database as a Content Store .......... 57
Set Up Database Connectivity for the Content Store Database ............... 58
- Set Up Database Connectivity for a DB2 Content Store ......................... 58
- Set Up Database Connectivity for an Oracle Content Store .................. 59
- Set Up Database Connectivity for an Informix Content Store ................ 59
- Set Up Database Connectivity for a Sybase Content Store .................... 60
Set Up Database Connectivity for the Planning Store Database .............. 60
Enable Security ....................................................................................... 60
Configure Environment Properties ......................................................... 61
Set Database Connection Properties for the Content Store ...................... 61
- Setting Database Connection Properties for a DB2 Content Store on Linux, UNIX or Microsoft Windows Operating Systems ........................................ 62
- Setting Database Connection Properties for a Microsoft SQL Server, Oracle, Informix, or Sybase Content Store .......... 63
Set Database Connection Properties for the Planning Store ....................... 64
Configure the Web Server ....................................................................... 65
Start the IBM Cognos Planning Services .............................................. 66
Setting the IBM Cognos Planning Service .............................................. 66
Uninstalling IBM Cognos ....................................................................... 67
- Uninstall IBM Cognos on Windows Operating Systems ........................ 67

Chapter 8. Installing and Configuring in a Medium-Sized Environment .... 69
Architecture of a Medium-Sized Environment ....................................... 72
Configure Role-based Planning Servers ................................................. 73
Chapter 9. Installing and Configuring in a Large Environment .......................... 111

Architecture of a Large Environment ......................................................... 114
Configure Role-based Planning Servers ..................................................... 115
Install Content Manager .............................................................................. 115

Configure Content Manager ........................................................................ 117
Setting Up Database Connectivity to the Content Store and Planning Store Database .. 117
Configure Properties for Content Manager ................................................... 119
Enable Security ............................................................................................. 121
Adding Standby Content Manager servers .................................................. 122
Setting Database Connection Properties for the Content Store .................... 122
Set Database Connection Properties for the Planning Store ......................... 125
Start Content Manager ................................................................................. 127
Test the Content Manager Installation and Configuration ........................... 127
Install IBM Cognos Server ............................................................................ 127
Configure IBM Cognos Server ...................................................................... 129
Configure Properties for IBM Cognos Server ............................................. 129
Start IBM Cognos Server .............................................................................. 130
Install the Gateway ....................................................................................... 131
Installing the gateway components on Windows operating systems .......... 132
Configure the Gateway ................................................................................ 133
Configure Properties for the Gateway ......................................................... 133
Configure a Web server ................................................................................. 133
Start the Gateway .................................................. 134
Test the Gateway Configuration .......................... 134
Install and configure the Gateway dispatcher ......... 134
Configure Properties for the Gateway dispatcher ..... 136
Planning Servers .................................................. 136
Create an Analyst Network Share ....................... 137
Install the Planning Administration Server .......... 137
Configure the Administration Server ................. 139
Configure Properties for the Administration Server . 139
Set Database Connection Properties for the Planning Store 141
Start the Planning Server ..................................... 143
Install the Web Services Server ......................... 143
Configure the Web Services Server .................... 145
Configure Properties for the Web Services Server ... 145
Set Database Connection Properties for the Planning Store 147
Start the Planning Server ..................................... 148
Install the Planning Job Server ......................... 149
Configure the Planning Job Server ................. 151
Configure Properties for the Planning Job Server ... 151
Set Database Connection Properties for the Planning Store 153
Start the Planning Server ..................................... 155
Install the Planning Data Server ....................... 155
Configure the Planning Data Server .................... 156
Configure Properties for the Planning Data Server ... 156
Set Database Connection Properties for the Planning Store 158
Start the Planning Server ..................................... 160

Chapter 10. Installing the IBM Cognos Planning Clients .................................................. 161
Install IBM Cognos Planning Administration Components .......... 161
Default Settings for IBM Cognos Planning Administration Components .......... 162
Configure Environment Properties for the Administration Components .......... 162
Configuring Analyst Computers .......... 162
IBM Cognos Planning Contributor .................. 165
Installing and Configuring IBM Cognos Planning Contributor .......... 166
Setting Installation Options ...................... 166
Install Planning Contributor Using a Web Link .......... 166
Install Planning Contributor Using a Command Line .......... 167
Install Planning Contributor from the Planning Client Installation CD .......... 169
Uninstall the Contributor Web Client .......... 169
Install Planning Contributor Add-in for Microsoft Excel .......... 169
Installing and Configuring IBM Cognos Framework Manager .................. 170
Default Settings for Framework Manager .......... 172
Install Framework Manager .......... 172
Update the Java Environment .......... 173
Data Sources and Framework Manager .......... 174
Environment Properties for Framework Manager Computers .......... 176
Test the Installation and Configuration .......... 178
Install an Analyst Network Connection Point .......... 179
Uninstall IBM Cognos .......... 179

Chapter 11. Additional Configuration Options .................................................. 181
Start IBM Cognos Configuration .......... 181
Changing Default Configuration Settings .......... 181
Port and URI Settings .......... 182
Configuring Cryptographic Settings .......... 183
IBM Cognos Application Firewall .......... 188
Configure the Gateway to Use a Namespace .......... 189
Enable and Disable Services .......... 190
Changing the Location of Temporary Report Output .......... 191
Change the Notification Database .......... 191
change the connection properties for the notification database .................................................. 192
configuring the SSL protocol ........................................................................................................... 192
configure SSL for IBM Cognos components .................................................................................. 193
changing the gateway ....................................................................................................................... 197
configure the gateway for Apache Server 1.3 .................................................................................. 198
configure the gateway for Apache Server 2.0 or IBM HTTP Server 6.1 ........................................... 199
configure the gateway for Apache Server 2.2.x or IBM HTTP Server 7.0 ....................................... 201
configure an IBM Cognos Business Intelligence UNIX Gateway for IBM Cognos BI Planning .......... 203
configuring IBM Cognos Planning to Work with Other IBM Cognos Products .................................. 204
accessing product documentation in an integrated environment .................................................... 204
configuring IBM Cognos BI Components to Use Another Certificate Authority ......................... 204
command syntax for generating keys and certificate signing requests ............................................. 205
configure IBM Cognos BI Components to Run Within Another Certificate Authority .................. 208
tuning techniques for improving performance ................................................................................. 208
tuning a DB2 Content Store ............................................................................................................. 209
tuning WebSphere Liberty Profile ..................................................................................................... 209
translated product documentation ................................................................................................. 210
additional language fonts ................................................................................................................. 210
configure support for Japanese yen and Korean won characters .................................................... 210

Chapter 12. Setting Up an Unattended Installation and Configuration ........................................... 213
set up an unattended installation ..................................................................................................... 213
setting up an unattended installation using a file generated by an installation on another computer ...... 213
setting up an unattended installation using a response.ats file ...................................................... 215
set up an unattended configuration ............................................................................................... 216

Chapter 13. Configuring IBM Cognos Components to Use an Authentication Provider ............... 219
disable anonymous access .............................................................................................................. 220
restrict user access to the cognos namespace ............................................................................... 220
configuring IBM Cognos components to use active directory server .......................................... 221
configure an active directory namespace ...................................................................................... 222
make custom user properties for active directory available to IBM Cognos components ................. 223
enabling secure communication to the active directory server ...................................................... 223
include or exclude domains using advanced properties .................................................................. 224
enabling single signon between active directory server and IBM Cognos components ................. 225
configuring IBM Cognos to use IBM Cognos Series 7 namespace ................................................ 226
configure an IBM Cognos Series 7 namespace ............................................................................ 227
enabling secure communication to the directory server used by the IBM Cognos Series 7 namespace 228
enabling single signon between IBM Cognos Series 7 and IBM Cognos .......................................... 228
IBM Cognos Series 7 Namespaces and the IBM Cognos Series 7 Trusted Signon Plug-in .................. 228
configuring IBM Cognos to Use a Custom Authentication Provider ............................................ 230
configure a Custom Authentication Namespace .............................................................................. 231
hide the namespace from users during login .................................................................................... 231
configuring IBM Cognos Components to Use LDAP .................................................................... 232
LDAP Mapping ................................................................................................................................. 232
configure an LDAP namespace ....................................................................................................... 233
configure an LDAP namespace for active directory server ........................................................... 234
configure an LDAP namespace for IBM directory server ............................................................. 237
configure an LDAP namespace for Novell Directory Server ....................................................... 238
configure an LDAP namespace for Oracle Directory Server ..................................................... 240
make custom user properties for LDAP available to IBM Cognos components ............................. 242
enable secure communication to the LDAP server ......................................................................... 243
enabling single signon between LDAP and IBM Cognos components ........................................ 244
replace operation ............................................................................................................................ 245
configuring IBM Cognos Components to Use eTrust SiteMinder ................................................ 246
eTrust SiteMinder Configured for More Than One User Directory ............................................. 246
eTrust SiteMinder Configured With Only One User Directory ...................................................... 246
configure a Netegrity SiteMinder namespace ............................................................................... 247
enabling secure communication to the eTrust SiteMinder User Directory .................................... 248
enable single signon between eTrust SiteMinder and IBM Cognos ............................................... 248
Chapter 14. Configuring IBM Cognos for an SAP Environment ............................................. 257
Verify System Requirements ............................................................................................................. 257
Set Access Permissions for Modeling and Reporting Access ............................................................... 257
Install and Configure IBM Cognos SAP Gateway Functions ............................................................... 259
  Install gateway functions on Windows ............................................................................................... 260
  Install gateway functions on UNIX .................................................................................................. 260
  Apply the SAP Gateway Functions .................................................................................................. 260
  Install the IBM Cognos Compression Utility .................................................................................. 261
Set Access Permissions for the IBM Cognos SAP Gateway Functions ................................................ 261

Chapter 15. Configuring Portal Services ......................................................................................... 265
Specify the Location of the Applications.xml File .............................................................................. 265
Configuring Security for Portal Services .............................................................................................. 266
  Disable Anonymous Access to IBM Cognos Components ............................................................... 266
  Enable Single Signon Using Shared Secret ...................................................................................... 267
  Enable Single Signon for SAP EP with the SAP Logon Ticket ......................................................... 272
  Enable Single Signon for SAP EP with User Mapping ..................................................................... 272
  Enable Secure Communication Between SAP EP and IBM Cognos Components ......................... 274
  Enable Single Signon for WebSphere Portal Using the Application Server .................................... 274
  Enable Single Signon for Oracle WebCenter Interaction Portal Using Basic Authentication .......... 274
  Enable Single Signon for Oracle WebCenter Interaction Portal Using SiteMinder ......................... 275

Chapter 16. Setting Up the Samples for Contributor ......................................................................... 277
Install IBM Tivoli Directory Server .................................................................................................... 277
Import the Sample Authentication Data .............................................................................................. 277
Configure IBM Cognos Planning to Use Your IBM Tivoli Directory Server ........................................ 278
Configure Contributor Administration ................................................................................................. 279
GO Contributor Sample ..................................................................................................................... 279
Create Contributor Applications ......................................................................................................... 283
  Cube Settings .................................................................................................................................. 283

Chapter 17. Troubleshooting .......................................................................................................... 289
Troubleshooting a problem .................................................................................................................. 289
  Searching knowledge bases .............................................................................................................. 291
  Getting fixes ..................................................................................................................................... 292
  Contacting IBM Support .................................................................................................................. 292
  Exchanging information with IBM .................................................................................................... 293
  Subscribing to Support updates ......................................................................................................... 294
Log Files ............................................................................................................................................. 295
Problems starting IBM Cognos Business Intelligence ........................................................................ 298
  CFG-ERR-0106 error when starting the IBM Cognos service in IBM Cognos Configuration ............ 298
  Unable to start the IBM Cognos service because the port is used by another process .................... 300
  IBM Cognos Business Intelligence server not available when starting IBM Cognos BI ................. 300
  Cannot log on to a namespace when using IBM Cognos Connection .......................................... 304
  IBM Cognos services fail to restart after a network outage ............................................................. 304
  No warning that installing a later version of IBM Cognos Business Intelligence will automatically update the earlier version of the content store .................................................................................... 305
Content Manager error when starting IBM Cognos Business Intelligence ........................................ 305
The page cannot be found when starting IBM Cognos Business Intelligence in Windows 2003 ......... 305
The page is not shown when opening a portal after installing IBM Cognos Business Intelligence .......... 306
DPR-ERR-2058 Error Displays in Web Browser When Starting IBM Cognos Business Intelligence .......... 306
DPR-ERR-2022 error displays in Web browser when starting IBM Cognos Business Intelligence .......... 308
Application server startup script fails ................................................................. 308
Permission Problems Using Contributor Administration or Analyst .............................................. 308
Problems Integrating IBM Cognos Business Intelligence and IBM Cognos Planning ......................... 309
Page Not Found Error When Trying to Open Analysis Studio ................................................. 309
Failed to Load the Pluggable Shared Library When Using Analysis Studio ................................ 309
Problems Using Contributor Administrator Caused by Incorrect Database Configuration .................. 309
Problems Creating an Application in an SQL Environment ...................................................... 309
Problems Creating an Application in a DB2 Environment ....................................................... 310
Problems Importing Data in an SQL Environment .................................................................. 310
Problems Running Go to Production in an SQL Environment ................................................... 310
Problems Creating a Module in Framework Manager Using a SAP BW Data Source ...................... 310
The BAP-ERR-0002 BAPI Error ........................................................................... 310
The BAP-ERR-0002 BAPI Authorization Error for Function Group RSOB .................................. 311
The BAP-ERR-0002 BAPI Authorization Error for RFC_READ_TABLE .................................. 311
Authorization Error for Component ........................................................................ 311
Authorization Error for InfoCube ........................................................................... 311
Authorization Error for Hierarchy ........................................................................ 312
Authorization Error for Temporary File ........................................................................ 312
Authorization Errors Using the IBM Cognos SAP Gateway ...................................................... 312
Unable to Identify Required SAP Permissions .................................................................. 312
Unable to Identify SAP BW Version and Corrections ......................................................... 312
Error Messages in SAP Log When Using Data Manager Connector for SAP R/3 ......................... 313
Fact Table Does Not Include Any Data ........................................................................ 313

Appendix A. Accessibility features .................................................................................. 315
Keyboard Shortcuts for the Installation Wizard ...................................................................... 315

Appendix B. Command Line Options .............................................................................. 317
Run IBM Cognos Configuration in Silent Mode ...................................................................... 318
Stop the IBM Cognos Service in Silent Mode ...................................................................... 318
Test IBM Cognos BI Configuration .............................................................................. 319
Save the Configuration in UTF-8 Encoding ...................................................................... 319
Run IBM Cognos Configuration in Another Language ...................................................... 319
Export Configuration Settings in Silent Mode ...................................................................... 320
Create an Error Log ............................................................................................... 320
Run IBM Cognos Configuration on Windows using Specified JVM ..................................... 321

Notices .................................................................................................................. 323

Index ............................................................................................................... 327
Introduction

This document is intended for use with IBM® Cognos® Planning. It contains instructions for installing, upgrading, configuring, and setting up samples.

IBM Cognos Planning provides the ability to plan, budget, and forecast in a collaborative, secure manner. The major components are Analyst and Contributor.

IBM Cognos Planning Analyst

IBM Cognos Planning Analyst is a flexible tool used by financial specialists to define their business models. These models include the drivers and content required for planning, budgeting, and forecasting. The models can then be distributed to managers using the web-based architecture of IBM Cognos Planning Contributor.

IBM Cognos Planning Contributor

IBM Cognos Planning Contributor streamlines data collection and workflow management. It eliminates the problems of errors, version control, and timeliness that are characteristic of a planning system solely based on spreadsheets. Users have the option to submit information simultaneously through a simple web or Microsoft Excel interface. Using an intranet or secure internet connection, users review only what they need to review and add data where they are authorized.

Audience

To use this guide, you should be familiar with
• planning concepts
• database and data warehouse concepts
• security issues
• basic Windows administration skills
• the existing server environment and security infrastructure in your organization

Finding information

To find product documentation on the web, including all translated documentation, access IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter).

Accessibility features

The installation wizards have accessibility features. For information on these features, see “Keyboard Shortcuts for the Installation Wizard” on page 315.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The
development, release, and timing of features or functionality remain at the sole discretion of IBM.

Samples disclaimer

The Great Outdoors Company, GO Sales, any variation of the Great Outdoors name, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or machine generated, factual data compiled from academic or public sources, or data used with permission of the copyright holder, for use as sample data to develop sample applications. Product names referenced may be the trademarks of their respective owners. Unauthorized duplication is prohibited.
Chapter 1. What's New?

This section contains a list of new features for this release. It also contains a cumulative list of similar information for previous releases. This information will help you plan your upgrade and application deployment strategies and the training requirements for your users.

For information about upgrading, see the IBM Cognos Installation and Configuration Guide for your product.

To review an up-to-date list of environments supported by IBM Cognos products, including operating systems, patches, browsers, Web servers, directory servers, database servers, and application servers, visit the IBM Cognos support pages at http://www.ibm.com.

For more information about new features for this release, see the IBM Cognos New Features Guide for your product.

New features in version 10.2.0

The following topics describe the new features for 10.2.0.

**Bundled Cognos BI upgraded to version 10.2.2.5**

The version of IBM Cognos Business Intelligence (BI) that is bundled with IBM Cognos Planning 10.2 was upgraded to BI 10.2.2 FP5.

For comprehensive documentation about Cognos BI 10.2.2 components and features, visit IBM Knowledge Center (www.ibm.com/support/knowledgecenter/SSEP7J_10.2.2).

**Compatibility with Cognos Analytics 11**

IBM Cognos Planning 10.2 is compatible with IBM Cognos Analytics 11.

For comprehensive documentation about IBM Cognos Analytics components and features, visit IBM Knowledge Center (http://www.ibm.com/support/knowledgecenter/SSPE7J_11.0.0).

**WebSphere Liberty Profile is the default application server**

IBM Cognos Planning now installs a WebSphere® Liberty Profile as the default application server. Apache Tomcat is no longer installed as the default application server with IBM Cognos BI.

WebSphere Liberty Profile uses the same default port numbers as were used for the Apache Tomcat server. For example, the default port number 9300 is also used for the WebSphere Liberty Profile.

**SSL connections to IBM Cognos Planning databases**

You can now use the secure sockets layer (SSL) protocol for communication to databases used by IBM Cognos Planning, including the content store, notification, and logging databases.
New security standards in IBM Cognos Planning

By default, IBM Cognos Planning is qualified for the NIST SP800-131a standard as the product's cryptographic functions are configured for this standard.

You can configure IBM Cognos Planning to comply with other standards or remove cryptographic components that are associated with older standards by using the ThirdPartyCertificateTool.

32-bit Cognos Planning gateway

Even though BI 10.2.2 has a 64-bit gateway, the IBM Cognos Planning 10.2 gateway is still 32-bit and can only be installed on a 32-bit BI gateway.

The 64-bit version of the gateway is the default for all 64-bit installations. For a 32-bit installation, the 32-bit version of the gateway is the default for 32-bit installations.

Compatibility with Microsoft Office 2016

IBM Cognos Planning 10.2 is compatible with Microsoft Office 2016.

For more information, see Software Environments for IBM Cognos Planning 10.2.0.

Option to initialize Cognos Configuration from a different file

You can use the -startupfile path/filename.xml option to specify a startup file other than the cogstartup.xml file when starting the IBM Cognos configuration tool.

The cogstartup.xml file must still exist in the Configuration directory.

For example, the following command runs the installation program in silent mode using the test.xml file located in the Configuration directory to set the configuration parameters.

cogconfig.bat -s -startupfile <c10_location>/configuration/test.xml

New Features in Version 10.1.1

Listed in this section are new features since the last release. Links to directly-related topics are included.

Additional installation kits improve Cognos Planning deployment and maintenance

In version 10.1.1, the packaging of IBM Cognos Planning has changed to provide greater flexibility over the installable components.

Installation enhancements

The following installation kits have been changed to enable you to integrate Cognos Planning more quickly into existing IBM Cognos Business Intelligence (BI) environments.

Planning Complete installation kit

The new Planning Complete installation kit combines the functionality of the Planning Server, Planning Administration, and Planning Client installation kits.
into one installation kit. Use this kit to install and enable all the required Planning and Business Intelligence services automatically on a single computer.

**Planning Server installation kit**
The Planning Server kit has been streamlined to enable you to install specific Planning components in distributed environments. You can use it to install and configure the following components:

- Planning Job service
- Planning Web service
- Planning Administration Console service
- Planning Data service
- Analyst Universal Naming Convention (UNC) Connection

**Important:** Only the installed components appear in IBM Cognos Configuration and are enabled by default. The services that are not installed do not appear in IBM Cognos Configuration.

To install the Planning gateway component, you must use the Planning Gateway installation kit.

To install the Content Manager and other Business Intelligence (BI) services, you must use the Planning Complete installation kit.

**Planning Gateway installation kit**
The new Planning Gateway kit enables you to install the Planning-specific files on the same computer that has the BI gateway. The following components are installed automatically:

- Contributor rich client installer
- Contributor workflow page

Starting this release, you can use the Planning Gateway installation kit on the UNIX and Linux operating systems that are supported by the BI gateway, in addition to the Windows operating systems.

The Planning Administration installation kit and the Planning Client installation kit are unchanged.

**Administration and maintenance enhancements**

When you select the Planning component-specific installation kits, the installation footprint for each installation is reduced. In addition, when you download fix pack images, the fix pack download time is reduced because the size of the fix pack images for the new kits is smaller than in previous releases.

For more information about how to use the Planning installation kits, see the *IBM Cognos Planning Installation and Configuration Guide*.

**New LDIF sample file for IBM Tivoli Directory Server**

In version 10.1.1, you can use a new sample file (*great_outdoors.ldif*) to import authentication data to IBM Tivoli® Directory Server. This new sample replaces the *Contributor_sample.ldif* that was available for the Sun Java Systems directory servers.

For information about how to use the new sample file, see [Chapter 16, “Setting Up the Samples for Contributor,” on page 277](#).
New Features in Version 10.1.0

Listed in this section are new features since the last release. Links to directly-related topics are included.

Creating and Configuring a Planning Store

It is now mandatory to create and configure a planning store for your IBM Cognos Planning environment. You can connect to your planning store using IBM Cognos Configuration.

Deprecated Features in Version 10.1.0

A deprecated feature is one that is being replaced by a newer version or a better implementation. The intention is to discontinue the use of the feature and provide recommendations for adapting to this change over multiple releases.

Listed in this section are deprecated features, including links to related topics.

Planning Classic Client

The Planning Classic Client is no longer supported.

This means that the Planning Classic Client is no longer available as a component install option from the Planning Client CD. Also, the Use the classic Contributor client check box on the Go to Production Options page was removed.
Chapter 2. Components Used by IBM Cognos Planning

IBM Cognos Planning uses Microsoft Windows and Web browser components to provide planning solutions for budgeting and forecasting in a collaborative and secure manner. IBM Cognos Planning uses a modelling tool to define the content required for planning, budgeting, and forecasting, and uses a Web-based architecture to distribute plans and allow users to input contributing data.

IBM Cognos Planning uses standard IBM Cognos components for security and distributing plans. IBM Cognos Planning can be integrated in your existing IBM Cognos environment.

IBM Cognos Planning integrates easily into your existing infrastructure by using resources that are in your environment, such as a database for the content store and planning store or a security provider for authentication.

Server Components

Server components provide the user interfaces for distributing plans and contributing data, as well as the server functionality for routing and processing user requests. Server components include the following tools:

IBM Cognos Planning Contributor

IBM Cognos Planning Contributor streamlines data collection and workflow management. It eliminates the problems of errors, version control, and timeliness that characterize decentralized planning processes. Organizations can easily engage thousands of people in the planning process, collecting data from managers and staff across divisions and across geographies as well as from resellers, suppliers, and customers worldwide.

IBM Cognos Planning Contributor Administration

IBM Cognos Planning Contributor Administration enables administrators to publish an IBM Cognos Planning Analyst business model to the Web, manage access settings and model distribution, and configure the user's view of the model.

IBM Cognos Planning Manager

Use IBM Cognos Planning Manager to design reports using data stored in IBM Cognos Planning Analyst. Choosing this option installs IBM Cognos Planning Manager on its own. You can select this if you do not want users to have direct access to Analyst. You must configure users’ security to attain this.

Note: If you choose this option on its own, Analyst is also installed, but it is only accessible through objects in an IBM Cognos Planning Manager report.

IBM Cognos Connection

Content Manager is the IBM Cognos service that manages the storage of customer application data, including security, configuration data, models, metrics, report specifications, and report output. Content Manager is needed to publish packages, retrieve or store report specifications, manage scheduling information, and manage the Cognos namespace.
Content Manager stores information in a content store database.

**Cognos Viewer**

Cognos Viewer is a portlet in which you can view and interact with any type of published IBM Cognos content. It is accessible through IBM Cognos Connection and any existing enterprise portal.

**IBM Cognos Configuration**

IBM Cognos Configuration is a tool that you use to configure IBM Cognos products, and to start and stop its services.

**Gateway**

Web communication in IBM Cognos is typically through gateways, which reside on one or more Web servers. A gateway is an extension of a Web server program that transfers information from the Web server to another server.

Gateways are often CGI programs, but may follow other standards, such as Internet Server Application Program Interface (ISAPI), Apache Modules (apache_mod), or as a servlet implementation.

**IBM Cognos for Microsoft Office**

Using IBM Cognos for Microsoft Office, Microsoft Office users can access data from IBM Cognos reporting products within Microsoft Office applications.

IBM Cognos for Microsoft Office components are included with IBM Cognos BI and must be installed separately.

**Content Manager**

Content Manager is the IBM Cognos service that manages the storage of customer application data, including security, configuration data, models, metrics, report specifications, and report output. Content Manager is needed to publish packages, retrieve or store report specifications, manage scheduling information, and manage the Cognos namespace.

Content Manager stores information in a content store database.

**IBM Cognos Virtual View Manager**

IBM Cognos Virtual View Manager provides access to additional data sources such as LDAP, JDBC, Open XML and WSDL, and improves performance when querying data from different data sources.

**Modeling Components**

Modeling components model data within data sources to define the content required for planning, budgeting, and forecasting. Modeling components include the following tools:

**IBM Cognos Planning Analyst**

IBM Cognos Planning Analyst is both a stand-alone desktop analysis tool and the tool used to create the plans to distribute using the Web-based architecture of IBM Cognos Planning Contributor. Use Analyst to establish the structure that defines the key drivers and content required for planning, budgeting, and forecasting, and
the distribution of templates to managers.

**IBM Cognos Planning Analyst Add-in for Microsoft Excel**

Use IBM Cognos Planning Analyst Add-in for Microsoft Excel to create a connection between the data held in Analyst and the view in Microsoft Excel. You can then create and transfer workbook data to and from the Analyst database.

**Creating a business view of your data - Framework Manager**

Framework Manager is the IBM Cognos Business Intelligence modeling tool for creating and managing business-related metadata for use in IBM Cognos BI analysis and reporting. Metadata is published for use by reporting tools as a package, providing a single, integrated business view of any number of heterogeneous data sources.

**Other Components**

In addition to the tools provided with IBM Cognos, it requires the following components that are created using other resources.

**Content Store**

The content store is a relational database that contains data that IBM Cognos Planning needs to operate, such as published plans, and the packages that contain them; connection information for data sources; information about the external namespace, and the Cognos namespace itself. The relational database must be from a supported vendor.

Design models and log files are not stored in the content store.

The IBM Cognos service that uses the content store is named Content Manager.

**Planning Store**

The planning store contains macros, links, access rights, system settings, and application linking information for your planning applications.

The planning store can be the same database as the content store or can be a separate database.

Communicating with the planning store is done using the object linking and embedding database (OLE DB) API.
Chapter 3. Installation Options

Before implementing IBM Cognos Planning, decide how you will install and configure it to provide optimal performance. The choices that produce the best performance depend on your requirements, resources, and preferences.

When you install IBM Cognos Planning, you specify where to install the gateways, planning servers, and Content Manager. You can install all IBM Cognos components on one computer, or distribute them over a network. You must also install the IBM Cognos Planning administration clients, including Analyst Administration and Contributor Administration, and the Analyst and Contributor user clients, Contributor for Microsoft Excel, and Contributor Web client.

For advanced modeling and for use with Event Studio, you can install Framework Manager, the metadata modeling application. Framework Manager also provides additional data source access for IBM Cognos Planning applications.

IBM Cognos Planning is compatible with other IBM Cognos products. If your environment includes other IBM Cognos products, consider how IBM Cognos Planning will fit into that environment.

**64-bit server installation considerations**

You cannot install IBM Cognos Planning components in the same directory as the 64-bit version of IBM Cognos Business Intelligence (BI). You must install them in separate paths or on separate computers.

**Installing All Server Components on One Computer**

Install all server components on one computer only for proof of concept or in demonstration environments where the user load is small. Because the gateway must be located with the Web server, the single computer must also be running a Web server.

In the following diagram, all server components are installed on one computer, and the client applications are installed on another.
Installing the Gateway on a Separate Computer

You can install the gateway and a web server on one computer, and install the remaining IBM Cognos components on other computers. If you have a web farm, you may want to install an IBM Cognos gateway on each web server. Using multiple web servers to manage incoming requests provides better service.

If you install only the gateway component on the same computer as the web server, your web server manages the core web services and does not process user requests. This separation of processing may be required if you have a network firewall between the web server and your Planning Server computers, as shown in the following diagram.
If you are installing into an environment with other IBM Cognos products, and you are using the same content store, we recommend that you either use the same gateway or install the gateway components of each product into the install locations of your other product’s gateway. If you use separate gateways while sharing the content store, a Page Not Found error will appear when you use one product’s component from the other product’s gateway. For example, Page Not Found appears when you try to open Analysis Studio from the IBM Cognos Planning gateway.

Figure 2. IBM Cognos Planning installation with a gateway on a separate computer
Installing the Planning Server and Content Manager on Separate Computers

Installing the Planning Server on a separate computer from Content Manager can improve performance, availability, and capacity.

This strategy is useful in the following situations:
- Your content store contains sensitive information
  Data is then stored in the data tier with your security information.
- Large volumes of data are managed by Content Manager
  You can improve scalability by increasing the processor size on which Content Manager is installed.

The following diagram shows a configuration where the Planning Server and the Content Manager are installed on separate computers.

Figure 3. IBM Cognos Planning installation with Content Manager on a separate computer
Multiple Installations of Content Manager

Your installation may include more than one Content Manager, each on a different computer. In this scenario, one Content Manager computer is active and one or more Content Manager computers are on standby. The standby Content Manager computers are for failover protection. If the active Content Manager computer is not available because of a software or hardware failure, a standby Content Manager computer becomes active and requests are directed to it.

When the active Content Manager fails, unsaved session data is lost. When another Content Manager becomes active, users may be prompted to log on.

Installing Multiple Planning Servers

To improve scalability in an environment that serves many users, you can install the Planning Server component on multiple computers dedicated to processing incoming requests. This strategy distributes and balances loads among the computers, and provides better accessibility, throughput, and failover support than installing on a single computer.

The following diagram shows an environment with each of the Planning Server roles on a separate computer, and one Planning Server running all the other IBM Cognos services.
In a small environment, such as a proof of concept or demonstration environment, you can install all the server components on the same computer, and the server computer can run all the IBM Cognos Planning services. The Planning clients connect to the server.

The following diagram shows a distributed installation for a small IBM Cognos Planning environment.

Figure 4. Role-based IBM Cognos Planning configuration
Distributed Installation in a Medium or Large Environment

In a medium-sized environment, you can distribute the Planning services among different servers to improve performance.

For example, you can separate the planning job service and planning data service onto different computers, the planning web service and planning administration service can be on another computer, and the other IBM Cognos services can be running on yet another computer. The Content Manager and gateway can also be on different computers.

The following diagram shows distribution options for a medium or large IBM Cognos Planning environment.

Figure 5. Distributed installation in a small environment
To provide more stability and predictability, distribute your planning servers, if possible. If each service is isolated, it is not affected by the high usage of other services.

As additional computers become available, we recommend that you assign them to a dedicated role, in the following order:

1. Specify that the first available computer run only the planning data service.
2. Specify that the next available computer run only the planning job service.
3. Specify that the next available computer run only the Content Manager service.

Figure 6. Distribution options for a medium or large IBM Cognos Planning environment
4. Specify that the next available computer run only the gateway and planning web service.

In a large environment, you can add servers to increase the number of planning job service computers and planning data service computers to meet your production needs. You can also run the planning web service and planning administration service on separate Planning Server computers. For more information, see the IBM Cognos Planning Architecture and Deployment Guide.

---

**Installing Planning Clients**

You can install the clients on the same computer as the Planning Server components, or on a separate computer. Also, you can install each client independently.

The administration clients include the following:

- Analyst
- Analyst for Microsoft Excel
- IBM Cognos Planning Manager
- Contributor Administration

The runtime clients include the following:

- Contributor web client
- Contributor for Microsoft Excel

A limited number of Analyst and Contributor Administration clients are usually installed in an environment, because most users will use either the Contributor web or Contributor for Microsoft Excel clients.

Each client connects to the Planning Servers through the gateway.

---

**Installing Framework Manager**

You can install Framework Manager either on a computer containing other IBM Cognos Planning components, or on a computer that is separate from these other components.

To publish Framework Manager models, you must configure Framework Manager to communicate with a dispatcher, either directly or through a dedicated gateway.

We recommend that Framework Manager connect to a Planning Server dispatcher using the internal dispatcher URI. An alternative is to connect to an additional, dedicated gateway that is configured to connect to the dispatcher using the internal dispatcher URI. You must configure appropriate security for this gateway. This method is useful when the modeling tool is outside a network firewall.

Do not change your main gateway to use the internal dispatcher URI. Doing so reduces the security of IBM Cognos Planning.

To ensure that Framework Manager can communicate with IBM Cognos Planning components, configure cryptographic properties and the following environment properties on the computer where Framework Manager is installed:

- Gateway URI
- Dispatcher URI for external applications
Web Servers Other Than Microsoft IIS

For web servers other than Microsoft Internet Information Services (IIS), no functional difference exists between the connection alternatives for Framework Manager and the Planning Server dispatcher. For either connection, Framework Manager uses the BI Bus SOAP API. If you connect through the gateway, and you have medium-sized and large models (approaching 1 MB in size), the models are broken into smaller pieces (chunked) for transmission.

If you use a web server other than Microsoft IIS, we recommend that you configure Framework Manager to communicate through your web server gateway. This eliminates the need to set up additional communications channels if you use firewalls to separate Framework Manager, your web server, and your Planning Server.

Network Firewall Considerations

When Framework Manager is outside a network firewall that protects the Planning Server computer, communication issues with the dispatcher can occur. For security reasons, the default IBM Cognos configuration prevents the dispatcher from accepting requests from Framework Manager when it is outside the network firewall.

By default, Framework Manager is configured to send requests directly to the dispatcher.

To avoid communication issues when communicating directly with the dispatcher, install Framework Manager in the same architectural tier as the Planning Server.

The following diagram shows Framework Manager installed inside the network firewall and how it can communicate with the Planning Server and Content Manager.
Alternatively, you can install an additional gateway that is dedicated for communication with Framework Manager. You then configure Framework Manager and its gateway such that the dispatcher accepts requests from Framework Manager. In addition to the environment properties that must be configured for Framework Manager, you must configure the Dispatcher URIs for gateway property on the dedicated gateway computer.

Installing IBM Cognos Planning with IBM Cognos Business Intelligence

You can install IBM Cognos Planning in an environment that includes other IBM Cognos products. The installation wizard for IBM Cognos Planning will recognize compatible directories and show a warning when conflicts occur.

If you plan to install IBM Cognos Planning and IBM Cognos Business Intelligence in the same environment then you must ensure that the following conditions are met:

- If you already have IBM Cognos Business Intelligence version 10.1.1 installed, you can install version 10.2.0 of IBM Cognos Planning. When you configure Cognos Planning, your existing BI 10.1.1 configuration is maintained.
- If you have IBM Cognos Analytics version 11.0 installed, you can install version 10.2.0 of IBM Cognos Planning. When you configure Cognos Planning 10.2, it uses the BI 10.1.1 components that are bundled with it. However, you can then use Cognos Planning to work with some features of your Cognos Analytics environment.
• Only one instance of a Planning Server or a Planning Administration tool is permitted per machine.

• Only one instance of each IBM Cognos product can be installed per machine. The IBM Cognos Planning instance and the IBM Cognos BI instance must be installed in the same location.

• A machine can only belong to one environment.

You can use IBM Cognos Planning published data as the basis for IBM Cognos Business Intelligence reports. Report Studio and Analysis Studio users can access unpublished (real-time) and published Contributor data for analysis and reporting. You can also import data from IBM Cognos data sources into Contributor applications and Analyst models. For more information, see the Contributor Administration Guide.

If you have an existing IBM Cognos Business Intelligence environment, you can install IBM Cognos Planning into that environment and use your existing IBM Cognos Business Intelligence content store. If the content store is on a database platform not supported by IBM Cognos Planning, you can still use the IBM Cognos Business Intelligence content store, but you must use a separate planning store on a supported database.

If you installed IBM Cognos Business Intelligence on a single server for a demonstration or proof of concept environment, you can install the IBM Cognos Planning server and clients into that environment. You can install the Planning Server component to the same location as your IBM Cognos Business Intelligence Application Tier Components. You can install the clients to the same location or to another location on the same computer.

In the following diagram, the server components are installed on one computer and the clients are installed on another computer. Also, the planning store has been added as a separate database.
If you installed IBM Cognos Business Intelligence in a distributed environment and separated the gateway, Application Tier Components, and Content Manager, you can install IBM Cognos Planning into that distributed environment. In this case, you must install the IBM Cognos Planning gateway to the same location as your IBM Cognos Business Intelligence gateway, and you can use your existing Content Manager. To enhance performance, you may want to install the Planning Server to a separate computer.

For example, you may have an IBM Cognos Business Intelligence environment that looks like this:

*Figure 8. IBM Cognos Planning and IBM Cognos Business Intelligence configuration*
You must install the IBM Cognos Planning gateway component into the same location where you installed the IBM Cognos Business Intelligence gateway.

Figure 9. IBM Cognos Business Intelligence environment without IBM Cognos Planning

You must install the IBM Cognos Planning gateway component into the same location where you installed the IBM Cognos Business Intelligence gateway.
Because IBM Cognos Planning uses the same Content Manager as IBM Cognos Business Intelligence, you do not need to reinstall Content Manager.

Your IBM Cognos Business Intelligence and IBM Cognos Planning environment could look like this:

Figure 10. IBM Cognos Business Intelligence environment with IBM Cognos Planning

You cannot install IBM Cognos Planning components in the same directory as the 64-bit version of IBM Cognos Business Intelligence (BI). You must install them in separate paths or on separate computers.
Chapter 4. Workflow for IBM Cognos Planning

Before you can use IBM Cognos Planning, you must prepare for the implementation, install and configure IBM Cognos Planning. Once these tasks are complete, you can set up security.

The following diagram shows the sequence of these tasks:

![IBM Cognos Planning workflow diagram]

Prepare for Implementation

Implementing IBM Cognos Planning means installing and configuring it to integrate effectively with your existing infrastructure.

To ensure that IBM Cognos Planning is implemented effectively, carefully outline your implementation beforehand using an implementation checklist. For more information, see the Architecture and Deployment Guide.

Install IBM Cognos Planning

Installing IBM Cognos Planning is typically done by Information Technology personnel under the direction of a solutions architect.

When you install IBM Cognos Planning using the Installation wizard, you specify where to install each of these components:

- Planning Gateway
- Planning Servers
- Content Manager

You can install the components on one computer, or distribute them across a network. Before installing IBM Cognos Planning, choose the appropriate installation and configuration option [Chapter 3, “Installation Options,” on page 9].

You must also install the administration applications, including IBM Cognos Planning Analyst and Contributor Administration, and IBM Cognos Framework Manager. The studio interfaces, such as Event Studio, are HTML- and JavaScript-based and do not require installation.
Client applications, such as the IBM Cognos Planning Contributor client and Contributor Add-in for Microsoft Excel, must also be installed on user computers.

**Unattended Installation**

If you plan to install an identical IBM Cognos Planning configuration across several computers on a network, or to install multiple configurations, you can set up and run an unattended installation. This is a noninteractive method of installing and configuring IBM Cognos Planning in which all the tasks run automatically, without user intervention. You can run the unattended installation as part of a script, or from the command line.

An unattended installation is useful if you must install IBM Cognos Planning at different geographic locations, some of which have no technical personnel to perform the installation. You can also use an unattended installation if you plan to install multiple Planning Servers in your environment.

For more information about unattended installations, see Chapter 12, “Setting Up an Unattended Installation and Configuration,” on page 213.

**Configure IBM Cognos Planning**

Use IBM Cognos Configuration to set up your IBM Cognos Planning environment. Some of the things that you can configure are

- **port numbers**
  You can change the default port numbers used by IBM Cognos Planning components.

- **gateway address**
  You can change the default gateway address from http://localhost/ibmcognos.

- **security**
  You can run IBM Cognos with or without security. By default, the only security that is enabled is IBM Cognos Application Firewall. For IBM Cognos Planning, you must apply security. IBM Cognos Planning can use your existing security provider.

- **data access**
  You must specify database connection information for the IBM Cognos content store and the planning store.

- **logging**
  You can specify the destination log for messages generated by some IBM Cognos server components, such as the gateway, Content Manager, and the IBM Cognos Dispatcher service. The default location for client log files is C:\Windows\Temp.

Following initial configuration, if a property changes or components are added, you can use IBM Cognos Configuration to change your settings. The list of properties and services displayed in IBM Cognos Configuration depends on the Cognos Planning components that are installed.

**Monitor Configuration Changes**

Each time that you save a configuration after making changes, date-stamped versions of the following configuration files are automatically saved in the c10_location/configuration directory:

- cogstartup.xml
This file records configuration settings. An example file name is cogstartup_200211231540.xml.

- coglocale.xml
  This file records locale settings used for multilingual reporting. An example file name is coglocale_200211261401.xml.

If you are unable to save a configuration, or you have problems with a configuration, you can revert to a previous configuration file.

You can use the configuration files to review your configuration history. Before calling Cognos Software Services for help, print a history of the configuration changes made in IBM Cognos.

**Configure Security**

IBM Cognos integrates with an existing security infrastructure to provide user authentication. IBM Cognos can secure content by using the user and group definitions from your security system, without any changes required.

A Cognos namespace is included in case you want to define additional groups for securing content. These groups can simplify security administration by including users and groups from one or more authentication providers.

IBM Cognos includes IBM Cognos Application Firewall, which is installed with the dispatcher to validate and filter incoming and outgoing traffic at the dispatcher layer. By default, IBM Cognos Application Firewall is enabled.

IBM Cognos provides an authorization facility for assigning permissions to users defined in the authentication provider. It also provides a standard certificate authority (CA) for setting up encryption. Enhanced capabilities are available separately.

If you intend to set up security for IBM Cognos, it should be the first thing that you do after installation. For information about setting up and maintaining security, see the *Administration and Security Guide*.

**Administer IBM Cognos**

After IBM Cognos is installed and configured, you can use IBM Cognos Connection or your portal to

- set up folders
- make plans available to business users
- monitor and administer servers
- back up data
- maintain security

For information about using IBM Cognos Connection, see the IBM Cognos Connection *User Guide*. For information about administration, including setting up sample report projects and models, see the *Administration and Security Guide*. 
Chapter 5. Setting Up Your Environment

You must set up resources in your environment for the IBM Cognos components to operate. For example, you must create a database for the content store and the planning store and you must configure your Web server.

You must ensure that a web browser and a web server are set up to provide access to IBM Cognos components. If you use a router, you must configure it to support IBM Cognos features.

If you install multiple Planning components on the same server, they must be at the same version level. If you install Planning web clients on separate computers from the Planning server, these computers can have multiple versions of the Planning clients connecting to their respective Planning servers.

Review the Release Notes Before You Install

Before you install your IBM Cognos product, it is important to be aware of all issues that may affect your installation strategy.

There may be late-breaking issues that were not known when this installation guide was created.

Review the Release Notes before you install your product. The Release Notes contains late-breaking information about known issues, and documentation updates and deprecation notices. The Release Notes are available from the first page of the installation wizard or from the product disk. Release Notes updates are also available on the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/].

Review Supported Environments

To ensure that your product works properly, apply all minimum required operating system patches and use only the versions of other software that are supported for an IBM Cognos product.

To review an up-to-date list of environments supported by IBM Cognos products, such as operating systems, patches, browsers, Web servers, directory servers, database servers, and application servers, visit the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/].
Verify System Requirements

Use the following table to check the minimum hardware and software requirements to install and run IBM Cognos components on one computer. Additional resources may be required for distributed or production environments.

Table 1. Minimum hardware and software requirements for IBM Cognos Planning

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Microsoft Windows&lt;br&gt;UNIX&lt;br&gt;Linux</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum: 2 GB</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum for Planning Client: 512 MB</td>
</tr>
<tr>
<td>Operating system specifications</td>
<td>File descriptor limit set to 2048 on UNIX and Linux operating systems&lt;br&gt;File descriptor limit set to 1024 on Oracle Solaris operating systems</td>
</tr>
<tr>
<td>Disk space</td>
<td>A minimum of 2.5 GB of free space is required to install the software and 4 GB of free space on the drive that contains the temporary directory used by IBM Cognos components.</td>
</tr>
<tr>
<td>Web server</td>
<td>A web server must be installed and started.</td>
</tr>
<tr>
<td>Java™ Runtime Environment (JRE)</td>
<td>An IBM JRE is installed automatically with IBM Cognos on Windows.&lt;br&gt;If you are using an application server, use the JRE that is installed with it, if it is supported in IBM Cognos.</td>
</tr>
</tbody>
</table>
| Database                         | You must have one of the following databases available to store IBM Cognos data:<br>  
  • Oracle<br>  
  • DB2®<br>  
  • Microsoft SQL Server<br>  
  • Sybase<br>  
  Sybase can only be used for the content store. You cannot use Sybase for the planning store. |
Table 1. Minimum hardware and software requirements for IBM Cognos Planning (continued)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web browser</td>
<td>For all web browsers, the following are enabled:</td>
</tr>
<tr>
<td></td>
<td>• cookies</td>
</tr>
<tr>
<td></td>
<td>• JavaScript</td>
</tr>
<tr>
<td></td>
<td>For Microsoft Internet Explorer only, the following are enabled:</td>
</tr>
<tr>
<td></td>
<td>• Run ActiveX controls and plug-ins</td>
</tr>
<tr>
<td></td>
<td>• Script ActiveX controls marked safe for scripting</td>
</tr>
<tr>
<td></td>
<td>• Active scripting</td>
</tr>
<tr>
<td></td>
<td>• Allow META REFRESH</td>
</tr>
<tr>
<td>Other</td>
<td>On Windows, Microsoft Data Access Component (MDAC) for use with product samples</td>
</tr>
<tr>
<td></td>
<td>If you want to email reports, the ability to use a mail server</td>
</tr>
<tr>
<td>SAP BW</td>
<td>The following SAP Front-End components installed on each IBM Cognos server computer:</td>
</tr>
<tr>
<td></td>
<td>• SAP GUI 6.40</td>
</tr>
<tr>
<td></td>
<td>• BW Add-ons</td>
</tr>
</tbody>
</table>

Guidelines for Creating the Content Store and Planning Store

The content store is a database that Content Manager uses to store global configuration data, global settings (such as the language and currency formats shown in the user interface), connections to data sources, and product-specific content. The planning store contains macros, links, access rights, system settings, and application linking information for your planning applications.

You can use the same database for both the content store and the planning store. Alternatively, you can use separate databases in the same database instance, or in different database instances.

You can use any of the following supported databases for the content store:
• Microsoft SQL Server
• Oracle
• DB2
• Sybase Adaptive Server Enterprise (ASE)

The planning store can be on any of the following supported databases:
• Microsoft SQL Server
• Oracle
• DB2
If you use Sybase for the content store, you must use another supported database for the planning store.

A Microsoft SQL Server or Oracle database can use UTF-8 or UTF-16 encoding. A DB2 or Sybase database must use UTF-8 encoding. The database you use for the content store must use the TCP/IP protocol.

**Database Properties**

You must create the database using one of the databases listed in the following table:

<table>
<thead>
<tr>
<th>Database</th>
<th>Character Encoding</th>
<th>Protocol</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>UTF-8</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Oracle</td>
<td>AL32UTF8 or AL32UTF16</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>SQL Server</td>
<td>UTF-8 or UTF-16</td>
<td>TCP/IP</td>
</tr>
<tr>
<td>Cognos Content Database</td>
<td>pre configured</td>
<td>pre configured</td>
</tr>
</tbody>
</table>

Your database administrator should back up IBM Cognos databases regularly because they contain the IBM Cognos data. To ensure the security and integrity of databases, protect them from unauthorized or inappropriate access.

**Collation Sequence**

IBM Cognos uses a single sort order that specifies the rules used by the database to interpret, collect, compare, and present character data. For example, a sort order defines whether the letter A is less than, equal to, or greater than the letter B; whether the collation is case sensitive; and whether the collation is accent sensitive. For more information about collation and collation sequences, see the database documentation.

**Suggested Settings for Creating the Content Store in DB2 on Linux, Windows and UNIX**

The database you create on the Microsoft Windows, Linux, or UNIX operating system for the content store must contain the specified configuration settings.

To ensure a successful installation, use the following guidelines when creating the content store. Use the same guidelines to create a database for log messages.

**Library Files for DB2**

Ensure that you use the appropriate library files for the version of the IBM Cognos Planning server that you install. IBM Cognos Planning requires 32-bit library files when running in a 32-bit application server and it requires 64-bit library files when running in a 64-bit application server. Depending on the version of DB2 that you have installed, you may have to change the library files or change the order in which the library files are listed so that IBM Cognos Planning server can find the correct files. Whichever version of library files are needed must be listed first.
Guidelines for Creating the Content Store in DB2 on Linux, UNIX, or Windows

Use the following checklist to help you set up the content store on DB2.

- If you use type 2 JDBC connectivity, set the appropriate environment variables for DB2, which are as shown in the following table.

Table 3. Environment variables for DB2

<table>
<thead>
<tr>
<th>Environment variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2PATH</td>
<td>The top level directory that contains the database client software or the entire database installation.</td>
</tr>
<tr>
<td>DB2INSTANCE</td>
<td>The default database server connection.</td>
</tr>
<tr>
<td>DB2CODEPAGE</td>
<td>Setting this optional environment variable to a value of 1208 provides support for multilingual databases. For information about whether to use this environment variable, see the DB2 documentation.</td>
</tr>
</tbody>
</table>

- Use UTF-8 as the code set value when you create the database.
  To check if your database has the correct code set, using the command line interface, type the following at the command prompt:
  
  `db2 get database configuration for database_name`
  
The code set value should be UTF-8 and the code page value should be 1208.

- Ensure that you set the configuration parameters and registry variable as shown in the following table.

Table 4. Configuration parameters and registry variables for DB2

<table>
<thead>
<tr>
<th>Property</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application heap size configuration parameter (applheapsz)</td>
<td>AUTOMATIC or at least 1024 KB</td>
</tr>
<tr>
<td></td>
<td>If the application heap size value is too small, out of memory errors may occur when there are many users.</td>
</tr>
<tr>
<td>Lock timeout configuration parameter (locktimeout)</td>
<td>240 seconds</td>
</tr>
<tr>
<td></td>
<td>Do not set this to an infinite timeout value.</td>
</tr>
<tr>
<td>DB2 registry variable (DB2_INLIST_TO_NLJN)</td>
<td>YES</td>
</tr>
<tr>
<td></td>
<td>Setting this variable to YES improves performance.</td>
</tr>
</tbody>
</table>

- Create a buffer pool with a page size of 32 KB, and a second one with a page size of 4 KB.
- Create a system temporary tablespace using the 32 KB buffer pool you created in the previous step.
- Create a user temporary tablespace using the 4 KB buffer pool you created. Global temporary tables will be created in the user temporary tablespace.
- Create a regular user tablespace using the 4 KB buffer pool you created.
  If you are also creating a logging database, create an additional regular user tablespace with a page size of 8 KB.
Grant the following database privileges for the user account IBM Cognos BI will use to access the database:
- connect to database
- create tables
- create schemas implicitly

**Tip:** If you want to host more than one content store on your DB2 instance and you will use both at the same time, use a different user account for each content store to ensure that each IBM Cognos BI instance is fully isolated from the other.

- Ensure that the user account has use privileges for the user temporary tablespace and other appropriate tablespaces associated with the database.
- Create a schema for the user account IBM Cognos BI will use to access the database, and ensure the user has create, drop, and alter permissions for the schema.
- Create a profile that sources the sqlib/db2profile from the DB2 user's home directory. For example, the content of your profile will be similar to the following:

```bash
if [-f /home/db2user/sqlib/db2profile ]; then
  /home/db2user/sqlib/db2profile
fi
```

- Your database administrator must back up IBM Cognos databases regularly because they contain the IBM Cognos data. To ensure the security and integrity of databases, protect them from unauthorized or inappropriate access.

### Suggested Settings for Creating the Content Store in Oracle

The database you create for the content store must contain the specified configuration settings.

To ensure a successful installation, use the following guidelines when creating the content store. Use the same guidelines to create a database for log messages.

Use the following list to help you set up the content store on Oracle.

- Ensure that the parameter for the database instance compatibility level of the content store database is set to 9.0.1 or higher.
  
  For example, you can check the COMPATIBLE initialization parameter setting by issuing the following SQL statement:

  ```sql
  SELECT name, value, description FROM v$parameter WHERE name='compatible';
  ```

  For information about changing an instance configuration parameter, see the Oracle documentation.

- Determine if the database is Unicode.

  **Tip:** One method is to type the following select statement:

  ```sql
  select * from NLS_DATABASE_PARAMETERS
  ```

  If the result set returns an NLS_CHARACTERSET that is not Unicode, create a new database and specify AL32UTF8 for the database character set parameters.

- Determine which user account will be used to access the database.
Tip: If you want to host more than one content store on your Oracle instance and you will use both at the same time, use a different user account for each content store to ensure that each IBM Cognos Business Intelligence instance is fully isolated from the others.

- Ensure that the user account that accesses the database has permission to do the following:
  - connect to the database
  - create, alter, and drop triggers, views, procedures, and sequences
  - create and alter tables
  - insert, update, and delete data in the database tables
- Your database administrator must back up IBM Cognos BI databases regularly because they contain the Cognos data. To ensure the security and integrity of databases, protect them from unauthorized or inappropriate access.

**Suggested Settings for Creating the Content Store in Microsoft SQL Server**

The database you create for the content store must contain the specified configuration settings.

To ensure a successful installation, use the following guidelines when creating the content store. Use the same guidelines to create a database for log messages.

Use the following checklist to help you set up the content store on Microsoft SQL Server.

- Ensure that the collation sequence is case-insensitive.
  In a Custom installation, you choose a collation, which includes character sets and sort order, during the Microsoft SQL Server setup. In a Typical installation, the installation uses the locale identified by the installation program for the collation. This setting cannot be changed later.
- When connecting to Microsoft SQL Server Management Studio to create the database, use Microsoft SQL Server authentication.
  If you connect using Microsoft Windows operating system authentication, the database that you create will also use Windows authentication. In this situation, you must configure the database connection using a database type of **SQL Server database (Windows Authentication)** in IBM Cognos Configuration.
- For the user account that will be used to access the database, create a new login under **Security** and use the following settings:
  - Select **SQL Server authentication**.
  - Clear the **Enforce password policy** check box.

Tip: If you want to host more than one content store on your Microsoft SQL Server instance and you will use both at the same time, use a different user account for each content store to ensure that each IBM Cognos Business Intelligence instance is fully isolated from the others.

- For Microsoft SQL Server 2008, grant EXECUTE permission to the user account that accesses the database.
- For the content store database, create a new database under **Databases**.
- Under **Security** for the new database, create a new schema and assign a name to it.
- Under **Security** for the new database, create a new user with the following settings:
- For **Login name**, specify the new login that you created for the user account.
- For **Default schema**, specify the new schema.
- For **Owned Schemas**, select the new schema.
- For **Role Members**, select `db_datareader`, `db_datawriter`, and `db_ddladmin`.

### Suggested Settings for Creating the Content Store in Sybase

The database you create for the content store must contain the specified configuration settings.

To ensure a successful installation, use the following guidelines when creating the content store. Use the same guidelines to create a database for log messages.

Use the following checklist to help you set up the content store on Sybase.

- On the Sybase server, create a server instance with an 8 KB server page size.
  
  For instructions, see the Sybase documentation.

- If required, install JConnect 6.
  
  This tool sets up the communication between the JDBC driver and the Sybase Adaptive Server instance.

  For instructions, see the Sybase documentation.

  If your version of Sybase does not include JConnect 6, you must download the installer from Sybase's Web site.

- Add the UTF-8 character set to the server instance.

- If required, make UTF-8 the default character set on the server.

- Create a database device.

  **Tip:** Set `log_segment` to a minimum of 10 MB.

- Set the new database device as the default.

  Information about the new database will be stored in the new database device.

  Keep a backup of the database device for recovery purposes.

- Create the database.

- Determine which user account will be used to access the database.

  **Tip:** If you want to host more than one content store on your Sybase instance and you will use them at the same time, use a different user account for each content store to ensure that each IBM Cognos Business Intelligence instance is fully isolated from the others.

- Ensure that the user account has the following privileges for the database: create default, create procedure, create rule, create table, and create view.

- Ensure that the database has the following settings and is restarted:
  
  - create and drop table privileges for the user account
  
  - `Select into` property is set to True

### Configure a User Account for IBM Cognos

You can configure a user account for IBM Cognos.

The user account under which IBM Cognos runs must:

- have access to all required resources, such as printers

- have the rights to log on as a service and act as part of the operating system
In addition, the user account must be a member of the local administrator group.

For example, to print reports using a network printer, the account must have access to the network printer, or you must assign a logon account to the IBM Cognos service.

**Configure Web Browsers**

IBM Cognos Business Intelligence products use default browser configurations. Additional required settings are specific to the browser.

**Browser Settings Required for IBM Cognos BI Portal**

The following table shows the settings that must be enabled.

*Table 5. Enabled Browser Settings for IBM Cognos BI Portal*

<table>
<thead>
<tr>
<th>Browser</th>
<th>Setting</th>
<th>IBM Cognos component</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Explorer (settings for studios and portals)</td>
<td>Allow Cookies</td>
<td>IBM Cognos Connection</td>
</tr>
<tr>
<td></td>
<td>Active Scripting</td>
<td>IBM Cognos Administration</td>
</tr>
<tr>
<td></td>
<td>Allow META REFRESH</td>
<td>Cognos Viewer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Event Studio</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PowerPlay® Studio</td>
</tr>
</tbody>
</table>

If you use Microsoft Internet Explorer Version 8, you may receive Adobe link errors when you open PDF documents in the IBM Cognos portal. To prevent these errors, in Internet Explorer, from the Tools menu, select Manage Add-ons, and disable Adobe PDF Reader Link Helper.

If you use a Microsoft Internet Explorer Web browser, then you can add the URL for your gateway(s) to the list of Trusted sites. For example, http://<server_name>:<port_number>/ibmcognos. This enables automatic prompting for file downloads.

For more information, see [“IBM Cognos Application Firewall” on page 188](#).

For more information, see the topic about configuring IBM Cognos Application Firewall in the *IBM Cognos Business Intelligence Installation and Configuration Guide*.

**Cookies Used by IBM Cognos BI Components**

IBM Cognos BI uses the following cookies to store user information.

*Table 6. Cookies used by IBM Cognos BI components*

<table>
<thead>
<tr>
<th>Cookie</th>
<th>Type</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS_TICKET</td>
<td>Session temporary</td>
<td>Created if IBM Cognos BI is configured to use an IBM Cognos Series 7 namespace</td>
</tr>
<tr>
<td>caf</td>
<td>Session temporary</td>
<td>Contains security state information</td>
</tr>
<tr>
<td>Cookie</td>
<td>Type</td>
<td>Purpose</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Cam_passport</td>
<td>Session temporary</td>
<td>Stores a reference to a user session stored on the Content Manager server. Administrators can set the HTTPOnly attribute to block scripts from reading or manipulating the CAM passport cookie during a user's session with their web browser. For more information, see the IBM Cognos Business Intelligence Administration and Security Guide.</td>
</tr>
<tr>
<td>cc_session</td>
<td>Session temporary</td>
<td>Holds session information that is specific to IBM Cognos Connection.</td>
</tr>
<tr>
<td>cc_state</td>
<td>Session temporary</td>
<td>Holds information during edit operations, such as cut, copy, and paste.</td>
</tr>
<tr>
<td>CRN</td>
<td>Session temporary</td>
<td>Contains the content and product locale information, and is set for all IBM Cognos users.</td>
</tr>
<tr>
<td>CRN_RS</td>
<td>Persistent</td>
<td>Stores the choice that the user makes for the View Members folder in Report Studio.</td>
</tr>
<tr>
<td>PAT_CURRENT_FOLDER</td>
<td>Persistent</td>
<td>Stores the current folder path if local file access is used, and is updated after the Open or Save dialog box is used.</td>
</tr>
<tr>
<td>pp_session</td>
<td>Session temporary</td>
<td>Stores session information that is specific to PowerPlay Studio.</td>
</tr>
<tr>
<td>qs</td>
<td>Persistent</td>
<td>Stores the settings that the user makes for user interface elements such as menus and toolbars.</td>
</tr>
<tr>
<td>userCapabilities</td>
<td>Session temporary</td>
<td>Contains all capabilities and the signature for the current user.</td>
</tr>
<tr>
<td>usersessionid</td>
<td>Session temporary</td>
<td>Contains a unique user session identifier, valid for the duration of the browser session.</td>
</tr>
</tbody>
</table>
Table 6. Cookies used by IBM Cognos BI components (continued)

<table>
<thead>
<tr>
<th>Cookie</th>
<th>Type</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>FrameBorder</td>
<td>Session temporary</td>
<td>These cookies store the preferences for export to PDF.</td>
</tr>
<tr>
<td>PageOrientation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PageSize</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PDFLayerDimension</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PDFOPTS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DimTreeToolbarVisible</td>
<td>Persistent</td>
<td>Stores the setting that determines whether to show or hide the dimension viewer toolbar.</td>
</tr>
<tr>
<td>cea-ssa</td>
<td>Session temporary</td>
<td>Stores the setting that determines whether the user session information is shared with other IBM Cognos BI components.</td>
</tr>
<tr>
<td>BRes</td>
<td>Session temporary</td>
<td>Stores information used to determine the screen resolution to use to render charts.</td>
</tr>
</tbody>
</table>

After upgrading or installing new software, restart the Web browser and advise users to clear their browser cache.

**Set Up the Data Source or Import Source Environment**

IBM Cognos Framework Manager is the IBM Cognos modeling tool that can be used with IBM Cognos Planning to create and manage metadata from other data sources to be used in plans. Metadata is derived from data sources in multi-platform or multilingual environments. Keep this in mind when you set up the data source environment for Framework Manager or the import source environment for IBM Cognos Planning Analyst.

**Before you begin**

If you upgraded from an older version of Framework Manager, you are not required to set up anything in the data source environment. You must set up the data source environment only if you installed Framework Manager in a different location from the older version.

Ensure that you install the appropriate fonts to support the character sets and currency symbols you use.

If users operating in different languages will be connecting to a Microsoft Analysis Services (MSAS) data source, you must create a separate IBM Cognos instance for each language.

**Procedure**

1. Set the environment variable for multilingual support:
For Oracle, set the NLS_LANG (National Language Support) environment variable on each computer where Framework Manager and the IBM Cognos Planning server are installed by typing the following command:

\[ \text{NLS\_LANG} = \text{language\_territory}:\text{character\_set} \]

Examples are:

- \[ \text{NLS\_LANG} = \text{AMERICAN\_AMERICA.UTF8} \]
- \[ \text{NLS\_LANG} = \text{JAPANESE\_JAPAN.UTF8} \]

The value of the variable determines the locale-dependent behavior of IBM Cognos. Error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.

For DB2, set the DB2CODEPAGE environment variable to a value of 1252.

For more information about whether to use this optional environment variable, see the DB2 documentation.

No settings are required for SAP BW. SAP support only a single code page on non-Unicode SAP BW systems.

2. For Oracle, add \$ORACLE\_HOME/lib to your LD\_LIBRARY\_PATH.

When you set the load library paths, ensure that the 32-bit Oracle libraries are in the library search path, which is usually the \$ORACLE\_HOME/lib directory or the \$ORACLE\_HOME/lib32 directory if you installed a 64-bit Oracle client.

3. For Oracle, copy the ojdbc14.jar file from ORACLE\_HOME/jdbc/lib to the \texttt{c10\_location/webapps/p2pd/WEB-INF/lib} directory.

4. For SAP BW, configure the authorization objects so that the modeling tool can retrieve metadata.

**Results**

After you complete these tasks, you must configure the IBM Cognos Planning components to work in your environment.
Chapter 6. Upgrading to IBM Cognos Planning

New versions of IBM Cognos Planning provide enhancements of product features and functionality, performance and scalability, and usability. Because of these improvements, upgrading may not be simple, and should be considered a process that you perform in stages.

Different groups are commonly involved in each of these activities. As part of the project, you should assess both your current IT environment and your existing applications separately, to ensure that the infrastructure can support your business objectives.

IBM Cognos Planning version 10.2.0 is a major upgrade. For this reason, you need to create a new environment for Planning version 10.2.0, starting with a clean content store.

You should treat upgrading as an IT project that requires careful planning, adequate time, and resources.

When you upgrade, you perform two distinct activities:
1. Install the new version of the product.
2. Move applications to the new version of the product.

Install the New Version of the Product

You can install the new version of the product in the same location as the existing version after you uninstall, or you can install into a new location.

You can configure your new environment to use the content store and planning store you used for your previous environment.

The first task you need to perform is to install IBM Cognos Planning into a new location, such as a test environment. This allows you to test your applications in both the old and new environment to ensure that they work as expected when you upgrade. You can compare the appearance and functionality of the reports in both environments to ensure equivalency.

Also, ensure that you back up your Planning Administration Domain and any other applications before you upgrade.

Move Content to the New Environment

As part of the upgrade process, ensure that your applications work as expected in the new version. Sometimes, changes may introduce unexpected results. It is important to test your applications before you move them to the production environment.

In IBM Cognos Planning, when you move content from one environment to another, you do a deployment.
Upgrade Process

The following diagram shows the approach for upgrading from version 8.2 and above. The diagram shows the stages in the upgrade process. Before you start, you plan the upgrade, assess the applications that you want to upgrade, and create a test environment. You should iteratively deploy and test content in both the source and target environments before you move successfully upgraded applications to a production environment.

![Workflow for the upgrade process in IBM Cognos Planning](image)

**Upgrading IBM Cognos Business Intelligence**

You must upgrade to BI 10.2.2 FP5 or CA 11 R4 before you can use Cognos Planning 10.2.0 and IBM Cognos BI together.

For more information about upgrading IBM Cognos BI, see the IBM Cognos Business Intelligence *Installation Guide*.

Choosing the Upgrade Tool

You can upgrade users, user classes, groups, libraries, and Planning Contributor applications from previous IBM Cognos Planning versions. Depending on your version, you can upgrade the entire Planning Application Database or you can upgrade individual applications.

Use the following table to determine which upgrade tool you need according to the version of Planning you currently have installed.

**Table 7. IBM Cognos Planning upgrade tools**

<table>
<thead>
<tr>
<th>Upgrade Tool</th>
<th>Current Planning Version</th>
<th>Description</th>
</tr>
</thead>
</table>
Table 7. IBM Cognos Planning upgrade tools (continued)

<table>
<thead>
<tr>
<th>Upgrade Tool</th>
<th>Current Planning Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning Administration Domain Wizard</td>
<td>7.3 8.1</td>
<td>Upgrades applications, administration links, and macros from the source</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Planning Administration Domain.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The security and access rights for the Planning Administration Domain</td>
</tr>
<tr>
<td></td>
<td></td>
<td>objects are remapped in the new environment.</td>
</tr>
</tbody>
</table>

Planning the Upgrade

You need to plan your upgrade so that you know what to expect at each stage of the process.

In the planning stage, you can review the upgrade documentation for information about the

- expected behavior
- new features
- deprecated features
- compatibility between versions
- requirements for preparing your production environment

When you finish the review, you can then conduct a site survey to identify the infrastructure, applications, and custom configuration settings. Finally, you can test the upgrade on a subset of your data to fine tune your plans, applications, and data before committing to the full upgrade.

The following diagram shows a high level view of the phases in an upgrade project.

![Figure 13. Overview of the IBM Cognos Planning upgrade process](image)

When planning your upgrade, ensure that you

- gather the necessary information, such as the required inputs and expected outputs for each phase
- assess the applications in your environment
- install the new software in a test environment and deploy the content to the test environment
- test the upgraded applications

Deployment and testing is usually an iterative process. Assess any differences between the source and target environments to determine actionable activities.
Move to your production environment when you are satisfied that the deployed applications meet your business requirements.

Do not change security providers, such as changing from a Cognos Series 7 namespace to Active Directory as part of the upgrade process. You should treat that as a separate project.

**Before you begin**

Ensure that you have the skills available, either internal or using external resources. Also consider the hardware that you will need before you begin.

**Review the Documentation**

Documentation is provided from a variety of sources to help you achieve a successful upgrade.

All the documentation is available online at [IBM Knowledge Center](http://www.ibm.com/support/knowledgecenter/SSPN2D_10.2.0).

**Procedure**

1. Read the "What’s New" section in this guide. It contains a list of new, changed, deprecated, and removed features for this release.
2. Read the rest of the Upgrade information in this document.
3. From the IBM Knowledge Center, download and review the latest versions of the following documentation:

   **Table 8. Important upgrade documentation from IBM Knowledge Center**

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Cognos Planning <em>Release Notes</em></td>
<td>Recent Planning issues that may affect an upgrade</td>
</tr>
<tr>
<td>IBM Cognos <em>Release Notes</em></td>
<td>Recent IBM Cognos issues that may affect an upgrade</td>
</tr>
<tr>
<td>IBM Cognos Planning <em>New Features Guide</em></td>
<td>New features that may affect the behavior of existing content</td>
</tr>
<tr>
<td>Framework Manager <em>User Guide</em></td>
<td>Upgrading models</td>
</tr>
</tbody>
</table>

**Assess Applications in the Source Environment**

Preparing to upgrade provides an opportunity to review your current Planning investment, and clean up your source environment. Inventory your Planning applications to understand the strengths, weaknesses, and areas for improvement in your environment.

For example, you may have a hundreds applications in your environment. However, it is not uncommon to find that a number of applications are not used, no longer meet the company’s requirements, or do not work in the source environments.

You should conduct an audit of your applications to determine which applications you should upgrade. Assessing and reducing the number of applications is a useful exercise. Do not rely only on user feedback to determine which content is used.
An audit of your existing applications may include the following tasks:

- Do a site survey.
  Assess the current production environment and identify areas that require attention during an upgrade. The site survey includes information about the infrastructure, applications, users, and configuration settings.

- Assess the software that you use in your environment.
  List software, such as operating systems, Web servers, security, databases. Compare the list to the supported versions for your target upgrade version, available from the Production Information, Software Environments links at [IBM Knowledge Center](http://www.ibm.com/support/knowledgecenter/SSPN2D_10.2.0). Determine whether any components require updating.

- Complete a detailed assessment of your applications.
  The usage, age, size, and complexity of your applications are important factors to consider when planning the upgrade. The total size of the applications may have an impact on the time required to complete the upgrade.

- List the following information about your configuration:
  - configuration settings that you enabled using IBM Cognos Configuration
    These settings are preserved through the upgrade. They are stored in two files, cogstartup.xml and coglocale.xml.
  - changes to other configuration files
    You must make the changes manually to other configuration files during the upgrade. If you changed other configuration files, you must assess the changes that you want to preserve in the upgraded environment. This may include .xml, .txt, and .css files in the configuration, templates, webapps, and webcontent directories of the installation location.
    **Important**: Changes to .ini files are not supported. If you changed .ini files, please contact Customer Support.

- Back up all reports, models, configuration data, and files.

Once your audit is complete, you can create an upgrade plan.

**Perform a Trial Upgrade**

Pilot upgrade projects are valuable and practical exercises because they ensure that the upgrade produce the expected and required outcome. In addition, an evaluation of the pilot project ensures that the upgrade is successful.

If unexpected results occur, you can determine whether the differences are enhancements for your situation or whether you should take action to mitigate the differences.

When you upgrade, applications usually work in the new environment, with little or no intervention. By running a pilot upgrade you can validate selected applications to see if the expected results are produced.

You can perform a trial upgrade several weeks before upgrading your production system. The trial upgrade identifies components that will upgrade with minimal effort, and components that may require additional actions before or after the upgrade.

Ensure skilled resources are available to perform migration work, especially for mission-critical applications. Also, test and debug all applications prior to deployment.
Create the Test Environment

Create a test environment for the new software in preparation for your trial upgrades.

Initially, the new environment does not need to be large, or be the same as your production environment. For example, if it is acceptable, you may use hardware from existing environments, such as development servers.

The environment can be scaled up and out in a phased way after the basic new environment is up and running.

Alternatively, existing environments can remain untouched. If you want the test environment to become the new production environment, configure the test system to match your production environment.

Procedure

1. Ensure the infrastructure is in place.
2. Review the supported environments.
3. Install the new software in the test environment.
   Having the new version of software in a different location than the earlier version ensures that you run both versions at the same time and confirm that your applications work properly in both environments.

Results

After you have installed the software, use the deployment process to upgrade the content. For more information, see the online help in the IBM Cognos Administration console.

Plan Your Deployment

Deployment involves moving applications, models, macros, administration links, or Planning Analyst libraries from one installation to another.

When you deploy, you must consider how to handle security and whether to deploy the entire content store or to deploy selected packages, folders, and directory content. Other considerations relate to the database you use for the content store, bursting reports, and ownership of entries.

For more information about planning the deployment of content to a new environment, see the IBM Cognos Planning Contributor Administration Guide.

The following diagram summarizes the deployment process.

Figure 14. Deployment Process Workflow
**Security**

Before you deploy, you must consider access permissions and security of deployment archives.

To deploy IBM Cognos Connection entries, you must have the following permissions:

- Execute permissions for the **Administration tasks** secured feature.
- Traverse permissions for the **Administration** secured function.

Also, you need to belong to the System Administrators group, and have read and write access to the Cognos namespace, so that you can deploy the System Administrators group.

**Important:** Only members of the System Administrators group can initially assign permissions to users, groups, and roles, for example, the ability to execute or schedule macros. However, System Administrators may choose to allow an additional group, such as Planning Rights Administrators, to grant permissions. In this case, both System Administrators and Planning Rights Administrators would then be able to assign permissions to execute or schedule macros.

For more information about security and deployment, see the IBM Cognos Planning Contributor *Administration Guide*.

**References to Namespaces**

Some entries, such as groups, roles, distribution lists, contacts, data source signons, and some report properties, such as email recipients and report contacts, can refer to entities in namespaces, or authentication providers. When you deploy public folders and directory content, you can deploy these entries with or without the third-party references.

**Deploying the Entire Content Store**

Deploying the entire content store ensures that all the data is copied to a new location. For example, if you are moving Planning to another computer, you can move the entire content store from the old environment to the new environment.

When you import an entire content store, configuration data is included in the export, but excluded from the import by default. Do not change this setting.

**Create an Export Deployment Specification**

After planning your deployment, the first step in moving content from the one installation to another is to export the content store or the entries that you want to keep in your new environment. To do this, use the Contributor Administration Console to create a deployment specification in your source environment.

The entries are exported to an export deployment archive in the source environment. Later, you import the archive entries into the target environment.

You can export complete models, macros, administration links, or Planning Analyst libraries with or without the associated data from Planning Contributor or Planning Analyst. You deploy a model by exporting it from one environment and importing it into another.
When you export a model, the reports, events, or Framework Manager models associated with the Planning Administration Domain are not exported.

The model structure and data are exported to the deployment directory location set in IBM Cognos Configuration.

You can backup an application by exporting it, but this is not a substitute for database backup.

The default deployment location is `c10_location\deployment`.

**Before you begin**

You must stop the IBM Cognos service before you export and import.

**Procedure**

1. From the *Tools* menu, click *Deployment* and then click one of the following:
   - Export Model
   - Export Model and Data
2. In the *Welcome to the Export Deployment Wizard* page, click *Next*.
3. Select the objects you want to export and click *Next*. Selecting a top level object will select all the children of that object.
4. Type a new name for the export, or choose a name from existing deployments and click *Finish*.
5. Click *OK*.

**Copy the Deployment Specification to the Test Environment**

Transfer the deployment to a test environment, then move the export folder from the source deployment directory location to the deployment directory location for the test environment.

**Before you begin**

If you plan to move the deployment archive to a location on a LAN, ensure that there is enough disk space.

**About this task**

Later, you use the deployment archive to import entries into the target environment.

**Import to the Test Environment**

You can import a model or object to move an application into a test or production environment. Models for import must be in the deployment directory location set in IBM Cognos Configuration.

You can import macros, administration links, applications, IBM Cognos Planning Analyst libraries, and security rights from the source Planning Content Store that were exported during a previous deployment. You can select exported objects for import or import an entire model. If a model was exported with data, then the data will be used during the import.
You can import administration links and macros even if they reference an application that is not in the target destination. If imported with a related application, macros and administration links are automatically mapped to the target application.

Through the import process, you can change the target datastore and security for your model. The deployment wizard attempts to map security settings for users, groups, and roles. If you are using different namespaces or changing user, group, or role mappings, you may have to complete some of the mapping manually.

The security settings for the source are applied to the user, group, or role to which you map. You can map source users, groups, and roles together or individually to any single target user, group, or role. When mapping a number of users, groups, or roles, the target maintains the greatest level of security privileges. Any unmapped items are mapped to Planning Rights Administrator and do not appear individually as a user, group, or role in the target.

Application IDs and object names must be unique within the Planning Administration Domain. During the import processes, if duplicate names or IDs are found, you are warned. If you proceed with the import without changing names and IDs, then any existing applications or objects with common names or IDs will be overwritten.

**Before you begin**

To import IBM Cognos Planning Contributor applications, you must have at least one configured datastore and the Planning content store must be added to a job server. A datastore is not required to import Analyst libraries, macros, or administration links.

**Procedure**

1. From the Tools menu, click Deployment and then click Import.
2. In the Welcome to the Import Deployment Wizard page, click Next.
3. In the Deployment Archive Name page, select a deployment to import and click Next.
4. In the Import Object Selection page, select the objects for import and click Next. Selecting a top level object selects all the children of that object.
5. In the Namespace Mapping page, select the target namespace for each source namespace, and click Next.
6. The User Group Role Mapping page contains a tab for each namespace mapping. For each mapping, assign the correct target user, group, or role to each source by clicking the ellipsis (...) button.
7. On the Select entries (Navigate) page, in the available entries directory, click the namespace that contains the target user, group, or role.
8. From the selected entries, select the target user, group, or role and click OK.
9. Complete the user, group, or role mapping for each Namespace mapping. Once you have completed mapping each source user, group, or role to the target, click Next.
10. For each application or library with a warning next to it in the Object Mapping page, click the ellipsis (...) button to change the configuration settings. You can also map all target options by clicking Map All and adding a prefix or suffix to the object names. You can also set the job server cluster for the application.
11. On the **Configuration settings** page, type new names, IDs and locations of files, and click **OK**. For an Oracle or DB2 datastore, you must identify tablespaces for data, indexes, blobs, and a temporary tables.

12. To avoid overwriting macros or administration links, for each object with a warning next to it in the **Object Mapping** page, type a new name for the target object directly into the target column.

13. Optionally, if you are importing a model without data, select the option to automatically go to production with all imported applications during the import process.

14. If you are overwriting objects, you will be prompted to confirm the import, to continue, click **Yes**.

15. Click **Finish**.

16. Click **OK**.

**Results**

The import request starts on the server.

You can view the progress of the export in the **Monitoring Console** on the **Deployments** tab.

If you did not set the job server cluster in the **Map All** dialog, refresh the console after the transfer is complete and add any newly created applications to a job server cluster.

**Tip:** During the import process, some application options are excluded from the transfer because they do not apply to the new application location, for example, display names, backup location, and publish options are excluded. If these options are required, you can include them by modifying the **AdminOptions to exclude during Limited transfer** or **AdminOptions to exclude during Full transfer** resource values in the `<install_location>\bin\epPNHelperResource.xml` file.

**Recommendation - Test the Upgraded Content**

After you import the packages from the deployment archive, you can check that all the entries were deployed successfully in the target environment.

Test your upgraded content by doing the following:

- View the status of existing deployments.
- Ensure that the correct packages and folders were imported, along with their contents.
- Test models.
- Test applications.
- Repair or exclude models that do not operate correctly.
- Test the repaired models by running them again on the test system. Troubleshoot any issues, and contact IBM Cognos Software Services about unresolved upgrade issues.
- Revise the upgrade plan to include adaptations that you made during the trial upgrade.

For more information, see the IBM Cognos Planning Contributor **Administration Guide**.
Moving to the Production Environment

When all issues that you discovered during the trial upgrade are resolved, you are ready to begin the full upgrade in your production environment. Your upgrade plan will provide the details for each step of the full upgrade.

The following diagram shows the high level steps in the process of moving upgraded applications to a production environment. After preparing the production environment and backing up data and configuration files, you can uninstall the older version of the software, and install the new version in the same location. Then, you can deploy the content from your test environment.

![Diagram showing the process to move upgraded applications to a production environment](image)

**Figure 15. Overview of the process to move upgraded applications to a production environment**

**Procedure**

1. Prepare the production environment.
   - Back up files and data.
     You may have modified files other than those in the configuration folder. For this reason, you need to back up the entire installation directory.
     When you back up the configuration data, store it in a secure directory. You must protect the directory from unauthorized or inappropriate access.
   - Install your new release system in the production environment.
     If you install the new software from the test environment to the same location as the existing software, you must first uninstall the existing software.
   - Configure the system.

2. Manually configure customization.
   - If you manually edited any configuration files, the changes will be overwritten during the upgrade. You must reapply the changes. You should keep a record of any customizations to ensure that they can be reapplied after upgrading. You should also back up these files so that you can restore the original version if necessary.
   - The IBM Cognos presentation service supports automatic upgrade of some system.xml files. If you made many customization changes to system.xml files, you can use this automatic upgrade feature instead of reapplying the changes manually after upgrading. The system.xml files are overwritten during the installation of IBM Cognos. Therefore, you must back up the customized versions of these files and then copy them to the directory after upgrading IBM Cognos. The automatic upgrade will be applied when you start the IBM Cognos service.
   - The system.xml files for which automatic upgrade is supported are in the following directories: `c10_location/templates/ps`, `c10_location/templates/ps/portal`, and `c10_location/templates/ps/qs`.
   - Upgrade customized files by manually reapply changes after the new software is installed. Use automatic upgrade of system.xml files only when you have made a large number of customizations to these files.
3. Start deployment on the production system.

**Upgrading Planning Administration Domains**

Use the Planning Administration Domain wizard to upgrade version 7.3 or 8.1 Planning Application Domains, as shown in the following diagram.

![Figure 16. Overview of the upgrade process for version 7.3 or 8.1 Planning Application Domains](image)

For more information, see the "Upgrade the Planning Application Domain" section of the IBM Cognos Planning Contributor *Administration Guide*.

**Upgrading Planning Applications**

Use the Upgrade wizard to upgrade version 7.2, 7.3 or 8.1 Planning applications, as shown in the following diagram.

![Figure 17. Overview of the upgrade process for IBM Cognos Planning applications running on version 7.2, version 7.3, or version 8.1](image)

For more information, see the IBM Cognos Planning Contributor *Administration Guide*.

**Upgrade Planning Analyst Security and Library Files**

If you use Planning Analyst models in your Planning Contributor applications, then you need to upgrade Planning Analyst security and library files.

**Procedure**

1. Create backup copies of your IBM Cognos Planning Analyst configuration files and data directories from the existing installation.
2. Uninstall previous Planning Analyst clients.
3. Install IBM Cognos Planning - Administration components, including Planning Analyst.
4. Upgrade Planning Analyst libraries, user classes, users, and groups.

**Upgrade Planning Analyst Libraries, User Classes, Users, and Groups**

You can upgrade all existing libraries, user classes, users, and groups at the same time, or individually.
Note: If you want to upgrade users and groups from a Series 7 namespace, use IBM Cognos Configuration to connect to the Series 7 namespace. Then, start Planning Analyst and add the users, groups and roles that you want to use.

Procedure
1. Start Planning Analyst.
2. Upgrade Planning Analyst by doing one of the following:
   
   • To upgrade libraries, user classes, users, and groups at the same time, from the File menu, select Administration, Upgrade, Existing File System, browse to find your existing filesys.ini file, and click Open.
   
   • To upgrade libraries, from the File menu, select Administration, Upgrade, Existing Libraries, browse to find your existing Libs.Tab file, and click Open.
   
   • To upgrade user classes, from the File menu, select Administration, Upgrade, Existing User Classes, browse to find your existing usersclasses.Tab file, and click Open.
   
   • To upgrade existing native security to Access Manager, from the File menu, select Administration, Upgrade, Existing Native Users and Groups, browse to find your existing existingusers.Tab file, and click Open.

Results
The files are converted automatically to the newer version format, after which they can no longer be opened in a previous version of Planning Analyst.

Upgrading a Test or Development Environment
You can quickly upgrade your test or development environment using an in-place upgrade.

Note: Never use an in-place upgrade for your production environment.

If you set your database connection properties for your new version of Planning to use your version 8.x planning store, you are prompted to upgrade the planning store to the newer version when you open Planning Contributor Administration the first time. Upgrading the planning store also upgrades all of your applications in the Planning Administration Domain.

If you have version 8.x applications that are not in your Planning Administration Domain, you can upgrade these applications by linking to them in the Contributor Administration Console.

Upgrading From Versions 7.2, 7.3, or 8.1
The IBM Cognos Planning Contributor Planning upgrade process for versions 7.2, 7.3, and 8.1 involves several stages.

Procedure
1. Plan the upgrade.
   For more information, see "Planning the Upgrade” on page 43.

2. Design, install, and configure the test environment.
   For more information, see Chapter 3, “Installation Options,” on page 9 or the IBM Cognos Planning Architecture and Deployment Guide.

3. Assign roles to Planning Contributor administrators and users.
• assign Planning Contributor Administration users and Planning Analyst administrators to the Planning Rights Administrator role
• add Planning Contributor users to the Planning Contributor Users role
For more information, see the IBM Cognos Administration and Security Guide or the IBM Cognos Planning Contributor Administration Guide.

4. Upgrade Planning Analyst security and library files.
   For more information, see "Upgrade Planning Analyst Security and Library Files" on page 52.

5. Upgrade planning applications in the test environment.
   For more information, see "Upgrading Planning Applications" on page 52.

6. Upgrade the Planning Administration Domain.
   For more information, see "Upgrading Planning Administration Domains" on page 52.

7. Test all components to ensure that the applications upgraded successfully.

8. Install and configure the new production environment.

9. Export the test planning environment to the new production environment.

10. Export the deployment package for Framework Manager or Event Studio objects.
    For more information, see the IBM Cognos Administration and Security Guide.

11. Import the planning environment to the new production environment.
    For more information, see the IBM Cognos Planning Contributor Administration Guide.

12. Import the deployment package for Framework Manager or Event Studio objects to the production environment.
    For more information, see the IBM Cognos Administration and Security Guide.

---

**Upgrading Planning Contributor web client**

The following information applies to users that plan to upgrade Planning Contributor web client.

When you install Planning Contributor 10.1 or a later release, the install location remains as 8.4. This means that once a machine has Planning Contributor 10.1 or later installed, users can connect to either an 8.4 or an 10.1 (or later) environment.
IBM Cognos Planning requires the installation of server components and client components. These installations are suitable when you are setting up a test or evaluation environment, or for small production environments. This installation is the quickest and easiest way to get started.

**Note:** Install IBM Cognos components in a directory that contains only ASCII characters in the path name. Some UNIX and Linux web servers do not support non-ASCII characters in directory names.

After you complete the required installation and configuration tasks, you can perform additional configuration tasks, and change the IBM Cognos Planning default behavior to better suit your environment.

If you no longer require Planning, you can uninstall all IBM Cognos Planning components.

**Install IBM Cognos Planning**

Use the installation wizards from the IBM Cognos Planning installation media to install the gateway, Planning Server, and Content Manager components. Installing all server components on the same computer is intended for proof of concept installations or demonstration environments.

**Before you begin**

Ensure that you have administrator privileges for the computer on which you are installing. Also ensure that your computer has a TEMP system variable that points to the directory where you want to store temporary files. During installation, files from the CD are temporarily copied to this directory.

Do not install IBM Cognos Planning server components on a computer running Microsoft Windows Vista operating system

**About this task**

If you intend to distribute IBM Cognos Planning, you can start your installation process by installing the server components on a single computer. After you verify that it is running, you can add server components as required. For example, you can install additional Planning Servers to your initial installation. Then, after you have the Planning Servers running, you can turn off some of the services on the computer with Content Manager installed on it to optimize its performance.

The Planning Complete installation kit contains all the necessary components to install and run IBM Cognos Planning on one computer. To install Planning in distributed environments, use the following lists to determine which Cognos Planning installation kit to use to install specific Planning components.
**Cognos Planning Server installation kit**
The Cognos Planning Server kit helps you install specific Planning components in distributed environments. You can use it to install and configure the following components:
- Planning Job service
- Planning Web service
- Planning Administration Console service
- Planning Data service
- Analyst Universal Naming Convention (UNC) Connection

**Cognos Planning Gateway installation kit**
The Cognos Planning Gateway kit enables you to install the Planning-specific files on the same computer that has the BI gateway. The following components are installed automatically:
- Contributor rich client installer
- Contributor workflow page

**Cognos Planning Administration Client installation kit**
The Cognos Planning Administration Client installation kit enables you to install the following administration components:
- Analyst
- Planning Analyst Add-in for Microsoft Excel
- Planning Manager
- Planning Administrator (CAC)

**Cognos Planning Client installation kit**
The Cognos Planning Client installation kit enables you to install the following contributor components:
- Planning Contributor
- Contributor Add-in for Microsoft Excel

Using the component-specific installation kits, rather than the Cognos Planning Complete installation kit, allows you to install the minimum subset of files and configurable services that you need for that component and reduces the installation footprint required.

**Note:** You can only install the Content Manager component from the Cognos Planning Complete installation kit.

**Procedure**
1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.
2. Insert the IBM Cognos Planning Complete installation media or go to the installation source file directory.
   The Welcome page of the installation wizard appears when you insert the CD.
   If no Welcome page appears or you are not installing from the CD, go to the win32 directory, and double-click issetup.exe.
3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.
4. In the Component Selection screen, select all components, except for Analyst UNC Connection Point.
The Analyst UNC Connection Point option allows you to create a network connection so that multiple users can access shared libraries.

5. Follow the directions in the installation wizard to copy the required files to your computer.
   - If an older version of the Microsoft Windows Installer Tool is installed on your computer, you are prompted to manually install Microsoft SOAP Toolkit before you configure your IBM Cognos Planning environment.
   - If you are installing in a directory that already has other IBM Cognos components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.

6. In the Finish page of the installation wizard,
   - If you want to configure Content Manager immediately, click Start IBM Cognos Configuration.
   - If you want to see late-breaking information about IBM Cognos components, click View the Readme.

7. Click Finish.

JDBC Driver Options for Using DB2 Database as a Content Store

IBM Cognos Business Intelligence uses Java Database Connectivity (JDBC) to access the database used for the content store.

If you use DB2 on a Microsoft Windows, Linux, or UNIX operating system as your content store you must choose whether to use the type 2 or type 4 JDBC driver depending on how you want to connect to the content store.

If you are using a DB2 database on z/OS for the content store, you must use a type 4 JDBC connection.

You specify the driver type to use in IBM Cognos Configuration.

Configuration Options for the Universal Driver

DB2 introduced a universal JDBC driver that contains both type 2 and type 4 JDBC driver support. The universal driver, db2jcc.jar, replaces the deprecated type 2 JDBC driver, db2java.zip.

If you are upgrading, you can continue to use a type 2 JDBC connection with no configuration change required. If you want to use a type 4 JDBC connection, you must change your configuration to include the host name and port number of the database server.

For both a type 2 and type 4 JDBC connection, however, you must copy the new universal driver, db2jcc.jar, and the accompanying license file, db2jcc_license_*.jar, to your IBM Cognos BI installation location.

Using the Type 2 JDBC Driver

Type 2 JDBC drivers are comprised of a native-API component and a Java component.

The connection to the DB2 database occurs through the DB2 CLI libraries, which comprise the native component that communicates with the database server.
Because type 2 JDBC drivers require common client code and rely on the native code of the product, a DB2 client must be installed to use this driver. For example, a DB2 client must be installed on the computer where you have Content Manager installed.

**Using the Type 4 JDBC Driver**

Type 4 JDBC drivers are pure Java drivers which provide direct access to DB2 database features through network communication.

The type 4 driver is considered an independent product. It does not require the DB2 client to be installed.

---

### Set Up Database Connectivity for the Content Store Database

For the content store, you must ensure that the appropriate JDBC drivers are installed on every computer where Content Manager is installed.

For the planning store, you must ensure that the appropriate OLE DB or SQL Native Client (for SQL Server) drivers are installed on each computer where Content Manager or a Planning Server is installed. This allows you to set up database connectivity for the planning store database.

If you configure Microsoft SQL Server Windows Authentication for the planning store databases, you must take into account that the planning data service inherits its security from the dispatcher.

After connectivity is set up, you can connect to the Content and Planning stores using IBM Cognos Configuration.

---

### Set Up Database Connectivity for a DB2 Content Store

This procedure describes how to set up database connectivity for a DB2 content store. You must perform this procedure on each computer where you install Content Manager.

**Procedure**

1. **If you are using a type 2 JDBC connection,** install the DB2 client software on the Content Manager computers.

   If you are using a type 4 JDBC connection for DB2, you are not required to install the DB2 client software where Content Manager is installed. If you use a DB2 database on z/OS for the content store, you must use a type 4 JDBC connection.

   For more information about the differences between type 2 and type 4 drivers, see "JDBC Driver Options for Using DB2 Database as a Content Store" on page 57.

2. **If you are using a type 2 JDBC connection,** and the content store is on a different computer than Content Manager, configure a database alias to the content store.

   On Microsoft Windows operating systems, run the DB2 Client Configuration Assistant.

   **Note:** If the content store database and Content Manager are on the same computer, the content store name automatically becomes the alias.
When you configure the Content Manager computers, ensure that they are all configured to use the same content store.

3. On Windows, stop the DB2 services and the HTML Search Server.

4. Copy the following files from DB2_installation/sqlib/java directory to the c10_location/webapps/p2pd/WEB-INF/lib directory.
   - the universal driver file, db2jcc.jar
   - the license file
     for DB2 on Linux, UNIX, or Windows, db2jcc_license_cu.jar
   If you are connecting to DB2 on z/OS, use the driver version from Linux, UNIX, or Windows version 9.1 fix pack 5 or version 9.5 fix pack 2.

   **Tip:** To check the driver version, run the following command
   ```shell
   java -cp path\db2jcc.jar com.ibm.db2.jcc.DB2Jcc -version
   ```

5. On Windows, restart the DB2 services and the HTML Search Server.

6. On UNIX, if you are using a type 2 JDBC connection, ensure that the 32-bit DB2 libraries are in the library search path, which is usually the $DB2DIR/lib directory or the $DB2DIR/lib32 directory.

7. Repeat this entire procedure on the IBM Cognos BI computers where Content Manager is installed or where notification is sent to a DB2 database.

### Set Up Database Connectivity for an Oracle Content Store

This procedure describes how to set up database connectivity for an Oracle content store. You must perform this procedure on each computer where you install Content Manager.

**Procedure**

1. On the computer where the Oracle client is installed, go to the ORACLE_HOME/jdbc/lib directory.

2. Copy the correct library file for your version of the Oracle client to the c10_location/webapps/p2pd/WEB-INF/lib directory on the computer where Content Manager is installed and where notification is sent to an Oracle database.

   - If you are using Oracle 10g, you must have ojdbc14.jar.
   - If you are using Oracle 11g, you must have ojdbc5.jar.

   The files are available from an Oracle client or server install, and can also be downloaded from the Oracle technology Web site.

### Set Up Database Connectivity for an Informix Content Store

This procedure describes how to set up database connectivity for an Oracle content store. You must perform this procedure on each computer where you install Content Manager.

**Procedure**

1. On the computer where Informix® is installed, go to the Informix_location/sqlib/java directory.

2. Copy the following files to the c10_location/webapps/p2pd/WEB-INF/lib directory on every computer where Content Manager is installed.
   - the universal driver file, db2jcc.jar
   - the license file, db2jcc_license_cisuz.jar
Set Up Database Connectivity for a Sybase Content Store

This procedure describes how to set up database connectivity for a DB2 content store. You must perform this procedure on each computer where you install Content Manager.

**Procedure**

1. On the computer where Sybase is installed, go to the `Sybase_location/jConnect-6/classes` directory.
2. Copy the `jconn3.jar` file to the `c10_location/webapps/p2pd/WEB-INF/lib` directory on every computer where Content Manager is installed and where notification is sent to a Sybase database.

---

Set Up Database Connectivity for the Planning Store Database

For IBM Cognos Planning, all Planning Server computers must be able to access the planning store using the object linking and embedding database (OLEDB) API.

You must install the appropriate OLE DB database driver on each computer where you install Planning Server components to set up database connectivity for the planning store database.

**Note:** If you configure Microsoft SQL Server Windows Authentication for the planning store databases, you must take into account that the planning data service inherits its security from the dispatcher.

---

Enable Security

IBM Cognos Planning requires that users log in. This ensures that users only see parts of budgets or plans for which they are responsible.

**Before you begin**

Use IBM Cognos Configuration to configure environment, security, and data access properties. To start IBM Cognos Configuration, click **All Programs** from the **Start** menu, then click **IBM Cognos**, and then click **IBM Cognos Configuration**.

**About this task**

By default, IBM Cognos Planning allows anonymous access to the Web portal. You must disable anonymous access and configure IBM Cognos Planning to use an authentication provider before users can access any of the client applications or the portal.

**Procedure**

1. In the IBM Cognos Configuration **Explorer** window, click **Security**, **Authentication**, **IBM Cognos**.
2. Click the **Value** box for **Allow Anonymous Access?**, and select **False**.
3. Right-click **Authentication**, and click **New Resource, Namespace**.
4. In the **Name** box, type a name for your authentication namespace.
5. In the **Type** list, click the appropriate namespace and then click **OK**.

The new authentication provider resource appears in the **Explorer** window, under the **Authentication** component.
6. In the **Properties** window, for the **Namespace ID** property, specify a unique identifier for the namespace.

7. From the **File** menu, click **Save**.

### Configure Environment Properties

The IBM Cognos service runs as a service in an IBM Cognos dispatcher. The dispatcher runs in a servlet container. The IBM Cognos Planning Server service runs as a Microsoft Windows service. By default the IBM Cognos dispatcher uses port number 9300 for communications, and the Planning Server service uses port 9900. You can change these port numbers to any available port number.

**Procedure**

1. In the IBM Cognos Configuration **Explorer** window, click **Environment**.

2. In the **Properties** window, click the value for **Content Manager URIs** and then click the edit button.

3. Specify the URIs for the other Content Manager computers:
   - In the **Value - Content Manager URIs** dialog box, click **Add**.
   - In the blank row of the table, click and then type the full URI of the Content Manager computer.
     Do not delete the first value in the table. This value identifies the local Content Manager computer and is required.
   - Repeat the previous two bulleted steps for each URI to be added.

   **Important:** You must include all Content Manager URIs in the list.
   - Click **OK**.

4. In the **Explorer** window, under **Security, Cryptography**, click **Cognos**, the default cryptographic provider.

5. Under the **Certificate Authority settings** property group, type a **Password**.

6. In the **Explorer** window, under **Security**, click **Cryptography**.

7. In the **Properties** window, under **CSK settings**, set **Store symmetric key locally** to **True**.

8. From the **File** menu, click **Save**.

### Results

If you configured IBM Cognos with standby Content Manager computers and you use the default CGI gateway, you must configure IBM Cognos to use an ISAPI gateway.

### Set Database Connection Properties for the Content Store

You use IBM Cognos Configuration to specify the database server information. This ensures that Content Manager can connect to the database that you are using for the content store. Content Manager uses the database logon to access the content store. After you set the database connection properties, you can test the connection between Content Manager and the content store.

Ensure that you used one of the supported database servers to create the content store.
Some database servers are available with advanced features. When you select an advanced database option, IBM Cognos uses features of the database server to manage the connection.

For example, if you select the advanced Oracle database, IBM Cognos uses enterprise-oriented Oracle features to
- select a listener
- switch to another listener if the first listener fails
- automatically reconnect to the database if the connection fails
- balance connection requests among listeners
- and balance connection requests among dispatchers.

IBM Cognos requires the TCP/IP protocol to access data and the content store. Ensure that the database server has the protocol set to TCP/IP.

**Using a DB2 database for the content store**

The default database for the content store is DB2.

When you use a DB2 database for your content store you must configure, set, and test the content store before setting up the planning store.

**Setting Database Connection Properties for a DB2 Content Store on Linux, UNIX or Microsoft Windows Operating Systems**

You must specify the database server information to ensure that Content Manager can connect to the database you use for a DB2 content store.

**Procedure**

1. In the location where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, Content Manager, click Content Store.
3. In the Properties window, for the Database name property, type the name of the database or the database alias.
4. Change the logon credentials to specify a valid user ID and password:
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   - Type the appropriate values and click OK.
5. To use a type 4 JDBC connection, for the Database server and port number property, type a value, using host:port syntax.
   If you leave this property blank, a type 2 JDBC connection is used.
   For more information about the differences between the driver types, see “**JDBC Driver Options for Using DB2 Database as a Content Store**” on page 57.
6. From the File menu, click Save.
   The logon credentials are immediately encrypted.
7. To test the connection between Content Manager and the content store database, from the Actions menu, click Test.
Content Manager connects to the database, checks the database permissions, and creates and populates a table. The table is not deleted and is used each time that the test is repeated.

**Setting Database Connection Properties for a Microsoft SQL Server, Oracle, Informix, or Sybase Content Store**

You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store.

**Procedure**

1. On the computer where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, Content Manager, right-click Content Store and click Delete.
   This deletes the connection to the default resource. Content Manager can access only one content store.
3. Right-click Content Manager, and then click New resource, Database.
4. In the Name box, type a name for the resource.
5. In the Type box, select the type of database and click OK.

   **Tip:** If you want to use an Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).
6. In the Properties window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the **Database server with port number or instance name** and **Database name** properties.
   - For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the **Database server with port number or instance name** property.
   - For the **Database server with port number or instance name** property, include the instance name if there are multiple instances of Microsoft SQL Server.
   - To connect to a named instance, you must specify the instance name. For example, you can type localhost\instance1. If an instance name is not specified, a connection to the default instance is created.
   - If you use an Oracle database, type the appropriate values for the **Database server and port number** and **Service name** properties.
   - If you use an advanced Oracle database, for the **Database specifier** property, type the Oracle Net8 keyword-value pair for the connection.
     Here is an example:
     (description=(address=(host=myhost)(protocol=tcp)(port=1521)
     (connect_data=(sid=(orcl))))))
     When you select the advanced Oracle database, IBM Cognos BI uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.
   - If you use an Informix database, type the appropriate values for the **Database server and port number** and **Database name** properties.
   - If you use a Sybase database, type the appropriate values for the **Database server and port number** and **Database name** properties.
7. To configure logon credentials, specify a user ID and password:
   - Click the **Value** box next to the **User ID and password** property and then
     click the edit button when it appears.
   - Type the appropriate values and click **OK**.
8. If you host more than one content store database on an Informix instance,
   create the advanced property CMSCRIPT_CS_ID and specify the account
   under which the instance runs:
   - In the **Explorer** window, click **Local Configuration**.
   - In the **Properties** window, click the **Value** column for **Advanced properties**
     and then click the edit button.
   - In the **Value - Advanced properties** dialog box, click **Add**.
   - In the **Name** column, type **CMSCRIPT_CS_ID**
   - In the **Value** column, type the user ID of the account under which the
     instance of the content store runs.
     Use a different user account for each instance of Informix content store
     database.
9. From the **File** menu, click **Save**.
    The logon credentials are immediately encrypted.
10. To test the connection between Content Manager and the content store
    database, from the **Actions** menu, click **Test**.
    Content Manager connects to the database, checks the database permissions,
    and creates and populates a table. The table is not deleted and is used each
    time that the test is repeated.

**Results**

Content Manager can now create the required tables in the content store when you
start the IBM Cognos service for the first time. If the connection properties are not
specified correctly, you cannot start the IBM Cognos services.

---

**Set Database Connection Properties for the Planning Store**

You must provide database connection properties for all IBM Cognos Planning
servers. You use IBM Cognos Configuration to specify database connection
information for the planning store. The planning store can be the same database as
the content store, or it can be a different database.

It is mandatory to configure connection properties for the Planning store.

The database must be created before you can connect to it. You can use a DB2,
SQL, or Oracle database.

**Note:** When you use a DB2 database for your content store you must configure,
set, and test the content store before setting up the planning store.

The default database for the content store is DB2.

If you are using a Microsoft SQL Server database, the version that you select in
IBM Cognos Configuration defaults to Microsoft SQL Server 2005. If you are using
SQL Server 2008, then you must select the correct version.
Before you begin

Some database servers are available with advanced features. When you select an advanced database option, IBM Cognos uses features of the database server to manage the connection.

Procedure

1. In the Explorer window, under Data Access, right-click IBM Cognos Planning and then click New resource, Database.
2. In the Name box, type a name for the resource. For example, Planning Store.
3. In the Type box, select the type of database and click OK.

   Tip: If you want to use an Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).

4. In the Properties window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the Database server with port number or instance name and Database name properties.
     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the Database server with port number or instance name property.
   - If you use an Oracle database, type the appropriate values for the Database server and port number and Service name properties.
   - If you use an advanced Oracle database, for the Database specifier property, type the Oracle Net8 keyword-value pair for the connection.
     Here is an example:
     (description=(address=(host=myhost)(protocol=tcp)(port=1521)
                   (connect_data=(sid=(orcl))))

     When you select the advanced Oracle database, IBM Cognos uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

5. To set the ID and password for the database:
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   - Type the appropriate values and click OK.
6. From the File menu, click Save.
   The logon credentials are immediately encrypted.
7. Right-click on the new connection and click Test. For example, if you named the new database resource Planning Store, right-click Planning store, and then click Test.

Configure the Web Server

For all installations, before you use Web pages generated by IBM Cognos, you must configure your Web server.
About this task

You must create virtual directories, or aliases, so that users can connect to IBM Cognos in the portal. If you plan to run more than one IBM Cognos product, or several instances of the same product, on one computer, you must create a separate application pool for each product or instance and then associate the aliases for that product or instance to the application pool. The steps for creating an application pool vary depending on your operating system.

Procedure

Create the following virtual directories using the information in the following table:

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos</td>
<td>c10_location/webcontent</td>
<td>Read</td>
</tr>
<tr>
<td>ibmcognos/cgi-bin</td>
<td>c10_location/cgi-bin</td>
<td>Execute</td>
</tr>
</tbody>
</table>

Note: The cogrcp folder, located in c10_location/planning/contributor must have Scripts only execute permissions.
You can use a name other than ibmcognos in the aliases. However, you must use cgi-bin as the second part of the alias. If you use an alias other than ibmcognos you must change the virtual directory in the Gateway URI property to match your alias.
For Apache Web Server, ensure that you define the ibmcognos/cgi-bin alias before the ibmcognos alias in the httpd.conf file located in the Apache_installation/conf directory. You must define the ibmcognos/cgi-bin alias as a ScriptAlias.

Start the IBM Cognos Planning Services

After you have set the database connection properties for the content store and planning store, you can start the IBM Cognos Planning services.

Procedure

From the Actions menu, click Start.
This action starts all installed services that are not running. If you want to start a particular service, select the service node in the Explorer window and then click Start from the Actions menu.

Setting the IBM Cognos Planning Service

The IBM Cognos Planning service can run as a non-administrator account or as the NetworkService account.

Note: If you use the NetworkService account, then you must specify NT AUTHORITY\NetworkService without a password.

Before you begin

You must stop the IBM Cognos Planning service before you edit the properties.
Uninstalling IBM Cognos

It is important to use uninstall programs to completely remove all files and modifications to system files.

Uninstall IBM Cognos on Windows Operating Systems

If you no longer require IBM Cognos or if you are upgrading, uninstall all IBM Cognos components and the IBM Cognos service.

If you installed more than one component in the same location, the uninstall wizard lets you choose the packages to uninstall. All components of the package will be uninstalled. You must repeat the uninstallation process on each computer that contains IBM Cognos components.

It is not necessary to back up the configuration and data files on Microsoft Windows operating systems. These files are preserved during the uninstallation.

Close all programs before you uninstall IBM Cognos. Otherwise, some files may not be removed.

Uninstalling does not remove any files that changed since the installation, such as configuration and user data files. Your installation location remains on your computer, and you retain these files until you delete them using Microsoft Windows Explorer.

**Important:** Do not delete the configuration and data files if you are upgrading to a new version of IBM Cognos and you want to use the configuration data with the new version.

**Procedure**

1. From the **Start** menu, click **Programs, IBM Cognos, Uninstall IBM Cognos**. The **Uninstall** wizard appears.

   **Tip:** IBM Cognos is the default name of the Program Folder that is created during the installation. If you chose another name, go to that folder to find the program.

2. Follow the instructions to uninstall the components.

   The cognos_uninst_log.htm file records the activities that the Uninstall wizard performs while uninstalling files.

   **Tip:** To find the log file, look in the Temp directory.

3. Delete all temporary Internet files.

   For more information, see your Web browser documentation.
Chapter 8. Installing and Configuring in a Medium-Sized Environment

Your installation of IBM Cognos Planning in a medium-sized environment distributes roles on separate servers to optimize performance and scalability. This type of installation is distributed across four tiers, as shown in this section.

The following diagram shows the IBM Cognos Planning components, and the order in which they should be installed, configured and started. You must configure and start Content Manager before you can start a Planning Server.

Server names are provided to help you understand the configuration requirements for each planning component in a distributed environment. The server names, for example, Server_1, correspond to the examples used in the configuration tables for each planning component.

Tip: Map your servers to the servers and server names in this diagram before you begin installing and configuring your planning components.
For information about the components, see “Architecture of a Medium-Sized Environment” on page 72.

For information about the roles of planning servers, see “Configure Role-based Planning Servers” on page 73.
Before you begin

Install IBM Cognos components in a directory that contains only ASCII characters in the path name. Some UNIX and Linux Web servers do not support non-ASCII characters in directory names.

The IBM Cognos Planning server components are intended to run in server environments and should not be installed on computers running Windows Vista or Windows 7 operating systems.

About this task

The Planning Complete installation kit contains all the necessary components to install and run IBM Cognos Planning on one computer. To install Planning in distributed environments, use the following lists to determine which Cognos Planning installation kit to use to install specific Planning components.

Cognos Planning Server installation kit
The Cognos Planning Server kit helps you install specific Planning components in distributed environments. You can use it to install and configure the following components:

- Planning Job service
- Planning Web service
- Planning Administration Console service
- Planning Data service
- Analyst Universal Naming Convention (UNC) Connection

Cognos Planning Gateway installation kit
The Cognos Planning Gateway kit enables you to install the Planning-specific files on the same computer that has the BI gateway. The following components are installed automatically:

- Contributor rich client installer
- Contributor workflow page

Cognos Planning Administration Client installation kit
The Cognos Planning Administration Client installation kit enables you to install the following administration components:

- Analyst
- Planning Analyst Add-in for Microsoft Excel
- Planning Manager
- Planning Administrator (CAC)

Cognos Planning Client installation kit
The Cognos Planning Client installation kit enables you to install the following contributor components:

- Planning Contributor
- Contributor Add-in for Microsoft Excel

Using the component-specific installation kits, rather than the Cognos Planning Complete installation kit, allows you to install the minimum subset of files and configurable services that you need for that component and reduces the installation footprint required.

Note: You can only install the Content Manager component from the Cognos Planning Complete installation kit.
Procedure
1. Install and configure Content Manager.
2. Install and configure IBM Cognos server.
3. Install the gateway and create virtual directories.
4. Install and configure the Planning administration and Web services server.
5. Install and configure the Planning job server.
6. Install the clients.
   For more information, see Chapter 10, “Installing the IBM Cognos Planning Clients,” on page 161.

Results
After you complete these installation and configuration tasks, you can perform additional configuration tasks, and change the IBM Cognos Planning default behavior to better suit your environment. For more information, see Chapter 11, “Additional Configuration Options,” on page 181.

Architecture of a Medium-Sized Environment

The four tiers, and planning components within them, that form the medium-sized environment are described in this section.

Data Tier

The data tier includes the content store and planning store.

Before you install any of the tier components, you must set up your environment for IBM Cognos content data stores, which includes creating the content store and the planning store. For more information, see Chapter 5, “Setting Up Your Environment,” on page 29.

You set up database connectivity to the content store and planning store after installing the planning components on your servers. For more information, see “Setting Up Database Connectivity to the Content Store and Planning Store Database” on page 75.

Application Tier

The application tier includes the following:
• Content Manager
• IBM Cognos server
• Planning Administration and Web Server
• Planning Job server
• Planning Data server, which is an optional component.

Web Tier

The Web tier components includes only the Gateway.

User Interface tier

The user interface tier includes the required Web-based and Windows-based user interfaces for your end-users. For client installation and configuration information,
Configure Role-based Planning Servers

You can configure each planning server to perform a specific role. You set roles by enabling and disabling services that are run by the dispatcher service.

The planning server roles are determined by the services running on that computer, which can include a planning job service, a planning data service, a planning administration service, and a planning Web service.

Each server must have the dispatcher service enabled and running. However, you can choose which Planning services you want running on each computer. There must also be at least one Planning Server running all non-Planning services, such as the data movement service, event management service, report service, and so on.

If some IBM Cognos services are not required in your environment, you can disable them to increase the performance of other services.

For example, if you are using a job server to only run planning jobs, that job server does not need to run reports. If you disable the report service, the performance of the job server is never impacted by running reports.

Prerequisites for Planning Services

Use the following as guidelines for enabling services on your planning servers.

- The presentation service must remain enabled on at least one computer in your IBM Cognos Planning environment.
- If you have IBM Cognos Business Intelligence installed and you want to use Query Studio, you must ensure that the presentation service is enabled on at least one server.
- If you have IBM Cognos Business Intelligence installed and you want to use Analysis Studio, you must enable the report service on at least one server.

Install Content Manager

Content Manager stores and manages IBM Cognos content, including user permissions. Content Manager must be configured, running, and accessible before you configure other computers in your IBM Cognos environment.

This ensures that the certificate authority service, which is installed with Content Manager, is available to issue certificates to other IBM Cognos computers.
Procedure

1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.

2. Insert the IBM Cognos Planning Complete CD or go to the installation source file directory.
   
   The Welcome page of the installation wizard appears when you insert the CD.
   
   If no Welcome page appears or you are not installing from the CD, go to the win32 directory, and double-click issetup.exe.

3. Select the language to use for the installation.
   
   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.

4. In the Component Selection page, select Content Manager.
   
   If you are installing it in a directory that contains other IBM Cognos components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.

5. In the Finish page of the installation wizard, do the following:
   
   • If you want to configure Content Manager immediately, click Start IBM Cognos Configuration.
If you want to see late-breaking information about IBM Cognos components, click View the Readme.

6. Click Finish.

**Configure Content Manager**

After you install Content Manager, you must set up database connectivity to the content store database.

Once connectivity is established you perform the following tasks using IBM Cognos Configuration.

**Procedure**

1. Start IBM Cognos Configuration.
2. Configure properties for Content Manager.
3. Enable security.
4. Set database connection properties for the content store.
5. Set database connection properties for the planning store.
6. Start Content Manager.
7. Use a Web browser to test Content Manager installation.

**Setting Up Database Connectivity to the Content Store and Planning Store Database**

For the planning store, you must ensure that the appropriate OLE DB or SQL Native Client (for SQL Server) drivers are installed on each computer where Content Manager or a Planning Server is installed. This allows you to set up database connectivity for the planning store database.

If you configure Microsoft SQL Server Windows Authentication for the planning store databases, you must take into account that the planning data service inherits its security from the dispatcher.

For the content store, you must ensure that the appropriate JDBC drivers are installed on every computer where Content Manager is installed.

After connectivity is set up, you can connect to the Content and Planning stores using IBM Cognos Configuration.

**Set up database connectivity for a DB2 content store**

Follow these steps to set up database connectivity for a DB2 content store.

**Procedure**

1. If you are using a type 2 JDBC connection, install the DB2 client software on the Content Manager computers.

   If you are using a type 4 JDBC connection for DB2, you are not required to install the DB2 client software where Content Manager is installed. If you use a DB2 database on z/OS for the content store, you must use a type 4 JDBC connection.

   For more information about the differences between type 2 and type 4 drivers, see "JDBC Driver Options for Using DB2 Database as a Content Store" on page 57.
2. If you are using a type 2 JDBC connection, and the content store is on a different computer than Content Manager, configure a database alias to the content store.

On Microsoft Windows operating systems, run the DB2 Client Configuration Assistant.

Note: If the content store database and Content Manager are on the same computer, the content store name automatically becomes the alias.

When you configure the Content Manager computers, ensure that they are all configured to use the same content store.

3. On Windows, stop the DB2 services and the HTML Search Server.

4. Copy the following files from DB2_installation/sqllib/java directory to the c10_location/webapps/p2pd/WEB-INF/lib directory.
   - the universal driver file, db2jcc.jar
   - the license file
     for DB2 on Linux, UNIX, or Windows, db2jcc_license_cu.jar

If you are connecting to DB2 on z/OS, use the driver version from Linux, UNIX, or Windows version 9.1 fix pack 5 or version 9.5 fix pack 2.

Tip: To check the driver version, run the following command

   java -cp path\db2jcc.jar com.ibm.db2.jcc.DB2Jcc -version

5. On Windows, restart the DB2 services and the HTML Search Server.

6. On UNIX, if you are using a type 2 JDBC connection, ensure that the 32-bit DB2 libraries are in the library search path, which is usually the $DB2DIR/lib directory or the $DB2DIR/lib32 directory.

7. Repeat this entire procedure on the IBM Cognos BI computers where Content Manager is installed or where notification is sent to a DB2 database.

Set up database connectivity for an Oracle content store

Follow these steps to set up database connectivity for an Oracle content store.

Procedure

1. On the computer where the Oracle client is installed, go to the ORACLE_HOME/jdbc/lib directory.

2. Copy the correct library file for your version of the Oracle client to the c10_location/webapps/p2pd/WEB-INF/lib directory on the computer where Content Manager is installed and where notification is sent to an Oracle database.
   - If you are using Oracle 10g, you must have ojdbc14.jar.
   - If you are using Oracle 11g, you must have ojdbc5.jar.
   - The files are available from an Oracle client or server install, and can also be downloaded from the Oracle technology Web site.

Configure Properties for Content Manager

Content Manager runs as a service in an IBM Cognos dispatcher. The dispatcher runs in a servlet container. By default the IBM Cognos dispatcher uses port number 9300 for communications. You can change this port number.

If you configured IBM Cognos with standby Content Manager computers and you use the default CGI gateway, you must now configure IBM Cognos to use an ISAPI gateway.
Content Manager creates security keys that allow only authorized servers to communicate with it. If you are installing server components on different computers, you must ensure that you set the same password for the Certificate Authority settings in IBM Cognos Configuration.

Use IBM Cognos configuration to configure environment, security, and data access properties for Content Manager. The following tables provide configuration options for each group of properties.

To start IBM Cognos Configuration, click All Programs from the Start menu, then click IBM Cognos, and then click IBM Cognos Configuration.

Tip: Test after each configuring each property group. To test a property, right-click on the property, and then click Test.

**Environment Group Properties**

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

*Table 10. IBM Cognos Configuration environment group properties for Content Manager*

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dispatcher settings</td>
<td>External dispatcher URI</td>
<td>Enter the name of the Content Manager server. For example, http://Server_1:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Internal dispatcher URI</td>
<td>Enter the name of the Content Manager server. For example, http://Server_1:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td>Other URI Settings</td>
<td>Dispatcher URI for external applications</td>
<td>Enter the name of the Content Manager server. For example, http://Server_1:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Content Manager URIs</td>
<td>Enter the name of the Content Manager server. For example, http://Server_1:9300/p2pd/servlet</td>
</tr>
</tbody>
</table>
Table 10. IBM Cognos Configuration environment group properties for Content Manager (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Cognos Service Component Properties</td>
<td>Content Manager enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Dispatcher service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>All other IBM Cognos services</td>
<td>False</td>
</tr>
<tr>
<td>IBM Cognos</td>
<td>Delete the existing IBM Cognos resource, and then create a new resource. Name the new resource IBM Cognos, and leave the default Maximum memory in MB, which is 768.</td>
<td></td>
</tr>
</tbody>
</table>

Security Group Properties

For detailed information about enabling security, see “Enable Security” on page 79.

The following table provides the configuration values for the security group properties in IBM Cognos configuration.

Table 11. IBM Cognos Configuration security group properties for Content Manager

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication component Properties</td>
<td>Allow session information to be shared between client applications?</td>
<td>True</td>
</tr>
</tbody>
</table>

Data Access Group Properties

The following table provides the configuration values for the data access group properties in IBM Cognos configuration.
Table 12. IBM Cognos Configuration data access group properties for Content Manager

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Manager</td>
<td></td>
<td>Create a new resource called Content Store, and then select the type of database that you are using for the Content Store. Values for the new Content Store follow.</td>
</tr>
<tr>
<td>Component Properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td>For more information, see “Set Database Connection Properties for the Content Store” on page 61</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Content Store Database Resource Properties</td>
<td>Datasource server and port number</td>
<td>Enter the name of the content store server. For example, http://Server_store:1433</td>
</tr>
<tr>
<td>User ID and password</td>
<td></td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td>Database name</td>
<td></td>
<td>Enter the name of the content store database.</td>
</tr>
<tr>
<td>IBM Cognos Planning</td>
<td></td>
<td>Create a new resource called Planning store, and then select the type of database that you are using for the Planning Store. Values for the new Planning store follow.</td>
</tr>
<tr>
<td>Component Properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td>For more information, see “Set Database Connection Properties for the Planning Store” on page 96</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planning store</td>
<td>Datasource server and port number</td>
<td>Enter the name of the planning store server, and the port number.&gt; For example, Server_store:1433</td>
</tr>
<tr>
<td>User ID and password</td>
<td></td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td>Database name</td>
<td></td>
<td>Enter the name of the planning store database. Note: The database must already exist.</td>
</tr>
</tbody>
</table>

Enable Security

IBM Cognos Planning requires that users log in. This ensures that users only see parts of budgets or plans for which they are responsible.

By default, IBM Cognos Planning allows anonymous access to the Web portal. You must disable anonymous access and configure IBM Cognos Planning to use an authentication provider before users can access any of the client applications or the portal.
Procedure
1. In the IBM Cognos Configuration Explorer window, click Security > Authentication > Cognos.
2. Click the Value box for Allow Anonymous Access, and select False.
4. In the Name box, type a name for your authentication namespace.
5. In the Type list, click the appropriate namespace type and then click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
6. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
   For more information about configuring IBM Cognos BI to use an authentication provider, see Chapter 13, “Configuring IBM Cognos Components to Use an Authentication Provider,” on page 219.
7. From the File menu, click Save.

Setting Database Connection Properties for the Content Store
You use IBM Cognos Configuration to specify the database server information. This ensures that Content Manager can connect to the database that you are using for the content store. Content Manager uses the database logon to access the content store. After you set the database connection properties, you can test the connection between Content Manager and the content store.

Ensure that you used one of the supported database servers to create the content store.

Some database servers are available with advanced features. When you select an advanced database option, IBM Cognos uses features of the database server to manage the connection.

For example, if you select the advanced Oracle database, IBM Cognos uses enterprise-oriented Oracle features to
- select a listener
- switch to another listener if the first listener fails
- automatically reconnect to the database if the connection fails
- balance connection requests among listeners
- and balance connection requests among dispatchers.

IBM Cognos requires the TCP/IP protocol to access data and the content store. Ensure that the database server has the protocol set to TCP/IP.

Using a DB2 database for the content store
The default database for the content store is DB2.

When you use a DB2 database for your content store you must configure, set, and test the content store before setting up the planning store.

Setting Database Connection Properties for a DB2 Content Store on UNIX, Linux, or Microsoft Windows
You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store.
Procedure
1. In the location where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access > Content Manager, click Content Store.
3. In the Properties window, for the Database name property, type the name of the database or the database alias.
4. Change the logon credentials to specify a valid user ID and password:
   • Click the Value box next to the User ID and password property and then click the edit button when it appears.
   • Type the appropriate values and click OK.
5. To use a type 4 JDBC connection, for the Database server and port number property, type a value, using host:port syntax.
   If you leave this property blank, a type 2 JDBC connection is used.
   For more information about the differences between the driver types, see “JDBC Driver Options for Using DB2 Database as a Content Store” on page 57.
6. From the File menu, click Save.
   The logon credentials are immediately encrypted.
7. To test the connection between Content Manager and the content store database, from the Actions menu, click Test.
   Content Manager connects to the database, checks the database permissions, and creates and populates a table. The table is not deleted and is used each time that the test is repeated.

Setting Database Connection Properties for a Microsoft SQL Server, Oracle, Informix, or Sybase Content Store
You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store.

Procedure
1. On the computer where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, Content Manager, right-click Content Store and click Delete.
   This deletes the connection to the default resource. Content Manager can access only one content store.
3. Right-click Content Manager, and then click New resource, Database.
4. In the Name box, type a name for the resource.
5. In the Type box, select the type of database and click OK.
   Tip: If you want to use an Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).
6. In the Properties window, provide values depending on your database type:
   • If you use a Microsoft SQL Server database, type the appropriate values for the Database server with port number or instance name and Database name properties.
     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the Database server with port number or instance name property.
For the **Database server with port number or instance name** property, include the instance name if there are multiple instances of Microsoft SQL Server.

To connect to a named instance, you must specify the instance name. For example, you can type `localhost\instance1`. If an instance name is not specified, a connection to the default instance is created.

- If you use an Oracle database, type the appropriate values for the **Database server and port number** and **Service name** properties.
- If you use an advanced Oracle database, for the **Database specifier** property, type the Oracle Net8 keyword-value pair for the connection.
  
  Here is an example:

  ```
  (description=(address=(host=myhost)(protocol=tcp)(port=1521)
  (connect_data=(sid=(orcl)))))
  ```

  When you select the advanced Oracle database, IBM Cognos BI uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

- If you use an Informix database, type the appropriate values for the **Database server and port number** and **Database name** properties.
- If you use a Sybase database, type the appropriate values for the **Database server and port number** and **Database name** properties.

7. To configure logon credentials, specify a user ID and password:
   - Click the Value box next to the **User ID and password** property and then click the edit button when it appears.
   - Type the appropriate values and click OK.

8. If you host more than one content store database on an Informix instance, create the advanced property CMSCRIPT_CS_ID and specify the account under which the instance runs:
   - In the Explorer window, click Local Configuration.
   - In the Properties window, click the Value column for Advanced properties and then click the edit button.
   - In the Value - Advanced properties dialog box, click Add.
   - In the Name column, type CMSCRIPT_CS_ID
   - In the Value column, type the user ID of the account under which the instance of the content store runs.

   Use a different user account for each instance of Informix content store database.

9. From the File menu, click **Save**.
   The logon credentials are immediately encrypted.

10. To test the connection between Content Manager and the content store database, from the Actions menu, click **Test**.

    Content Manager connects to the database, checks the database permissions, and creates and populates a table. The table is not deleted and is used each time that the test is repeated.

### Results

Content Manager can now create the required tables in the content store when you start the IBM Cognos service for the first time. If the connection properties are not specified correctly, you cannot start the IBM Cognos services.
Set Database Connection Properties for the Planning Store

You must specify database connection information for the planning store. You can choose to use the same database for the planning store and the content store. You must create the database you will use for the planning store before you can connect to it.

Note: When you use a DB2 database for your content store you must configure, set, and test the content store before setting up the planning store.

It is mandatory to configure connection properties for the Planning store.

If you install multiple Planning Servers in your environment, you must set the connection properties for the planning store on each Planning Server computer.

The planning store can be on a Microsoft SQL Server, Oracle, or DB2 database.

Some database servers are available with advanced features. When you select an advanced database, IBM Cognos uses features of the database server to manage the connection. If you select the advanced Oracle database, for example, IBM Cognos uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

The default database for the content store is DB2.

If you are using a Microsoft SQL Server database, the version that you select in IBM Cognos Configuration defaults to Microsoft SQL Server 2005. If you are using SQL Server 2008, then you must select the correct version.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, right-click IBM Cognos Planning, and click New resource, Database.
3. In the Name box, type a name for the resource.
4. In the Type box, select the type of database and click OK.

Tip: If you want to use Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).
5. In the Properties window, provide values depending on your database type:
   • If you use a Microsoft SQL Server database, type the appropriate values for the Database server with port number or instance name and Database name properties.
     In the Properties window, type the appropriate values for the mandatory and optional properties.
     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the Database server with port number or instance name property. Include the port number if you use nondefault ports. Include the instance name if there are multiple instances of Microsoft SQL Server.
     To connect to a named instance, you must specify the instance name. For example, you can type localhost\instance1. If no instance name property is specified, a connection to the default instance is created.
Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example:

jdbc:JSQLConnect://localhost\instance1/user=sa/more properties as required

- If you use a DB2 database, for the Database name property, type the database alias.
- If you use an Oracle database, type the appropriate values for the Database server and port number and Service name properties.
- If you use an advanced Oracle database, for the Database specifier property, type the Oracle Net8 keyword-value pair for the connection.
  Here is an example:
  
  (description=(address=(host=myhost)(protocol=tcp)(port=1521)
  (connect_data=(sid=(orcl))))

6. To set the user ID and password for the database
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   - Type the appropriate values and click OK.

7. In the Explorer window, right-click the new database resource name and then click Test.

8. From the File menu, click Save.
   The logon credentials are immediately encrypted.

### Start Content Manager

After you have set the database connection properties for the content store, you can start the Content Manager computer.

**Procedure**

From the Actions menu, click Start.
It might take a few minutes for the IBM Cognos service to start.
This action starts all installed services that are not running. If you want to start a particular service, select the service node in the Explorer window and then click Start from the Actions menu.

### Test the Content Manager Installation and Configuration

You can test your installation in a Web browser.

**Procedure**

1. Open a Web browser.
2. Test that Content Manager is running by typing the Content Manager URIs value from IBM Cognos Connection. For example,

   http://hostname:port_number/p2pd/servlet

   The State value should be Running.

### Install IBM Cognos Server

A working planning environment requires IBM Cognos services. You can obtain a Planning environment with IBM Cognos services in one of the following ways:

- Installing a planning server.
• Installing IBM Cognos Business Intelligence (BI), which provides a Planning and Business Intelligence environment.

The following instructions assume that you are using a planning server installation. For more information, see “Installing IBM Cognos Planning with IBM Cognos Business Intelligence” on page 19.

To install and configure the IBM BI Cognos Server, see the IBM Cognos Business Intelligence Installation and Configuration Guide.

![Diagram of IBM Cognos Server installation in a medium-sized environment](image)

**Figure 20. IBM Cognos Server installation in a medium-sized environment**

**Procedure**

1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.

2. Insert the IBM Cognos Planning Server CD or go to the installation source file directory.

   The **Welcome** page of the installation wizard appears when you insert the CD. If no **Welcome** page appears or you are not installing from the CD, go to the win32 directory, and double-click isetup.exe.

3. Select the language to use for the installation.
The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.

4. In the Component Selection page, select Planning Server.
   If you are installing it in a directory that contains other IBM Cognos components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.

5. In the Finish page of the installation wizard, do the following:
   • If you want to configure Content Manager immediately, click Start IBM Cognos Configuration.
   • If you want to see late-breaking information about IBM Cognos components, click View the Readme.

6. Click Finish.

Configure IBM Cognos Server

After you install IBM Cognos server, you must perform several tasks using IBM Cognos Configuration to configure the server.

Procedure
1. Start IBM Cognos Configuration.
2. Configure properties for IBM Cognos Server.

Configure Properties for IBM Cognos Server

Use IBM Cognos Configuration to configure environment, and data access properties for your IBM Cognos server. The following tables provide configuration options for each group of properties.

To start IBM Cognos Configuration, click All Programs from the Start menu, then click IBM Cognos, and then click IBM Cognos Configuration.

Tip: Test after configuring each property. To test a property, right-click on the property, and then click Test.

Environment Group Properties

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway Settings</td>
<td>Gateway URI</td>
<td>Enter the name of the gateway server. For example http://Server_3:80/ibmcognos/cgi-bin/cognos.cgi</td>
</tr>
</tbody>
</table>
### Table 13. IBM Cognos Configuration environment group properties for IBM Cognos Server (continued)

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dispatcher Settings</td>
<td>External dispatcher URI</td>
<td>Enter the name of the IBM Cognos server. For example, http://Server_2:9300/p2pd/ servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Internal dispatcher URI</td>
<td>Enter the name of the IBM Cognos server. For example, http://Server_2:9300/p2pd/ servlet/dispatch</td>
</tr>
<tr>
<td>Other URI Settings</td>
<td>Dispatcher URI for external applications</td>
<td>Enter the name of the IBM Cognos server. For example, http://Server_2:9300/p2pd/ servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Content Manager URIs</td>
<td>Enter the name of the content manager server. For example, http://Server_1:9300/p2pd/ servlet</td>
</tr>
<tr>
<td>IBM Cognos Service Component Properties</td>
<td>All Planning services</td>
<td>False</td>
</tr>
<tr>
<td></td>
<td>All other services</td>
<td>True</td>
</tr>
<tr>
<td>IBM Cognos</td>
<td></td>
<td>Delete the existing IBM Cognos resource, and then create a new resource. Name the new resource IBM Cognos, and leave the default Maximum memory in MB, which is 768.</td>
</tr>
<tr>
<td>Planning Component Properties</td>
<td>Analyst maximum workspace in KB</td>
<td>Enter a value that is consistent for each Planning server.</td>
</tr>
</tbody>
</table>

### Data Access Group Properties

The following table provides the configuration values for the data access group properties in IBM Cognos Configuration.
### Table 14. IBM Cognos Configuration data access group properties for IBM Cognos Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Store Database Resource Properties</td>
<td></td>
<td>Delete the existing resource, and then create a new resource.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name the new resource Notification Store, and then select the database type.</td>
</tr>
<tr>
<td></td>
<td>Datasource server and port number</td>
<td>Enter the name of the content store server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the content store database.</td>
</tr>
</tbody>
</table>

### Start IBM Cognos Server

After you configure properties, you can start the IBM Cognos server computer.

#### Procedure

From the **Actions** menu, click **Start**.

It might take a few minutes for the IBM Cognos service to start.

This action starts all installed services that are not running. If you want to start a particular service, select the service node in the **Explorer** window and then click **Start** from the **Actions** menu.

### Install the Gateway

You must install the IBM Cognos Planning gateway on a web server computer. You can install the gateway on one or more computers, depending on your environment.
If you plan to install Planning in a mixed environment with IBM Cognos BI, then you must install the Planning gateway on the same computer as the BI gateway.

**Installing the gateway components**

**Procedure**

1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.

2. Insert the IBM Cognos Planning Gateway CD or go to the installation source directory.

3. Follow the directions in the installation wizard to copy the required files to your computer.

   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.

4. In the Finish page of the installation wizard,
   - If you want to configure Content Manager immediately, click **Start IBM Cognos Configuration**.

---

*Figure 21. IBM Cognos Planning gateway installation in a medium-sized environment*
Configure the Gateway

After you install the Planning Gateway, you perform the following tasks using IBM Cognos configuration.

Procedure
1. Start IBM Cognos Configuration.
2. Configure properties for the Gateway.
3. Configure your Web server.
4. Start the gateway.
5. Use a Web browser to test the gateway configuration.

Configure Properties for the Gateway

The gateway computer must know the location of at least one Planning Server dispatcher in your environment. The load management of Planning Server dispatchers is controlled by the Content Manager, which knows the location of all Planning Server dispatchers. Additional dispatchers that you configure on the gateway computer are used for failover purposes.

Use IBM Cognos configuration to configure environment properties for your gateway server. The following table provides configuration options for these properties.

**Tip:** Test after each configuring each property. To test a property, right-click on the property, and then click **Test**.

Environment Group Properties

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway settings</td>
<td>Dispatcher URIs for gateway</td>
<td>Enter the name of the gateway server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example http://Server_3:9300/p2pd/servlet/dispatch/ext</td>
</tr>
</tbody>
</table>

Configure a Web server

For all installations, before you use Web pages generated by IBM Cognos, you must configure your Web server.

Procedure

Create the following virtual directories using the information in the following table:
Table 16. Virtual directories information

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos</td>
<td>c10_location/webcontent</td>
<td>Read</td>
</tr>
<tr>
<td>ibmcognos/cgi-bin</td>
<td>c10_location/cgi-bin</td>
<td>Execute</td>
</tr>
</tbody>
</table>

**Note:** The cogrcp folder, located in c10_location/planning/contributor must have Scripts only execute permissions. You can use a name other than ibmcognos in the aliases. However, you must use cgi-bin as the second part of the alias. If you use an alias other than ibmcognos you must change the virtual directory in the Gateway URI property to match your alias.

For Apache Web Server, ensure that you define the ibmcognos/cgi-bin alias before the ibmcognos alias in the httpd.conf file located in the Apache_installation/conf directory. You must define the ibmcognos/cgi-bin alias as a ScriptAlias.

**Start the Gateway**

After you have configured the environment group properties, you can start the gateway computer.

**Procedure**

From the Actions menu, click Start. It might take a few minutes for the IBM Cognos service to start. This action starts all installed services that are not running. If you want to start a particular service, select the service node in the Explorer window and then click Start from the Actions menu.

**Test the Gateway Configuration**

You can test the installation using a web browser.

**Procedure**

1. Ensure that your web server is running.
2. Open a web browser.
3. In your address box, type the URI for the gateway. For example `http://hostname:port/ibmcognos` The IBM Cognos Connection Welcome page appears.

**Planning Servers**

Planning Servers run job-based administration tasks, such as publishing and reconciliation tasks. They also manage communications with IBM Cognos Planning clients and IBM Cognos Business Intelligence components. Depending on your environment, you might need to install more than one Planning Server.

To improve scalability in an environment that serves many users, you can install the Planning Server component on multiple computers dedicated to processing incoming requests. This strategy distributes and balances loads among the computers, and provides better accessibility, throughput, and failover support than installing on a single computer.
After you install the Planning Servers, you can configure specific roles for each server. For more information, see “Configure Role-based Planning Servers” on page 73.

Ensure that you have administrator privileges for the Windows computer on which you are installing. Also ensure that your computer has a TEMP system variable that points to the directory where you want to store temporary files. During installation, files from the CD are temporarily copied to this directory.

**Setting the IBM Cognos Planning Service**

The IBM Cognos Planning service can run as a non-administrator account or as the NetworkService account.

**Note:** If you use the NetworkService account, then you must specify NT AUTHORITY\NetworkService without a password.

**Before you begin**

You must stop the IBM Cognos Planning service before you edit the properties.

**Create an Analyst Network Share**

A network connection point is the location where you set up a network share. For distributed IBM Cognos Planning Analyst installations, you should always install a network connection point so that both Analyst server and Analyst clients use a Universal Naming Convention (UNC) path to connect to a shared library.

When you create a network connection point, the Analyst software is installed on the local drive of your computer, and the data is stored in a shared location on the network server, along with control files and the samples files.

One of the files created at the network installation point is filesys.ini. The filesys.ini file is a control file used by Analyst. It contains file paths for the Libs.tab, Users.tab, and Groups.tab that control the specific library and user setup. If you do not specify the filesys.ini path by creating a network connection point, you must specify the path when you create planning tables. For more information, see the IBM Cognos Planning Contributor Administration Guide or the IBM Cognos Planning Analyst User Guide.

You must set up a network share so that server and client computers can access the installation files. Ensure that all Analyst users have NTFS permissions of Modify.

**Note:** You only need to install the Analyst UNC connection point once, regardless of how many planning servers you install.

**Install the Planning Administration and Web Services Server**

Planning administration servers manage communications with Contributor Administration and perform other administrative tasks.

Contributor Administration users connect to the Planning administration server through the gateway.

Planning Web servers manage Contributor web Client and Contributor for Microsoft Excel client communications.
The gateway manages client connectivity in the web tier, and the planning web service manages client connectivity in the application tier. Clients communicate directly with the gateway, and with the planning web server through the dispatcher. The planning web server communicates with the planning store and sends data back to the clients through the gateway.

Procedure

1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.

2. Insert the IBM Cognos Planning Server CD or go to the installation source file directory.

   The Welcome page of the installation wizard appears when you insert the CD. If no Welcome page appears or you are not installing from the CD, go to the win32 directory, and double-click issetup.exe.

3. Select the language to use for the installation.

   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.

Figure 22. Planning Administration and Web Services Server installation in a medium-sized environment
4. In the **Component Selection** page, click **Planning Server, Application Tier**, then select the following components:
   - **Planning Web service**
   - **Planning Administration Console service**
   - **Analyst UNC Connection Point**

   If you are installing it in a directory that contains other IBM Cognos components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.

5. In the **Analyst UNC Install Location** page, type the UNC path for the shared directory to which you want the network installation point installed.

   **Note:** You only need to install the Analyst UNC connection point once, regardless of how many planning servers you install.

6. In the **Finish** page of the installation wizard, do the following
   - If you want to configure Content Manager immediately, click **Start IBM Cognos Configuration**.

7. Click **Finish**.

---

**Configure the Planning Administration and Web Services Server**

After you install the planning server, you must perform the following tasks using IBM Cognos configuration.

**Procedure**

1. Start IBM Cognos Configuration.
2. Configure properties for the Planning Server.
3. Set database connection properties for the planning store.
4. Start the Planning Server.

**Configure Properties for the Planning Administration and Web Services Server**

Use IBM Cognos Configuration to configure environment, and data access properties for your planning administration and Web services server. The following tables provide configuration options for each group of properties.

To start IBM Cognos Configuration, click **All Programs** from the **Start** menu, then click **IBM Cognos**, and then click **IBM Cognos Configuration**.

**Tip:** Test after each configuring each property. To test a property, right-click on the property, and then click **Test**.

**Environment Group Properties**

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.
## Table 17. IBM Cognos Configuration environment group properties for Planning Administration and Web Services Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway settings</td>
<td>Gateway URI</td>
<td>Enter the name of the gateway server. For example, http://Server_3:80/ibmcognos/cgi-bin/cognos.cgi</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dispatcher settings</td>
<td>External dispatcher URI</td>
<td>Enter the name of the planning administration and Web services server. For example, http://Server_4:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Internal dispatcher URI</td>
<td>Enter the name of the planning administration and Web services server. For example, http://Server_4:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td>Other URI Settings</td>
<td>Dispatcher URI for external applications</td>
<td>Enter the value of the IBM Cognos server. For example, http://Server_2:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Content Manager URIs</td>
<td>Enter the value of the content manager server. For example, http://Server_1:9300/p2pd/servlet</td>
</tr>
<tr>
<td>IBM Cognos Service - Component Properties</td>
<td>Dispatcher service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Agent service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Monitor service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Planning administration console service enabled?</td>
<td>True</td>
</tr>
</tbody>
</table>
Table 17. IBM Cognos Configuration environment group properties for Planning Administration and Web Services Server (continued)

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Planning Web service enabled?</td>
<td>True</td>
<td></td>
</tr>
<tr>
<td>All other IBM Cognos services</td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>IBM Cognos Configuration</td>
<td>Type</td>
<td>Leave the default.</td>
</tr>
<tr>
<td>IBM Cognos Configuration</td>
<td>Resource Properties</td>
<td></td>
</tr>
<tr>
<td>IBM Cognos Planning Component Properties</td>
<td>Analyst maximum workspace in KB</td>
<td>Enter a value that is consistent for each Planning server.</td>
</tr>
</tbody>
</table>

Data Access Group Properties

The following table provides the configuration values for the data access group properties in IBM Cognos Configuration.

Table 18. IBM Cognos Configuration data access group properties for Planning Administration and Web Services Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Cognos Planning Component Properties</td>
<td>Datasource server and port number</td>
<td>Enter the name of the planning store server, and port number. For example, Server_store:1433</td>
</tr>
<tr>
<td>User ID and password</td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td>Database name</td>
<td>Database name</td>
<td>Enter the name of the planning store database.</td>
</tr>
</tbody>
</table>

Set Database Connection Properties for the Planning Store

You must specify database connection information for the planning store. You can choose to use the same database for the planning store and the content store. You must create the database you will use for the planning store before you can connect to it.
Note: When you use a DB2 database for your content store you must configure, set, and test the content store before setting up the planning store.

It is mandatory to configure connection properties for the Planning store.

If you install multiple Planning Servers in your environment, you must set the connection properties for the planning store on each Planning Server computer.

The planning store can be on a Microsoft SQL Server, Oracle, or DB2 database.

Some database servers are available with advanced features. When you select an advanced database, IBM Cognos uses features of the database server to manage the connection. If you select the advanced Oracle database, for example, IBM Cognos uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

The default database for the content store is DB2.

If you are using a Microsoft SQL Server database, the version that you select in IBM Cognos Configuration defaults to Microsoft SQL Server 2005. If you are using SQL Server 2008, then you must select the correct version.

Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, right-click IBM Cognos Planning, and click New resource, Database.
3. In the Name box, type a name for the resource.
4. In the Type box, select the type of database and click OK.

Tip: If you want to use Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).
5. In the Properties window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the Database server with port number or instance name and Database name properties.
     In the Properties window, type the appropriate values for the mandatory and optional properties.
     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the Database server with port number or instance name property. Include the port number if you use nondefault ports. Include the instance name if there are multiple instances of Microsoft SQL Server.
     To connect to a named instance, you must specify the instance name. For example, you can type localhost\instance1. If no instance name property is specified, a connection to the default instance is created.
     Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example: jdbc:JSQLConnect://localhost\instance1/user=sa/more properties as required
   - If you use a DB2 database, for the Database name property, type the database alias.
• If you use an Oracle database, type the appropriate values for the **Database server and port number** and **Service name** properties.

• If you use an advanced Oracle database, for the **Database specifier** property, type the Oracle Net8 keyword-value pair for the connection.

   Here is an example:
   
   (description=(address=(host=myhost)(protocol=tcp)(port=1521)
   (connect_data=(sid=(oracle)))))

6. To set the user ID and password for the database
   
   • Click the **Value** box next to the **User ID and password** property and then click the edit button when it appears.
   
   • Type the appropriate values and click **OK**.

7. In the **Explorer** window, right-click the new database resource name and then click **Test**.

8. From the **File** menu, click **Save**.

   The logon credentials are immediately encrypted.

---

**Start the Planning Server**

After you have set the environment properties and database connection properties for the planning store, you can start the Planning Server computer.

Content Manager must be running before you start the Planning Server services.

**Procedure**

From the **Actions** menu, click **Start**.

It might take a few minutes for the IBM Cognos service and IBM Cognos Planning service to start.

This action starts all installed services that are not running. If you want to start a particular service, select the service node in the **Explorer** window and then click **Start** from the **Actions** menu.

---

**Install the Planning Job Server**

The planning job server runs job-based administrative tasks, such as publishing and reconciliation tasks. It also divides work among other available job servers.

Planning job servers implement a proprietary job-server clustering technique that allows you to allocate or distribute work to individual job servers. You can also distribute job-based work as appropriate for a group of applications and macros over a group of job servers belonging to a cluster. You can allocate a single cluster of job servers to monitor many applications to make most efficient use of all job server resources. Alternatively, you can dedicate a single job server or job server cluster to a specific application to ensure that resources are available.

In most cases, planning job servers should have only the dispatcher and the planning job services enabled. By having many planning job servers, you can distribute the work load. You should have more planning job servers than other role-based planning servers because job servers consume the most resources.
Procedure

1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.

2. Insert the IBM Cognos Planning Server CD or go to the installation source file directory.
   The Welcome page of the installation wizard appears when you insert the CD. If no Welcome page appears or you are not installing from the CD, go to the win32 directory, and double-click isetup.exe.

3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.

   If you are installing it in a directory that contains other IBM Cognos components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.
5. In the Finish page of the installation wizard, do the following:
   • If you want to configure Content Manager immediately, click **Start IBM Cognos Configuration**.
   • If you want to see late-breaking information about IBM Cognos components, click **View the Readme**.

6. Click **Finish**.

---

**Configure the Planning Job Server**

After you install the planning server, you must perform the following tasks using IBM Cognos configuration.

**Procedure**

1. Start IBM Cognos Configuration.
2. Configure properties for the Planning Server.
3. Set database connection properties for the planning store.
4. Start the Planning Server.

**Configure Properties for the Planning Job Server**

Use IBM Cognos Configuration to configure environment, and data access properties for your planning job server. The following tables provide configuration options for each group of properties.

To start IBM Cognos Configuration, click **All Programs** from the **Start** menu, then click **IBM Cognos**, and then click **IBM Cognos Configuration**.

**Tip:** Test after each configuring each property. To test a property, right-click on the property, and then click **Test**.

**Environment Group Properties**

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

**Table 19. IBM Cognos Configuration environment group properties for the Cognos Planning Job Server**

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway settings</td>
<td>Gateway URI</td>
<td>Enter the name of the gateway server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_3:80/ibmcognos/cgi-bin/cognos.cgi</td>
</tr>
<tr>
<td>Dispatcher settings</td>
<td>External dispatcher URI</td>
<td>Enter the name of the planning job server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_5:9300/p2pd/servlet/dispatch</td>
</tr>
</tbody>
</table>
Table 19. IBM Cognos Configuration environment group properties for the Cognos Planning Job Server (continued)

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internal dispatcher URI</td>
<td></td>
<td><a href="http://Enter">http://Enter</a> the name of the planning job server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_5:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td>Other URI Settings</td>
<td>Dispatcher URI for external applications</td>
<td>Enter the value of the IBM Cognos server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_2:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Content Manager URIs</td>
<td>Enter the value of the content manager server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_1:9300/p2pd/servlet</td>
</tr>
<tr>
<td>IBM Cognos Service Component Properties</td>
<td>Data movement service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Dispatcher service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Planning job service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>All other IBM Cognos services</td>
<td>False</td>
</tr>
<tr>
<td>IBM Cognos Configuration Resource Properties</td>
<td>Type</td>
<td>Leave the default, which is Small configuration.</td>
</tr>
<tr>
<td>Planning Component Properties</td>
<td>Analyst maximum workspace in KB</td>
<td>This value must be the same for every Planning server.</td>
</tr>
</tbody>
</table>

Data Access Group Properties

The following table provides the configuration values for the data access group properties in IBM Cognos Configuration.
Table 20. IBM Cognos Configuration data access group properties for Cognos Planning Job Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Store Database Resource Properties</td>
<td></td>
<td>You must delete the existing resource, and then create a new resource.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name the new resource Notification Store, and then select the database type.</td>
</tr>
<tr>
<td></td>
<td>Datasource server and port</td>
<td>Enter the name of the content store server.</td>
</tr>
<tr>
<td></td>
<td>number</td>
<td>For example, http://Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the content store database.</td>
</tr>
<tr>
<td>IBM Cognos Planning Component Properties</td>
<td></td>
<td>Create a new resource, called Planning Store, and then select the type of database.</td>
</tr>
<tr>
<td>For more information, see Set Database Connection Properties</td>
<td></td>
<td>Values for the new Planning Store follow.</td>
</tr>
<tr>
<td>for the Planning Store on page 96</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Planning store</td>
<td>Datasource server and port</td>
<td>Enter the name of the planning store server, and port number.</td>
</tr>
<tr>
<td></td>
<td>number</td>
<td>For example, Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the planning store database.</td>
</tr>
</tbody>
</table>

**Set Database Connection Properties for the Planning Store**

You must specify database connection information for the planning store. You can choose to use the same database for the planning store and the content store. You must create the database you will use for the planning store before you can connect to it.

**Note:** When you use a DB2 database for your content store you must configure, set, and test the content store before setting up the planning store.

It is mandatory to configure connection properties for the Planning store.
If you install multiple Planning Servers in your environment, you must set the connection properties for the planning store on each Planning Server computer.

The planning store can be on a Microsoft SQL Server, Oracle, or DB2 database.

Some database servers are available with advanced features. When you select an advanced database, IBM Cognos uses features of the database server to manage the connection. If you select the advanced Oracle database, for example, IBM Cognos uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

The default database for the content store is DB2.

If you are using a Microsoft SQL Server database, the version that you select in IBM Cognos Configuration defaults to Microsoft SQL Server 2005. If you are using SQL Server 2008, then you must select the correct version.

**Procedure**

1. Start **IBM Cognos Configuration**.
2. In the **Explorer** window, under **Data Access**, right-click **IBM Cognos Planning**, and click **New resource**, **Database**.
3. In the **Name** box, type a name for the resource.
4. In the **Type** box, select the type of database and click **OK**.

   **Tip:** If you want to use Oracle Net8 keyword-value pair to manage the database connection, select **Oracle database (Advanced)**.

5. In the **Properties** window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the **Database server with port number or instance name** and **Database name** properties.
     In the **Properties** window, type the appropriate values for the mandatory and optional properties.
     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the **Database server with port number or instance name** property. Include the port number if you use nondefault ports. Include the instance name if there are multiple instances of Microsoft SQL Server.
     To connect to a named instance, you must specify the instance name. For example, you can type `localhost\instance1`. If no instance name property is specified, a connection to the default instance is created.
     Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example:
     `jdbc:JSQLConnect://localhost\instance1/user=sa/more properties as required`
   - If you use a DB2 database, for the **Database name** property, type the database alias.
   - If you use an Oracle database, type the appropriate values for the **Database server and port number** and **Service name** properties.
   - If you use an advanced Oracle database, for the **Database specifier** property, type the Oracle Net8 keyword-value pair for the connection.
Here is an example:

(description=(address=(host=myhost)(protocol=tcp)(port=1521)
   (connect_data=(sid=(orcl)))))

6. To set the user ID and password for the database
   • Click the Value box next to the User ID and password property and then
     click the edit button when it appears.
   • Type the appropriate values and click OK.

7. In the Explorer window, right-click the new database resource name and then
   click Test.

8. From the File menu, click Save.
   The logon credentials are immediately encrypted.

---

### Start the Planning Server

After you have set the environment properties and database connection properties
for the planning store, you can start the Planning Server computer.

Content Manager must be running before you start the Planning Server services.

**Procedure**

From the Actions menu, click Start.
It might take a few minutes for the IBM Cognos service and IBM Cognos Planning
service to start.
This action starts all installed services that are not running. If you want to start a
particular service, select the service node in the Explorer window and then click
Start from the Actions menu.

---

### Install the Planning Data Server

Installing a planning data server is optional, and depends on your planning
requirements.

Planning data servers manage communications between IBM Cognos Business
Intelligence components, such as Report Studio and Analysis Studio, and
Contributor applications to provide real-time IBM Cognos reporting and analysis
activities.

**Procedure**

1. If you are installing to a directory with other IBM Cognos components, stop the
   IBM Cognos service.

2. Insert the IBM Cognos Planning Server CD or go to the installation source file
directory.
   The Welcome page of the installation wizard appears when you insert the CD.
   If no Welcome page appears or you are not installing from the CD, go to the
   win32 directory, and double-click isetup.exe.

3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. You
   can change the language to any of the installed languages after installation.

4. In the Component Selection page, select Planning Data Services.
If you are installing it in a directory that contains other IBM Cognos components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.

5. In the Finish page of the installation wizard, do the following:
   • If you want to configure Content Manager immediately, click Start IBM Cognos Configuration.
   • If you want to see late-breaking information about IBM Cognos components, click View the Readme.

6. Click Finish.

Configure the Planning Data Server

After you install the planning server, you must perform the following tasks using IBM Cognos configuration.

Procedure

1. Start IBM Cognos Configuration.
2. Configure properties for the Planning Server.
3. Set database connection properties for the planning store.
4. Start the Planning Server.

Configure Properties for the Planning Data Server

Use IBM Cognos Configuration to configure environment and data access properties for your planning data server. The following tables provide configuration options for each group of properties.

To start IBM Cognos Configuration, click All Programs from the Start menu, then click IBM Cognos, and then click IBM Cognos Configuration.

Tip: Test after each configuring each property. To test a property, right-click on the property, and then click Test.

Environment Group Properties

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

<table>
<thead>
<tr>
<th>Table 21. IBM Cognos Configuration environment group properties for IBM Cognos Planning Data Server</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configuration Option</strong></td>
</tr>
<tr>
<td>Gateway settings</td>
</tr>
</tbody>
</table>
Table 21. IBM Cognos Configuration environment group properties for IBM Cognos Planning Data Server (continued)

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dispatcher settings</td>
<td>External dispatcher URI</td>
<td>Enter the name of the planning data server. For example, http://server_plan_data:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Internal dispatcher URI</td>
<td><a href="http://Enter">http://Enter</a> the name of the planning data server. For example, http://server_plan_data:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td>Other URI Settings</td>
<td>Dispatcher URI for external applications</td>
<td>Enter the value of the IBM Cognos server. For example, http://Server_2:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Content Manager URIs</td>
<td>Enter the value of the content manager server. For example, http://Server_1:9300/p2pd/servlet</td>
</tr>
<tr>
<td>IBM Cognos Service Component Properties</td>
<td>Data movement service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Dispatcher service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Planning data service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>All other IBM Cognos services</td>
<td>False</td>
</tr>
<tr>
<td>IBM Cognos Configuration Resource Properties</td>
<td>Type</td>
<td>Leave the default, which is Small configuration.</td>
</tr>
<tr>
<td>Planning Component Properties</td>
<td>Analyst maximum workspace in KB</td>
<td>This value must be the same for every Planning server.</td>
</tr>
</tbody>
</table>
Data Access Group Properties

The following table provides the configuration values for the data access group properties in IBM Cognos Configuration.

Table 22. IBM Cognos Configuration data access group properties for IBM Cognos Planning Data Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Store Database Resource</td>
<td></td>
<td>You must delete the existing resource, and then create a new resource.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name the new resource Notification Store, and then select the database type.</td>
</tr>
<tr>
<td></td>
<td>Datasource server and port number</td>
<td>Enter the name of the content store server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the content store database.</td>
</tr>
<tr>
<td>IBM Cognos Planning Component Properties</td>
<td></td>
<td>Create a new resource, called Planning Store, and then select the type of database.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Values for the new Planning Store follow.</td>
</tr>
<tr>
<td>Planning store</td>
<td>Datasource server and port number</td>
<td>Enter the name of the planning store server, and port number.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the planning store database.</td>
</tr>
</tbody>
</table>

Set Database Connection Properties for the Planning Store

You must specify database connection information for the planning store. You can choose to use the same database for the planning store and the content store. You must create the database you will use for the planning store before you can connect to it.
Note: When you use a DB2 database for your content store you must configure, set, and test the content store before setting up the planning store.

It is mandatory to configure connection properties for the Planning store.

If you install multiple Planning Servers in your environment, you must set the connection properties for the planning store on each Planning Server computer.

The planning store can be on a Microsoft SQL Server, Oracle, or DB2 database.

Some database servers are available with advanced features. When you select an advanced database, IBM Cognos uses features of the database server to manage the connection. If you select the advanced Oracle database, for example, IBM Cognos uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

The default database for the content store is DB2.

If you are using a Microsoft SQL Server database, the version that you select in IBM Cognos Configuration defaults to Microsoft SQL Server 2005. If you are using SQL Server 2008, then you must select the correct version.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, right-click IBM Cognos Planning, and click New resource, Database.
3. In the Name box, type a name for the resource.
4. In the Type box, select the type of database and click OK.

Tip: If you want to use Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).

5. In the Properties window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the Database server with port number or instance name and Database name properties.
     In the Properties window, type the appropriate values for the mandatory and optional properties.
     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the Database server with port number or instance name property. Include the port number if you use nondefault ports. Include the instance name if there are multiple instances of Microsoft SQL Server.
     To connect to a named instance, you must specify the instance name. For example, you can type localhost\instance1. If no instance name property is specified, a connection to the default instance is created.
     Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example:
     jdbc:SQLConnect://localhost\instance1/user=sa/more properties as required
   - If you use a DB2 database, for the Database name property, type the database alias.
• If you use an Oracle database, type the appropriate values for the **Database server** and **port number** and **Service name** properties.

• If you use an advanced Oracle database, for the **Database specifier** property, type the Oracle Net8 keyword-value pair for the connection.

  Here is an example:

  (description=(address=(host=myhost)(protocol=tcp)(port=1521)
  (connect_data=(sid=(orcl)))))

6. To set the user ID and password for the database

   • Click the **Value** box next to the **User ID and password** property and then click the edit button when it appears.
   • Type the appropriate values and click **OK**.

7. In the **Explorer** window, right-click the new database resource name and then click **Test**.

8. From the **File** menu, click **Save**.

   The logon credentials are immediately encrypted.

**Start the Planning Server**

After you have set the environment properties and database connection properties for the planning store, you can start the Planning Server computer.

Content Manager must be running before you start the Planning Server services.

**Procedure**

From the **Actions** menu, click **Start**.

It might take a few minutes for the IBM Cognos service and IBM Cognos Planning service to start.

This action starts all installed services that are not running. If you want to start a particular service, select the service node in the **Explorer** window and then click **Start** from the **Actions** menu.
Chapter 9. Installing and Configuring in a Large Environment

Your installation of IBM Cognos Planning in a large environment distributes roles on separate servers to optimize performance and scalability. This type of installation is distributed across four tiers, as shown in this section. You can provide redundancy and failover measures in your environment by running multiple instances of the Content Manager, gateway, gateway dispatcher, and planning servers.

The following diagram shows the IBM Cognos Planning components, and the order in which they should be installed, configured and started. You must configure and start Content Manager before you can start a Planning Server.

Server names are provided to help you understand the configuration requirements for each planning component in a distributed environment. The server names, for example, Server_1, correspond to the examples used in the configuration tables for each planning component.

Tip: Map your servers to the servers and server names in this diagram before you begin installing and configuring your planning components.
For detailed information about the components, see “Architecture of a Large Environment” on page 114.

For detailed information about the roles of planning servers, see “Configure Role-based Planning Servers” on page 115.
Before you begin

- Install IBM Cognos components in a directory that contains only ASCII characters in the path name. Some UNIX and Linux Web servers do not support non-ASCII characters in directory names.
- The IBM Cognos Planning server components are intended to run in server environments and should not be installed on computers running Microsoft Windows Vista or Windows 7 operating systems.

About this task

The Planning Complete installation kit contains all the necessary components to install and run IBM Cognos Planning on one computer. To install Planning in distributed environments, use the following lists to determine which Cognos Planning installation kit to use to install specific Planning components.

Cognos Planning Server installation kit

The Cognos Planning Server kit helps you install specific Planning components in distributed environments. You can use it to install and configure the following components:
- Planning Job service
- Planning Web service
- Planning Administration Console service
- Planning Data service
- Analyst Universal Naming Convention (UNC) Connection

Cognos Planning Gateway installation kit

The Cognos Planning Gateway kit enables you to install the Planning-specific files on the same computer that has the BI gateway. The following components are installed automatically:
- Contributor rich client installer
- Contributor workflow page

Cognos Planning Administration Client installation kit

The Cognos Planning Administration Client installation kit enables you to install the following administration components:
- Analyst
- Planning Analyst Add-in for Microsoft Excel
- Planning Manager
- Planning Administrator (CAC)

Cognos Planning Client installation kit

The Cognos Planning Client installation kit enables you to install the following contributor components:
- Planning Contributor
- Contributor Add-in for Microsoft Excel

Using the component-specific installation kits, rather than the Cognos Planning Complete installation kit, allows you to install the minimum subset of files and configurable services that you need for that component and reduces the installation footprint required.

Note: You can only install the Content Manager component from the Cognos Planning Complete installation kit.
Procedure
1. Install and configure Content Manager.
2. Install and configure IBM Cognos server.
3. Install and configure the gateway dispatcher and create virtual directories.
4. Install and configure the Planning administration server.
5. Install and configure the Planning Web service server.
6. Install and configure the Planning job server.
7. Install the clients.

Results
After you complete these installation and configuration tasks, you can perform additional configuration tasks, and change the IBM Cognos Planning default behavior to better suit your environment. For more information, see Chapter 11, “Additional Configuration Options,” on page 181.

Architecture of a Large Environment
The four tiers, and planning components within them, that form the large-sized environment are described in this section.

Data Tier
The data tier includes the content store and planning store.

Before you install any of the tier components, you must set up your environment for IBM Cognos content data stores such as creating the content store and the planning store.

You set up database connectivity to the content store and planning store after installing the planning components on your servers. For more information, see Set Up Database Connectivity to the Content Store and Planning Store Database.

Application Tier
The application tier includes:
- Content Manager server(s)
- IBM Cognos server(s)
- Planning Administration server(s)
- Planning Web services server(s)
- Planning Job server(s)
- Planning Data server(s), which is an optional component.

Web Tier
The Web tier components includes:
- Gateway(s)
- Gateway dispatcher(s)
User Interface tier

The user interface tier includes the required Web-based and Microsoft Windows-based user interfaces for your end-users. For client installation and configuration information, see Chapter 10, “Installing the IBM Cognos Planning Clients,” on page 161.

Configure Role-based Planning Servers

You can configure each planning server to perform a specific role. You set roles by enabling and disabling services that are run by the dispatcher service.

The planning server roles are determined by the services running on that computer, which can include a planning job service, a planning data service, a planning administration service, and a planning Web service.

Each server must have the dispatcher service enabled and running. However, you can choose which Planning services you want running on each computer. There must also be at least one Planning Server running all non-Planning services, such as the data movement service, event management service, report service, and so on.

If some IBM Cognos services are not required in your environment, you can disable them to increase the performance of other services.

For example, if you are using a job server to only run planning jobs, that job server does not need to run reports. If you disable the report service, the performance of the job server is never impacted by running reports.

Prerequisites for Planning Services

Use the following as guidelines for enabling services on your planning servers.

- The presentation service must remain enabled on at least one computer in your IBM Cognos Planning environment.
- If you have IBM Cognos Business Intelligence installed and you want to use Query Studio, you must ensure that the presentation service is enabled on at least one server.
- If you have IBM Cognos Business Intelligence installed and you want to use Analysis Studio, you must enable the report service on at least one server.

Install Content Manager

Content Manager stores and manages IBM Cognos content, including user permissions. Content Manager must be configured, running, and accessible before you configure other computers in your IBM Cognos environment. This ensures that the certificate authority service, which is installed with Content Manager, is available to issue certificates to other IBM Cognos computers.
To provide a standby Content Manager server, you can install Content Manager on multiple servers.

**Note:** You can only have one active Content Manager server in your environment.

**Procedure**
1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.
2. Insert the IBM Cognos Planning Complete CD or go to the installation source file directory.
   The Welcome page of the installation wizard appears when you insert the CD. If no Welcome page appears or you are not installing from the CD, go to the win32 directory, and double-click isetup.exe.
3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.
4. In the Component Selection page, select Content Manager.
If you are installing it in a directory that contains other IBM Cognos components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.

5. In the Finish page of the installation wizard, do the following:
   - If you want to configure Content Manager immediately, click Start IBM Cognos Configuration.
   - If you want to see late-breaking information about IBM Cognos components, click View the Readme.

6. Click Finish.

Configure Content Manager

After you install Content Manager, you must set up database connectivity to the content store database.

Once connectivity is established, you perform the following tasks using IBM Cognos Configuration.

1. Configure properties for Content Manager
2. Enable security
3. Set database connection properties for the content store
4. Set database connection properties for the planning store
5. Start Content Manager
6. Use a Web browser to test Content Manager installation

Set Up Database Connectivity to the Content Store and Planning Store Database

For the planning store, you must ensure that the appropriate OLE DB or SQL Native Client (for SQL Server) drivers are installed on each computer where Content Manager or a Planning Server is installed. This allows you to set up database connectivity for the planning store database.

If you configure Microsoft SQL Server Windows Authentication for the planning store databases, you must take into account that the planning data service inherits its security from the dispatcher.

For the content store, you must ensure that the appropriate JDBC drivers are installed on every computer where Content Manager is installed.

After connectivity is set up, you can connect to the Content and Planning stores using IBM Cognos Configuration.

Set Up Database Connectivity for a DB2 Content Store

This procedure describes how to set up database connectivity for a DB2 content store. You must perform this procedure on each computer where you install Content Manager.

Procedure

1. If you are using a type 2 JDBC connection, install the DB2 client software on the Content Manager computers.
If you are using a type 4 JDBC connection for DB2, you are not required to install the DB2 client software where Content Manager is installed. If you use a DB2 database on z/OS for the content store, you must use a type 4 JDBC connection.

For more information about the differences between type 2 and type 4 drivers, see “JDBC Driver Options for Using DB2 Database as a Content Store” on page 57.

2. If you are using a type 2 JDBC connection, and the content store is on a different computer than Content Manager, configure a database alias to the content store.

On Microsoft Windows operating systems, run the DB2 Client Configuration Assistant.

**Note:** If the content store database and Content Manager are on the same computer, the content store name automatically becomes the alias.

When you configure the Content Manager computers, ensure that they are all configured to use the same content store.

3. On Windows, stop the DB2 services and the HTML Search Server.

4. Copy the following files from DB2_installation/sqlib/java directory to the c10_location/webapps/p2pd/WEB-INF/lib directory:
   - the universal driver file, db2jcc.jar
   - the license file for DB2 on Linux, UNIX, or Windows, db2jcc_license_cu.jar

   If you are connecting to DB2 on z/OS, use the driver version from Linux, UNIX, or Windows version 9.1 fix pack 5 or version 9.5 fix pack 2.

   **Tip:** To check the driver version, run the following command:
   
   ```
   java -cp path\db2jcc.jar com.ibm.db2.jcc.DB2Jcc -version
   ```

5. On Windows, restart the DB2 services and the HTML Search Server.

6. On UNIX, if you are using a type 2 JDBC connection, ensure that the 32-bit DB2 libraries are in the library search path, which is usually the $DB2DIR/lib directory or the $DB2DIR/lib32 directory.

7. Repeat this entire procedure on the IBM Cognos BI computers where Content Manager is installed or where notification is sent to a DB2 database.

**Set Up Database Connectivity for an Oracle Content Store**

This procedure describes how to set up database connectivity for an Oracle content store. You must perform this procedure on each computer where you install Content Manager.

**Procedure**

1. On the computer where the Oracle client is installed, go to the ORACLE_HOME/jdbc/lib directory.

2. Copy the correct library file for your version of the Oracle client to the c10_location/webapps/p2pd/WEB-INF/lib directory on the computer where Content Manager is installed and where notification is sent to an Oracle database.

   If you are using Oracle 10g, you must have ojdbc14.jar.

   If you are using Oracle 11g, you must have ojdbc5.jar.

   The files are available from an Oracle client or server install, and can also be downloaded from the Oracle technology Web site.
Configure Properties for Content Manager

Content Manager runs as a service in an IBM Cognos dispatcher. The dispatcher runs in a servlet container. By default the IBM Cognos dispatcher uses port number 9300 for communications. You can change this port number.

If you configured IBM Cognos with standby Content Manager computers and you use the default CGI gateway, you must now configure IBM Cognos to use an ISAPI gateway.

Content Manager creates security keys that allow only authorized servers to communicate with it. If you are installing server components on different computers, you must ensure that you set the same password for the **Certificate Authority settings** in IBM Cognos Configuration.

Use IBM Cognos Configuration to configure environment, security, and data access properties for Content Manager. The following tables provide configuration options for each group of properties.

To start IBM Cognos Configuration, click **All Programs** from the **Start** menu, then click **IBM Cognos**, and then click **IBM Cognos Configuration**.

**Tip:** Test after each configuring each property group. To test a property, right-click on the property, and then click **Test**.

Environment Group Properties

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

Table 23. IBM Cognos Configuration environment group properties for Content Manager

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dispatcher settings</td>
<td>External dispatcher URI</td>
<td>Enter the name of the Content Manager server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_1:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Internal dispatcher URI</td>
<td>Enter the name of the Content Manager server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_1:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td>Other URI Settings</td>
<td>Dispatcher URI for external applications</td>
<td>Enter the name(s) of the Content Manager server(s).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_1:9300/p2pd/servlet/dispatch</td>
</tr>
</tbody>
</table>
Table 23. IBM Cognos Configuration environment group properties for Content Manager (continued)

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Content Manager URIs</td>
<td>Enter the name of the Content Manager server. For example, http://Server_1:9300/p2pd/servlet To add multiple URIs, see Adding Stand-By Content Manager servers</td>
</tr>
<tr>
<td>IBM Cognos Service Component Properties</td>
<td>Content Manager enabled?</td>
<td>True</td>
</tr>
<tr>
<td>Dispatcher service enabled?</td>
<td>True</td>
<td></td>
</tr>
<tr>
<td>All other IBM Cognos services</td>
<td>False</td>
<td></td>
</tr>
<tr>
<td>IBM Cognos</td>
<td>Delete the existing IBM Cognos resource, and then create a new resource. Name the new resource IBM Cognos, and then enter a Maximum memory in MB value for a large environment.</td>
<td></td>
</tr>
</tbody>
</table>

Security Group Properties

For detailed information about enabling security, see “Enable Security” on page 122.

The following table provides the configuration values for the security group properties in IBM Cognos configuration.

Table 24. IBM Cognos Configuration security group properties for Content Manager

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication component Properties</td>
<td>Allow session information to be shared between client applications?</td>
<td>True</td>
</tr>
</tbody>
</table>

Data Access Group Properties

The following table provides the configuration values for the data access group properties in IBM Cognos configuration.
### Table 25. IBM Cognos Configuration data access group properties for Content Manager

<table>
<thead>
<tr>
<th>Property</th>
<th>Name</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Content Manager Component Properties</strong></td>
<td></td>
<td>Create a new resource called Content Store, and then select the type of database that you are using for the Content Store. Values for the new Content Store follow.</td>
</tr>
<tr>
<td>Content Store Database Resource Properties</td>
<td>Datasource server and port number</td>
<td>Enter the name of the content store server. For example, http://Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the content store database.</td>
</tr>
<tr>
<td><strong>IBM Cognos Planning Component Properties</strong></td>
<td></td>
<td>Create a new resource called Planning store, and then select the type of database that you are using for the Planning Store. Values for the new Planning store follow.</td>
</tr>
<tr>
<td>Planning store</td>
<td>Datasource server and port number</td>
<td>Enter the name of the planning store server, and the port number. For example, Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the planning store database. <strong>Note:</strong> The database must already exist.</td>
</tr>
</tbody>
</table>

### Adding Standby Content Manager servers

You can provide a standby Content Manager server by adding multiple URIs. The first Content Manager server that starts becomes the active Content Manager server, and the other servers become the standby Content Manager servers.

**Note:** You can only have one active Content Manager server in your environment.
Procedure
1. In the IBM Cognos Configuration Explorer window, click Environment.
2. In the Properties window, click the value for Content Manager URIs and then click the edit button.
3. Specify the URIs for the other Content Manager computers:
   • In the Value - Content Manager URIs dialog box, click Add.
   • In the blank row of the table, click and then type the full URI of the Content Manager computer.
     Do not delete the first value in the table. This value identifies the local Content Manager computer and is required.
   • Repeat the previous two bulleted steps for each URI to be added.

   **Important:** You must include all Content Manager URIs in the list.
   • Click OK.
4. From the File menu, click Save.

Enable Security
IBM Cognos Planning requires that users log in. This ensures that users only see parts of budgets or plans for which they are responsible.

By default, IBM Cognos Planning allows anonymous access to the Web portal. You must disable anonymous access and configure IBM Cognos Planning to use an authentication provider before users can access any of the client applications or the portal.

Procedure
1. In the IBM Cognos Configuration Explorer window, click Security > Authentication > Cognos.
2. Click the Value box for Allow Anonymous Access, and select False.
4. In the Name box, type a name for your authentication namespace.
5. In the Type list, click the appropriate namespace type and then click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
6. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
   For more information about configuring IBM Cognos BI to use an authentication provider, see Chapter 13, “Configuring IBM Cognos Components to Use an Authentication Provider,” on page 219.
7. From the File menu, click Save.

Setting Database Connection Properties for the Content Store
You use IBM Cognos Configuration to specify the database server information. This ensures that Content Manager can connect to the database that you are using for the content store. Content Manager uses the database logon to access the content store. After you set the database connection properties, you can test the connection between Content Manager and the content store.

Ensure that you used one of the supported database servers to create the content store.
Some database servers are available with advanced features. When you select an advanced database option, IBM Cognos uses features of the database server to manage the connection.

For example, if you select the advanced Oracle database, IBM Cognos uses enterprise-oriented Oracle features to
- select a listener
- switch to another listener if the first listener fails
- automatically reconnect to the database if the connection fails
- balance connection requests among listeners
- and balance connection requests among dispatchers.

IBM Cognos requires the TCP/IP protocol to access data and the content store. Ensure that the database server has the protocol set to TCP/IP.

Using a DB2 database for the content store

The default database for the content store is DB2.

When you use a DB2 database for your content store you must configure, set, and test the content store before setting up the planning store.

Setting Database Connection Properties for a DB2 Content Store on Linux, UNIX or Microsoft Windows Operating Systems

You must specify the database server information to ensure that Content Manager can connect to the database you use for a DB2 content store.

Procedure

1. In the location where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, Content Manager, click Content Store.
3. In the Properties window, for the Database name property, type the name of the database or the database alias.
4. Change the logon credentials to specify a valid user ID and password:
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   - Type the appropriate values and click OK.
5. To use a type 4 JDBC connection, for the Database server and port number property, type a value, using host:port syntax.
   If you leave this property blank, a type 2 JDBC connection is used.
   For more information about the differences between the driver types, see “JDBC Driver Options for Using DB2 Database as a Content Store” on page 57.
6. From the File menu, click Save.
   The logon credentials are immediately encrypted.
7. To test the connection between Content Manager and the content store database, from the Actions menu, click Test.
   Content Manager connects to the database, checks the database permissions, and creates and populates a table. The table is not deleted and is used each time that the test is repeated.
Setting Database Connection Properties for a Microsoft SQL Server, Oracle, Informix, or Sybase Content Store

You must specify the database server information to ensure that Content Manager can connect to the database you use for the content store.

Procedure

1. On the computer where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, Content Manager, right-click Content Store and click Delete.
   This deletes the connection to the default resource. Content Manager can access only one content store.
3. Right-click Content Manager, and then click New resource, Database.
4. In the Name box, type a name for the resource.
5. In the Type box, select the type of database and click OK.

   Tip: If you want to use an Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).

6. In the Properties window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the Database server with port number or instance name and Database name properties.
     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the Database server with port number or instance name property.
     For the Database server with port number or instance name property, include the instance name if there are multiple instances of Microsoft SQL Server.
     To connect to a named instance, you must specify the instance name. For example, you can type localhost\instance1. If an instance name is not specified, a connection to the default instance is created.
   - If you use an Oracle database, type the appropriate values for the Database server and port number and Service name properties.
   - If you use an advanced Oracle database, for the Database specifier property, type the Oracle Net8 keyword-value pair for the connection.
     Here is an example:
     (description=(address=(host=myhost)(protocol=tcp)(port=1521)
     (connect_data=(sid=(orcl))))))
     When you select the advanced Oracle database, IBM Cognos BI uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.
   - If you use an Informix database, type the appropriate values for the Database server and port number and Database name properties.
   - If you use a Sybase database, type the appropriate values for the Database server and port number and Database name properties.
7. To configure logon credentials, specify a user ID and password:
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   - Type the appropriate values and click OK.
8. If you host more than one content store database on an Informix instance, create the advanced property CMSCRIPT_CS_ID and specify the account under which the instance runs:

- In the Explorer window, click Local Configuration.
- In the Properties window, click the Value column for Advanced properties and then click the edit button.
- In the Value - Advanced properties dialog box, click Add.
- In the Name column, type CMSCRIPT_CS_ID
- In the Value column, type the user ID of the account under which the instance of the content store runs.
  Use a different user account for each instance of Informix content store database.

9. From the File menu, click Save.
The logon credentials are immediately encrypted.

10. To test the connection between Content Manager and the content store database, from the Actions menu, click Test.
Content Manager connects to the database, checks the database permissions, and creates and populates a table. The table is not deleted and is used each time that the test is repeated.

Results

Content Manager can now create the required tables in the content store when you start the IBM Cognos service for the first time. If the connection properties are not specified correctly, you cannot start the IBM Cognos services.

Set Database Connection Properties for the Planning Store

You must specify database connection information for the planning store. You can choose to use the same database for the planning store and the content store. You must create the database you will use for the planning store before you can connect to it.

Note: When you use a DB2 database for your content store you must configure, set, and test the content store before setting up the planning store.

It is mandatory to configure connection properties for the Planning store.

If you install multiple Planning Servers in your environment, you must set the connection properties for the planning store on each Planning Server computer.

The planning store can be on a Microsoft SQL Server, Oracle, or DB2 database.

Some database servers are available with advanced features. When you select an advanced database, IBM Cognos uses features of the database server to manage the connection. If you select the advanced Oracle database, for example, IBM Cognos uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

The default database for the content store is DB2.
If you are using a Microsoft SQL Server database, the version that you select in IBM Cognos Configuration defaults to Microsoft SQL Server 2005. If you are using SQL Server 2008, then you must select the correct version.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, right-click IBM Cognos Planning, and click New resource, Database.
3. In the Name box, type a name for the resource.
4. In the Type box, select the type of database and click OK.

**Tip:** If you want to use Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).

5. In the Properties window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the Database server with port number or instance name and Database name properties.
   
   In the Properties window, type the appropriate values for the mandatory and optional properties.
   
   For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the Database server with port number or instance name property. Include the port number if you use nondefault ports. Include the instance name if there are multiple instances of Microsoft SQL Server.
   
   To connect to a named instance, you must specify the instance name. For example, you can type localhost\instance1. If no instance name property is specified, a connection to the default instance is created.
   
   Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example:
   
   jdbc:JSQLConnect://localhost\instance1/user=sa/more properties as required
   
   - If you use a DB2 database, for the Database name property, type the database alias.
   
   - If you use an Oracle database, type the appropriate values for the Database server and port number and Service name properties.
   
   - If you use an advanced Oracle database, for the Database specifier property, type the Oracle Net8 keyword-value pair for the connection.
   
   Here is an example:
   
   (description=(address=(host=myhost)(protocol=tcp)(port=1521) (connect_data=(sid=(orcl))))
   
   6. To set the user ID and password for the database
   
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   
   - Type the appropriate values and click OK.
   
   7. In the Explorer window, right-click the new database resource name and then click Test.
   
   8. From the File menu, click Save.

   The logon credentials are immediately encrypted.
Start Content Manager

After you have set the database connection properties for the content store, you can start the Content Manager computer.

Procedure

From the Actions menu, click Start. It might take a few minutes for the IBM Cognos service to start. This action starts all installed services that are not running. If you want to start a particular service, select the service node in the Explorer window and then click Start from the Actions menu.

Test the Content Manager Installation and Configuration

Procedure

1. Open a Web browser.
2. Test that Content Manager is running by typing the Content Manager URIs value from IBM Cognos Connection. For example,
   
   http://hostname:port_number/p2pd/servlet
   
   The State value should be Running.

Install IBM Cognos Server

A working planning environment requires IBM Cognos services. You can obtain a Planning environment with IBM Cognos services in one of the following ways:

- Installing a planning server.
- Installing IBM Cognos Business Intelligence (BI), which provides a Planning and Business Intelligence environment.

The following instructions assume that you are using a planning server installation. For more information, see “Installing IBM Cognos Planning with IBM Cognos Business Intelligence” on page 19.

To install and configure the IBM BI Cognos Server, see the IBM Cognos Business Intelligence Installation and Configuration Guide.
Procedure

1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.
2. Insert the IBM Cognos Planning Server CD or go to the installation source file directory.
   The Welcome page of the installation wizard appears when you insert the CD.
   If no Welcome page appears or you are not installing from the CD, go to the win32 directory, and double-click isetup.exe.
3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.
4. In the Component Selection page, select Planning Server.
   If you are installing it in a directory that contains other IBM Cognos components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.
5. In the Finish page of the installation wizard, do the following:
   - If you want to configure Content Manager immediately, click Start IBM Cognos Configuration.
Configure IBM Cognos Server

After you install IBM Cognos server, you must complete configuration tasks using IBM Cognos Configuration.

Configure Properties for IBM Cognos Server

Use IBM Cognos Configuration to configure environment and data access properties for your IBM Cognos server. The following tables provide configuration options for each group of properties.

To start IBM Cognos Configuration, click All Programs from the Start menu, then click IBM Cognos, and then click IBM Cognos Configuration.

Tip: Test after each configuring each property group. To test a property, right-click on the property, and then click Test.

Environment Group Properties

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

Table 26. IBM Cognos Configuration environment group properties for IBM Cognos Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway Settings</td>
<td>Gateway URI</td>
<td>Enter the name of the gateway server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_3:80/ibmcognos/cgi-bin/cognos.cgi</td>
</tr>
<tr>
<td>Dispatcher Settings</td>
<td>External dispatcher URI</td>
<td>Enter the name of the IBM Cognos server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_2:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td>Other URI Settings</td>
<td>Dispatcher URI for external</td>
<td>Enter the name of the IBM Cognos server.</td>
</tr>
<tr>
<td></td>
<td>applications</td>
<td>For example, http://Server_2:9300/p2pd/servlet/dispatch</td>
</tr>
</tbody>
</table>
Table 26. IBM Cognos Configuration environment group properties for IBM Cognos Server (continued)

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Content Manager URIs</td>
<td>Enter the name of the content manager server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_1:9300/p2pd/servlet</td>
</tr>
<tr>
<td></td>
<td>IBM Cognos Service Component Properties</td>
<td>All Planning services</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All other services</td>
</tr>
<tr>
<td></td>
<td>IBM Cognos</td>
<td>Delete the existing IBM Cognos resource, and then create a new resource.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name the new resource IBM Cognos, and then enter a Maximum memory in MB value for a large environment.</td>
</tr>
<tr>
<td></td>
<td>Planning Component Properties</td>
<td>Analyst maximum workspace in KB</td>
</tr>
</tbody>
</table>

**Data Access Group Properties**

The following table provides the configuration values for the data access group properties in IBM Cognos Configuration.

Table 27. IBM Cognos Configuration data access group properties for IBM Cognos Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Store Database Resource Properties</td>
<td></td>
<td>Delete the existing resource, and then create a new resource.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Name the new resource Notification Store, and then select the database type.</td>
</tr>
<tr>
<td></td>
<td>Datasource server and port number</td>
<td>Enter the name of the content store server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
</tbody>
</table>
Table 27. IBM Cognos Configuration data access group properties for IBM Cognos Server (continued)

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the content store database.</td>
</tr>
</tbody>
</table>

**Start IBM Cognos Server**

After you configure properties, you can start the IBM Cognos server computer.

**Procedure**

From the Actions menu, click **Start**.

It might take a few minutes for the IBM Cognos service to start.

This action starts all installed services that are not running. If you want to start a particular service, select the service node in the **Explorer** window and then click **Start** from the Actions menu.

**Install the Gateway**

You must install the IBM Cognos Planning gateway on a web server computer. You can install the gateway on one or more computers, depending on your environment. If you plan to install multiple gateways, then you also need to implement hardware or software load balancing.
If you plan to install Planning in a mixed environment with IBM Cognos BI, then you must install the Planning gateway on the same computer as the BI gateway.

**Installing the gateway components on Windows operating systems**

**Procedure**

1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.
2. Insert the IBM Cognos Planning Gateway CD or go to the installation source file directory.
3. Follow the directions in the installation wizard to copy the required files to your computer.
   
   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.
4. In the Finish page of the installation wizard,
   
   - If you want to configure Content Manager immediately, click Start IBM Cognos Configuration.
Configure the Gateway

After you install the IBM Cognos Planning Gateway, you must complete configuration tasks using IBM Cognos Configuration.

Configure Properties for the Gateway

The gateway computer must know the location of at least one IBM Cognos Planning Server dispatcher in your environment. The load management of Planning Server dispatchers is controlled by the Content Manager, which knows the location of all Planning Server dispatchers. Additional gateway dispatchers that you configure on the gateway computer are used for failover purposes. If you are using multiple dispatchers then they must be listed for each gateway.

Use IBM Cognos Configuration to configure environment properties for your gateway server. The following table provides configuration options for these properties.

To start IBM Cognos Configuration, click All Programs from the Start menu, then click IBM Cognos, and then click IBM Cognos Configuration.

Tip: Test after each configuring each property group. To test a property, right-click on the property, and then click Test.

Environment Group Properties

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway settings</td>
<td>Dispatcher URIs for gateway</td>
<td>Enter the name of the gateway server. For example http://Server_3:9300/p2pd/servlet/dispatch/ext</td>
</tr>
</tbody>
</table>

Configure a Web server

For all installations, before you use Web pages generated by IBM Cognos, you must configure your Web server.

Procedure

Create the following virtual directories using the information in the following table:

<table>
<thead>
<tr>
<th>Alias</th>
<th>Location</th>
<th>Permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>ibmcognos</td>
<td>c10_location/webcontent</td>
<td>Read</td>
</tr>
<tr>
<td>ibmcognos/cgi-bin</td>
<td>c10_location/cgi-bin</td>
<td>Execute</td>
</tr>
</tbody>
</table>

Note: The cogrcp folder, located in c10_location/planning/contributor must have **Scripts only** execute permissions.
You can use a name other than ibmcognos in the aliases. However, you must use cgi-bin as the second part of the alias. If you use an alias other than ibmcognos you must change the virtual directory in the Gateway URI property to match your alias.
For Apache Web Server, ensure that you define the ibmcognos/cgi-bin alias before the ibmcognos alias in the httpd.conf file located in the Apache_installation/conf directory. You must define the ibmcognos/cgi-bin alias as a ScriptAlias.

**Start the Gateway**

After you have configured the environment group properties, you can start the gateway computer.

**Procedure**

From the Actions menu, click Start.  
It might take a few minutes for the IBM Cognos service to start.  
This action starts all installed services that are not running. If you want to start a particular service, select the service node in the Explorer window and then click Start from the Actions menu.

**Test the Gateway Configuration**

You can test the installation using a web browser.

**Procedure**

1. Ensure that your web server is running.
2. Open a web browser.
3. In your address box, type the URI for the gateway. For example  
   http://hostname:port/ibmcognos  
   The IBM Cognos Connection Welcome page appears.

**Install and configure the Gateway dispatcher**

You must install the gateway dispatcher on a Web server computer. The role of the dispatcher is to distribute the work load and provide scalability. Additional dispatchers that you configure on the gateway computer are used for failover purposes.
You can install either a BI gateway dispatcher or an IBM Cognos Planning dispatcher.

The tasks for installing and configuring the gateway dispatcher are similar to installing the gateway. The only difference is that you need to configure the gateway settings in IBM Cognos Configuration to point to the location where your gateway dispatcher is installed.

**Procedure**

1. **Install the gateway dispatcher.** For more information, see “Install the Gateway” on page 131.

2. **Configure the gateway dispatcher.** For more information, see Configure the gateway dispatcher.

3. **Configure your Web server.** For more information, see “Configure Properties for the Gateway” on page 133.
4. Start the gateway dispatcher server. For more information, see “Start the Gateway” on page 134.

5. Use a Web browser to test the gateway dispatcher configuration. For more information, see “Test the Gateway Configuration” on page 134.

Configure Properties for the Gateway dispatcher

The gateway computer must know the location of at least one IBM Cognos Planning Server dispatcher in your environment. The load management of Planning Server dispatchers is controlled by the Content Manager, which knows the location of all Planning Server dispatchers.

All gateways that you install must point to your dispatcher. Additional dispatchers that you configure on the gateway computer are used for failover purposes. Ensure that if you use multiple dispatchers they are listed for each gateway.

Use IBM Cognos configuration to configure environment group properties for your gateway dispatcher server. The following table provides these properties.

Tip: Test after each configuring each property group. To test a property, right-click on the property, and then click Test.

Environment Group Properties

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway settings</td>
<td>Dispatcher URIs for gateway</td>
<td>Enter the name of the gateway dispatcher server. For example http://Server_4:9300/p2pd/servlet/dispatch/ext</td>
</tr>
<tr>
<td>IBM Cognos Service Component Properties</td>
<td>Dispatcher service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>All other services</td>
<td>False</td>
</tr>
</tbody>
</table>

Planning Servers

IBM Cognos Planning Servers run job-based administration tasks, such as publishing and reconciliation tasks. They also manage communications with IBM Cognos Planning clients and IBM Cognos Business Intelligence components. For a large environment, you can choose to install multiple Administration, Web services, Data, and Job servers. Each additional Planning server that you add to your environment is installed and configured according to the instructions that follow for each type of server.

To improve scalability in an environment that serves many users, you can install the Planning Server component on multiple computers dedicated to processing
incoming requests. This strategy distributes and balances loads among the computers, and provides better accessibility, throughput, and failover support than installing on a single computer.

After you install the Planning Servers, you can configure specific roles for each server. For more information, see "Configure Role-based Planning Servers" on page 73.

Ensure that you have administrator privileges for the Microsoft Windows computer on which you are installing. Also ensure that your computer has a TEMP system variable that points to the directory where you want to store temporary files. During installation, files from the CD are temporarily copied to this directory.

Create an Analyst Network Share

A network connection point is the location where you set up a network share. For distributed IBM Cognos Planning Analyst installations, you should always install a network connection point so that both Analyst server and Analyst clients use a Universal Naming Convention (UNC) path to connect to a shared library.

When you create a network connection point, the Analyst software is installed on the local drive of your computer, and the data is stored in a shared location on the network server, along with control files and the samples files.

One of the files created at the network installation point is filesys.ini. The filesys.ini file is a control file used by Analyst. It contains file paths for the Libs.tab, Users.tab, and Groups.tab that control the specific library and user setup. If you do not specify the filesys.ini path by creating a network connection point, you must specify the path when you create planning tables. For more information, see the IBM Cognos Planning Contributor Administration Guide or the IBM Cognos Planning Analyst User Guide.

You must set up a network share so that server and client computers can access the installation files. Ensure that all Analyst users have NTFS permissions of Modify.

Note: You only need to install the Analyst UNC connection point once, regardless of how many planning servers you install.

Install the Planning Administration Server

IBM Cognos Planning administration servers manage communications with Contributor Administration and perform other administrative tasks.

Contributor Administration users connect to the Planning administration server through the gateway.

You can install multiple Planning Administration servers in your environment.

Note: If your environment has multiple Planning Administration servers then you cannot use the copy or load feature to import IBM Cognos Planning Contributor data. Instead, you can load data into Import Tables (im_cubename) prior to running a Prepare Import job. For more information about importing data, see the IBM Cognos Contributor Administration Guide.
**Procedure**

1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.

2. Insert the IBM Cognos Planning Server CD or go to the installation source file directory.
   
   The **Welcome** page of the installation wizard appears when you insert the CD.
   
   If no **Welcome** page appears or you are not installing from the CD, go to the `win32` directory, and double-click `isetup.exe`.

3. Select the language to use for the installation.
   
   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.

4. In the **Component Selection** page, click **Planning Server, Application Tier**, then select the following components:
   
   - **Planning Web service**
   - **Planning Administration Console service**
   - **Analyst UNC Connection Point**

---

*Indicates that you can install multiple instances of this server*

---

**Figure 29. Cognos Planning Administration Server installation in a large-sized environment**
If you are installing it in a directory that contains other IBM Cognos components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.

5. In the Analyst UNC Install Location page, type the UNC path for the shared directory to which you want the network installation point installed.

Note: You only need to install the Analyst UNC connection point once, regardless of how many planning servers you install.

6. In the Finish page of the installation wizard, do the following
   • If you want to configure Content Manager immediately, click Start IBM Cognos Configuration.

7. Click Finish.

Configure the Administration Server

After you install the planning server, you must complete configuration tasks using IBM Cognos Configuration.

Configure Properties for the Administration Server

Use IBM Cognos Configuration to configure environment, and data access properties for your planning administration server. The following tables provide configuration options for each group of properties.

To start IBM Cognos Configuration, click All Programs from the Start menu, then click IBM Cognos, and then click IBM Cognos Configuration.

Tip: Test after each configuring each property group. To test a property, right-click on the property, and then click Test.

Environment Group Properties

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

Table 31. IBM Cognos Configuration environment group properties for the IBM Cognos Planning Administration Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway settings</td>
<td>Gateway URI</td>
<td>Enter the name of the gateway server. For example, http://Server_3:80/ibmcognos/cgi-bin/cognos.cgi</td>
</tr>
<tr>
<td>Dispatcher settings</td>
<td>External dispatcher URI</td>
<td>Enter the name of the planning administration server. For example, http://Server_5:9300/p2pd/servlet/dispatch</td>
</tr>
</tbody>
</table>
Table 31. IBM Cognos Configuration environment group properties for the IBM Cognos Planning Administration Server (continued)

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Internal dispatcher URI</td>
<td>Enter the name of the planning administration server. For example, http://server_5:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td>Other URI Settings</td>
<td>Dispatcher URI for external applications</td>
<td>Enter the value of the IBM Cognos server. For example, http://Server_2:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Content Manager URIs</td>
<td>Enter the value of the content manager server. For example, http://Server_1:9300/p2pd/servlet</td>
</tr>
<tr>
<td>IBM Cognos Service Component Properties</td>
<td>Agent service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Monitor service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Planning administration console service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>All other IBM Cognos services</td>
<td>False</td>
</tr>
<tr>
<td>IBM Cognos Configuration Resource Properties</td>
<td>Type</td>
<td>Leave the default, which is Small configuration.</td>
</tr>
<tr>
<td>Planning Component Properties</td>
<td>IBM Cognos Planning Analyst maximum workspace in KB</td>
<td>Enter a value that is consistent for each Planning server.</td>
</tr>
</tbody>
</table>

**Data Access Group Properties**

The following table provides the configuration values for the data access group properties in IBM Cognos Configuration.
Table 32. IBM Cognos Configuration data access group properties for the IBM Cognos Planning Administration Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Cognos Planning Component Properties</td>
<td></td>
<td>Create a new resource, called Planning Store, and then select the type of database.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Values for the new Planning Store follow.</td>
</tr>
<tr>
<td>Planning store</td>
<td>Datasource server and port number</td>
<td>Enter the name of the planning store server, and port number.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the planning store database.</td>
</tr>
</tbody>
</table>

**Set Database Connection Properties for the Planning Store**

You must specify database connection information for the planning store. You can choose to use the same database for the planning store and the content store. You must create the database you will use for the planning store before you can connect to it.

**Note:** When you use a DB2 database for your content store you must configure, set, and test the content store before setting up the planning store.

It is mandatory to configure connection properties for the Planning store.

If you install multiple Planning Servers in your environment, you must set the connection properties for the planning store on each Planning Server computer.

The planning store can be on a Microsoft SQL Server, Oracle, or DB2 database.

Some database servers are available with advanced features. When you select an advanced database, IBM Cognos uses features of the database server to manage the connection. If you select the advanced Oracle database, for example, IBM Cognos uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

The default database for the content store is DB2.

If you are using a Microsoft SQL Server database, the version that you select in IBM Cognos Configuration defaults to Microsoft SQL Server 2005. If you are using SQL Server 2008, then you must select the correct version.
Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, right-click IBM Cognos Planning, and click New resource, Database.
3. In the Name box, type a name for the resource.
4. In the Type box, select the type of database and click OK.

Tip: If you want to use Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).

5. In the Properties window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the Database server with port number or instance name and Database name properties.
     In the Properties window, type the appropriate values for the mandatory and optional properties.
     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the Database server with port number or instance name property. Include the port number if you use nondefault ports. Include the instance name if there are multiple instances of Microsoft SQL Server.
     To connect to a named instance, you must specify the instance name. For example, you can type localhost\instance1. If no instance name property is specified, a connection to the default instance is created.
     Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example:
     jdbc:JSQLConnect://localhost\instance1/user=sa/more properties as required
   - If you use a DB2 database, for the Database name property, type the database alias.
   - If you use an Oracle database, type the appropriate values for the Database server and port number and Service name properties.
   - If you use an advanced Oracle database, for the Database specifier property, type the Oracle Net8 keyword-value pair for the connection.
     Here is an example:
     (description=(address=(host=myhost)(protocol=tcp)(port=1521)
     (connect_data=(sid=(orcl)))))
6. To set the user ID and password for the database
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   - Type the appropriate values and click OK.
7. In the Explorer window, right-click the new database resource name and then click Test.
8. From the File menu, click Save.
   The logon credentials are immediately encrypted.
Start the Planning Server

Procedure

From the Actions menu, click Start.
It might take a few minutes for the IBM Cognos service and IBM Cognos Planning service to start.
This action starts all installed services that are not running. If you want to start a particular service, select the service node in the Explorer window and then click Start from the Actions menu.

Install the Web Services Server


The gateway manages client connectivity in the Web tier, and the planning web service manages client connectivity in the application tier. Clients communicate directly with the gateway, and with the planning web server through the dispatcher. The planning web server communicates with the planning store and sends data back to the clients through the gateway.
Procedure

1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.
2. Insert the IBM Cognos Planning Server CD or go to the installation source file directory.
   The Welcome page of the installation wizard appears when you insert the CD.
   If no Welcome page appears or you are not installing from the CD, go to the win32 directory, and double-click issetup.exe.
3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.
4. In the Component Selection page, click Planning Server, Application Tier, then select the following components:
   - Planning Web service
   - Planning Administration Console service
• **Analyst UNC Connection Point**

If you are installing it in a directory that contains other IBM Cognos components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.

5. In the **Analyst UNC Install Location** page, type the UNC path for the shared directory to which you want the network installation point installed.

**Note:** You only need to install the Analyst UNC connection point once, regardless of how many planning servers you install.

6. In the **Finish** page of the installation wizard, do the following

   • If you want to configure Content Manager immediately, click **Start IBM Cognos Configuration**.

7. Click **Finish**.

**Configure the Web Services Server**

After you install the planning server, you must complete configuration tasks using IBM Cognos Configuration.

**Configure Properties for the Web Services Server**

Use IBM Cognos Configuration to configure environment, and data access properties for your Web services server. The following tables provide configuration options for each group of properties.

To start IBM Cognos Configuration, click **All Programs** from the **Start** menu, then click **IBM Cognos**, and then click **IBM Cognos Configuration**.

**Tip:** Test after each configuring each property group. To test a property, right-click on the property, and then click **Test**.

**Environment Group Properties**

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

*Table 33. IBM Cognos Configuration environment group properties for Planning Web Services Server*

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway settings</td>
<td>Gateway URI</td>
<td>Enter the name of the gateway server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_3:80/ibmcognos/cgi-bin/cognos.cgi</td>
</tr>
<tr>
<td>Dispatcher settings</td>
<td>External dispatcher URI</td>
<td>Enter the name of the planning Web services server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_6:9300/p2pd/servlet/dispatch</td>
</tr>
</tbody>
</table>
Table 33. IBM Cognos Configuration environment group properties for Planning Web Services Server (continued)

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Internal dispatcher URI</td>
<td>Enter the name of the planning Web services server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_6:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td>Other URI Settings</td>
<td>Dispatcher URI for external applications</td>
<td>Enter the value of the IBM Cognos server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_2:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Content Manager URIs</td>
<td>Enter the value of the content manager server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_1:9300/p2pd/servlet</td>
</tr>
<tr>
<td><strong>IBM Cognos Service Component Properties</strong></td>
<td>Dispatcher service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Planning Web service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>All other IBM Cognos services</td>
<td>False</td>
</tr>
<tr>
<td><strong>IBM Cognos Configuration Resource Properties</strong></td>
<td>Type</td>
<td>Leave the default, which is Small configuration.</td>
</tr>
<tr>
<td><strong>Planning Component Properties</strong></td>
<td>IBM Cognos Planning Analyst maximum workspace in KB</td>
<td>Enter a value that is consistent for each Planning server.</td>
</tr>
</tbody>
</table>

Data Access Group Properties

The following table provides the configuration values for the data access group properties in IBM Cognos Configuration.
Table 34. IBM Cognos Configuration data access group properties for Planning Web Services Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Cognos Planning</td>
<td></td>
<td>Create a new resource, called Planning Store, and then select the type of database.</td>
</tr>
<tr>
<td>Component Properties</td>
<td></td>
<td>Values for the new Planning Store follow.</td>
</tr>
<tr>
<td>Planning store</td>
<td>Datasource server and port number</td>
<td>Enter the name of the planning store server, and port number. For example, Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the planning store database.</td>
</tr>
</tbody>
</table>

Set Database Connection Properties for the Planning Store

You must specify database connection information for the planning store. You can choose to use the same database for the planning store and the content store. You must create the database you will use for the planning store before you can connect to it.

**Note:** When you use a DB2 database for your content store you must configure, set, and test the content store before setting up the planning store.

It is mandatory to configure connection properties for the Planning store.

If you install multiple Planning Servers in your environment, you must set the connection properties for the planning store on each Planning Server computer.

The planning store can be on a Microsoft SQL Server, Oracle, or DB2 database.

Some database servers are available with advanced features. When you select an advanced database, IBM Cognos uses features of the database server to manage the connection. If you select the advanced Oracle database, for example, IBM Cognos uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

The default database for the content store is DB2.

If you are using a Microsoft SQL Server database, the version that you select in IBM Cognos Configuration defaults to Microsoft SQL Server 2005. If you are using SQL Server 2008, then you must select the correct version.
Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Data Access, right-click IBM Cognos Planning, and click New resource, Database.
3. In the Name box, type a name for the resource.
4. In the Type box, select the type of database and click OK.

Tip: If you want to use Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).

5. In the Properties window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the Database server with port number or instance name and Database name properties.
     In the Properties window, type the appropriate values for the mandatory and optional properties.
     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the Database server with port number or instance name property. Include the port number if you use nondefault ports. Include the instance name if there are multiple instances of Microsoft SQL Server.
     To connect to a named instance, you must specify the instance name. For example, you can type `localhost\instance1`. If no instance name property is specified, a connection to the default instance is created.
     Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example:
     `jdbc:JSQLConnect://localhost\instance1/user=sa/more properties as required`
   - If you use a DB2 database, for the Database name property, type the database alias.
   - If you use an Oracle database, type the appropriate values for the Database server and port number and Service name properties.
   - If you use an advanced Oracle database, for the Database specifier property, type the Oracle Net8 keyword-value pair for the connection.
     Here is an example:
     `(description=(address=(host=myhost)(protocol=tcp)(port=1521)(connect_data=(sid=(orcl))))`)

6. To set the user ID and password for the database
   - Click the Value box next to the User ID and password property and then click the edit button when it appears.
   - Type the appropriate values and click OK.

7. In the Explorer window, right-click the new database resource name and then click Test.

8. From the File menu, click Save.
   The logon credentials are immediately encrypted.

Start the Planning Server

After you have set the environment properties and database connection properties for the planning store, you can start the Planning Server computer.

Content Manager must be running before you start the Planning Server services.
Procedure

From the Actions menu, click Start.
It might take a few minutes for the IBM Cognos service and IBM Cognos Planning service to start.
This action starts all installed services that are not running. If you want to start a particular service, select the service node in the Explorer window and then click Start from the Actions menu.

Install the Planning Job Server

The IBM Cognos Planning job server runs job-based administrative tasks, such as publishing and reconciliation tasks. It also divides work among other available job servers.

Planning job servers implement a proprietary job-server clustering technique that allows you to allocate or distribute work to individual job servers. You can also distribute job-based work as appropriate for a group of applications and macros over a group of job servers belonging to a cluster. You can allocate a single cluster of job servers to monitor many applications to make most efficient use of all job server resources. Alternatively, you can dedicate a single job server or job server cluster to a specific application to ensure that resources are available.

In most cases, planning job servers should have only the dispatcher and the planning job services enabled. By having many planning job servers, you can distribute the work load. You should have more planning job servers than other role-based planning servers because job servers consume the most resources.
Procedure

1. If you are installing to a directory with other IBM Cognos components, stop the IBM Cognos service.

2. Insert the IBM Cognos Planning Server CD or go to the installation source file directory.
   The **Welcome** page of the installation wizard appears when you insert the CD. If no **Welcome** page appears or you are not installing from the CD, go to the win32 directory, and double-click issetup.exe.

3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.

4. In the **Component Selection** page, select **Planning Server, Application Tier, Planning Job service**.
If you are installing it in a directory that contains other IBM Cognos components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.

5. In the Finish page of the installation wizard, do the following:
   • If you want to configure Content Manager immediately, click Start IBM Cognos Configuration.
   • If you want to see late-breaking information about IBM Cognos components, click View the Readme.

6. Click Finish.

Configure the Planning Job Server

After you install the planning server, you must complete configuration tasks using IBM Cognos Configuration.

Configure Properties for the Planning Job Server

Use IBM Cognos Configuration to configure environment, and data access properties for your planning job server. The following tables provide configuration options for each group of properties.

To start IBM Cognos Configuration, click All Programs from the Start menu, then click IBM Cognos, and then click IBM Cognos Configuration.

Tip: Test after each configuring each property group. To test a property, right-click on the property, and then click Test.

Environment Group Properties

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

Table 35. IBM Cognos Configuration environment group properties for the Cognos Planning Job Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway settings</td>
<td>Gateway URI</td>
<td>Enter the name of the gateway server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_3:80/ibmcognos/cgi-bin/cognos.cgi</td>
</tr>
<tr>
<td>Dispatcher settings</td>
<td>External dispatcher URI</td>
<td>Enter the name of the planning job server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://server_7:9300/p2pd/servlet/dispatch</td>
</tr>
</tbody>
</table>
Table 35. IBM Cognos Configuration environment group properties for the Cognos Planning Job Server (continued)

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Internal dispatcher URI</td>
<td><a href="http://Enter">http://Enter</a> the name of the planning job server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://server_7:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td>Other URI Settings</td>
<td>Dispatcher URI for external applications</td>
<td>Enter the value of the IBM Cognos server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_2:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Content Manager URIs</td>
<td>Enter the value of the content manager server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_1:9300/p2pd/servlet</td>
</tr>
<tr>
<td>IBM Cognos Service</td>
<td>Data movement service enabled?</td>
<td>True</td>
</tr>
<tr>
<td>Component Properties</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Dispatcher service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Planning job service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>All other IBM Cognos services</td>
<td>False</td>
</tr>
<tr>
<td>IBM Cognos Configuration Resource Properties</td>
<td>Type</td>
<td>Leave the default, which is Small configuration.</td>
</tr>
<tr>
<td>Planning Component Properties</td>
<td>IBM Cognos Planning Analyst maximum workspace in KB</td>
<td>This value must be the same for every Planning server.</td>
</tr>
</tbody>
</table>

**Data Access Group Properties**

The following table provides the configuration values for the data access group properties in IBM Cognos Configuration.
### Table 36. IBM Cognos Configuration data access group properties for Cognos Planning Job Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Store Database Resource Properties</td>
<td></td>
<td>You must delete the existing resource, and then create a new resource. Name the new resource Notification Store, and then select the database type.</td>
</tr>
<tr>
<td></td>
<td>Datasource server and port number</td>
<td>Enter the name of the content store server. For example, http://Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the content store database.</td>
</tr>
<tr>
<td>IBM Cognos Planning Component Properties</td>
<td></td>
<td>Create a new resource, called Planning Store, and then select the type of database. Values for the new Planning Store follow.</td>
</tr>
<tr>
<td>Planning store</td>
<td>Datasource server and port number</td>
<td>Enter the name of the planning store server, and port number.the For example, Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the planning store database.</td>
</tr>
</tbody>
</table>

### Set Database Connection Properties for the Planning Store

You must specify database connection information for the planning store. You can choose to use the same database for the planning store and the content store. You must create the database you will use for the planning store before you can connect to it.

**Note:** When you use a DB2 database for your content store you must configure, set, and test the content store before setting up the planning store.

It is mandatory to configure connection properties for the Planning store.
If you install multiple Planning Servers in your environment, you must set the connection properties for the planning store on each Planning Server computer.

The planning store can be on a Microsoft SQL Server, Oracle, or DB2 database.

Some database servers are available with advanced features. When you select an advanced database, IBM Cognos uses features of the database server to manage the connection. If you select the advanced Oracle database, for example, IBM Cognos uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

The default database for the content store is DB2.

If you are using a Microsoft SQL Server database, the version that you select in IBM Cognos Configuration defaults to Microsoft SQL Server 2005. If you are using SQL Server 2008, then you must select the correct version.

**Procedure**

1. Start **IBM Cognos Configuration**.
2. In the **Explorer** window, under **Data Access**, right-click **IBM Cognos Planning**, and click **New resource**, **Database**.
3. In the **Name** box, type a name for the resource.
4. In the **Type** box, select the type of database and click **OK**.

   **Tip:** If you want to use Oracle Net8 keyword-value pair to manage the database connection, select **Oracle database (Advanced)**.

5. In the **Properties** window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the **Database server with port number or instance name** and **Database name** properties.
     In the **Properties** window, type the appropriate values for the mandatory and optional properties.
     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the **Database server with port number or instance name** property. Include the port number if you use nondefault ports. Include the instance name if there are multiple instances of Microsoft SQL Server.
     To connect to a named instance, you must specify the instance name. For example, you can type `localhost\instance1`. If no instance name property is specified, a connection to the default instance is created.
     Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example:
     `jdbc:JSQLConnect://localhost\instance1/user=sa/more properties as required`
   - If you use a DB2 database, for the **Database name** property, type the database alias.
   - If you use an Oracle database, type the appropriate values for the **Database server and port number** and **Service name** properties.
   - If you use an advanced Oracle database, for the **Database specifier** property, type the Oracle Net8 keyword-value pair for the connection.
Here is an example:
(description=(address=(host=myhost)(protocol=tcp)(port=1521)
(connect_data=(sid=(orcl)))))

6. To set the user ID and password for the database
   • Click the Value box next to the User ID and password property and then
     click the edit button when it appears.
   • Type the appropriate values and click OK.
7. In the Explorer window, right-click the new database resource name and then
   click Test.
8. From the File menu, click Save.
   The logon credentials are immediately encrypted.

Start the Planning Server
After you have set the environment properties and database connection properties
for the planning store, you can start the Planning Server computer.

Content Manager must be running before you start the Planning Server services.

Procedure
From the Actions menu, click Start.
It might take a few minutes for the IBM Cognos service and IBM Cognos Planning
service to start.
This action starts all installed services that are not running. If you want to start a
particular service, select the service node in the Explorer window and then click
Start from the Actions menu.

Install the Planning Data Server
Installing a planning data server is optional, and depends on your planning
requirements.

Planning data servers manage communications between IBM Cognos Business
Intelligence components, such as Report Studio and Analysis Studio, and
Contributor applications to provide real-time IBM Cognos reporting and analysis
activities.

Procedure
1. If you are installing to a directory with other IBM Cognos components, stop the
   IBM Cognos service.
2. Insert the IBM Cognos Planning Server CD or go to the installation source file
directory.
   The Welcome page of the installation wizard appears when you insert the CD.
   If no Welcome page appears or you are not installing from the CD, go to the
   win32 directory, and double-click issetup.exe.
3. Select the language to use for the installation.
   The language that you select determines the language of the user interface. You
   can change the language to any of the installed languages after installation.
4. In the Component Selection page, select Planning Data Services.
   If you are installing it in a directory that contains other IBM Cognos
   components, you are prompted for the location of a directory in which to store
   backup copies of the files that will be overwritten.
5. In the **Finish** page of the installation wizard, do the following:
   - If you want to configure Content Manager immediately, click **Start IBM Cognos Configuration**.
   - If you want to see late-breaking information about IBM Cognos components, click **View the Readme**.

6. Click **Finish**.

---

**Configure the Planning Data Server**

After you install the planning server, you must complete configuration tasks using IBM Cognos Configuration.

**Configure Properties for the Planning Data Server**

Use IBM Cognos Configuration to configure environment and data access properties for your planning data server. The following tables provide configuration options for each group of properties.

To start IBM Cognos Configuration, click **All Programs** from the **Start** menu, then click **IBM Cognos**, and then click **IBM Cognos Configuration**.

**Tip:** Test after each configuring each property group. To test a property, right-click on the property, and then click **Test**.

**Environment Group Properties**

The following table provides the configuration values for the environment group properties in IBM Cognos Configuration.

*Table 37. IBM Cognos Configuration environment group properties for IBM Cognos Planning Data Server*

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway settings</td>
<td>Gateway URI</td>
<td>Enter the name of the gateway server. For example, http://Server_3:80/ibmcognos/cgi-bin/cognos.cgi</td>
</tr>
<tr>
<td>Dispatcher settings</td>
<td>External dispatcher URI</td>
<td>Enter the name of the planning data server. For example, http://server_plan_data:9300/p2pd/servlet/dispatch</td>
</tr>
<tr>
<td></td>
<td>Internal dispatcher URI</td>
<td><a href="http://Enter">http://Enter</a> the name of the planning data server. For example, http://server_plan_data:9300/p2pd/servlet/dispatch</td>
</tr>
</tbody>
</table>
Table 37. IBM Cognos Configuration environment group properties for IBM Cognos Planning Data Server (continued)

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Other URI Settings</td>
<td>Dispatcher URI for external applications</td>
<td>Enter the value of the IBM Cognos server. For example, <code>http://Server_2:9300/p2pd/servlet/dispatch</code></td>
</tr>
<tr>
<td></td>
<td>Content Manager URIs</td>
<td>Enter the value of the content manager server. For example, <code>http://Server_1:9300/p2pd/servlet</code></td>
</tr>
<tr>
<td><strong>IBM Cognos Service Component Properties</strong></td>
<td>Data movement service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Dispatcher service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>Planning data service enabled?</td>
<td>True</td>
</tr>
<tr>
<td></td>
<td>All other IBM Cognos services</td>
<td>False</td>
</tr>
<tr>
<td>IBM Cognos Configuration Resource Properties</td>
<td>Type</td>
<td>Leave the default, which is Small configuration.</td>
</tr>
<tr>
<td>Planning Component Properties</td>
<td>IBM Cognos Planning Analyst maximum workspace in KB</td>
<td>This value must be the same for every Planning server.</td>
</tr>
</tbody>
</table>

**Data Access Group Properties**

The following table provides the configuration values for the data access group properties in IBM Cognos Configuration.

Table 38. IBM Cognos Configuration data access group properties for IBM Cognos Planning Data Server

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Store Database Resource Properties</td>
<td></td>
<td>You must delete the existing resource, and then create a new resource. Name the new resource Notification Store, and then select the database type.</td>
</tr>
</tbody>
</table>
Table 38. IBM Cognos Configuration data access group properties for IBM Cognos Planning Data Server (continued)

<table>
<thead>
<tr>
<th>Configuration Option</th>
<th>Property</th>
<th>Value and Information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Datasource server and port number</td>
<td>Enter the name of the content store server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, http://Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the content store database.</td>
</tr>
<tr>
<td>IBM Cognos Planning</td>
<td>Component Properties</td>
<td>Create a new resource, called Planning Store, and then select the type of database.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Values for the new Planning Store follow.</td>
</tr>
<tr>
<td>Planning store</td>
<td>Datasource server and port number</td>
<td>Enter the name of the planning store server, and port number.the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, Server_store:1433</td>
</tr>
<tr>
<td></td>
<td>User ID and password</td>
<td>Enter the ID and password for the database.</td>
</tr>
<tr>
<td></td>
<td>Database name</td>
<td>Enter the name of the planning store database.</td>
</tr>
</tbody>
</table>

Set Database Connection Properties for the Planning Store

You must specify database connection information for the planning store. You can choose to use the same database for the planning store and the content store. You must create the database you will use for the planning store before you can connect to it.

**Note:** When you use a DB2 database for your content store you must configure, set, and test the content store before setting up the planning store.

It is mandatory to configure connection properties for the Planning store.

If you install multiple Planning Servers in your environment, you must set the connection properties for the planning store on each Planning Server computer.

The planning store can be on a Microsoft SQL Server, Oracle, or DB2 database.

Some database servers are available with advanced features. When you select an advanced database, IBM Cognos uses features of the database server to manage the connection. If you select the advanced Oracle database, for example, IBM Cognos
uses enterprise-oriented Oracle features to select a listener, switch to another listener if the first listener fails, automatically reconnect to the database if the connection fails, balance connection requests among listeners, and balance connection requests among dispatchers.

The default database for the content store is DB2.

If you are using a Microsoft SQL Server database, the version that you select in IBM Cognos Configuration defaults to Microsoft SQL Server 2005. If you are using SQL Server 2008, then you must select the correct version.

**Procedure**

1. Start **IBM Cognos Configuration**.
2. In the **Explorer** window, under **Data Access**, right-click **IBM Cognos Planning**, and click **New resource**, **Database**.
3. In the **Name** box, type a name for the resource.
4. In the **Type** box, select the type of database and click **OK**.

   **Tip:** If you want to use Oracle Net8 keyword-value pair to manage the database connection, select **Oracle database (Advanced)**.

5. In the **Properties** window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the **Database server with port number or instance name** and **Database name** properties.
     In the **Properties** window, type the appropriate values for the mandatory and optional properties.
     For a Microsoft SQL Server database, you can choose to use a port number, such as 1433, or a named instance as the value for the **Database server with port number or instance name** property. Include the port number if you use nondefault ports. Include the instance name if there are multiple instances of Microsoft SQL Server.
     To connect to a named instance, you must specify the instance name. For example, you can type `localhost\instance1`. If no instance name property is specified, a connection to the default instance is created.
     Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example:
     ```
jdbc:JSQLConnect://localhost\instance1/user=sa/more properties as required
```
   - If you use a DB2 database, for the **Database name** property, type the database alias.
   - If you use an Oracle database, type the appropriate values for the **Database server and port number** and **Service name** properties.
   - If you use an advanced Oracle database, for the **Database specifier** property, type the Oracle Net8 keyword-value pair for the connection.
     Here is an example:
     ```
(description=(address=(host=myhost)(protocol=tcp)(port=1521)
  (connect_data=(sid=(orcl))))))
```
6. To set the user ID and password for the database
   - Click the **Value** box next to the **User ID and password** property and then click the edit button when it appears.
   - Type the appropriate values and click **OK**.
7. In the Explorer window, right-click the new database resource name and then click **Test**.

8. From the **File** menu, click **Save**.
   The logon credentials are immediately encrypted.

### Start the Planning Server

After you have set the environment properties and database connection properties for the planning store, you can start the Planning Server computer.

Content Manager must be running before you start the Planning Server services.

### Procedure

From the **Actions** menu, click **Start**.
It might take a few minutes for the IBM Cognos service and IBM Cognos Planning service to start.
This action starts all installed services that are not running. If you want to start a particular service, select the service node in the **Explorer** window and then click **Start** from the **Actions** menu.
Chapter 10. Installing the IBM Cognos Planning Clients

You can install the following IBM Cognos Planning clients:

- the administration components, including IBM Cognos Planning Analyst and Contributor Administration
- IBM Cognos Planning Contributor
- Contributor Add-in for Microsoft Excel
- IBM Cognos Framework Manager
- an Analyst network connection point

Install IBM Cognos Planning Administration Components

Install IBM Cognos Planning administration components to have access to all IBM Cognos Planning administration tools. You can select the administration components that you want to install and the location on your computer where you want to install them.

You can install

- IBM Cognos Planning Analyst
- IBM Cognos Planning Analyst Add-in for Microsoft Excel
- IBM Cognos Planning Manager
- Contributor Administration Console

Procedure

1. Insert the CD for IBM Cognos Planning Administration or go to the installation source file directory.

   The **Welcome** page of the installation wizard should appear when you insert the CD.

   If no **Welcome** page appears or you are not installing from the CD, go to the win32 directory, and double-click issetup.exe.

2. Select the language to use for the installation.

3. Follow the directions in the installation wizard to copy the required files to your computer.

   If an older version of the Microsoft Windows Installer Tool is installed on your computer, you are prompted to manually install Microsoft SOAP Toolkit before you configure your IBM Cognos Planning environment.

   If you are installing in a directory that already has other IBM Cognos Planning components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.

4. Expand **Planning Administration**, and select the components that you want to install.

   **Tip**: If you are installing Analyst Add-in for Microsoft Excel in a Citrix environment, you can select **Analyst for Microsoft Excel**, and select **To be run in a Citrix environment**.

5. Choose how to proceed in the **Finish** page of the installation wizard:

   - If you want to configure IBM Cognos components immediately, click **Start IBM Cognos Configuration**.
If you want to see late-breaking information about IBM Cognos Planning components, click View the Readme.

6. Click Finish.

Results

After you install administration components, you must configure the location of the IBM Cognos Planning gateway and an IBM Cognos Planning server.

Default Settings for IBM Cognos Planning Administration Components

The following table lists the default workspace size used by IBM Cognos Planning Analyst. After installation, you can use IBM Cognos Configuration to change this setting.

You can also change it by editing the cogstartup.xml file in the \configuration directory.

<table>
<thead>
<tr>
<th>Component</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analyst maximum workspace size in KB</td>
<td>64000</td>
<td>The amount of memory that the APL interpreter can use.</td>
</tr>
</tbody>
</table>

Configure Environment Properties for the Administration Components

The IBM Cognos Planning administration components require the gateway URI and the URI of at least one Planning Server dispatcher in your environment.

Procedure

1. In the IBM Cognos Configuration Explorer window, click Environment.
2. Type the value for the Gateway URI.
3. Type the value for the Dispatcher URI for external applications.
   The host name can be any Planning Server dispatcher in your environment. Ensure that you use the server name or IP address, and the correct port number.
4. In the Explorer window, under Cryptography, click Cognos, the default cryptographic provider.
5. Under the Certificate Authority settings property group, for the Password property, enter the same password you configured on the default active Content Manager computer.
6. Ensure that all other cryptographic settings match what you set on the default active Content Manager computer.
7. From the File menu, click Save.

Configuring Analyst Computers

When you install IBM Cognos Planning Server, IBM Cognos Planning Analyst is always installed even though it is not a selectable component. You can also install Analyst as an optional component when you install Analyst IBM Cognos Planning Administration.
Some configuration tasks are optional. You perform them to change the default property values used by Analyst.

Many Analyst configuration tasks are performed in Analyst. For more information, see the Analyst User Guide.

If you install Analyst on the same computer as other IBM Cognos Planning components, no configuration is required if you

- configure your Web server using the default virtual directories
- use the default ports
- use the default resources
- use the default cryptographic settings

**Configure Environment Properties for Analyst Computers**

If you install Analyst on a computer than other IBM Cognos Planning components, you must configure it to communicate with the other components.

You must also set up the planning data sources before you configure Analyst.

**Important:** If IBM Cognos Planning was installed in more than one location, ensure that all URIs point to the correct version of IBM Cognos Planning. Configure Analyst to use the same version of IBM Cognos Planning.

When Analyst is outside a network firewall that protects the planning server components, communication issues with the dispatcher can arise. To avoid communication issues, you can install Analyst in the same architectural tier as the Planning Server components, or you can install and configure a gateway that is dedicated to Analyst communications.

**Procedure**

1. On the computer where you installed Analyst, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, in the Gateway URI box, type the syntax that corresponds to the type of gateway you are using. Use the following table to find the syntax for your gateway:

<table>
<thead>
<tr>
<th>Gateway Type</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISAPI</td>
<td>Replace cognos.cgi with cognosisapi.dll</td>
</tr>
<tr>
<td>Apache Web server Module 1.3</td>
<td>http://host_name:port/ibmcognos/cgi-bin/mod_cognos.dll</td>
</tr>
<tr>
<td>Apache Web server Module 2.0</td>
<td>http://host_name:port/ibmcognos/cgi-bin/mod2_cognos.dll</td>
</tr>
<tr>
<td>Apache Web server Module 2.2.x</td>
<td>http://host_name:port/ibmcognos/cgi-bin/mod2_2_cognos.dll</td>
</tr>
</tbody>
</table>
Table 40. Valid syntax for the type of gateway used (continued)

<table>
<thead>
<tr>
<th>Gateway Type</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Servlet gateway</td>
<td>http[s]://host_name:port/context_root/servlet/Gateway</td>
</tr>
<tr>
<td></td>
<td>where context_root is the value you assigned to the ServletGateway Web application when you deployed the ServletGateway application.</td>
</tr>
<tr>
<td>Dispatcher</td>
<td>http[s]://host_name:port/p2pd/servlet/dispatch</td>
</tr>
</tbody>
</table>

**Note:** If you are using Apache Web Server for the Gateway URI, ensure that you configured it first.

4. Change the host name portion of the Gateway URI from localhost to either the IP address of the computer or the computer name.

5. In the Explorer window, under Cryptography, click IBM Cognos, the default cryptographic provider.

6. Under the Certificate Authority settings property group, for the Password property, enter the same password you configured on the default active Content Manager computer.

7. From the File menu, click Save.

**Configure Integrated Windows Authentication**

If you intend to run the Analyst Batch Scheduler wizard, you must configure integrated Microsoft Windows authentication to secure jobs and macros in Analyst.

To use Integrated Windows Authentication, you must use an authentication provider that supports it. You can configure all authentication providers supported by IBM Cognos to use Integrated Windows authentication, except for the SAP provider.

**Procedure**

1. In Internet Information Services (IIS) Manager, right-click the virtual directory for Planning, and select Properties.

2. Click the Directory Security tab, and click Edit next to Enable anonymous access and edit the authentication methods for this resource.

3. Clear Anonymous access, and select Integrated Windows authentication. Click OK, and close IIS.

**Change the Language of the Analyst Samples**

The Analyst samples require no further setup if you want to access the samples in the language that you selected when you installed IBM Cognos Planning server or administration components.

The filesys.ini file determines the language of the samples. To change languages, you must edit the filesys.ini.

The location of the Analyst samples depends on the type of installation you selected.
• If you created a network installation point, the samples are located on the computer with the network installation point, in the `\server\shared_directory\samples\Planning\Analyst` folder.

• If you installed Analyst but did not create a network installation point, the samples are located locally on your computer in the `c10planning_location\samples\Planning\Analyst` folder.

Creating a network installation point:

You can create a network installation point based on the desired language.

Procedure
1. In the `c10_location\uninstall` folder, open a command prompt.
2. Type the following:
   ```
   uninst.exe -wct "\server\share\bin\wct\epAnalystFileSysCfg_lang.xml"
   ```
   where
   • `\server\share` is the location of the network installation point.
   • `lang` is the language.
     If `lang` is de, filesys.ini will point to the German samples.
     If `lang` is en, filesys.ini will point to the English samples.
     If `lang` is fr, filesys.ini will point to the French samples.
     If `lang` is sv, filesys.ini will point to the Swedish samples.

Creating the network installation point when Analyst is installed locally:

You can install the network installation point when Analyst is installed locally.

Procedure
1. In the `c10_location\uninstall` folder, open a command prompt.
2. Type the following:
   ```
   uninst.exe -wct "\c10_location\bin\wct\epAnalystFileSysCfg_lang.xml"
   ```
   where
   • `c10_location` is the location of the IBM Cognos Planning installation on your computer.
   • `lang` is the language.
     If `lang` is de, filesys.ini will point to the German samples.
     If `lang` is en, filesys.ini will point to the English samples.
     If `lang` is fr, filesys.ini will point to the French samples.
     If `lang` is sv, filesys.ini will point to the Swedish samples.

IBM Cognos Planning Contributor

Contributor administrators or Contributor users can install IBM Cognos Planning Contributor, which is a Web client.

• An administrator can install the Contributor Web Client for a single user or all users. This is done by using a command line to install the IBM Cognos Rich Client Framework and the IBM Cognos Contributor.

  Administrators can also install the Web client from the IBM Cognos Planning Client installation CD.
• A Contributor user can install the Web client by clicking a Web link on their Workflow page.

### Installing and Configuring IBM Cognos Planning Contributor

Administrators use the Contributor Administration Console to set options for downloading, installing, and updating IBM Cognos Planning Contributor.

Depending on the options the administrator sets, an administrator or a Contributor user can install Contributor.

Contributor users can uninstall Contributor using the **Add or Remove Programs** on the Microsoft Windows **Control Panel**.

### Before you begin

The Contributor Administration Console must be installed before you can install and configure the Contributor Web Client.

### Setting Installation Options

Administrators set installation options using the Contributor Administration Console.

These installation options determine whether the administrator or the Contributor user installs the client. The settings also determine whether the updates are automatically received or if the administrator remotely installs the updates.

### Procedure

1. On the **Contributor Administration Console**, select **System Settings**, and then click the **Web Client Settings tab**.

2. Do one of the following:
   - Select the **Allow automatic downloads and installations** check box to allow Contributor users to download and install the Contributor Web client from the Workflow page.
   - Clear **Allow automatic downloads and installations** check box to allow administrators to remotely install the MSI's using a command line installation, or CD.

3. Do one of the following:
   - Select **Allow automatic client software updates** check box to allow Contributor users to automatically receive Web client updates.
   - Clear **Allow automatic client software updates** check box to allow administrators to remotely install updates using the command line.

**Note:** If you clear the **Allow automatic downloads and installations** check box, Contributor users cannot install the Contributor Web Client. This means that an administrator must install the Contributor Web Client using a command line installation.

### Install Planning Contributor Using a Web Link

If the **Allow automatic downloads and installations** is selected in the Contributor Administration Console, then IBM Cognos Planning Contributor users can download and install the Planning Contributor Web Client on their machine.
Note: Contributor users only receive Contributor Web Client documentation after the client is installed. For this reason, administrators need to provide installation and uninstallation instructions to Contributor users.

Procedure
1. Log on to IBM Cognos Connection.
2. In IBM Cognos Connection, in the upper-right corner, click Launch, Contributor. If you have access to more than one package, click the package that you require.
   On the workflow page, you see a graphical overview of all the areas you are responsible for, and the status of the data.
3. Click an eList item.
   A new Contributor page appears, and you are prompted to install IBM Cognos Rich Client Framework.
4. Click Install Now.
5. On the File Download dialog box, click Run to install CognosRCP.msi.
6. Restart your Web browser.

Results
IBM Cognos Planning Contributor is now installed on the IBM Cognos Rich Client Framework. The Planning Contributor Web Client opens the next time you navigate to a node on the workflow page.

Install Planning Contributor Using a Command Line
Administrators can install IBM Cognos Planning Contributor using a Microsoft Windows Installer command line. This allows the client to be distributed using Active Directory or other software management tools.

You must install the following msi files in the following order:
1. CognosRCP.msi
   This file installs IBM Cognos Rich Client Framework.
2. contributor.msi
   This file installs IBM Cognos Contributor. This installation does not require any command-line parameters. The location of the installed files are relative to the installation location of the IBM Cognos Rich Client Framework.

The commands that administrators can use to install CognosRCP.msi are described in the following table.

Table 41. Command-line installation options

<table>
<thead>
<tr>
<th>Command-line installation options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALLUSERS=2</td>
<td>Installs the MSI for all Contributor users. This command ensures that the registry entries for the IBM Cognos Rich Client Framework are located in HKEY_LOCAL_MACHINE. Note: You must use this command with the TARGETDIR command.</td>
</tr>
</tbody>
</table>
Table 41. Command-line installation options (continued)

<table>
<thead>
<tr>
<th>Command-line installation options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TARGETDIR=&quot;CognosRCP_install_location&quot;</td>
<td>Specifies the install location for the MSI. For example, TARGETDIR=&quot;C:\Program Files&quot;</td>
</tr>
<tr>
<td>NOUPDATE=Yes</td>
<td>Prevents Contributor users from receiving automatic updates for the IBM Cognos Rich Client Framework.</td>
</tr>
</tbody>
</table>

Installing the IBM Cognos Rich Client Framework
You can install IBM Cognos Rich Client Framework.

Procedure
1. Open a command prompt, and navigate to the location of the CognosRCP.msi file.
   By default, the MSI files are located in c10_location\webcontent\rcp_installs
2. Install CognosRCP.msi by doing one of the following:
   - To install the MSI for a single user, type the following command
     CognosRCP.msi TARGETDIR="install_location"
     **Note:** To prevent automatic updates for Contributor users add NOUPDATE=Yes before you execute the command.
   - To install the MSI for all users, type the following command
     CognosRCP.msi TARGETDIR="install_location" ALLUSERS=2
     **Note:** To prevent automatic updates for Contributor users add NOUPDATE=Yes before you execute the command.

Results
After you install the CognosRCP.msi, IBM Cognos Rich Client Framework appears on the Windows Add or Remove Programs list. In addition, a folder called CognosRCP is created in the installation location that you specified in the TARGETDIR command.

Installing IBM Cognos Contributor
You can install IBM Cognos Contributor.

Procedure
1. Open a command prompt, and navigate to the location of the contributor.msi file.
   By default, the MSI files are located in c10_location\webcontent\rcp_installs
2. Type the following command:
   contributor.msi

Results
After the is successfully installed, IBM Cognos Contributor appears on the Windows Add or Remove Programs list.
Install Planning Contributor from the Planning Client

Installation CD

Use the IBM Cognos Planning Client installation CD to install IBM Cognos Planning Contributor as a Web Client or to use while you are offline.

If you are installing on a Microsoft Windows Vista operating system and the User Account Control (UAC) is enabled, you must start the installation wizard using Run As Administrator.

Procedure

1. Insert the CD for IBM Cognos Planning Client or go to the installation source file directory.
   The Welcome page of the installation wizard should appear when you insert the CD.
   If no Welcome page appears or you are not installing from the CD, go to the win32 directory, and double-click isetup.exe.
   If you are using Windows Vista and UAC is enabled, right-click isetup.exe, and select Run As Administrator.
2. Select the language to use for the installation.
3. Follow the directions in the installation wizard to copy the required files to your computer.
   If you are installing in a directory that already has other IBM Cognos Planning components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.
4. Click Finish.

Results

After you install the client, you can access the IBM Cognos Planning portal to use Contributor Web.

Uninstall the Contributor Web Client

The steps to uninstall the IBM Cognos Planning Contributor Web Client depend on how the client was installed.

If a Contributor user installed Contributor by clicking a Web link on the workflow page, then only the IBM Cognos Rich Client Framework appears on the Add or Remove Programs list. IBM Cognos Planning Contributor appears in this list if an Administrator used the command line to install it.

Use Add or Remove Programs on the Windows Control Panel to uninstall the IBM Cognos Rich Client Framework or IBM Cognos Contributor.

Install Planning Contributor Add-in for Microsoft Excel

Install IBM Cognos Planning Contributor Add-in for Microsoft Excel to view and edit Contributor data using Microsoft Excel formatting and linking functionality.

Do not install Contributor Add-in for Microsoft Excel on a computer that already has IBM Cognos Planning Analyst or Contributor Administration installed on it.
If you are installing on a Microsoft Windows Vista operating system and the User Account Control (UAC) is enabled, you must start the installation wizard using Run As Administrator.

Before you begin

If you are installing Contributor Add-in for Microsoft Excel on multiple computers, ensure that you install the same version on each computer.

If you have an older version of Contributor for Microsoft Excel, you need to uninstall it before you install the IBM Cognos version. Uninstalling does not remove any XLS worksheets that you have saved.

Procedure

1. Insert the CD for IBM Cognos Planning Client or go to the installation source file directory.
   The Welcome page of the installation wizard should appear when you insert the CD.
   If no Welcome page appears or you are not installing from the CD, go to the win32 directory, and double-click issetup.exe.
   If you are using Windows Vista and UAC is enabled, right-click issetup.exe, and select Run As Administrator.
2. Select the language to use for the installation.
3. Follow the directions in the installation wizard to copy the required files to your computer.
   If you are installing in a directory that already has other IBM Cognos Planning components, you are prompted for the location of a directory in which to store backup copies of the files that will be overwritten.
4. Click Finish.

Results

After you install the Client, you can access the IBM Cognos Planning portal to use Contributor Web. The Planning Contributor Web Client does not require any configuration.

When you start Microsoft Excel, Contributor appears in the Microsoft Excel menu bar. For more information about using Contributor Add-in for Microsoft Excel, see the IBM Cognos Planning Contributor for Microsoft Excel User Guide.

Installing and Configuring IBM Cognos Framework Manager

You can install IBM Cognos Framework Manager, the metadata modeling tool for IBM Cognos Business Intelligence for reporting, on the same computer as other IBM Cognos BI components, or on a different computer. All required files are copied to one computer. Default settings are used for the configuration. You can change these default settings if necessary, or if you install Framework Manager on a separate computer from IBM Cognos BI.

If you upgraded from an older version of Framework Manager, you can use the same models and projects that you used with the older version. To upgrade existing projects, you must open them in the new version of Framework Manager.
Framework Manager is available as a 32-bit installation only. It must be installed on a 32-bit computer with a Microsoft Windows operating system.

Before you install Framework Manager, close all programs that are currently running to ensure that the installation program copies all the required files to your computer.

Also, ensure that you have administrator privileges for the Windows computer you are installing on. If you are not an administrator, ask your system administrator to add you to the Administrator group on your computer. Administrator privileges are also required for the account that is used to run Framework Manager.

Install and configure all IBM Cognos BI server components before you install Framework Manager.

Install in a directory that contains only ASCII characters in the path name. Some servers do not support non-ASCII characters in directory names. Installing Framework Manager in directory that has an apostrophe in the path name may result in the help not opening properly.

If you are installing the modeling tool in the same directory as IBM Cognos BI and do not stop the IBM Cognos services, you are prompted to do so during the installation.

To help you manage, share, and secure different versions of your metadata, you can configure Framework Manager to use an external source control system. For more information, see the section about using external repository control in the Framework Manager User Guide.

**System Requirements for Framework Manager**

Before you install Framework Manager, ensure that the Windows computer meets IBM Cognos BI software and hardware requirements. The size of your models determines the hardware requirements, such as disk space.

The following table lists the minimum hardware and software requirements to run Framework Manager.

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows</td>
</tr>
<tr>
<td>RAM</td>
<td>Minimum: 512 MB</td>
</tr>
<tr>
<td></td>
<td>Optimal: 1 GB</td>
</tr>
<tr>
<td>Disk space</td>
<td>Minimum: 500 MB of free space on the drive that contains the temporary directory used by IBM Cognos BI</td>
</tr>
<tr>
<td>Database</td>
<td>Database client software installed on the same computer as Framework Manager (Oracle, DB2, or Sybase only. Microsoft SQL drivers are installed with IBM Cognos BI by default)</td>
</tr>
<tr>
<td></td>
<td>Database connectivity set up</td>
</tr>
<tr>
<td>Other</td>
<td>Microsoft Data Access Component (MDAC) 2.6 or later for use with product samples</td>
</tr>
</tbody>
</table>
To help you manage, share, and secure different versions of your metadata, you can configure Framework Manager to use an external source control system. For more information, see the section about using external repository control in the Framework Manager *User Guide*.

To install and configure Framework Manager, follow these steps:

1. Install Framework Manager.
2. Update the Java Environment.
3. Set up the data source environment for Framework Manager.
4. Configure environment properties for Framework Manager.
5. Test the Framework Manager installation.

**Default Settings for Framework Manager**

The following table lists the default settings for the IBM Cognos BI ports and URIs that are used by Framework Manager.

<table>
<thead>
<tr>
<th>Component</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gateway</td>
<td><a href="http://localhost:80/ibmcognos/cgi-bin/cognos.cgi">http://localhost:80/ibmcognos/cgi-bin/cognos.cgi</a></td>
<td>The URI to the IBM Cognos BI gateway</td>
</tr>
<tr>
<td>Dispatcher URI for external</td>
<td><a href="http://localhost:9300/p2pd/servlet/dispatch">http://localhost:9300/p2pd/servlet/dispatch</a></td>
<td>The URI to the dispatcher</td>
</tr>
<tr>
<td>applications</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log Server Port</td>
<td>9362</td>
<td>The port used by the local log server</td>
</tr>
</tbody>
</table>

After installation, you can use the configuration tool to change the default settings. You can also change them by editing the cogstartup.xml file in the *c10_location*\configuration directory.

**Install Framework Manager**

To install Framework Manager, use the appropriate product disk. When prompted to select the components, install all the components that are selected by default.

**Procedure**

1. If you are installing in a directory with other IBM Cognos BI components, stop the IBM Cognos service.
2. Do one of the following:
   - Insert the product disk.
     - If the installation wizard does not open automatically, go to the operating system directory, and double-click issetup.exe.
   - Go to the location where the installation files were downloaded and extracted and then double-click issetup.exe.
3. Select the language to use for the installation.
   - The language that you select determines the language of the user interface. All supported languages are installed. You can change the user interface to any of the installed languages after installation.
4. Follow the directions in the installation wizard to copy the required files to your computer.
If you are installing IBM Cognos BI on a computer that already has ReportNet or an older version of IBM Cognos BI, and you want to keep the older version running, you must install IBM Cognos BI in a different directory.

If you are installing in a directory that contains other IBM Cognos BI components, you are prompted to create backup copies of the files that will be replaced.

5. In the Finish page of the installation wizard, do the following:
   - If you want to see the log files, click View for the appropriate log file.
   - If you want to see late-breaking information about the product, select the check box for IBM Cognos Release Notes.
   - If the server components are configured, select the IBM Cognos Configuration check box so that you can configure Framework Manager immediately.

   If the server components are not configured, ensure that the IBM Cognos Configuration check box is clear. You can later configure Framework Manager using the Microsoft Windows operating system Start menu to start IBM Cognos Configuration from the shortcut folder.

   - Click Finish.

**What to do next**

To ensure the security and integrity of IBM Cognos BI, it is important to protect the installation directory from unauthorized or inappropriate access.

**Update the Java Environment**

In a distributed installation, Framework Manager must load the cryptographic keys from the IBM Cognos BI server. To do this, set up your Java environment by ensuring that the JAVA_HOME environment variable is set up on the server and on the Framework Manager computer.

If you do not have a JAVA_HOME variable already set on a Microsoft Windows operating system, the JRE files provided with Framework Manager will be used, and you do not have to update any files in your environment.

If you want to use your own JRE and have JAVA_HOME set to that location on Windows, the JRE files from that location will be used.

The default Windows JRE that is provided with Framework Manager includes a restricted policy file that limits you to certain cryptographic algorithms and cipher suites. If your security policy requires a wider range of cryptographic algorithms and cipher suites than are shown in IBM Cognos Configuration, you can download and install the unrestricted JCE policy file.

1. Ensure that the JAVA_HOME environment variable is set to the JRE location.

   For example, to set JAVA_HOME to a JRE that you are already using, the path is `Java_location/bin/jre/version`.

2. If your security policy requires it, download and install the unrestricted JCE policy file.

   For Java that is provided by IBM, the unrestricted JCE policy file is available from the following location:

   ```
   ```

Chapter 10. Installing the IBM Cognos Planning Clients  173
For information about configuring the cryptographic provider to support your security policy, see "Configuring Cryptographic Settings" on page 183.

**Data Sources and Framework Manager**

The IBM Cognos BI modeling tools create and manage metadata. Framework Manager creates and manages metadata for the reporting functions. Because metadata is derived from data sources in multi-platform or multilingual environments, there are several things you must think about or do when you set up the data source environment for Framework Manager. Commonly, these things depend on the other technology you use for your data or import source.

If you upgraded from an older version of Framework Manager, you are not required to set up anything in the data source environment. You must set up the data source environment only if you installed Framework Manager in a different location from the older version.

If users operating in different languages will be connecting to a Microsoft Analysis Services (MSAS) 2000 data source, you must create a separate IBM Cognos BI instance for each language.

Users operating in different languages can connect to an MSAS 2005 data source from the same instance of IBM Cognos BI. Modelers must create a separate package for each language. Users can run reports in any language.

For more information about data source connections, see the IBM Cognos Administration and Security Guide.

Ensure that you install the appropriate fonts to support the character sets and currency symbols you use. For Japanese and Korean currency symbols to appear correctly, you must install the additional fonts from the Supplementary Language Documentation disk.

**Setting up the data source environment for Framework Manager**

Perform the following steps in the location where you installed Framework Manager.

If you use a Sybase data source, these steps are not necessary.

**Procedure**

1. Set the environment variable for multilingual support:
   - For Oracle, set the NLS_LANG (National Language Support) environment variable on each computer where Framework Manager or Metric Designer and the IBM Cognos BI server are installed by typing the following command:
     
     \[ \text{NLS\_LANG = language\_territory.character\_set} \]
     
     Examples are:
     
     NLS\_LANG = AMERICAN\_AMERICA.UTF8
     NLS\_LANG = JAPANESE\_JAPAN.UTF8
     
     The value of the variable determines the locale-dependent behavior of IBM Cognos BI. Error messages, sort order, date, time, monetary, numeric, and calendar conventions automatically adapt to the native language and locale.
   - For DB2, set the DB2CODEPAGE environment variable to a value of 1252.
For more information about whether to use this optional environment variable, see the DB2 documentation.

No settings are required for SAP BW. SAP support only a single code page on non-Unicode SAP BW systems.

2. For Oracle, add $ORACLE_HOME/lib to your LD_LIBRARY_PATH.
   When you set the load library paths, ensure that the 32-bit Oracle libraries are in the library search path, which is usually the $ORACLE_HOME/lib directory or the $ORACLE_HOME/lib32 directory if you installed a 64-bit Oracle client.

3. For SAP BW, configure the following authorization objects so that the modeling tool can retrieve metadata.

Where default values are specified, you may want to modify the values on the SAP system.

- **S_RFC**
  - Set the **Activity** field to the value: 16
  - Set the **Name of RFC to be protected** field to the value: SYST, RSOB, SUGU, RFC1, RS_UNIFICATION, RSAB, SDTX, SU_USER
  - Set the **Type of RFC** object to be protected field to the value: FUGR

- **S_TABU_DIS**
  - Set the **Activity** field to the value: 03
  - Set the **Authorization Group** field to the value: &NC&

  **Note**: &NC& represents any table that does not have an authorization group.
  For security reasons, create a new authorization group and assign the table RSHIEDIR to it. The new authorization group restricts the user's access to this table only, which is needed by the modeling tool. Create the new authorization group as a customization in the SAP system.

- **S_USER_GRP**
  - Set the **Activity** field to the value: 03, 05
  - Set the **User group in user master main** field to the default value.

- **S_RS_COMP**
  - Set the **Activity** field to the default value.
  - Set the **Info Area** field to the value: InfoArea Technical Name
  - Set the **Info Cube** field to the value: InfoCube Technical Name
  - Set the **Name (ID) of reporting components** field to the default value.
  - Set the **Type of reporting components** field to the default value.

- **S_RS_COMP1**
  - Set the **Activity** field to the default value.
  - Set the **Name (ID) of reporting components** field to the default value.
  - Set the **Type of reporting components** field to the default value.
  - Set the **Owner (Person Responsible)** field to the default value.

- **S_RS_HIER**
  - Set the **Activity** field to the value: 71
  - Set the **Hierarchy Name** field to the value: Hierarchy Name
  - Set the **InfoObject** field to the value: InfoObject Technical Name
  - Set the **Version** field to the value: Hierarchy Version

- **S_RS_ICUBE**
  - Set the **Activity** field to the value: 03
Set the **InfoCube sub-object** field to the values: DATA and DEFINITION
Set the **Info Area** field to the value: InfoArea Technical Name
Set the **InfoCube** field to the value: InfoCube Technical Name

For more information about SAP BW authorization objects, see Transaction SU03.

**Environment Properties for Framework Manager Computers**

When you install Framework Manager on a different computer from the non-modeling components of IBM Cognos BI, you must configure it to communicate with the other components.

If you install Framework Manager on the same computer as the non-modeling components of IBM Cognos BI, no configuration is required if you
- configure your Web server using the default virtual directories
- use the default ports
- use the default resources
- use the default cryptographic settings

If IBM Cognos BI was installed in more than one location, ensure that all URIs point to the correct version of IBM Cognos BI. Framework Manager must be configured to use the same version of IBM Cognos BI.

**Installations with a Firewall**

When the modeling tool is outside a network firewall that protects the Application Tier Components, communication issues with the dispatcher can arise. To avoid communication issues, you can install the modeling tool in the same architectural tier as the Application Tier Components or you can install and configure a gateway that is dedicated to modeling tool communications.

The steps in this topic describe how to configure the modeling tool computer when the computer is inside or outside of the network firewall.

**Prerequisites**

Ensure that the IBM Cognos service on at least one Content Manager computer is running. This ensures that the certificate authority service issues a certificate to the Framework Manager computer.

Ensure that the Web server is configured and running.

You must also set up the data sources before you configure Framework Manager.

**Configuring Framework Manager inside the network firewall**

Use the following steps to set up communication between Framework Manager and the other IBM Cognos Business Intelligence components when Framework Manager is inside a network firewall.

**Procedure**

1. On the computer where you installed Framework Manager, start IBM Cognos Configuration.
2. In the **Explorer** window, click **Environment**.
3. In the **Properties** window, in the **Gateway URI** box, type the appropriate value.
• To use ISAPI, replace cognos.cgi with cognosisapi.dll.
• To use an Apache Web server, type the following syntax:
  For Apache 1.3 module,
  \texttt{http://host_name:port/ibmcognos/cgi-bin/mod_cognos.dll}
  For Apache 2.0 module,
  \texttt{http://host_name:port/ibmcognos/cgi-bin/mod2_cognos.dll}
  For Apache 2.2.x module,
  \texttt{http://host_name:port/ibmcognos/cgi-bin/mod2_2_cognos.dll}
  Ensure that you configured your Apache Web Server.
• To use IBM HTTP Server, type the following syntax:
  \texttt{http://host_name:port/ibmcognos/cgi-bin/mod2_cognos.dll}
  Ensure that you configured your IBM HTTP Web Server.
• To use a servlet gateway, type the following syntax:
  \texttt{http[s]://host_name:port/context_root/servlet/Gateway}
  where context_root is the value you assigned to the ServletGateway Web
  application when you deployed the ServletGateway application.
• If you are not using a Web server, then to use the dispatcher as the gateway,
  type the following syntax:
  \texttt{http[s]://host_name:port/p2pd/servlet/dispatch/ext}

4. Change the host name portion of the \texttt{Gateway URI} from localhost to either the
   IP address or the host name of the computer where the Gateway component is
   installed.

5. Specify the value for the Dispatcher URI for external applications by typing
   the URI of the server where Application Tier Components are installed.
   This value will be the same as the Internal dispatcher URI property on your
   Application Tier Components computer.

6. In the Explorer window, under Cryptography, click Cognos, the default
   cryptographic provider.

7. Under the Certificate Authority settings property group, for the Password
   property, type the same password you configured on the default active Content
   Manager computer.

8. From the File menu, click Save.

**Configuring Framework Manager outside the network firewall**

Use the following steps to set up communication between Framework Manager
and the other IBM Cognos Business Intelligence components when Framework
Manager uses a dedicated gateway and is outside the network firewall.

**Procedure**

1. Set up a dedicated gateway for Framework Manager.

2. On the dedicated gateway, in IBM Cognos Configuration, change the
   Dispatcher URIs for gateway property to the URI of the dispatcher on the
   server where Application Tier Components are installed.
   This value will be the same as the Internal dispatcher URI property on your
   Application Tier Components computer.

3. On the computer where you installed Framework Manager, start IBM Cognos
   Configuration.

4. In the Explorer window, click Environment.
5. In the Properties window, in the Gateway URI box, type the appropriate value for the server you are using as the dedicated gateway.
   - To use ISAPI, replace cognos.cgi with cognosisapi.dll.
   - To use an Apache Web server, type the following syntax:
     For Apache 1.3 module,
     \texttt{http://host_name:port/ibmcognos/cgi-bin/mod_cognos.dll}
     For Apache 2.0 module,
     \texttt{http://host_name:port/ibmcognos/cgi-bin/mod2_cognos.dll}
     For Apache 2.2.x module,
     \texttt{http://host_name:port/ibmcognos/cgi-bin/mod2_2_cognos.dll}

   \textbf{Note:} Ensure that you configured your Apache Web Server.
   - To use IBM HTTP Server, type the following syntax:
     \texttt{http://host_name:port/ibmcognos/cgi-bin/mod2_cognos.dll}
     Ensure that you configured your IBM HTTP Web Server.
   - To use a servlet gateway, type the following syntax:
     \texttt{http[s]://host_name/context_root/servlet/Gateway}
     where \textit{context_root} is the value you assigned to the ServletGateway Web application when you deployed the ServletGateway application.

6. Change the localhost portion of the Gateway URI to either the IP address or the host name of the dedicated gateway server.

7. Specify the value for the Dispatcher URI for external applications by typing the URI of the internal dispatcher on the server where Application Tier Components are installed.

   Ensure that you change the host name in the URI from localhost.

8. In the Explorer window, under Cryptography, click Cognos, the default cryptographic provider.

9. Under the Certificate Authority settings property group, for the Password property, type the same password you configured on the default active Content Manager computer.

10. From the File menu, click Save.

\textbf{Results}

Framework Manager is configured to communicate with the other components of IBM Cognos BI. If you installed Framework Manager on a Microsoft Windows Vista operating system computer, you must update file location properties on Windows Vista computers.

\textbf{Test the Installation and Configuration}

You can test your configuration by starting the application and creating a project.

\textbf{Procedure}

To start Framework Manager, from the Start menu, click Programs > IBM Cognos 10 > Framework Manager.

You may be prompted to upgrade if the model schema version is older than the currently supported version.

If you see the Welcome page of Framework Manager, your installation is working.
Install an Analyst Network Connection Point

A network connection point is the location where you set up a network share. For distributed IBM Cognos Planning Analyst installations, you should always install a network connection point so that both Analyst server and Analyst clients use a Universal Naming Convention (UNC) path to connect to a shared library.

When you create a network connection point, the Analyst software is installed on the local drive of your computer, and the data is stored in a shared location on the network server, along with control files and the samples files.

One of the files created at the network installation point is filesys.ini. The filesys.ini file is a control file used by Analyst. It contains file paths for the Libs.tab, Users.tab, and Groups.tab that control the specific library and user setup. If you do not specify the filesys.ini path by creating a network connection point, you must specify the path when you create planning tables. For more information, see the IBM Cognos Planning Contributor Administration Guide or the IBM Cognos Planning Analyst User Guide.

Before you begin

Before you begin the installation, you must set up a network share so that server and client computers can access the installation files. Ensure that all Analyst users have NTFS permissions of Modify.

Procedure

1. Insert the CD for IBM Cognos Planning Server or go to the installation source file directory.
   The Welcome page of the installation wizard appears when you insert the CD.
   If no Welcome page appears or you are not installing from the CD, go to the win32 directory, and double-click issetup.exe.
   If you are using Microsoft Windows Vista and UAC is enabled, right-click issetup.exe, and select Run As Administrator.
2. Select the language to use for the installation.
   The language that you select determines the language of the user interface. You can change the language to any of the installed languages after installation.
3. In the Component Selection screen, select Analyst UNC Connection Point, and clear all other components.
4. In the Analyst UNC Install Location screen, type the UNC path for the shared directory to which you want the network installation point installed.
5. In the Finish page of the installation wizard,
   • If you want to configure Content Manager immediately, click Start IBM Cognos Configuration.
   • If you want to see late-breaking information about IBM Cognos components, click View the Readme.
6. Click Finish.

Uninstall IBM Cognos

It is important to use uninstall programs to completely remove all files and modifications to system files.
If you no longer require IBM Cognos or if you are upgrading, uninstall all IBM Cognos components and the IBM Cognos service.

If you installed more than one component in the same location, the uninstall wizard lets you choose the packages to uninstall. All components of the package will be uninstalled. You must repeat the uninstallation process on each computer that contains IBM Cognos components.

It is not necessary to back up the configuration and data files on Microsoft Windows. These files are preserved during the uninstallation.

Close all programs before you uninstall IBM Cognos. Otherwise, some files may not be removed.

Uninstalling does not remove any files that changed since the installation, such as configuration and user data files. Your installation location remains on your computer, and you retain these files until you delete them using Windows Explorer.

**Important:** Do not delete the configuration and data files if you are upgrading to a new version of IBM Cognos and you want to use the configuration data with the new version.

**Procedure**

1. From the **Start** menu, click **Programs, IBM Cognos, Uninstall IBM Cognos**. The **Uninstall** wizard appears.

   **Tip:** IBM Cognos is the default name of the Program Folder that is created during the installation. If you chose another name, go to that folder to find the program.

2. Follow the instructions to uninstall the components.

   The cognos_uninst_log.htm file records the activities that the Uninstall wizard performs while uninstalling files.

   **Tip:** To find the log file, look in the Temp directory.

3. Delete all temporary Internet files.

   For more information, see your Web browser documentation.
Chapter 11. Additional Configuration Options

After you install one or more IBM Cognos Planning components on your computer, you must configure them to work in your IBM Cognos environment. Initially, default property settings are used to configure the components. However, you may want to change these default settings if existing conditions make the default choices inappropriate, or to better suit your environment.

Other configuration tasks are optional and depend on your IBM Cognos environment. Use these optional configuration tasks to customize your configuration so that IBM Cognos Planning easily integrates into your existing environment. For example, you can configure features for IBM Cognos Application Firewall or specify the amount of resources IBM Cognos uses. Also, you can deliver IBM Cognos content using any other portal by configuring Portal Services.

You can configure IBM Cognos Planning to use other resources, such as using an authentication provider and then enabling single signon for the database connection and the users.

If you use a load-balancing scheme in your environment, you can change settings to improve performance. For example, you can balance requests among dispatchers by changing their processing capacity or by setting the minimum and maximum number of processes and connections. For more information about tuning server performance, see the Administration and Security Guide.

Start IBM Cognos Configuration

Use the configuration tool, IBM Cognos Configuration, to configure IBM Cognos, or to start and stop IBM Cognos services.

- From the Start menu, click Programs > IBM Cognos 10 > IBM Cognos Configuration.

Changing Default Configuration Settings

When you install IBM Cognos components, the installation uses default configuration settings. If you have any reason not to use these default values, such as a port is being used by another process, use IBM Cognos Configuration to change the value.

If you change the value of a property, you must save the configuration and then restart the IBM Cognos service to apply the new settings to your computer.

For distributed installations, ensure that you configured all computers where you installed Content Manager before you change default configuration settings on other IBM Cognos computers. For example, you can

- change a URI
- configure cryptographic settings
- configure IBM Cognos components to use IBM Cognos Application Firewall
- configure the gateway to use a namespace
- enable and disable services
- change the notification database
Port and URI Settings

You can change certain elements in a URI depending on your environment. An IBM Cognos URI contains the following elements:

- For a Content Manager URI, Dispatcher URI for external applications, or dispatcher URI
  protocol://host_name_or_IP:port/context_root/alias_path

- For a Gateway URI or a Web content URI
  protocol://host_name_or_IP:port/virtual_directory/gateway_application
  or
  protocol://host_name_or_IP:port/context_root/alias_path

The elements are described in the following table:

<table>
<thead>
<tr>
<th>Table 44. IBM Cognos URI elements and descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element</strong></td>
</tr>
<tr>
<td>protocol</td>
</tr>
<tr>
<td>Example: http or https</td>
</tr>
<tr>
<td>host name or IP</td>
</tr>
<tr>
<td>In a distributed installation, you must change the localhost element of a URI.</td>
</tr>
<tr>
<td>Example: localhost or 192.168.0.1 or [2001:0db8:0000:0000:0000:148:57ab]:80</td>
</tr>
<tr>
<td>port</td>
</tr>
<tr>
<td>The default port for the IBM Cognos BI services is 9300. The default port for a Web server is 80.</td>
</tr>
<tr>
<td>Example: 9300 or 80</td>
</tr>
<tr>
<td>context root</td>
</tr>
<tr>
<td>Example: p2pd</td>
</tr>
<tr>
<td>alias path</td>
</tr>
<tr>
<td>The alias path must not be modified or IBM Cognos components will not function properly.</td>
</tr>
<tr>
<td>Example: servlet/dispatch</td>
</tr>
<tr>
<td>virtual directory</td>
</tr>
<tr>
<td>For example, in the default Gateway URI of <a href="http://localhost:80/ibmcognos/cgi-bin/cognos.cgi">http://localhost:80/ibmcognos/cgi-bin/cognos.cgi</a>, the virtual directory is ibmcognos/cgi-bin.</td>
</tr>
<tr>
<td>Example: ibmcognos/</td>
</tr>
</tbody>
</table>
Table 44. IBM Cognos URI elements and descriptions (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>gateway application</td>
<td>Specifies the name of the Cognos gateway application that is used. For example, if you are accessing IBM Cognos components using a Common Gateway Interface (CGI), then the default gateway application would be cognos.cgi.</td>
</tr>
<tr>
<td></td>
<td><strong>Example</strong>: cognos.cgi</td>
</tr>
</tbody>
</table>

Change a Port or URI Setting

Use the following procedure to change URI properties in IBM Cognos Configuration.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the **Explorer** window click the appropriate group or component:
   - To change an element for the dispatcher, click **Environment**.
   - To change an element for the local log server, under **Environment**, click **Logging**.
3. In the **Properties** window, click the **Value** box next to the URI property that you want to change.
4. Select the element and type the new information.
5. From the **File** menu, click **Save**.

Configuring Cryptographic Settings

IBM Cognos components require a cryptographic provider; otherwise they will not run. If you delete the default cryptographic provider, you must configure another provider to replace it.

You can configure the following cryptographic settings:
- general cryptographic settings
- settings for the default cryptographic provider
- settings for a cryptographic provider in an Entrust security infrastructure

**Configure General Cryptographic Settings**

In a distributed installation, IBM Cognos computers communicate with Content Manager to establish trust and obtain some cryptographic keys from Content Manager.
If you change the cryptographic keys in Content Manager, such as by changing application servers or reinstalling Content Manager, you must delete the cryptographic keys on the other IBM Cognos computers. You must then save the configuration on each computer so that they obtain the new cryptographic keys from Content Manager. In addition, all IBM Cognos components in a distributed installation must be configured with the same cryptographic provider settings.

Also, in a distributed environment, the symmetric key should only be stored on computers where Content Manager has been installed.

You can configure the following general cryptographic settings:

- common symmetric key store (CSK) properties
  - The CSK is used by IBM Cognos to encrypt and decrypt data.
- secure sockets layer (SSL) settings
  - These include mutual authentication and confidentiality.
- advanced algorithm settings
  - These include signing and digest algorithms.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the **Explorer** window, under **Security**, click **Cryptography**.
3. In the **Properties** window, change the default values by clicking the **Value** box and then selecting the appropriate value:
   - On computers that do not contain Content Manager, if you do not want to store the CSKs locally, under **CSK settings**, change **Store symmetric key locally** to **False**.
     - When **Store symmetric key locally** is **False**, the key is retrieved from Content Manager when required. The **Common symmetric key store location** property is ignored.
   - If you want to change the digest algorithm, for the **Digest algorithm** property, select another value.
4. From the **File** menu, click **Save**.
5. Test the cryptographic provider on a gateway computer only. In the **Explorer** window, right-click **Cryptography** and click **Test**.
   - IBM Cognos components check the availability of the symmetric key.

**Results**

After you configure the cryptographic settings, passwords in your configuration and any data you create are encrypted.

**Configure Settings for the Default Cryptographic Provider**

You can configure some cryptographic settings for the cryptographic provider.

The configurable settings include the following:

- algorithms and ciphersuites
- identity name settings
- signing key store properties
  - The signing key pair includes the private key used to generate the digital signature and the public key used to verify authenticity.
- encryption key store properties
The encryption key pair includes the private key used to encrypt data and the public key used to decrypt data.

- certificate authority settings
  These include properties for the provided certificate authority (CA) or a third-party CA.

**Procedure**

1. If you are using a JRE other than the one provided with IBM Cognos server, ensure that the following files from IBM Cognos exist in the location where the JRE is installed:
   - From `c10_location/bin/jre/version/lib/ext`, copy `bcprov-jdk14-134.jar` to `JRE_location/lib/ext`.
   - From `c10_location/bin/jre/version/lib/security`, copy `local_policy.jar` and `US_export_policy.jar` to `JRE_location/lib/security`.
     If you are using 64-bit components, copy the files from `c10_location/bin64` rather than `c10_location/bin`.

2. If you are using a JRE other than one IBM provides, you must also download and install the unrestricted Java Cryptograph Extension (JCE) policy file for your JRE to ensure that all available algorithms and cipher suites are shown in IBM Cognos Configuration.


4. In the **Explorer** window, under **Security, Cryptography**, click **Cognos**.

5. In the **Properties** window, change the properties as needed.
   - To configure the confidentiality algorithm, under the appropriate property, **Confidentiality algorithm** or **PDF Confidentiality algorithm**, click in the **Value** column and then select the algorithm from the drop-down list.

   The value of a confidentiality algorithm determines how data is encrypted by IBM Cognos components. For example, database passwords entered in IBM Cognos Configuration are encrypted when you save the configuration. The algorithm selected when the data is encrypted must also be available for the data to be decrypted at a later date.

   The availability of confidentiality algorithms can change if there are changes to your environment. For example, if your Java Runtime Environment (JRE) has changed or if you have installed other cryptographic software on the computer. You must ensure that the **Confidentiality algorithm** that was selected when the data was encrypted is also available when you want to access the data.

   If you have made changes to a computer, such as upgraded the JRE or installed software that has upgraded the JRE, this may affect the availability of confidentiality algorithms. To ensure that the available algorithms and cipher suites are shown in IBM Cognos Configuration, download and install the unrestricted Java Cryptography Extension (JCE) policy file. For Java that IBM provides, the unrestricted JCE policy file can be downloaded from

   - To adjust the cipher suites, under **Supported ciphersuites**, click in the **Value** column and then click the edit button.

     Remove the cipher suites that are not applicable and move the remaining cipher suites up or down in the list so that the cipher suites in the highest range are higher in the list.
Do not mix cipher suites in the 40- to 56-bit range with cipher suites in the 128- to 168-bit range.

- To change the location of the signing keys, under **Signing key settings**, change the **Signing key store location** property to the new location.
- To change the location of the encryption keys, under **Encryption key settings**, change **Encryption key store location** to the new location.
- To use another certificate authority, under **Certificate Authority settings**, change **Use third party CA** to **True**.

You must also ensure that you use the same values for the `-k` parameter as you used for the **Signing key store location** and **Encryption key store location** properties.

6. From the **File** menu, click **Save**.

**Results**

If you use another Certificate Authority (CA) server, configure IBM Cognos components to use the CA. For more information, see the topic about configuring IBM Cognos to use another certificate authority in this guide.

**Configure Cryptographic Provider Settings in an Entrust Security Infrastructure**

To configure encryption in an Entrust security infrastructure, you replace the default cryptographic provider in IBM Cognos Configuration with a provider that you configure for Entrust and then you update security files in your IBM Cognos environment.

**Before you begin**

Ensure that the key store passwords match the one in your Entrust Profile (EPF).

To prevent gateway errors, ensure that the Internet Guest Account has read and write permission to the Entrust .epf file and read permission to the Entrust .ual file.

**Procedure**

1. If you are using a JRE other than the one provided with IBM Cognos server, ensure that the following files from IBM Cognos and Entrust exist in the location where the JRE is installed:
   - From `c10_location/bin/jre/version/lib/ext`, copy `bcprov-jdk14-134.jar` to `JRE_location/lib/ext`.
   - From `c10_location/bin/jre/version/lib/security`, copy `local_policy.jar` and `US_export_policy.jar` to `JRE_location/lib/security`.
   - From the Entrust Authority Security Toolkit that you download from Entrust, copy the .jar file, such as `enttoolkit.jar`, to `JRE_location/lib/ext`.

   If you are using 64-bit components, copy the `bcprov-jdk14-134.jar`, `local_policy.jar`, and `US_export_policy.jar` files from `c10_location/bin64` rather than `c10_location/bin`.

2. To ensure that all available algorithms and cipher suites are shown in IBM Cognos Configuration, download and install the unrestricted Java Cryptography Extension (JCE) policy file. For Java that IBM provides, the unrestricted JCE policy file can be downloaded from [https://www14.software.ibm.com/webapp/iwm/web/preLogin.do?source=jcesdk](https://www14.software.ibm.com/webapp/iwm/web/preLogin.do?source=jcesdk)

4. In the **Explorer** window, under the **Security** group, click **Cryptography**.

5. In the **Properties** window, under **Advanced algorithm settings**, change the **Digest algorithm** to the appropriate message digest or secure hash algorithm for your security policy.

6. In the **Explorer** window, under the **Security** group and the **Cryptography** component, right-click the **IBM Cognos** resource, and click **Delete**.

7. Under the **Security** group, right-click **Cryptography**, and click **New resource > Provider**.

8. In the **Name** field, type a name for the encryption service you are creating.

9. In the **Type** field, click the arrow, and click **Entrust**, and then click **OK**.

   A branch with the name you assigned appears below **Cryptography**.

10. Click the branch you created.

    Resource properties appear in the properties window.

11. In the **Properties** window, enter the appropriate values, as listed in the following table.

### Table 45. Cryptography property values and descriptions

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INI file location</td>
<td>The location of the Entrust initialization file (.ini).</td>
</tr>
<tr>
<td>Identity file distinguished name (DN)</td>
<td>The distinguished name associated with the profile of the Entrust identity.</td>
</tr>
<tr>
<td>Identity file location</td>
<td>The location of the Entrust identity profile file (.epf).</td>
</tr>
<tr>
<td>Use Entrust Server Login</td>
<td>The parameter that controls whether users must enter a password to log on to the Entrust PKI.</td>
</tr>
<tr>
<td>Identity file password</td>
<td>The Entrust Profile password, which must match the one in your Entrust Profile (EPF).</td>
</tr>
<tr>
<td>Confidentiality algorithm</td>
<td>The level of encryption that is required to comply with your security policy.</td>
</tr>
<tr>
<td>PDF Confidentiality algorithm</td>
<td>The encryption algorithm to use when encrypting PDF data.</td>
</tr>
<tr>
<td>Supported ciphersuites</td>
<td>The cipher suites that are supported in your security environment. Remove the ones that are not applicable and rearrange the remaining cipher suites from highest to lowest. This ensures that the most secure cipher suite is used first.</td>
</tr>
<tr>
<td>Signing Key Store Location</td>
<td>The location of the key store that contains the signing key pairs.</td>
</tr>
<tr>
<td>Encryption Key Store Location</td>
<td>The location of the key store that contains encryption key pairs.</td>
</tr>
</tbody>
</table>
Important: Record your passwords in a secure location.

12. From the File menu, click Save.
13. Update to Entrust Java Toolkit 7.2 SP2 Patch 152842.

IBM Cognos Application Firewall

IBM Cognos Application Firewall analyzes and validates HTTP and XML requests before they are processed by IBM Cognos servers. IBM Cognos Application Firewall may modify these HTTP and XML requests.

IBM Cognos Application Firewall protects IBM Cognos Web products from malicious data. The most common forms of malicious data are buffer overflows and cross-site scripting (XSS) attacks, either through script injection in valid pages or redirection to another Web site.

You can track firewall activity by checking the log file, which contains rejected requests. By default, log messages are stored in the $c10_location/logs/cogserver.log file.

All Cognos Application Firewall settings must be the same for all computers where IBM Cognos Application Tier Components are installed within a distributed environment. For example, if Cognos Application Firewall is disabled on some computers and enabled on others, unexpected behavior and product errors may result.

The following types of URLs are accepted by Cognos Application Firewall validation:

- fully qualified (absolute) URLs
  - in the format $protocol://$host:$port/$path, where $protocol$ is http or https and $host$ is validated against the valid domain list
- URLs relative to the Web installation directory
  - in the format /$Web_installation_root/.* where $Web_installation_root$ is the gateway Web directory, based on the ibmcognos alias that you configured on your Web server.
  - For example, /ibmcognos/ps/portal/images/action_delete.gif
- specific allowed URLs, including the following (all case insensitive)
  - about:blank
  - JavaScript:window.close( )
  - JavaScript:parent.close( )
  - JavaScript:history.back( )
  - parent.cancelErrorPage( )
  - doCancel( )

Configure IBM Cognos Components to Use IBM Cognos Application Firewall

Using IBM Cognos Configuration, you can change settings for other XSS tool support, and you can add host and domain names to the IBM Cognos list of valid names.

Procedure

1. On each computer where an IBM Cognos Planning Server has been installed, start IBM Cognos Configuration.
2. In the Explorer window, under Security, click IBM Cognos Application Firewall.

3. In the Properties window, for the Enable CAF validation property, set the appropriate values.
   By default, IBM Cognos Application Firewall is enabled.

   **Important:** The IBM Cognos Application Firewall is an essential component of IBM Cognos security, helping to provide protection against penetration vulnerabilities. Disabling the IBM Cognos Application Firewall will remove this protection. Under normal circumstances, do not disable the IBM Cognos Application Firewall.

4. If you are using another XSS tool that checks for specific characters in GET request parameters, in the Properties window, for the Is third party XSS checking enabled property, change the value to True.
   The default characters that are prohibited include >, <, and '.

5. Add host and domain names to the IBM Cognos list of valid names:
   * For the Valid domains and hosts property, click the value and then click the edit button.
   * In the Value - Valid domains or hosts dialog box, click Add.
     You must include the domains from all hyperlinks that are added in IBM Cognos Connection. For more information, see the topic about creating a URL in the Administration and Security Guide.

   **Tip:** If you are using drill-through from IBM Cognos Series 7 to reports in IBM Cognos BI, add the hostnames of the IBM Cognos Series 7 gateway servers to the list.

5. In the blank row of the table, click and then type the host or domain name.
   To allow a domain and all its sub-domains, use a wildcard character at the beginning of the domain name.
   For example, *.mycompany.com
   * Repeat the previous two bulleted steps for each name to be added.
   * Click OK.
   IBM Cognos Application Firewall validates domain and host names to protect URLs that are created. By default, IBM Cognos Application Firewall considers domain names derived from the environment configuration properties to be safe domain names. Adding names to the list of valid names and hosts is useful when you need to redirect requests to non-IBM Cognos computers using the Back or Cancel functions or when using drill-through to different IBM Cognos product installations.

6. Save the configuration.

7. Restart the services.

---

**Configure the Gateway to Use a Namespace**

If IBM Cognos components use multiple namespaces, or if anonymous access is enabled and IBM Cognos components use one namespace, you can configure the gateway to connect to one namespace. Users logged onto the Web server where the gateway is located are not prompted to choose an authentication source. For example, if you have two Web servers, you can configure each Web server to use a different namespace.
Procedure
1. On the computer where the gateway is located, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, in the Value box next to the Gateway namespace property, type the Namespace ID of the namespace that you want to use.
4. From the File menu, click Save.
5. Restart your Web server.

Enable and Disable Services
In a distributed installation, you can send certain types of requests to specific computers by enabling or disabling the installed services.

Note: The default values for dispatcher service and presentation service are false on computers that only have Content Manager installed. On all other types of installations, the default values are true.

If you installed all components on several computers, you can disable appropriate services on each computer to get the distributed configuration you require. Requests are only sent to dispatchers where a given service is enabled.

Disabling a service prevents the service from loading into memory. When disabled, services do not start and therefore do not consume resources. The service does not run until you enable it.

If you disable the dispatcher service, the dispatcher-related services are disabled. Only dispatcher services that are enabled can process requests.

Enabling and disabling services
Use the following procedure to disable selected services on components in a distributed installation.

Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer window, under Environment, click IBM Cognos services.
3. In the Properties window, click the Value next to the service that you want to disable or enable.
   By default, all services are enabled.
4. Click the appropriate state for the services:
   • To disable the service, click False.
   • To enable the service, click True.
   For example:
   • for a Planning job server, you must enable the dispatcher service, the monitoring service, and the Planning job service. All other services can be disabled.
   • for a Planning data server, you must enable the dispatcher service, the monitoring service, and the Planning data service.
   • for a Planning administration server, you must enable the dispatcher service, the monitoring service, and the Planning administration console service.
   • for a Planning Web server, you must enable the dispatcher service, the monitoring service, and the Planning Web service.
If you are configuring role-based Planning servers, you must also ensure that at least one Planning server has all the other IBM Cognos services running.

5. From the File menu, click Save.

**Changing the Location of Temporary Report Output**

When users run interactive reports, the report output is stored in Content Manager or in a temporary session cache in the local report file system. You can change the location of the temporary session cache to a remote computer such as a shared directory on a Microsoft Windows based system or a common mounted directory on a UNIX or Linux based system.

By default, the location of the temporary session cache on the report file system is `c10_location/temp/Session`. The Session directory is created by the report server when the first request from a user session is received.

To configure whether the temporary report output is stored in Content Manager or in the local report file system, see the topic about storing user session files on a local report file system in the Administration and Security Guide.

**Procedure**

1. On the computer where Application Tier Components are installed, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, click the value for Temporary files location, and then click the edit button.
4. In the Select Folder dialog box, use the Save in box to locate the computer and directory, and then click Select.
5. From the File menu, click Save. When a user runs an interactive report session, the temporary report output is now stored in the new location.

---

**Change the Notification Database**

By default, the notification server uses the same database that Content Manager uses for the content store. You can use a separate database for notification in situations where you run large volumes of batch reports and email.

Using a separate database for notification involves the following tasks:

- Create a notification database.
  
  For DB2, Oracle, Microsoft SQL Server, or Sybase, use the same procedure that was used to create the content store database.

- Set up the database connectivity.
  
  You can use the same procedure as to set the connectivity for the content store database, “Set Database Connection Properties for the Content Store” on page 61.

  - Change the connection properties for the notification database
Change the Connection Properties for the Notification Database

After you create a separate database for notification, you must configure IBM Cognos components to use the new database.

You must configure all Content Managers and Application Tier Components to use the same notification database.

**Procedure**

1. In each location where Content Manager or Application Tier Components is installed, start IBM Cognos Configuration.
2. In the **Explorer** window, under **Data Access**, click **Notification**.
3. Identify the database that is used for notification:
   - In the Explorer window, right-click **Notification** and select **New resource > Database**.
   - Type a name for the database resource.
   - Select the type of database from the pull-down menu.
   - Click **OK**.
4. In the **Properties** window, enter the values for the notification database resource.
5. From the **File** menu, click **Save**.
6. Test the notification. In the **Explorer** window right-click **Notification** and click **Test**.
   - This tests the database connection and the mail server connection.
   - If you have been using the content store database for notification, the schedules will be replicated in the tables of the new notification database.

**Results**

Ensure that the values used to identify the notification database resource are the same on all Content Manager and Application Tier Components computers. To use the default notification database, you do not have to edit the values in the **Properties** window.

---

**Configuring the SSL Protocol**

The Secure Sockets Layer (SSL) protocol is used to secure communication between IBM Cognos components installed on the same computer or on different computers.

In addition, you may want to set up SSL connections between IBM Cognos components and other servers. You must ensure that SSL is set up for the other servers before you set up a shared trust between IBM Cognos components and the other servers.

Use the following checklist to configure SSL protocol.

- Configure SSL for IBM Cognos components. For more information, see “Steps to Configure SSL for IBM Cognos Components” on page 194.
- Set up shared trust between IBM Cognos components and other servers, if required. For more information, see “Set Up Shared Trust Between IBM Cognos Servers and Other Servers” on page 195.
Select and rank Cipher Suites to be used in an SSL connection, if required. For more information, see “Select and Rank Cipher Suites for SSL” on page 195.

Enable SSL on your Web server. For more information, see “Enable SSL on the Web Server” on page 196.

After configuring the SSL protocol, you can select and rank cipher suites, which control the quality of protection used in the SSL connection.

**Configure SSL for IBM Cognos Components**

You can configure IBM Cognos components to use the SSL protocol for

- internal connections only
- external connections only
- internal and external connections
- connections to local and remote log servers

If you configure SSL for internal connections only, IBM Cognos components on the local computer communicate using this protocol. The dispatcher listens for secure connections on a different port than for remote, http requests. Therefore, you must configure two dispatcher URIs.

If you configure SSL for external connections only, communications from remote IBM Cognos components to the local computer use the SSL protocol. You must configure the dispatcher to listen for secure, remote requests on a different port than local, HTTP requests. You must also configure the Content Manager URIs and the dispatcher URI for external applications to use the same protocol and port as the external dispatcher.

If you configure SSL for all connections, the dispatcher can use the same port for internal and external connections. Similarly, if you do not use SSL for local or remote communication, the dispatcher can use the same port for all communications.

You must also update the Content Manager URIs, Dispatcher URI for external applications, and Gateway URI to use SSL, if required.

**IBM WebSphere Liberty Profile connectors**

If the internal dispatcher URI is prefixed with http but the external dispatcher URI is prefixed with https, or vice versa, both the non-SSL Liberty HTTP/1.1 and SSL Liberty HTTP/1.1 connectors are enabled in the server.xml file.

If the internal and external dispatcher URIs use different protocols or ports, the internal dispatcher port is accessible only to the components on the local computer. The internal dispatcher URI must also specify localhost.

**Single Computer Installations**

In single computer installations, if you are running IBM Cognos without SSL, you must stop the service before adding SSL to your configuration. After you save the configuration with SSL settings, you can restart the service.
Distributed Installations

In distributed installations, if you are using the IBM Cognos certificate authority service, you must first configure all IBM Cognos computers to use the non-secure (http) protocol before you configure IBM Cognos components to use the SSL protocol. You must do this because you cannot set up the SSL protocol before trust has been established.

Also, ensure that you follow the required order of configuring computers in a distributed environment. That means that you must first configure the computer where the default active Content Manager is installed and then start the services on this computer before you configure other computers or start services on other computers. By first configuring the default active Content Manager computer and starting the services, you ensure that the certificate authority service on the default active Content Manager computer can issue certificates to other computers in the IBM Cognos environment.

After you configure all computers in the distributed installation to use the default, non-secure protocol, test your installation to ensure that IBM Cognos components are working properly. After you test your installation, you can configure the SSL protocol.

When you configure IBM Cognos to use the SSL protocol, ensure that you first configure the default active Content Manager computer to use the protocol and start the services on the default active Content Manager computer. After you do this, you can configure the SSL protocol on other IBM Cognos computers in your environment.

Add a Computer to an Installation

If you add a computer to an SSL-enabled environment, you will be prompted to temporarily accept trust for a certificate when you save the configuration. Accepting the temporary certificate will allow permanent trust to be established with the Content Manager computer.

Add a Component to a Computer

You can later add a component to the same location as other IBM Cognos components. If you add the component to a different location on the same computer as other IBM Cognos components, you will be prompted to temporarily accept trust for a certificate when you save the configuration. Accepting the temporary certificate will allow permanent trust to be established between the new component and the Content Manager computer.

Steps to Configure SSL for IBM Cognos Components

Use this procedure to configure SSL for internal connections, external connections, or all connections.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, type the appropriate values for the Internal dispatcher URI and External dispatcher URI values:
To configure SSL for internal connections only, for the **Internal dispatcher URI** property, type **https** and a port for SSL communication. For the **External dispatcher URI** property, type **http** and use the default or another available port. The ports in the two dispatcher URIs must be different.

To configure SSL for external connections only, for the **External dispatcher URI** property, type **https** and a secure port. For the **Internal dispatcher URI** property, type **http** and use the default or another available port. The ports in the two dispatcher URIs must be different.

To configure SSL for all connections, type the same URI for both the **Internal dispatcher URI** and **External dispatcher URI** properties. Type **https** and a secure port, such as 9343.

**Note:** You do not have to use port 9343, the default SSL port. You can choose any available port.

4. Configure the SSL protocol for the other environment URIs, including the **Content Manager URIs**, the **Dispatcher URI for external applications**, and **Gateway URI**.
   - For internal connections only, type **https** in the URIs that contain localhost.
   - For external connections only, type **https** in the URIs that do not contain localhost.
   - For all connections, type **https** in all the URIs.

5. In the **Explorer** window, click **Security > Cryptography**.

6. To use SSL protocol, you must specify passwords for the IBM Cognos encryption key stores. There are more settings under **Security > Cryptography > Cognos**.

7. From the **File** menu, click **Save**.

**Set Up Shared Trust Between IBM Cognos Servers and Other Servers**

If you want to use the default IBM Cognos certificate authority and you want to use SSL for connections from other servers to IBM Cognos servers, you must add the IBM Cognos certificate to the trust store on the other servers.

**Note:** If you use browsers to connect to IBM Cognos components, the browsers automatically prompt users to update their trust stores.

If you want the connection between IBM Cognos servers and the other server to be mutually authenticated, you must also copy the certificate from your certificate authority to the trust store for IBM Cognos servers.

If you have configured IBM Cognos components to use another certificate authority (CA), you do not have to set up shared trust between IBM Cognos server and other servers.

**Select and Rank Cipher Suites for SSL**

An SSL connection begins with a negotiation in which the client and server present a list of supported cipher suites in a priority sequence. A cipher suite provides the quality of protection for the connection. It contains cryptographic, authentication, hash, and key exchange algorithms. The SSL protocol selects the highest priority suite that the client and the server both support.
A list of supported cipher suites for SSL is provided. You can eliminate cipher suites that do not meet your requirements and then assign a priority, or preference, to the remaining cipher suites. The selected cipher suites are presented in priority sequence for the client and server sides of the negotiation. At least one of the selected cipher suites between the client and server platforms must match.

The list of supported cipher suites is dynamically generated on each computer, and depends on the Java Runtime Environment (JRE) or whether you have other cryptographic software installed on the computer. If you have made changes to a computer, such as upgraded the JRE or installed software that has upgraded the JRE, this may affect the supported cipher suites available on that computer. If you no longer have a supported cipher suite that matches the other computers in your environment, you may have to change the JRE on the computer to match the other computers in your environment.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window, click Cryptography > Cognos.
3. In the Properties window, click the Value column for the Supported ciphersuites property.
4. Click the edit button :pencil:.
   - To move a cipher suite to the Current values list, click the check box in the Available values list and then click Add.
   - To move a cipher suite up or down in the Current values list, click the check box and then click the up or down arrows.
   - To remove a cipher suite from the Current values list, click the check box and then click Remove.
5. Click OK.
6. From the File menu, click Save.

**Enable SSL on the Web Server**

Enable secure sockets layer (SSL) to encrypt a user's communication with the Web server.

To enable SSL on your Web server, you must obtain a Web server certificate signed by a Certificate Authority and install it into your Web server. The certificate must not be self-signed, because self-signed certificates will not be trusted by IBM Cognos components.

To enable IBM Cognos components to use an SSL-enabled Web server, you must have copies of the trusted root certificate (the certificate of the root Certificate Authority which signed the Web server certificate) and all other certificates which make up the chain of trust for the Web server's certificate. These certificates must be in Base64 encoded in ASCII (PEM) or DER format, and must not be self-signed. The certificates must be installed on every computer where you have installed Planning Server components.

For more information about installing certificates into your Web server, see your Web server documentation.
Procedure

1. Configure the Web server for SSL and start the Web server.
   For more information, see your Web server documentation.

2. On each Planning Server computer that points to the gateway, in IBM Cognos Configuration, change the gateway URI from HTTP to HTTPS, and save the configuration.
   Do not start the IBM Cognos service yet.

3. On each Planning Server computer, go to the $c10_location/bin directory and import all the certificates that make up the chain of trust, in order starting with the root CA certificate, into the IBM Cognos trust store.
   Import the certificates by typing the following command:
   ```
   ThirdPartyCertificateTool.bat -T -i -r certificate_fileName -D
   ./configuration/signkeypair -p password
   
   Note: The password should have already been set. If not, the default password is NoPassWordSet.
   
   4. On each Planning Server computer, in IBM Cognos Configuration, start the IBM Cognos service.

Results

You can verify trust, by creating and running a PDF report that contains pictures that are not stored locally but which the gateway gets from a remote computer. If the pictures appear, trust is established.

To avoid being prompted by a security alert for each new session, install the certificate into one of your Web browser’s certificate stores.

In addition, you may want to set up SSL connections between IBM Cognos components and other servers. You must ensure that SSL is set up for the other servers and then you must set up a shared trust between IBM Cognos components and the other servers.

Changing the Gateway

To improve web server performance, you can configure IBM Cognos to use alternate gateways that replace the default CGI program. You can use one of the following gateways:

- Microsoft Internet Server Application Programming Interface (ISAPI) for Microsoft Internet Information Services on Windows
- Apache Web Server module for Apache Web Server and IBM HTTP Server

There is no additional Web server configuration required to use ISAPI. To access IBM Cognos components using ISAPI, in IBM Cognos Configuration, change the cognos.cgi portion of the Gateway URI property to cognosisapi.dll. Then specify the ISAPI URI, `http://host_name/ibmcognos/isapi`, in your browser. If you use multiple Content Managers for failover protection, configure IBM Cognos to use an ISAPI gateway instead of the default CGI gateway. Otherwise, performance may be affected after failover.

Before you change the gateway, first ensure that the default CGI gateway and your configuration work in your environment.
Configure the Gateway for Apache Server 1.3

IBM Cognos provides three Apache modules. Use IBM Cognos Apache module for Apache Server 1.3.x.

Procedure

1. Stop Apache Web Server.
2. Append the c10_location/cgi-bin directory to the appropriate environment variable:
   - On Solaris or Linux, LD_LIBRARY_PATH
   - On HP-UX, SHLIB_PATH
   - On AIX®, LIBPATH
3. On HP-UX PA-RISC, do the following:
   - Ensure that the LD_PRELOAD environment variable contains /usr/lib/libcl.2.
   - Set the COG_CGIBIN_DIR environment variable to c10_location/cgi-bin.
4. Go to the Apache_installation/conf directory.
5. Open the httpd.conf file in an editor.
6. Add the following to the end of the load module list:
   
   LoadModule cognos_module "c10_location/cgi-bin/mod_cognos.suffix" 
   
   where suffix is as listed in the following table:

   **Table 46. Load module list settings for Configure the Gateway for Apache Server 1.3**

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Suffix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>dll</td>
</tr>
<tr>
<td>Solaris, AIX</td>
<td>so</td>
</tr>
<tr>
<td>HP-UX PA-RISC</td>
<td>sl</td>
</tr>
<tr>
<td>HP-UX IA®, Linux</td>
<td>so</td>
</tr>
</tbody>
</table>

7. Add the following to the end of the add module list:

   AddModule mod_cognos.cpp

8. Add the following Apache Directive:

   ScriptAlias /ibmcognos/cgi-bin "c10_location/cgi-bin"

   Alias /ibmcognos "c10_location/webcontent"

   <Directory "c10_location/webcontent">
   Options Indexes MultiViews
   </Directory>

   The <Directory> directive is optional.

   **Tip:** Ensure that you define the ibmcognos/cgi-bin alias before the ibmcognos alias.

9. Add the following to the server status reports section:

   <Location /ibmcognos/cgi-bin/mod_cognos.suffix>
   SetHandler cognos-handler
   </Location>
Enter the code exactly as specified, except for *suffix*. Replace *suffix* with the appropriate value from the table in step 6.

10. To enable the gateway diagnostic page, add the following to the server status reports section:

```xml
<Location /ibmcognos/cgi-bin/diag_mod_cognos.
suffix>
  SetHandler cognos-handler
</Location>
```

Enter the code exactly as specified, except for *suffix*. Replace *suffix* with the appropriate value from the table in step 6.

11. On Windows, Solaris, and AIX, add the following to the user directory section:

```xml
<IfModule mod_cognos.cpp>
  CGIBinDir "c10_location/cgi-bin"
</IfModule>
```

12. Save and close the file.


14. Users must then specify the Apache module URI in their browser, as follows

```
http://host_name:port/ibmcognos/cgi-bin/cognos_module
```

The cognos_module string must be entered exactly as specified.

For example,
```
http://123.432.154.12:5562/c10/cgi-bin/cognos_module
```

### Configure the Gateway for Apache Server 2.0 or IBM HTTP Server 6.1

IBM Cognos provides three Apache modules. Use IBM Cognos Apache 2 module for Apache Server 2.0.x and IBM HTTP Server 6.1.

#### Procedure

1. Stop the Web Server.
2. Append the `c10_location/cgi-bin` directory to the appropriate environment variable:
   - On Solaris or Linux, `LD_LIBRARY_PATH`
   - On HP-UX, `SHLIB_PATH` and `LD_LIBRARY_PATH`
   - On AIX, `LIBPATH`
3. On HP-UX PA-RISC, ensure that the `LD_PRELOAD` environment variable contains `/usr/lib/libcl.2`.
4. Go to the `Webserver_installation/conf` directory.
5. Open the `httpd.conf` file in an editor.
6. For successful portal integration, ensure that both `SERVERNAME` and `SERVER_PORT` are specified in the `ServerName` property.
7. Add the following to the end of the load module list:

```
LoadModule cognos_module "c10_location/cgi-bin/mod2_cognos.suffix"
```

where *suffix* is as listed in the following table:
Table 47. Load module settings for Configure the Gateway for Apache Server 2.0 or IBM HTTP Server 6.1

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Suffix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>dll</td>
</tr>
<tr>
<td>Solaris, AIX</td>
<td>so</td>
</tr>
<tr>
<td>HP-UX PA-RISC</td>
<td>sl</td>
</tr>
<tr>
<td>HP-UX IA, Linux</td>
<td>so</td>
</tr>
</tbody>
</table>

8. Add the following Apache Directive:
   ```
   ScriptAlias /ibmcognos/cgi-bin "c10_location/cgi-bin"
   Alias /ibmcognos "c10_location/webcontent"
   <Directory "c10_location/webcontent">
   Options Indexes MultiViews
   </Directory>
   
   The <Directory> directive is optional.
   
   Tip: Ensure that you define the ibmcognos/cgi-bin alias before the ibmcognos alias.
   ```

9. Add the following to the server status reports section:
   ```
   <Location /ibmcognos/cgi-bin/mod2_cognos.suffix>
   SetHandler cognos-handler
   </Location>
   
   Enter the code exactly as specified, except for suffix. Replace suffix with the appropriate value from the table in step 6.
   ```

10. To enable the gateway diagnostic page, add the following to the server status reports section:
    ```
    <Location /ibmcognos/cgi-bin/diag_mod2_cognos.suffix>
    SetHandler cognos-handler
    </Location>
    
    Enter the code exactly as specified, except for suffix. Replace suffix with the appropriate value from the table in step 6.
    ```

11. Add the following to the user directory section:
    ```
    <IfModule mod2_cognos.c>
    CGIBinDir "c10_location/cgi-bin"
    </IfModule>
    ```

12. Save and close the file.

13. On HP-UX, enable searching for SHLIB_PATH by running the following command in the Apache_installation/bin directory:
    ```
    chattr +s enable +b enable httpd
    ```


15. Users must then specify the Apache module URI in their browser, as follows:
    ```
    http://host_name:port/ibmcognos/cgi-bin/cognos_module
    ```
    The cognos_module string must be entered exactly as specified.
For example,

http://123.432.154.12:5562/c10/cgi-bin/cognos_module

Configure the Gateway for Apache Server 2.2.x or IBM HTTP Server 7.0

IBM Cognos provides three Apache modules. Use IBM Cognos Apache 2.2 module for Apache Server 2.2.x and IBM HTTP Server 7.1.

Procedure
1. Stop the Web server.
2. Append the c10_location/cgi-bin directory to the appropriate environment variable:
   - On Solaris or Linux, LD_LIBRARY_PATH
   - On HP-UX, SHLIB_PATH and LD_LIBRARY_PATH
   - On AIX, LIBPATH
3. On HP-UX PA-RISC, ensure that the LD_PRELOAD environment variable contains /usr/lib/libcl.2.
4. Go to the Apache_installation/conf directory.
5. Open the httpd.conf file in an editor.
6. For successful portal integration, ensure that both SERVER_NAME and SERVER_PORT are specified in the ServerName property.
7. Add the following to the end of the load module list:

   LoadModule cognos_module "c10_location/cgi-bin/mod2_2_cognos.suffix"

   where suffix is as listed in the following table:

<table>
<thead>
<tr>
<th>Operating system</th>
<th>Suffix</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>dll</td>
</tr>
<tr>
<td>Solaris, AIX</td>
<td>so</td>
</tr>
<tr>
<td>HP-UX PA-RISC</td>
<td>sl</td>
</tr>
<tr>
<td>HP-UX IA, Linux</td>
<td>so</td>
</tr>
</tbody>
</table>

8. Add the following Apache Directive:

   ScriptAlias /ibm cognos/cgi-bin "c10_location/cgi-bin"
   Alias /ibm cognos "c10_location/webcontent"
   <Directory "c10_location/webcontent">
   Options Indexes MultiViews
   </Directory>
   The <Directory> directive is optional.

   **Tip:** Ensure that you define the ibm cognos/cgi-bin alias before the ibm cognos alias.

9. Add the following Apache Directive:

   ScriptAlias /ibm cognos/cgi-bin "c10_location/cgi-bin"
Alias /ibmcognos "c10_location /webcontent"

<Directory "c10_location /webcontent">
  Options Indexes MultiViews
  AllowOverride None
  Options None
  Order allow,deny
  Allow from all
</Directory>

<Directory "c10_location /cgi-bin">
  AllowOverride None
  Options None
  Order allow,deny
  Allow from all
</Directory>

10. Add the following to the server status reports section:
    <Location /ibmcognos/cgi-bin/cognos_module>
      SetHandler cognos-handler
      Order allow,deny
      Allow from all
    </Location>
    Enter the code exactly as specified, including the cognos_module string.

11. To enable the gateway diagnostic page, add the following to the server status reports section:
    <Location /ibmcognos/cgi-bin/diag_cognos_module>
      SetHandler cognos-handler
      Order allow,deny
      Allow from all
    </Location>
    Enter the code exactly as specified, including the diag_cognos_module string.

12. On Windows, Solaris, and AIX, add the following to the user directory section:
    Add the following to the user directory section:
    <IfModule mod2_2_cognos.c>
      CGIBinDir "c10_location /cgi-bin"
    </IfModule>

13. Save and close the file.


15. Users must then specify the Apache module URI in their browser, as follows
    http://host_name:port/ibmcognos/cgi-bin/cognos_module
    The cognos_module string must be entered exactly as specified.
    For example,
    http://123.432.154.12:5562/c10/cgi-bin/cognos_module
Configure an IBM Cognos Business Intelligence UNIX Gateway for IBM Cognos BI Planning

If you have an IBM Cognos Business Intelligence (BI) environment running on UNIX, you can configure your existing UNIX gateway for IBM Cognos BI Planning rather than using two separate gateways.

To configure the gateway for IBM Cognos BI Planning, you must copy files from the installation files to the c10_location on your IBM Cognos BI gateway computer.

Procedure

1. Copy the following Planning gateway files to the UNIX gateway computer.
   a. In the installation source directory or on the IBM Cognos Planning Gateway disk, go to the zipfiles\win32 directory.
   b. Extract the zip file whose name begins with planwd-win32-gate- to a temporary directory.
   c. FTP the extracted webcontent\contributor folder to the c10_location/webcontent directory on your UNIX gateway computer.
   d. FTP the contents of the extracted vers folder to the c10_location/vers directory on your UNIX gateway computer.

2. Copy the following Planning gateway files to the UNIX gateway computer.
   a. In the installation source directory or on the IBM Cognos Planning Gateway disk, go to the zipfiles\win32 directory.
   b. Extract the zip file whose name begins with hal-win32-gate- to a temporary directory.
   c. FTP the extracted webcontent\hal folder to the c10_location/webcontent directory on your UNIX gateway computer.
   d. FTP the contents of the extracted webcontent\skins folder to the c10_location/webcontent directory on your UNIX gateway computer.

3. Copy the Contributor documentation to the UNIX gateway computer.
   a. In the installation source directory or on the IBM Cognos Planning Gateway disk, go to the zipfiles\win32 directory.
   b. Extract the zip files whose names begin with doccontribweb and docplanningrdm to a temporary directory.
   c. FTP the extracted webcontent\documentation folder to the c10_location/webcontent directory on your UNIX gateway computer.
   d. FTP the contents of the extracted vers folder to the c10_location/vers directory on your UNIX gateway computer.

4. On your UNIX gateway computer, add the component version information for the files that you copied.
   a. Go to the c10_location/vers directory and note the version number at the end of one of the planwd-win32-gate- file names; for example, 8.3.###.
   b. Go to the c10_location directory, and open the file named cmplst.txt in a text editor.
   c. On a new line, type the following text, including the version number you noted:

```
EPCONTRIBUTORSERVER_WEBDOWNLOADGATE_version= EPCONTRIBUTORSERVERWEBDOWNLOADGATE-AW-ML-RTM-8.3.###.###
```
   d. On a new line, type the following text:

```
EPCONTRIBUTORSERVER_WEBDOWNLOADGATE_name= Contributor Server Gateway Web Download
```

5. Configure your Planning Server and client computers to point to the UNIX gateway URI.
Some IBM Cognos products provide functionality that is not available in IBM Cognos 10 Planning. You can continue to use these products in the same environment. Additional configuration tasks may be required to ensure that IBM Cognos 10 Planning can access objects that were created using other IBM Cognos products. Additional requirements for access depend on how you choose to run the two products.

Accessing Product Documentation in an Integrated Environment

The documentation for IBM Cognos BI components is installed with the gateway component. If you integrate different IBM Cognos BI products, you can either use the same gateway or use separate gateways.

If you want to use the same gateway, all gateway components must be of the same product version, and you should install the IBM Cognos BI gateway component for each product into the same location on the same computer. This ensures that all the product documentation is available to all users. If you want to use separate gateways for each product, you can install the IBM Cognos BI gateway component for each product on separate computers, but the product documentation on each gateway will be specific for the IBM Cognos BI product you installed.

For example, you have IBM Cognos BI Business Intelligence and IBM Cognos BI Controller installed using separate gateways but sharing the same content store. When users access IBM Cognos Connection, both Report Studio and Controller are available, assuming they have permission for both components. If users access Report Studio through the IBM Cognos BI Business Intelligence gateway, they are able to use the component and access the documentation for that component. However, if users access Report Studio through the IBM Cognos BI Controller gateway, they are able to use the component but do not have access to the Report Studio documentation.

If you want users to access each IBM Cognos BI product through separate gateways, yet still be able to access documentation for all components, you can install each product’s gateway component into the same location as your other IBM Cognos BI gateway components.

Configuring IBM Cognos BI Components to Use Another Certificate Authority

By default, IBM Cognos BI components use their own certificate authority (CA) service to establish the root of trust in the IBM Cognos security infrastructure. You can configure IBM Cognos BI components to use another certificate authority, if you already have an existing certificate authority, such as iPlanet or Microsoft, in your reporting environment.

When you configure IBM Cognos BI components to use another certificate authority, ensure that you specify the same information in both the command line utility tool and in IBM Cognos Configuration.

Use the following checklist to configure IBM Cognos BI components to use another certificate authority.
1. **Generate IBM Cognos security keys and certificate signing requests** to use with your CA.
2. Submit the Cognos security keys and certificates to your third-party certificate authority.
3. **Configure IBM Cognos BI components to use a your certificate authority.**

**Command syntax for generating keys and certificate signing requests**

Use the command line utility to generate all the keys for the IBM Cognos key stores and to generate the certificate signing requests (CSR).

The following tables list the options for the command-line tool used to generate keys and signing requests.

**Table 49. Main operation mode**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-c</td>
<td>Create a new CSR</td>
</tr>
<tr>
<td>-i</td>
<td>Import a certificate</td>
</tr>
</tbody>
</table>

**Table 50. Operation modifiers**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-s</td>
<td>Work with the signing identity</td>
</tr>
<tr>
<td>-e</td>
<td>Work with the encryption identity</td>
</tr>
<tr>
<td>-T</td>
<td>Work with the trust store (only with -i)</td>
</tr>
</tbody>
</table>

**Table 51. Information flags**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-d</td>
<td>DN to use for certificate</td>
</tr>
<tr>
<td>-r</td>
<td>CSR or certificate file location (depends on mode)</td>
</tr>
<tr>
<td>-t</td>
<td>certificate authority certificate file (only with -i)</td>
</tr>
<tr>
<td>-p</td>
<td>Key Store password (must be provided)</td>
</tr>
<tr>
<td>-a</td>
<td>Key pair algorithm. RSA or DSA. Default: RSA</td>
</tr>
<tr>
<td>-D</td>
<td>Directory location</td>
</tr>
</tbody>
</table>

The sample values from the following table are used:

**Table 52. Sample values**

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signing certificate DN</td>
<td>CN=SignCert,O=MyCompany,C=CA</td>
</tr>
<tr>
<td>Encryption certificate DN</td>
<td>CN=EncryptCert,O=MyCompany,C=CA</td>
</tr>
<tr>
<td>Key store password</td>
<td>password</td>
</tr>
</tbody>
</table>
Generate Keys and Certificate Signing Requests
Use the following steps to generate all the keys for the IBM Cognos key stores and to generate the certificate signing requests (CSR).

Procedure
1. In the c10_location\configuration directory, back up the cogstartup.xml file to a secure location.
2. Back up the contents of the following directories to a secure location:
   - c10_location\configuration\signkeypair
   - c10_location\configuration\encryptkeypair
3. Using IBM Cognos Configuration, export the configuration in clear text by doing the following:
   - Open IBM Cognos Configuration.
   - From the File menu, click Export As.
   - When prompted about exporting decrypted content, click Yes.
   - In the Export As dialog box, select cogstartup.xml and then click Save.
   - When prompted about replacing the existing file, click Yes.
   - When the tasks are complete, close the IBM Cognos Configuration dialog box.
   - Save the configuration.
   - Close IBM Cognos Configuration.
4. Go to the c10_location\bin directory.
5. Create the certificate signing request for the signing keys by typing the following command:
   On UNIX or Linux operating system, type
   ```
   ThirdPartyCertificateTool.sh -c -s -d "CN=SignCert,O=MyCompany,C=CA" -r signRequest.csr -D ../configuration/signkeypair -p password
   ```
   On Microsoft Windows operating system, type
   ```
   ThirdPartyCertificateTool.bat c -s -d "CN=SignCert,O=MyCompany,C=CA" -r signRequest.csr -D ../configuration/signkeypair -p password
   ```
   Tip: UNIX or Linux filenames are case-sensitive and must be entered exactly as shown.
   You can safely ignore any warnings about logging.
   The command creates the jSignKeystore file in the signkeypair directory, sets the specified password, creates a new keypair and stores it in the keystore, and exports the signRequest.csr file to the c10_location\bin directory.
6. Create the certificate signing request for the encryption keys by typing the following command:
   On UNIX or Linux, type
   ```
   ThirdPartyCertificateTool.sh -c -e -d "CN=EncryptCert,O=MyCompany,C=CA" -r encryptRequest.csr -D ../configuration/encryptkeypair -p password
   ```
   On Windows, type
   ```
   ThirdPartyCertificateTool.bat c -e -d "CN=EncryptCert,O=MyCompany,C=CA" -r encryptRequest.csr -D ../configuration/encryptkeypair -p password
   ```
   You can safely ignore any warnings about logging.
The command creates the jEncKeystore file in the encryptkeypair directory, sets the specified password, creates a new keypair and stores it in the keystore, and exports the encryptRequest.csr file to the \texttt{c10\_location\_bin} directory.

7. Copy the signRequest.csr and encryptRequest.csr files that were generated in steps 5 and 6 to a directory that is accessible by your certificate authority.

8. Input the signRequest.csr and encryptRequest.csr files into the certificate authority.

The certificate authority produces a signing certificate and an encryption certificate.

For more information, see your CA documentation.

9. Copy the contents of the signing certificate into a file named signCertificate.cer.

10. Copy the contents of the encryption certificate into a file named encryptCertificate.cer.

11. Find the root CA certificate for the certificate authority and copy the contents into a file named ca.cer.

12. Copy ca.cer, signCertificate.cer, and encryptCertificate.cer to \texttt{c10\_location\_bin}. These files must be PEM (Base-64 encoded ASCII) format.

13. Import the signing certificate from step 10 into the IBM Cognos signing key store by typing the following command:

   
   On UNIX or Linux, type
   
   \texttt{ThirdPartyCertificateTool.sh -i -s -r signCertificate.cer -D ./configuration/signkeypair -p password -t ca.cer}
   
   On Windows, type
   
   \texttt{ThirdPartyCertificateTool.bat -i -s -r signCertificate.cer -D ./configuration/signkeypair -p password -t ca.cer}

   You can safely ignore any warnings about logging.

   The command reads the signCertificate.cer and ca.cer files in the \texttt{c10\_location\_bin} directory and imports the certificates from both files into the jSignKeystore file in the signkeypair directory using the specified password.

14. Import the encryption certificate from step 11 into the IBM Cognos encryption key store by typing the following command:

   
   On UNIX or Linux, type
   
   \texttt{ThirdPartyCertificateTool.sh -i -e -r encryptCertificate.cer -D ./configuration/encryptkeypair -p password -t ca.cer}
   
   On Windows, type
   
   \texttt{ThirdPartyCertificateTool.bat -i -e -r encryptCertificate.cer -D ./configuration/encryptkeypair -p password -t cacert.cer}

   You can safely ignore any warnings about logging.

   The command reads the encryptCertificate.cer and ca.cer files in the \texttt{c10\_location\_bin} directory and imports the certificates from both files into the jEncKeystore file in the encryptkeypair directory using the specified password.

15. Import the CA certificate from step 12 into the IBM Cognos trust store by typing the following command:

   
   On UNIX or Linux, type
   
   \texttt{ThirdPartyCertificateTool.sh -i -T -r ca.cer -D ./configuration/signkeypair -p password}
   
   On Windows, type
   
   \texttt{ThirdPartyCertificateTool.bat -i -T -r ca.cer -D ./configuration/signkeypair -p password}
ThirdPartyCertificateTool.bat -i -T -r ca.cer -D ../configuration/signkeypair -p password

The command reads the ca.cer file and imports the contents into the jCAKeystore file in the signkeypair directory using the specified password.

Results

The certificates are now ready to be configured for IBM Cognos BI.

Configure IBM Cognos BI Components to Run Within Another Certificate Authority

You must configure each IBM Cognos computer to use an external certificate authority by setting the appropriate property in IBM Cognos Configuration.

By setting this property, IBM Cognos BI components assume that all required keys have been generated and vetted by the external certificate authority.

Ensure that the key store locations and password in IBM Cognos Configuration match the ones you typed in the command-line tool.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Security > Cryptography, click Cognos.
3. In the Properties window, under Certificate Authority settings property group, click the Value box next to the Use third party CA property and then click True.

   **Note:** When you set this property to true, all properties for the certificate authority and identity name are ignored.

4. Configure the following properties to match the ones you typed in the command line utility:
   - Signing key store location
   - Signing key store password
   - Encryption key store location
   - Encryption key store password
   - Certificate Authority key store password

5. From the File menu, click Save.
6. If you want to start the IBM Cognos service, from the Actions menu, click Start.

   This action starts all installed services that are not running. If you want to start a particular service, select the service node in the Explorer window and then click Start from the Actions menu.

---

**Tuning Techniques for Improving Performance**

Changes in your environment can affect the performance of IBM Cognos Planning. Therefore, it is important to monitor and tune performance regularly. Monitoring performance means regularly gathering data about your usage and response times.

For more information about performance tuning, see the IBM Cognos Planning Architecture and Deployment Guide.
Tuning a DB2 Content Store

If you use a DB2 database for the content store, you can take steps to improve the speed with which requests are processed.

By default, DB2 assigns tables that contain large objects (LOBS) to a database-managed tablespace. As a result, the LOBS are not managed by the DB2 buffer pools. This results in direct I/O requests on the LOBS, which affects performance. By reassigning the tables that contain LOBS to a system-managed tablespace, you reduce the number of direct I/O requests.

Before changing a DB2 content store, allocate sufficient log space to restructure the database. To reconfigure the DB2 content store, do the following:

1. Export the data from the tables that contain at least one large object (LOB).
2. Create the tables in a system-managed table space.
3. Import the data into the tables.

Tuning WebSphere Liberty Profile

In production environments, tune the WebSphere Liberty Profile to allow for the maximum number of concurrent users you expect by adjusting the coreThreads and maxThreads values in the Advanced properties of the resources. These values set the core and maximum executor thread counts.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Environment, under IBM Cognos services click the Resources name (default is IBM Cognos).
3. In the Properties window, next to Advanced properties, click inside the Value box, and then click the edit icon .
4. Adjust the parameter values as needed.

Table 53. Service Resource parameter names and values

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>coreThreads</td>
<td>The core number of threads that the WebSphere Liberty Profile server starts up with. If this value is less than 0, a default value is used. This default value is calculated based on the number of hardware threads on the system.</td>
</tr>
<tr>
<td>maxThreads</td>
<td>The maximum number of threads that can be associated with the WebSphere Liberty Profile server.</td>
</tr>
</tbody>
</table>

For more information, refer to the WebSphere Liberty Profile knowledge center, [Tuning the Liberty profile](http://www.ibm.com/support/knowledgecenter/?lang=en#/SSEQTP_8.5.5/com.ibm.websphere.wlp.doc/ae/twlp_tun.html?cp=SSEQTP_8.5.5%2F1-3-11-0-7).

5. From the File menu, click Save.
Translated Product Documentation

The product installation includes a limited set of translated documentation for some languages, such as installation guides and release notes. To access a complete set of translated documentation, you must install it from IBM Cognos BI Supplementary Language Documentation.

Before you begin

Before installing the Supplementary Language Documentation, ensure that:

- IBM Cognos BI is installed and configured correctly
- adequate disk space is available to install supplementary language documentation
  You need at least 220 MB of disk space.
- your software environment is supported

Procedure

1. In the location where the Gateway component is installed, insert the IBM Supplementary Language Documentation disk or go to the directory where the installation files were downloaded and extracted.
   - On UNIX or Linux operating systems, mount the disk using Rock Ridge file extensions.
   - On Windows, the installation wizard starts automatically from the product disk.
2. To manually start the installation wizard, go to the operating system directory and do the following:
   - On Windows, if no Welcome page appears, double-click the issetup.exe file.
   - On UNIX or Linux, type
     ```
     ./issetup
     ```
   **Note:** When you use the issetup command with XWindows, Japanese characters may be corrupted.
3. Follow the instructions in the installation wizard to copy the required files to the same location where you installed gateway components for IBM Cognos BI. Install in a directory that contains only ASCII characters in the path name. Some Web servers do not support non-ASCII characters in directory names. The supplementary languages documentation components is selected by default.
4. Choose the option you want in the Finish page of the installation wizard.

Additional Language Fonts

To add support for the Japanese Yen or Korean Won character, you must install additional fonts from the IBM Cognos BI Supplementary Language Documentation disk.

The Unicode code point "U+005C" is officially assigned to the backslash. However, in Japan and Korea, that code point is historically assigned to their currency symbols and many people still prefer to see a yen or won sign in certain parts of software, for example in file paths. To accommodate this, you can install the “Andale WT J” and “Andale WT K” fonts.
Before you begin

Before installing the additional fonts, ensure that following conditions are met:

- IBM Cognos is installed and configured correctly.
- There is adequate disk space available to install additional fonts. You need at least 220 MB of disk space.
- Your software environment is supported.

Procedure

1. In the location where Application Tier Components are installed, insert the IBM Cognos BI Supplementary Language Documentation disk.
   - On UNIX or Linux operating systems, mount the disk using Rock Ridge file extensions.
2. Go to the directory on the disk that is appropriate for your operating system.
3. Start the installation wizard by typing the following command:
   - On Windows, `isssetup`
   - On UNIX or Linux, `.isssetup`
   
   **Note:** When you use the isssetup command with XWindows, Japanese characters may be corrupted.
4. Follow the instructions in the installation wizard to copy the required files to the same location where you installed Application Tier Components.
   - Install in a directory that contains only ASCII characters in the path name.
   - Some Web servers do not support non-ASCII characters in directory names.
   - When you are prompted to select components, clear **IBM Cognos Business Intelligence Supplementary Languages Documentation**, expand **Additional Language Fonts**, and then select the font.
   - These fonts are copied to the `c10_location/bin/fonts` directory. This font location is defined in the **Physical fonts location** property value in IBM Cognos Configuration under **Environment**. If you move the fonts to another location, ensure that the new location is added to the **Physical fonts location** property value.
   - Fonts used to display data in a report are selected using a matching process between the fonts requested when the report is designed and the fonts that are available when the report is rendered. For PDF output and charts, this process occurs on the server where all fonts on the server that generates the report can be used.
5. Choose the option you want in the **Finish** page of the installation wizard.

Results

After you install the additional fonts, you must configure support for them. For more information, see “Configure Support for Japanese Yen and Korean Won Characters.”

Configure Support for Japanese Yen and Korean Won Characters

For Japanese and Korean currency characters to display correctly, you must define the additional fonts in the global style sheet.
Before you begin

Before you configure these fonts, you must install them from the IBM Cognos BI Supplementary Language Documentation disk.

Procedure

   
   The GlobalReportStyles.css style sheet is located in the c10_location\bin
directory.

2. Enable one of the following sections and modify it as follows:
   
   • /* For Japanese: */
     
     .pg,
     .pp
     {
       font-family: 'MS UI Gothic', 'Andale WT J', Tahoma, arial, geneva, helvetica, sans-serif;
     }

   • /* For Korean: */
     
     .pg,
     .pp
     {
       font-family: Gulim, 'Andale WT K', Tahoma, arial, geneva, helvetica, sans-serif;
     }

   The PDF generator uses the first available font on the server and includes all
   the characters in the string to be displayed. If you prefer to use other fonts on
   your server, you can insert them into the list.


4. Restart the IBM Cognos BI server.

Results

Any changes that you make to the style sheet are overwritten if you upgrade IBM
Cognos BI. You must repeat this procedure following an upgrade.
Chapter 12. Setting Up an Unattended Installation and Configuration

Set up an unattended installation and configuration to install an identical configuration across several computers on your network, or automate the installation and configuration process by specifying options and settings for users.

Before you set up an unattended installation and configuration, ensure that all the system requirements and prerequisites are met and that all third-party products are installed and configured.

To set up an unattended installation and configuration:
1. configure a transfer specification file (.ats) to specify installation options
2. run the installation tool in silent mode
3. use a preconfigured configuration file from another computer
4. run the configuration tool in silent mode

After you complete these tasks, ensure that the IBM Cognos Planning installation directory on all computers is protected from unauthorized or inappropriate access.

Set Up an Unattended Installation

Use a transfer specification file (.ats) to copy IBM Cognos Planning components, including Analyst, to your computer without being prompted for information.

By default, each time you install IBM Cognos Planning components using the installation wizard, the options you select are recorded in a transfer specification file. Therefore, if you already installed IBM Cognos Planning components on a sample computer, you can use the generated transfer specification file as a template for unattended installations on different computers.

If you do not use the installation wizard to install components, you can use the default transfer specification file named response.ats that is available on the CD. You must modify the response.ats file for your environment before you can use it for an unattended installation.

You can check if the unattended installation was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

Setting up an unattended installation using a file generated by an installation on another computer

Complete the following steps to set up the unattended installation.

Procedure
1. Use the installation wizard to install IBM Cognos Planning components on your computer.
2. Go to c10Planning_location/instlog.
3. Locate the transfer specification file (.ats) that was generated:
• If you installed IBM Cognos Planning Server, the file name is ts-PLANSRVR-version-yyyyymmdd_hhmm.ats.
• If you installed IBM Cognos Planning Complete, the file name is ts-PLANCOMP-version-yyyyymmdd_hhmm.ats.
• If you installed IBM Cognos Planning Gateway, the file name is ts-PLANGATE-version-yyyyymmdd_hhmm.ats.
• If you installed IBM Cognos Planning Administration, the file name is ts-PLANADMIN-version-yyyyymmdd_hhmm.ats.
• If you installed IBM Cognos Planning Client, the file name is ts-PLANCLIENT-version-yyyyymmdd_hhmm.ats.

4. Copy the transfer specification file to the computer where you plan to install IBM Cognos Planning.

5. On the computer where you plan to install the software, insert the appropriate CD and copy the contents of the CD to your computer.

6. Open the transfer specification file that you copied in a text editor.

7. In the section named License Agreement, change the ACCEPTED= property to y.

8. Save the transfer specification file in the directory where you copied the contents of the installation CD.

9. Install IBM Cognos Planning:
   On UNIX or Linux operating systems, change to the directory where you copied the contents of the CD, and in the directory for your operating system, type the following command, where location is where you copied filename, the transfer specification file:
   `istsetup -s location/filename.ats`

Results

If zero (0) is not returned, check the log files for error messages. Errors are recorded in the installation directory in the following log file:
• For IBM Cognos Planning Server, the file name is tl-PLANSRVR-version-yyyyymmdd-hhmm_summary-error.txt.
• For IBM Cognos Planning Complete, the file name is tl-PLANCOMP-version-yyyyymmdd-hhmm_summary-error.txt.
• For IBM Cognos Planning Gateway, the file name is tl-PLANGATE-version-yyyyymmdd-hhmm_summary-error.txt.
• For IBM Cognos Planning Administration, the file name is tl-PLANADMIN-version-yyyyymmdd-hhmm_summary-error.txt.
• For IBM Cognos Planning Client, the file name is tl-PLANCLIENT-version-yyyyymmdd-hhmm_summary-error.txt.

If errors occur before sufficient initialization occurs, log messages are sent to one of the following log files in the Temp directory:
• For IBM Cognos Planning Server, the file name is tl-PLANSRVR-version-yyyyymmdd-hhmm.txt.
• For IBM Cognos Planning Complete, the file name is tl-PLANCOMP-version-yyyyymmdd-hhmm.txt.
• For IBM Cognos Planning Gateway, the file name is tl-PLANGATE-version-yyyyymmdd-hhmm.txt.
• For IBM Cognos Planning Administration, the file name is tl-PLANADMIN-version-yyyyymmdd-hhmm.txt.
• For IBM Cognos Planning Client the file name is tl-PLANCLIENT-version-yyyyymmdd-hhmm.txt.

Also ensure that the installation directory is protected from unauthorized or inappropriate access.

After all errors are resolved, you can set up an unattended configuration.

**Setting up an unattended installation using a response.ats file**

Complete the following steps to set up the unattended installation.

**Procedure**

1. On the target computer, insert the CD and copy the contents to your computer.
2. Go to the operating system directory and open the response.ats file in a text editor.
   Each section in the response.ats file corresponds to a dialog box in the installation wizard.
3. In the section named License Agreement, change the ACCEPTED= property to y.
4. Type the installation location of the program files for IBM Cognos Planning in APPDIR=location.

   **Tip:** There should be no space on either side of the equal sign, (=).
5. For the server components of IBM Cognos Planning, in the section named [Component List], next to each component:
   • To install the component, type 1
   • To not install the component, type 0

   **Note:** You do not select components for Analyst. All required files are installed.
6. For APPFOLDER= property in a Microsoft Windows operating system installation, type the name of the Start menu folder that contains your program shortcuts.

   **Tip:** To ensure that the shortcut folder is visible to all users, type for the ALLUSERS_FLAG= property.
7. For the install information in the [Install Conditions] section:
   • To specify that the condition is true, type 1
   • To specify that the condition is false, type 0
8. Save the response.ats file to a local directory after you make the necessary changes.
9. Go to the operating system directory.
10. At the command prompt type the following command, where location is the directory where you copied response.ats:
   • On Microsoft Windows operating systems,
   `isssetup -s location/response.ats`
   • On UNIX or Linux operating systems,
   `./isssetup -s location/response.ats`
Results

If zero (0) is not returned, check the log files for error messages. Errors are recorded in the installation directory in the following log file:

- For IBM Cognos Planning Server, the file name is tl-PLANSRVR-version-yyyyymmdd-hhmm_summary-error.txt.
- For IBM Cognos Planning Complete, the file name is tl-PLANCOMP-version-yyyyymmdd-hhmm_summary-error.txt.
- For IBM Cognos Planning Gateway, the file name is tl-PLANGATE-version-yyyyymmdd-hhmm_summary-error.txt.
- For IBM Cognos Planning Administration, the file name is tl-PLANADN-version-yyyyymmdd-hhmm_summary-error.txt.
- For IBM Cognos Planning Client, the file name is tl-PLANCLIENT-version-yyyyymmdd-hhmm_summary-error.txt.

If errors occur before sufficient initialization occurs, log messages are sent to one of the following log files in the Temp directory:

- For IBM Cognos Planning Server, the file name is tl-PLANSRVR-version-yyyyymmdd-hhmm.txt.
- For IBM Cognos Planning Complete, the file name is tl-PLANCOMP-version-yyyyymmdd-hhmm.txt.
- For IBM Cognos Planning Gateway, the file name is tl-PLANGATE-version-yyyyymmdd-hhmm.txt.
- For IBM Cognos Planning Administration, the file name is tl-PLANADN-version-yyyyymmdd-hhmm.txt.
- For IBM Cognos Planning Client the file name is tl-PLANCLIENT-version-yyyyymmdd-hhmm.txt.

Also ensure that the installation directory is protected from unauthorized or inappropriate access.

After all errors are resolved, you can set up an unattended configuration.

Set Up an Unattended Configuration

Before you set up an unattended configuration, you must export a configuration from another computer that has the same IBM Cognos Planning components installed. You can then run IBM Cognos Configuration in silent mode.

The exported configuration contains the properties of the IBM Cognos Planning components that you installed on the source computer. If you made changes to the global configuration, you must also copy the global configuration file from the source computer to the computer where you plan to run an unattended configuration.

Before you begin

Ensure that the configuration settings on the local computer are appropriate to use to configure another IBM Cognos Planning computer with the same installed components. For example, if you changed the host name portion of the Gateway URI property from local host to an IP address or computer name, ensure this setting is appropriate for the new computer’s configuration.
Procedure

1. In IBM Cognos Configuration, from the File menu, click Export as.
2. If you want to export the current configuration to a different folder, in the Look in box, locate and open the folder. Ensure that the folder is protected from unauthorized or inappropriate access.
3. In the File name box, type a name for the configuration file.
4. Click Save.
5. Copy the exported configuration file from the source computer or network location to the c10_location/configuration directory on the computer where you plan to do an unattended configuration.
6. Rename the file to cogstartup.xml.
7. If you changed the global configuration on the source computer, copy the coglocale.xml file from the source computer to the c10planning_location/configuration directory on the computer where you plan to do an unattended configuration.
8. Go to c10planning_location/bin.
9. Type the configuration command:
   cogconfig.bat -s

   Tip: To view log messages that were generated during an unattended configuration, see the cogconfig_response.csv file in the c10planning_location/logs directory.

Results

You can check if the unattended configuration was successful by checking the return status. A value of zero (0) indicates success and all other values indicate that an error occurred.

IBM Cognos Configuration applies the configuration settings specified in the local copy of cogstartup.xml, encrypts credentials, generates digital certificates, and if applicable, starts the IBM Cognos service or process.
Chapter 13. Configuring IBM Cognos Components to Use an Authentication Provider

IBM Cognos components run with two levels of logon: anonymous and authenticated. By default, anonymous access is enabled.

You can use both types of logon with your installation. If you choose to use authenticated logon only, you can disable anonymous access.

For authenticated logon, you must configure IBM Cognos components with an appropriate namespace for the type of authentication provider in your environment. You can configure multiple namespaces for authentication and then choose, at run time, which namespace you want to use. For more information, see the Administration and Security Guide.

If you upgraded from ReportNet and IBM Cognos detects a previously configured namespace that is no longer configured, the unconfigured namespace appears in the list of authentication providers in the Administration portal. You can configure the namespace if you still require the user account information. Otherwise, you can delete the namespace. For information about deleting the namespace, see the Administration and Security Guide.

Also, when upgrading from one version to another, you must use the same authentication namespace for both versions. Otherwise, the old secured content will not be available because the new version may not contain the same policies, users, roles, and groups.

IBM Cognos components support the following types of servers as authentication sources:

- Active Directory Server
- IBM Cognos Series 7
- Custom Authentication Provider
- LDAP
- eTrust SiteMinder
- NTLM
- RACF®
- SAP

If you use more than one Content Manager, you must configure identical authentication providers in each Content Manager location. This means that the type of authentication provider you select and the way you configure it must be identical in all locations for all platforms. The configuration must contain information that is accessible by all Content Managers.

If you enable security, you must configure security settings immediately after you complete the installation and configuration process. For more information, see the Administration and Security Guide.

Important: Do not disable security after you enable it. If you delete a namespace, the user preferences, My Folders, and My Pages entries are permanently lost.
Existing permission settings will refer to users, groups, or roles that no longer exist. While this does not affect how the permissions work, a user administering the permission settings may see "unknown" entries. Because these entries refer to users, groups, and roles which no longer exist, you can safely delete them.

After you configure an authentication provider for IBM Cognos components, you can enable single signon between your authentication provider environment and IBM Cognos components. This means that a user logs on once and can then switch to another application without being asked to log on again.

Users can select namespaces when they log in to the IBM Cognos portal. You can hide Custom Java namespaces and eTrust SiteMinder namespaces from users. For more information, see “Hide the Namespace from Users During Login” on page 231 and “Hide the Namespace from Users During Login” on page 249.

To use an authentication provider and to require users to authenticate, do the following:

- Disable anonymous access if required.
- Configure IBM Cognos components to use an authentication provider.

### Disable Anonymous Access

If you want to use authenticated logon only, you can use IBM Cognos Configuration to disable anonymous access.

By default, users are not required to log in to IBM Cognos. To use IBM Cognos Planning, you must disable anonymous access so that users are required to log in. Only authenticated users can access your planning applications.

#### Procedure

1. In each location where Content Manager is installed, start IBM Cognos Configuration.
2. In the Explorer window, under Security > Authentication, click Cognos. The IBM Cognos resource represents the Cognos namespace. The Cognos namespace stores information about IBM Cognos groups, such as the Anonymous User, contacts, and distribution lists, and refers to objects in other security namespaces. For more information, see the Administration and Security Guide.
3. In the Properties window, click the box next to the Allow anonymous access property and then select False.
4. From the File menu, click Save.

#### Results

Now, you must configure a namespace so that users are required to provide logon credentials when they access IBM Cognos resources.

### Restrict User Access to the Cognos Namespace

You can restrict access to users belonging to any group or role defined in the Cognos built-in namespace.

By default, all users belong to several built-in groups or roles. To restrict access, you must do the following:
• Enable the property to restrict access, using IBM Cognos Configuration.
• Remove the Everyone group from the built-in roles and groups, using IBM Cognos Administration.
• Ensure that authorized users belong to at least one role or group, using IBM Cognos Administration.

**Procedure**

1. In each Content Manager location, start IBM Cognos Configuration.
2. In the **Explorer** window, under **Security**, click **Authentication**.
3. In the Properties window, change the value of **Restrict access to members of the built-in namespace** to **True**.
4. From the **File** menu, click **Save**.

**Results**

You must now use the portal to remove the Everyone group from the built-in roles and groups, and then ensure that authorized users belong to at least one built-in role or group.

For information about adding or removing members of a group or role, see the *Administration and Security Guide*.

---

**Configuring IBM Cognos Components to Use Active Directory Server**

If you install Content Manager on a Microsoft Windows operating system computer, you can configure Active Directory as your authentication source using an Active Directory namespace.

If you want to use Microsoft SQL Server or Microsoft Analysis Server as a data source and use single signon for authentication, you must use Active Directory as your authentication source.

You cannot connect to the Active Directory Global Catalog, which is a caching server for Active Directory Server. If the connection uses port 3268, you must change it. By default, Active Directory Server uses port 389.

**Procedure**

1. **Configure IBM Cognos components to use an Active Directory Server namespace**
2. **Enable secure communication to the Active Directory Server**, if required
3. **Enable single signon between Active Directory and IBM Cognos components**

**Related concepts:**

“Enabling Single Signon Between Active Directory Server and IBM Cognos Components” on page 225

By default, the Active Directory provider uses Kerberos delegation and integrates with the IIS Web server for single signon if integrated authentication (formerly named NT Challenge Response) on Microsoft Windows operating system is enabled on the IIS Web server.

**Related tasks:**

“Include or Exclude Domains Using Advanced Properties” on page 224

When you configure an authentication namespace for IBM Cognos, users from only one domain can log in. By using the Advanced properties for Active Directory Server, users from related (parent-child) domains and unrelated domain trees
within the same forest can also log in.

“Configure an LDAP Namespace for Active Directory Server” on page 234

If you configure a new LDAP namespace for use with an Active Directory Server, you must modify the necessary settings and change the values for all properties of the Active Directory objects.

Configure an Active Directory Namespace

You can use Active Directory Server as your authentication provider.

You also have the option of making custom user properties from the Active Directory Server available to IBM Cognos components.

Before you begin

For IBM Cognos to work properly with Active Directory Server, ensure that the Authenticated users group has Read privileges for the Active Directory folder where users are stored.

If you are configuring an Active Directory namespace to support single signon with a Microsoft SQL Server or Microsoft Analysis Server data source, ensure the following configuration:

- The IBM Cognos gateway is installed on an IIS Web server that is configured for Integrated Authentication on Microsoft Windows operating system.
- The gateway is assigned to the local intranet Web site in your Web browser.
- Content Manager is installed on a Windows 2000 or Windows 2003 server.
- Content Manager, Application Tier Components, IIS Web server, and the data source server (Microsoft SQL Server or Microsoft Analysis Server) belong to the Active Directory domain.
- The data source connection for Microsoft SQL Server or Microsoft Analysis Server is configured for External Namespace and that namespace must be the Active Directory namespace.

For more information about data sources, see the Administration and Security Guide.

Procedure

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click the appropriate namespace and then click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.
7. Specify the values for the Host and port property.
   To support Active Directory Server failover, you can specify the domain name instead of a specific domain controller. For example, use mydomain.com:389 instead of dc1.mydomain.com:389.
8. If you want to search for details when authentication fails, specify the user ID and password for the **Binding credentials** property.

   Use the credentials of an Active Directory Server user who has search and read privileges for that server.

9. From the **File** menu, click **Save**.

10. Test the connection to a new namespace. In the **Explorer** window, under **Authentication**, right-click the new authentication resource and click **Test**.

**Results**

IBM Cognos loads, initializes, and configures the provider libraries for the namespace.

**Make Custom User Properties for Active Directory Available to IBM Cognos Components**

You can use arbitrary user attributes from your Active Directory Server in IBM Cognos components. To configure this, you must add these attributes as custom properties for the Active Directory namespace.

The custom properties are available as session parameters through Framework Manager. For more information about session parameters, see the Framework Manager **User Guide**

You can also use the custom properties inside command blocks to configure Oracle sessions and connections. You can use the command blocks can be used with Oracle light-weight connections and virtual private databases. For more information, see the **Administration and Security Guide**.

**Procedure**

1. In every location where you installed Content Manager, open IBM Cognos Configuration.

2. In the **Explorer** window, under **Security > Authentication**, click the Active Directory namespace.

3. In the **Properties** window, click in the **Value** column for **Custom properties** and click the edit button.

4. In the **Value - Custom properties** window, click **Add**.

5. Click the **Name** column and type the name you want IBM Cognos components to use for the session parameter.

6. Click the **Value** column and type the name of the account parameter in your Active Directory Server.

7. Repeat steps 4 to 6 for each custom parameter.

8. Click **OK**.

9. From the **File** menu, click **Save**.

**Enabling Secure Communication to the Active Directory Server**

If you are using an SSL connection to the Active Directory Server, you must copy the certificate from the Active Directory Server to the Content Manager location.
Procedure

1. In every Content Manager location, use your Web browser to connect to the Active Directory Server and copy the CA root certificate to the Content Manager location.

2. Add the CA root certificate to the certificate store of the account that you are using for the current IBM Cognos session:
   - If you are running the IBM Cognos session under a user account, use the same Web browser as in step 1 to import the CA root certificate to the certificate store for your user account.
     For information, see the documentation for your Web browser.
   - If you are running the IBM Cognos session under the local account, use Microsoft Management Console (MMC) to import the CA root certificate to the certificate store for the local computer.
     For information, see the documentation for MMC.

3. In IBM Cognos Configuration, restart the service:
   - In the Explorer window, click IBM Cognos services, IBM Cognos.
   - From the Actions menu, click Restart.

Include or Exclude Domains Using Advanced Properties

When you configure an authentication namespace for IBM Cognos, users from only one domain can log in. By using the Advanced properties for Active Directory Server, users from related (parent-child) domains and unrelated domain trees within the same forest can also log in.

If you set a parameter named chaseReferrals to true, users in the original authenticated domain and all child domains of the domain tree can log in to IBM Cognos. Users above the original authenticated domain or in a different domain tree cannot log in.

If you set a parameter named MultiDomainTrees to true, users in all domain trees in the forest can log in to IBM Cognos.

Procedure

1. In every location where you installed Content Manager, open IBM Cognos Configuration.

2. In the Explorer window, under Security > Authentication, click the Active Directory namespace.

3. In the Properties window, specify the Host and port property:
   - For users in one domain, specify the host and port of a domain controller for the single domain.
   - For users in one domain tree, specify the host and port of the top-level controller for the domain tree.
   - For users in all domain trees in the forest, specify the host and port of any domain controller in the forest.

4. Click in the Value column for Advanced properties and click the edit button.

5. In the Value - Advanced properties window, click Add.

6. Specify two new properties, chaseReferrals and MultiDomainTrees, with the values from the following table:
Table 54. Advanced properties settings

<table>
<thead>
<tr>
<th>Authentication for</th>
<th>chaseReferrals</th>
<th>MultiDomainTrees</th>
</tr>
</thead>
<tbody>
<tr>
<td>One domain</td>
<td>False</td>
<td>False</td>
</tr>
<tr>
<td>One domain tree</td>
<td>True</td>
<td>False</td>
</tr>
<tr>
<td>All domain trees in the forest</td>
<td>True</td>
<td>True</td>
</tr>
</tbody>
</table>

7. Click OK.
8. From the File menu, click Save.

Related tasks:
“Configuring IBM Cognos Components to Use Active Directory Server” on page 221
If you install Content Manager on a Microsoft Windows operating system computer, you can configure Active Directory as your authentication source using an Active Directory namespace.

**Enabling Single Signon Between Active Directory Server and IBM Cognos Components**

By default, the Active Directory provider uses Kerberos delegation and integrates with the IIS Web server for single signon if integrated authentication (formerly named NT Challenge Response) on Microsoft Windows operating system is enabled on the IIS Web server.

If Windows integrated authentication is enabled, you are not prompted to reenter authentication information when accessing IBM Cognos content that is secured by the Active Directory namespace.

If you do not want Kerberos delegation, you can configure the provider to access the environment variable REMOTE_USER to achieve single signon.

Related tasks:
“Configuring IBM Cognos Components to Use Active Directory Server” on page 221
If you install Content Manager on a Microsoft Windows operating system computer, you can configure Active Directory as your authentication source using an Active Directory namespace.

**Single Signon Using Kerberos Delegation**

You can enable single signon between the Active Directory provider and the IBM Cognos components using Kerberos delegation.

By default, Active Directory uses Kerberos delegation and integrates with the IIS Web server for single signon if integrated authentication (formerly named NT Challenge Response) on Microsoft Windows operating system is enabled on the IIS Web server.

If Windows integrated authentication is enabled, you are not prompted to reenter authentication information when accessing IBM Cognos content that is secured by the Active Directory namespace.
Procedure

1. Set up Windows integrated authentication on the IIS Web server.
2. Install Content Manager in a location that is part of the domain, for the active and standby Content Managers.
3. Set up the computers, or the user account under which Content Manager runs, to be trusted for delegation.

   When setting up the computers using the Active Directory user tool, do not select the Account attribute, which is sensitive and cannot be delegated.

Enabling Single Signon Between Active Directory Server and IBM Cognos Components using REMOTE_USER

If you do not want Kerberos delegation, you can configure the provider to access the environment variable REMOTE_USER to achieve single signon.

You must set the advanced property singleSignOnOption to the value IdentityMapping. You must also specify bind credentials for the Active Directory namespace.

Microsoft IIS sets REMOTE_USER by default when you enable Windows integrated authentication. If Kerberos authentication is bypassed, single signon to Microsoft OLAP (MSAS) data sources will not be possible.

Procedure

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security > Authentication, click the Active Directory namespace.
3. Click in the Value column for Advanced properties and then click the edit button.
4. In the Value - Advanced properties dialog box, click Add.
5. In the Name column, type singleSignOnOption
6. In the Value column, type IdentityMapping.
7. Click OK.
8. Click in the Value column for Binding credentials, and then click the edit button.
9. In the Value - Binding credentials dialog box, specify a user ID and password and then click OK.

Results

The Active Directory provider now uses REMOTE_USER for single signon.

Tip: To switch back to Kerberos delegation, edit Advanced properties and, in the Value column, type KerberosAuthentication.

Configuring IBM Cognos to Use IBM Cognos Series 7 Namespace

You can configure IBM Cognos components to use an IBM Cognos Series 7 namespace as the authentication provider. Users will be authenticated based on the authentication and signon configuration of the IBM Cognos Series 7 namespace.

Note: You cannot use an IBM Cognos Series 7 Local Authentication Export (LAE) file for authentication with IBM Cognos components.
You can configure IBM Cognos components to use multiple IBM Cognos Series 7 authentication providers. All IBM Cognos Series 7 namespaces must use the same primary IBM Cognos Series 7 Ticket Server. Otherwise, you may receive errors or be prompted for authentication more than once. To maintain performance, also ensure that the ticket server is running.

If you change the configuration information stored in the directory server used for IBM Cognos Series 7, you must restart the IBM Cognos service before the changes take effect in the IBM Cognos installation.

A user must be in at least one Access Manager user class to log on to IBM Cognos components.

Procedure
1. Configure an IBM Cognos Series 7 namespace
2. Enable secure communication to the directory server used by the IBM Cognos Series 7 namespace if required
3. Enable single signon between IBM Cognos Series 7 and IBM Cognos

Configure an IBM Cognos Series 7 Namespace
You can configure IBM Cognos to use one or more IBM Cognos Series 7 namespaces for authentication.

Procedure
1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click the appropriate namespace and then click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.
   If your IBM Cognos Series 7 namespace version is 16.0, ensure that the Data encoding property is set to UTF-8. In addition, the locations where Content Manager is installed must use the same locale as the data in the IBM Cognos Series 7 namespace.
   The host value can be a server name or an IP address. If you are publishing from PowerPlay Enterprise Server to IBM Cognos BI, you must use the same value format used in IBM Cognos Series 7 Configuration Manager for the location of the directory server. For example, if the server name is used in IBM Cognos Series 7 Configuration Manager, you must also use the server name in IBM Cognos Configuration for IBM Cognos BI.
7. If your namespace environment includes version 15.2 of the IBM Cognos Series 7 namespace, you must disable the Series7NamespacesAreUnicode setting.
   • In the Properties window, in the Advanced Properties value, click the edit button.
   • In the Value - Advanced properties window, click Add.
• In the **Name** box, type **Series7NamespacesAreUnicode**.
• In the **Value** box, type **False**, and then click **OK**.

8. In the **Properties** window, under **Cookie settings**, ensure that the **Path**, **Domain**, and **Secure flag enabled** properties match the settings configured for IBM Cognos Series 7.

9. From the **File** menu, click **Save**.

10. Test the connection to a new namespace. In the **Explorer** window, under **Authentication**, right-click the new authentication resource and click **Test**.

**Enabling Secure Communication to the Directory Server Used by the IBM Cognos Series 7 Namespace**

If you are using an SSL connection to the Directory Server used by the IBM Cognos Series 7 namespace, you must copy the certificate from the Directory Server to each Content Manager location.

For more information, see the IBM Cognos Access Manager **Administrator Guide** and the documentation for your Directory Server.

**Enabling Single Signon Between IBM Cognos Series 7 and IBM Cognos**

If your IBM Cognos Series 7 namespace has been configured for integration with your external authentication mechanisms for single signon, the IBM Cognos Series 7 provider will automatically use this configuration.

By configuring single signon, you are not prompted to reenter authentication information when accessing IBM Cognos content that is secured by the IBM Cognos Series 7 namespace.

**Procedure**

1. Ensure that you configured IBM Cognos components to use an IBM Cognos Series 7 namespace as an authentication provider.
2. For IBM Cognos Series 7, start Configuration Manager.
3. Click **Open the current configuration**.
4. On the **Components** tab, in the **Explorer** window, expand **Services**, **Access Manager - Web Authentication** and click **Cookie Settings**.
5. In the **Properties** window, ensure that the **Path**, **Domain**, and **Secure Flag Enabled** properties match the settings configured for IBM Cognos.
6. Save and close Configuration Manager.
7. If the IBM Cognos Series 7 namespace uses the Trusted Signon plug-in for single signon, you must now define the SaferAPIGetTrustedSignonWithEnv function.

**Results**

You can now add IBM Cognos Upfront Series 7 NewsBoxes to your IBM Cognos Connection portal pages.

**IBM Cognos Series 7 Namespaces and the IBM Cognos Series 7 Trusted Signon Plug-in**

If the IBM Cognos Series 7 namespace uses the Trusted Signon plug-in for single signon, you must define the SaferAPIGetTrustedSignonWithEnv function in your
plug-in. Then you must recompile and redeploy the library for single signon to be achieved between IBM Cognos components and your authentication mechanism.

The SaferAPITrustedSignonWithEnv function is an updated version of the SaferAPITrustedSignon function. This update is required because IBM Cognos logon is not performed at the Web server as is the case for IBM Cognos Series 7 applications. Therefore, it is not possible for the plug-in to perform a getenv() API call to retrieve Web server environment variables. The plug-in can request that specific environment variables be removed from the Web server using the SaferAPITrustedSignonWithEnv function.

If you are running both IBM Cognos Series 7 and IBM Cognos products using the same plug-in, both the SaferAPITrustedSignonWithEnv and SaferAPITrustedSignon functions are required. For information about the SaferAPITrustedSignon function, see the IBM Cognos Series 7 documentation.

**SaferAPITrustedSignonWithEnv Function**

For users to be successfully authenticated by Access Manager, OS signons must exist and be enabled in the current namespace.

The memory for the returned trustedSignonName and trustedDomainName is allocated internally in this API. If the function returns SAFER_SUCCESS, Access Manager calls SaferAPIFreeTrustedSignon to free the memory allocated.

The memory for the returned reqEnvVarList is allocated internally in this API. If the function returns SAFER_INFO_REQUIRED, Access Manager calls SaferAPIFreeBuffer() to free the memory allocated.

You must implement both the SaferAPITrustedSignon and SaferAPIFreeBuffer functions to successfully register the library when SaferAPITrustedSignonWithEnv is implemented. The function SaferAPIGetError is required only if you want specific error messages returned from your plug-in.

**Syntax**

```c
SaferAPITrustedSignonWithEnv(
    EnvVar envVar[],  /*[IN]*/
    char **reqEnvVarList,  /*[OUT]*/
    void **trustedSignonName,  /*[OUT]*/
    unsigned long *trustedSignonNameLength,  /*[OUT]*/
    void **trustedDomainName,  /*[OUT]*/
    unsigned long *trustedDomainNameLength,  /*[OUT]*/
    SAFER_USER_TYPE *userType,  /*[OUT]*/
    void **implementerData);  /*[IN/OUT]*/
```

**Parameters for the SaferAPITrustedSignonWithEnv Function**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[in] envVar</td>
<td>An array of environment variable names and values that were retrieved from the Web server. The end of the array is represented by an entry with a null envVarName and a null envVarValue. Note that the first time this API is called, the envVar array contains only the end of array marker.</td>
</tr>
</tbody>
</table>
Table 55. Parameters and description for the SaferAPIGetTrustedSignonWithEnv Function (continued)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[in] reqEnvVarList</td>
<td>A string that contains a comma separated list of environment variable names that are requested by the Safer implementation. The end of the list must be null-terminated.</td>
</tr>
<tr>
<td>[out] trustedSignonName</td>
<td>A sequence of bytes that identifies the currently authenticated user. This value does not need to be null-terminated. This value is mandatory.</td>
</tr>
<tr>
<td>[out] trustedSignonNameLength</td>
<td>An integer value that indicates the length of the trustedSignonName. This length should exclude the null terminator, if there is one. This value is mandatory.</td>
</tr>
<tr>
<td>[out] trustedDomainName</td>
<td>A sequence of bytes that identifies the domain of the currently authenticated user. You do not need to null-terminate this value. If there is no trustedDomainName, the return is null. This value is optional.</td>
</tr>
<tr>
<td>[out] trustedDomainNameLength</td>
<td>An integer value that indicates the length of the trustedDomainName. This length should exclude the null terminator, if there is one. This value is mandatory and must be set to zero if there is no trustedDomainName.</td>
</tr>
<tr>
<td>[out] userType</td>
<td>A value that indicates the type of user that Access Manager will authenticate. This value is mandatory.</td>
</tr>
<tr>
<td></td>
<td>The following return values are required for Access Manager to successfully authenticate users:</td>
</tr>
<tr>
<td></td>
<td>SAFER_NORMAL_USER</td>
</tr>
<tr>
<td></td>
<td>SAFER_GUEST_USER</td>
</tr>
<tr>
<td></td>
<td>SAFER_ANONYMOUS_USER</td>
</tr>
<tr>
<td>[in/out] implementerData</td>
<td>A pointer used to preserve implementation-specific data between invocations. An invocation occurs every time Access Manager calls the trusted signon plug-in. This value is valid only if the trusted signon plug-in was invoked and you set a value for it.</td>
</tr>
</tbody>
</table>
You can use a custom authentication provider to access and authenticate users to an alternate authentication source. You can also use it as a single signon mechanism to integrate IBM Cognos components with your security infrastructure. You can hide the namespace from users during logon.

For more information, see the Custom Authentication Provider Developer Guide.

Configure a Custom Authentication Namespace

You can configure IBM Cognos components to use a custom authentication namespace. Any additional configuration for authentication source access, single signon, or custom attributes are dependent on the custom authentication provider implementation.

Ensure that the versions of Java runtime environment (JRE) and Java Software Development Kit that you use are compatible with each other. If you use supported versions of the JRE and Java Software Development Kit that are not compatible with each other, then the custom Java authentication provider that you configure will not appear in the list of namespaces in IBM Cognos Configuration.

Procedure

1. In every location where Content Manager is installed, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, select Custom Java Provider and then click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the NamespaceID property, specify a unique identifier for the namespace.
   
   Tip: Do not use colons (:) in the Namespace ID property.
6. Specify the values for all other required properties to ensure that IBM Cognos can locate and use your existing authentication provider.
7. From the File menu, click Save.
8. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

Results

IBM Cognos loads, initializes, and configures the provider libraries for the namespace.

Hide the Namespace from Users During Login

You can hide namespaces from users during logon. You can have trusted signon namespaces without showing them on the namespace selection list that is presented when users log in.

For example, you may want to integrate single signon across systems but maintain the ability for customers to authenticate directly to IBM Cognos without being prompted to choose a namespace.
Procedure

1. In each location where you configured a custom Java authentication provider, open IBM Cognos Configuration.
2. In the Explorer window, under Security > Authentication, click the custom Java authentication provider.
3. In the Properties window, click the box next to Selectable for authentication and select False.
4. From the File menu, click Save.

Results

The namespace is not shown on the selection list that is presented at login.

Configuring IBM Cognos Components to Use LDAP

You can configure IBM Cognos components to use an LDAP namespace as the authentication provider. You can use an LDAP namespace for users that are stored in an LDAP user directory, Active Directory Server, IBM Directory Server, Novell Directory Server, or Oracle Directory Server.

You can also use LDAP authentication with DB2 and Essbase OLAP data sources by specifying the LDAP namespace when you set up the data source connection. For more information, see the Administration and Security Guide.

You also have the option of making custom user properties from the LDAP namespace available to IBM Cognos components.

If you want to bind users to the LDAP server, see “LDAP Mapping.”

Procedure

1. “Configure an LDAP Namespace” on page 233 if required
2. Make custom user properties available to IBM Cognos components if required
3. Enable secure communication to the LDAP server if required
4. Enable single signon between LDAP and IBM Cognos components if required

LDAP Mapping

To bind a user to the LDAP server, the LDAP authentication provider must construct the distinguished name (DN). If the Use external identity property is set to True, it uses the External identity mapping property to try to resolve the user’s DN. If it cannot find the environment variable or the DN in the LDAP server, it attempts to use the User lookup property to construct the DN.

If users are stored hierarchically within the directory server, you can configure the User lookup and External identity mapping properties to use search filters. When the LDAP authentication provider performs these searches, it uses the filters you specify for the User lookup and External identity mapping properties. It also binds to the directory server using the value you specify for the Bind user DN and password property or using anonymous if no value is specified.

When an LDAP namespace has been configured to use the External identity mapping property for authentication, the LDAP provider binds to the directory server using the Bind user DN and password or using anonymous if no value is
specified. All users who log on to IBM Cognos using external identity mapping see the same users, groups, and folders as the Bind user.

If you do not use external identity mapping, you can specify whether to use bind credentials to search the LDAP directory server by configuring the Use bind credentials for search property. When the property is enabled, searches are performed using the bind user credentials or using anonymous if no value is specified. When the property is disabled, which is the default setting, searches are performed using the credentials of the logged-on user. The benefit of using bind credentials is that instead of changing administrative rights for multiple users, you can change the administrative rights for the bind user only.

Note that if you use a DN syntax, such as $\text{uid}=$\{userID\}, $\text{ou}=$mycompany.com, for the properties User lookup, External identity mapping, or Bind user DN and password, you must escape all special characters that are used in the DN. If you use a search syntax, such as ($\text{uid}=$\{userID\}$), for the properties User lookup or External identity mapping, you must not escape special characters that are used in the DN.

**Configure an LDAP Namespace**

You can configure IBM Cognos components to use an LDAP namespace when the users are stored in an LDAP user directory. The LDAP user directory may be accessed from within another server environment, such as Active Directory Server or eTrust SiteMinder.

If you are configuring an LDAP namespace for a directory server other than LDAP, see the appropriate section:

- For Active Directory Server, see [Configure an LDAP Namespace for Active Directory Server](#).
- For IBM Directory Server, see [Configure an LDAP Namespace for IBM Directory Server](#).
- For Novell Directory Server, see [Configure an LDAP Namespace for Novell Directory Server](#).
- For Oracle Directory Server, see [Configure an LDAP Namespace for Oracle Directory Server](#).

You can also use LDAP authentication with DB2 and Essbase OLAP data sources by specifying the LDAP namespace when you set up the data source connection. For more information, see the *Administration and Security Guide.*

**Procedure**

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click the appropriate namespace and then click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.
7. If you want the LDAP authentication provider to bind to the directory server using a specific **Bind user DN and password** when performing searches, then specify these values.

   If no values are specified, the LDAP authentication provider binds as anonymous.

   If external identity mapping is enabled, **Bind user DN and password** are used for all LDAP access. If external identity mapping is not enabled, **Bind user DN and password** are used only when a search filter is specified for the **User lookup** property. In that case, when the user DN is established, subsequent requests to the LDAP server are executed under the authentication context of the end user.

8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   - Ensure that **Use external identity** is set to **False**.
   - Set **Use bind credentials for search** to **True**.

   If you do not specify a user ID and password, and anonymous access is enabled, the search is done using anonymous.

9. Check the mapping settings for required objects and attributes.

   Depending on the LDAP configuration, you may have to change some default values to ensure successful communication between IBM Cognos components and the LDAP server.

   LDAP attributes that are mapped to the **Name** property in **Folder mappings**, **Group mappings**, and **Account mappings** must be accessible to all authenticated users. In addition, the **Name** property must not be blank.

10. From the **File** menu, click **Save**.

11. Test the connection to a new namespace. In the **Explorer** window, under **Authentication**, right-click the new authentication resource and click **Test**.

**Results**

IBM Cognos loads, initializes, and configures the provider libraries for the namespace.

**Configure an LDAP Namespace for Active Directory Server**

If you configure a new LDAP namespace for use with an Active Directory Server, you must modify the necessary settings and change the values for all properties of the Active Directory objects.

**Procedure**

1. In every location where you installed Content Manager, open IBM Cognos Configuration.

2. In the **Explorer** window, under **Security**, right-click **Authentication**, and then click **New resource > Namespace**.

3. In the **Name** box, type a name for your authentication namespace.

4. In the **Type** list, click the appropriate namespace and then click **OK**.
   The new authentication provider resource appears in the **Explorer** window, under the **Authentication** component.

5. In the **Properties** window, for the **NamespaceID** property, specify a unique identifier for the namespace.
**Tip:** Do not use colons (:) in the Namespace ID property.

6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.

The following settings are examples:

- For **User lookup**, specify (sAMAccountName=${userID})
- If you use single signon, for **Use external identity**, set the value to True.
- If you use single signon, for **External identity mapping**, specify (sAMAccountName=${environment("REMOTE_USER")})
  
  If you want to remove the domain name from the REMOTE_USER variable, specify (sAMAccountName=${replace(${environment("REMOTE_USER")}, "domain\","")}).

- For **Bind user DN and password**, specify user@domain
- For **Unique identifier**, specify objectGUID

7. If you want the LDAP authentication provider to bind to the directory server using a specific **Bind user DN and password** when performing searches, then specify these values.

   If no values are specified, the LDAP authentication provider binds as anonymous.

8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:

   - Ensure that **Use external identity** is set to False.
   - Set **Use bind credentials for search** to True.
   - Specify the user ID and password for **Bind user DN and password**.

9. To configure the LDAP advanced mapping properties for use with the Active Directory Server objects, use the values specified in the following table.

   *Table 56. LDAP advanced mapping values for use with Active Directory Server objects*

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Object class</td>
<td>organizationalUnit,organization,container</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>ou,o,cn</td>
</tr>
<tr>
<td>Group</td>
<td>Object class</td>
<td>group</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Member</td>
<td>member</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>cn</td>
</tr>
<tr>
<td>Account</td>
<td>Object class</td>
<td>user</td>
</tr>
<tr>
<td></td>
<td>Business phone</td>
<td>telephonenumber</td>
</tr>
<tr>
<td></td>
<td>Content locale</td>
<td>(leave blank)</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
</tbody>
</table>
Table 56. LDAP advanced mapping values for use with Active Directory Server objects (continued)

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td>mail</td>
<td></td>
</tr>
<tr>
<td>Fax/Phone</td>
<td>facsimiletelephonenumber</td>
<td></td>
</tr>
<tr>
<td>Given name</td>
<td>givenname</td>
<td></td>
</tr>
<tr>
<td>Home phone</td>
<td>homephone</td>
<td></td>
</tr>
<tr>
<td>Mobile phone</td>
<td>mobile</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>displayName</td>
<td></td>
</tr>
<tr>
<td>Pager phone</td>
<td>pager</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>unicodePwd</td>
<td></td>
</tr>
<tr>
<td>Postal address</td>
<td>postaladdress</td>
<td></td>
</tr>
<tr>
<td>Product locale</td>
<td>(leave blank)</td>
<td></td>
</tr>
<tr>
<td>Surname</td>
<td>sn</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>sAMAccountName</td>
<td></td>
</tr>
</tbody>
</table>

These mapping properties represent changes based on a default Active Directory Server installation. If you have modified the schema, you may have to make additional mapping changes.

LDAP attributes that are mapped to the Name property in Folder mappings, Group mappings, and Account mappings must be accessible to all authenticated users. In addition, the Name property must not be blank.

10. From the File menu, click Save.
11. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

Results

IBM Cognos loads, initializes, and configures the provider libraries for the namespace.

Related tasks:
“Configuring IBM Cognos Components to Use Active Directory Server” on page 221

If you install Content Manager on a Microsoft Windows operating system computer, you can configure Active Directory as your authentication source using an Active Directory namespace.
Configure an LDAP Namespace for IBM Directory Server

If you configure a new LDAP namespace for use with an IBM Directory Server, you must modify the necessary settings and change the values for all properties of the IBM Directory objects.

Procedure

1. In each location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click LDAP, and then click OK.
   The new authentication namespace resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the NamespaceID property, specify a unique identifier for the namespace.
   **Tip:** Do not use colons (:) in the Namespace ID property.
6. Specify the values for all other required properties to ensure that IBM Cognos can locate and use your existing authentication namespace.
   - For User lookup, specify (cn=${userID})
   - For Bind user DN and password, specify cn=root
7. If you want the LDAP authentication provider to bind to the directory server using a specific Bind user DN and password when performing searches, then specify these values.
   If no values are specified, the LDAP authentication namespace binds as anonymous.
8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   - Ensure that Use external identity is set to False.
   - Set Use bind credentials for search to True.
   - Specify the user ID and password for Bind user DN and password.
9. To configure the LDAP advanced mapping properties for use with IBM Directory Server objects, use the values specified in the following table.

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Object class</td>
<td>organizationalunit,organization,container</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>ou,o,cn</td>
</tr>
<tr>
<td>Group</td>
<td>Object class</td>
<td>groupofnames</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Member</td>
<td>member</td>
</tr>
</tbody>
</table>

Table 57. LDAP advanced mapping values for use with IBM Directory Server objects
Table 57. LDAP advanced mapping values for use with IBM Directory Server objects (continued)

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>cn</td>
<td></td>
</tr>
<tr>
<td>Account</td>
<td>Object class</td>
<td>inetorgperson</td>
</tr>
<tr>
<td>Business phone</td>
<td>telephone</td>
<td>number</td>
</tr>
<tr>
<td>Content locale</td>
<td>(leave blank)</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>description</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td>mail</td>
<td></td>
</tr>
<tr>
<td>Fax/Phone</td>
<td>facsimiletelephonenumber</td>
<td></td>
</tr>
<tr>
<td>Given name</td>
<td>givenname</td>
<td></td>
</tr>
<tr>
<td>Home phone</td>
<td>homephone</td>
<td></td>
</tr>
<tr>
<td>Mobile phone</td>
<td>mobile</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>cn</td>
<td></td>
</tr>
<tr>
<td>Pager phone</td>
<td>pager</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>userPassword</td>
<td></td>
</tr>
<tr>
<td>Postal address</td>
<td>postaladdress</td>
<td></td>
</tr>
<tr>
<td>Product locale</td>
<td>(leave blank)</td>
<td></td>
</tr>
<tr>
<td>Surname</td>
<td>sn</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>uid</td>
<td></td>
</tr>
</tbody>
</table>

These mapping properties represent changes based on a default IBM Directory Server installation. If you have modified the schema, you may have to make additional mapping changes.

LDAP attributes that are mapped to the Name property in Folder mappings, Group mappings, and Account mappings must be accessible to all authenticated users. In addition, the Name property must not be blank.

10. From the File menu, click Save.

**Configure an LDAP Namespace for Novell Directory Server**

If you configure a new LDAP namespace for use with a Novell Directory Server, you must modify the necessary settings and change the values for all properties of the Novell Directory objects.
Procedure

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click LDAP and then click OK.
   The new authentication namespace resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.

   **Tip:** Do not use colons (:) in the Namespace ID property.
6. Specify the values for all other required properties to ensure that IBM Cognos can locate and use your existing authentication namespace.
   - For **User lookup**, specify `(cn=${userID})`
   - For **Bind user DN and password**, specify the base DN for an administration user, such as `cn=Admin,0=Cognos`
7. If you want the LDAP authentication provider to bind to the directory server using a specific **Bind user DN and password** when performing searches, then specify these values.
   If no values are specified, the LDAP authentication namespace binds as anonymous.
8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   - Ensure that **Use external identity** is set to **False**.
   - Set **Use bind credentials for search** to **True**.
   - Specify the user ID and password for **Bind user DN and password**.
9. To configure the LDAP advanced mapping properties for use with Novell Directory Server objects, use the values specified in the following table.

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Object class</td>
<td>organizationalUnit,Organization,Container</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>ou,o,cn</td>
</tr>
<tr>
<td>Group</td>
<td>Object class</td>
<td>groupOfNames</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Member</td>
<td>member</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>cn</td>
</tr>
<tr>
<td>Account</td>
<td>Object class</td>
<td>inetOrgPerson</td>
</tr>
</tbody>
</table>
Table 58. LDAP advanced mapping values for use with Novell Directory Server objects (continued)

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business phone</td>
<td>telephonenumber</td>
<td></td>
</tr>
<tr>
<td>Content locale</td>
<td>Language</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>description</td>
<td></td>
</tr>
<tr>
<td>Email</td>
<td>mail</td>
<td></td>
</tr>
<tr>
<td>Fax/Phone</td>
<td>facsimiletelephonenumber</td>
<td></td>
</tr>
<tr>
<td>Given name</td>
<td>givenname</td>
<td></td>
</tr>
<tr>
<td>Home phone</td>
<td>homephone</td>
<td></td>
</tr>
<tr>
<td>Mobile phone</td>
<td>mobile</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>cn</td>
<td></td>
</tr>
<tr>
<td>Pager phone</td>
<td>pager</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>(leave blank)</td>
<td></td>
</tr>
<tr>
<td>Postal address</td>
<td>postaladdress</td>
<td></td>
</tr>
<tr>
<td>Product locale</td>
<td>Language</td>
<td></td>
</tr>
<tr>
<td>Surname</td>
<td>sn</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>uid</td>
<td></td>
</tr>
</tbody>
</table>

These mapping properties represent changes based on a default Novell Directory Server installation. If you have modified the schema, you may have to make additional mapping changes.

LDAP attributes that are mapped to the Name property in Folder mappings, Group mappings, and Account mappings must be accessible to all authenticated users. In addition, the Name property must not be blank.

For users to successfully log in to IBM Cognos Connection, they must have permission to read the ou and o attributes.

10. From the File menu, click Save.

Configure an LDAP Namespace for Oracle Directory Server

If you configure a new LDAP namespace for use with Oracle Directory Server, you must modify the necessary settings and change the values for all properties of the Oracle Directory Server objects.

Procedure

1. In every location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and then click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click LDAP and then click OK.
   The new authentication namespace resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
   **Tip:** Do not use colons (:) in the Namespace ID property.
6. Specify the values for all other required properties to ensure that IBM Cognos can locate and use your existing authentication namespace.
   The following settings are examples:
   • For User lookup, type (uid=${userID})
   • If you use single signon, for Use external identity, set the value to True.
   • If you use single signon, for External identity mapping, specify any attribute, such as the NT user domain ID or the user ID:
     (ntuserdomainid=${environment("REMOTE_USER")})
     (uid=${environment("REMOTE_USER")})
   • For Unique identifier, type nsuniqueid
7. If you want the LDAP authentication provider to bind to the directory server using a specific Bind user DN and password when performing searches, then specify these values.
   If no values are specified, the LDAP authentication namespace binds as anonymous.
8. If you do not use external identity mapping, use bind credentials for searching the LDAP directory server by doing the following:
   • Ensure that Use external identity is set to False.
   • Set Use bind credentials for search to True.
   • Specify the user ID and password for Bind user DN and password.
9. To configure the LDAP advanced mapping properties for use with Oracle Directory Server objects, use the values specified in the following table.

   **Table 59. LDAP advanced mapping values for use with Oracle Directory Server objects**

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Object class</td>
<td>organizationalUnit,organization</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>ou,0</td>
</tr>
<tr>
<td>Group</td>
<td>Object class</td>
<td>groupofuniquenames</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Member</td>
<td>uniquemember</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>cn</td>
</tr>
</tbody>
</table>
### Table 59. LDAP advanced mapping values for use with Oracle Directory Server objects (continued)

<table>
<thead>
<tr>
<th>Mappings</th>
<th>LDAP property</th>
<th>LDAP value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Object class</td>
<td>inetorgperson</td>
</tr>
<tr>
<td></td>
<td>Business phone</td>
<td>telephonenumber</td>
</tr>
<tr>
<td></td>
<td>Content locale</td>
<td>preferredlanguage</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>description</td>
</tr>
<tr>
<td></td>
<td>Email</td>
<td>mail</td>
</tr>
<tr>
<td></td>
<td>Fax/Phone</td>
<td>facsimiletelephonenumber</td>
</tr>
<tr>
<td></td>
<td>Given name</td>
<td>givenname</td>
</tr>
<tr>
<td></td>
<td>Home phone</td>
<td>homephone</td>
</tr>
<tr>
<td></td>
<td>Mobile phone</td>
<td>mobile</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>cn</td>
</tr>
<tr>
<td></td>
<td>Pager phone</td>
<td>pager</td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>userPassword</td>
</tr>
<tr>
<td></td>
<td>Postal address</td>
<td>postaladdress</td>
</tr>
<tr>
<td></td>
<td>Product locale</td>
<td>preferredlanguage</td>
</tr>
<tr>
<td></td>
<td>Surname</td>
<td>sn</td>
</tr>
<tr>
<td></td>
<td>Username</td>
<td>uid</td>
</tr>
</tbody>
</table>

These mapping properties represent changes based on a default Oracle Directory Server installation. If you have modified the schema, you may have to make additional mapping changes.

LDAP attributes that are mapped to the Name property in Folder mappings, Group mappings, and Account mappings must be accessible to all authenticated users. In addition, the Name property must not be blank.

10. From the File menu, click Save.

### Make Custom User Properties for LDAP Available to IBM Cognos Components

You can use arbitrary user attributes from your LDAP authentication provider in IBM Cognos components. To configure this, you must add these attributes as custom properties for the LDAP namespace. The custom properties are available as session parameters through Framework Manager.
You can also use the custom properties inside command blocks to configure Oracle sessions and connections. You can use the command blocks with Oracle lightweight connections and virtual private databases. For more information, see the Administration and Security Guide.

For more information about session parameters, see the Framework Manager User Guide.

Procedure
1. In each location where you installed Content Manager, open Cognos Configuration.
2. In the Explorer window, under Security > Authentication, click the LDAP namespace.
3. In the Properties window, click in the Value column for Custom properties, and click the edit button.
4. In the Value - Custom properties window, click Add.
5. Click the Name column, and type the name you want IBM Cognos components to use for the session parameter.
6. Click the Value column, and type the name of the account parameter in your LDAP authentication provider.
7. Repeat the preceding two steps for each custom parameter.
8. Click OK.
9. From the File menu, click Save.

Enable Secure Communication to the LDAP Server
Secure LDAP protocol (LDAPS) encrypts the communication between the Access Manager component of Content Manager and the directory server. LDAPS prevents sensitive information in the directory server and the LDAP credentials from being sent as clear text.

To enable LDAPS, install a server certificate that is signed by a certificate authority in the directory server. Next, create a certificate database to contain the certificates. Finally, configure the directory server and the IBM Cognos LDAP namespace to use LDAPS.

The server certificate must be a copy of either
- the trusted root certificate and all other certificates that make up the chain of trust for the directory server certificate.
  The trusted root certificate is the certificate of the root certificate authority that signed the directory server certificate.
- the directory server certificate only

The certificates must be Base64 encoded in ASCII (PEM) format. All certificates except the trusted root certificate must not be self-signed.

Before you begin
IBM Cognos works with both the cert8.db and cert7.db versions of the client certificate database. You must use the certutil tool from Netscape OpenSource toolkit NSS_3_11_4_RTM to create the certificate database. IBM Cognos does not
accept other versions of cert8.db files, including those from the certutil tool that is provided with Microsoft Active Directory. The appropriate certutil tool is available from the FTP Web site at Mozilla.

You must also use version 4.6.7 of the NSPR library, which is available from the FTP Web site at Mozilla.

**Procedure**

1. Create a directory for the certificate database.
2. Create the certificate database by typing
   
   ```
   certutil -N -d certificate_directory
   ```
   
   where `certificate_directory` is the directory that you created in step 1.

   This command creates a cert8.db file and a key3.db file in the new directory.

3. Add the certificate authority (CA) certificate or the directory server certificate to the certificate database by typing the appropriate command for the type of certificate:

   - For a CA certificate, type
     ```
     certutil -A -n certificate_name -d certificate_directory -i CA.cert -t C,C,C
     ```
   - For a directory server certificate, type
     ```
     certutil -A -n certificate_name -d certificate_directory -i server_certificate
     ```

   where `certificate_name` is an alias that you assign, such as the CA name or host name; and `server_certificate` is the prefix of the directory server certificate file.

4. Copy the certificate database directory to the `c10_location/configuration` directory on every location where Content Manager is installed.

5. Configure the directory server to use LDAPS and restart the directory server.

   For more information, see the documentation for the directory server.

6. In each Content Manager location where you configured the LDAP namespace to use the directory server, start IBM Cognos Configuration.

7. In the **Explorer** window, under **Security > Authentication**, click the LDAP namespace.

8. In the **Properties** window, for the **Host and port** property, change the port to the secure LDAPS port.

   For the **SSL certificate database** property, specify the path to the cert7.db file.

9. In the **Explorer** window, right-click the LDAP namespace and click **Test**.

   If the test fails, revise the properties, ensuring that the correct certificate is used.

10. From the **File** menu, click **Save**.

11. From the **Actions** menu, click **Restart**.

12. Repeat steps 6 to 11 on every other location where Content Manager is installed.

**Enabling Single Signon Between LDAP and IBM Cognos Components**

You achieve single signon to IBM Cognos components by configuring the External Identity mapping property.

The External Identity mapping can refer to a CGI environment variable or an HTTP header variable. In the case of an application server gateway or dispatcher
entry pointing to IBM Cognos components, the External Identity mapping can refer to the userPrincipalName session variable. The resolved value of the External Identity mapping property at runtime must be a valid user DN.

When an LDAP namespace is configured to use the External Identity mapping property for authentication, the LDAP provider binds to the directory server using the Bind user DN and password or using anonymous if no value is specified. All users who log on to IBM Cognos using external identity mapping see the same users, groups, and folders as the Bind user.

If you want IBM Cognos components to work with applications that use Java or application server security, you can configure the External identity mapping property to obtain the user ID from the Java user principal. Include the token ${environment("USER_PRINCIPAL")} in the value for the property. For more information, see the online help for IBM Cognos Configuration.

You can apply limited expression editing to the External Identity mapping property using the replace operation.

Replace Operation

The replace operation returns a copy of the string with all occurrences of the old substring replaced by the new substring.

The following rules apply:

• The character \ escapes the characters in the function parameters. Characters such as \ and " need escaping.
• Nested function calls are not supported.
• Special characters are not supported.

Syntax

${replace(str , old , new)}

Parameters for the Replace Operation

Table 60. Parameters and description for the Replace Operation

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>str</td>
<td>The string to search.</td>
</tr>
<tr>
<td>old</td>
<td>The substring to be replaced by the new substring.</td>
</tr>
<tr>
<td>new</td>
<td>The substring that replaces the old substring.</td>
</tr>
</tbody>
</table>

Examples

${replace(${environment("REMOTE_USER")},"NAMERICA\",""}]

${replace(${environment("REMOTE_USER")},"NAMERICA\","")}

Chapter 13. Configuring IBM Cognos Components to Use an Authentication Provider 245
Configuring IBM Cognos Components to Use eTrust SiteMinder

You can configure IBM Cognos components to use a Netegrity SiteMinder namespace as the authentication source, provided that you installed Content Manager on a non-Linux computer.

To configure an authentication provider in an eTrust SiteMinder environment, you configure an LDAP, NTLM, or Netegrity SiteMinder namespace depending on your eTrust SiteMinder configuration. Supported eTrust SiteMinder configurations are LDAP, Active Directory Server, and NTLM user directories.

**Note:** The authentication provider uses an eTrust SiteMinder Software Development Kit to implement a custom agent. The custom agent deployment requires that you set the Agent Properties in the eTrust SiteMinder Policy server administration console to support 4.x agents.

If you plan to run IBM Cognos Business Intelligence products within a 64-bit application server, you cannot configure a Netegrity SiteMinder namespace as your authentication source.

**eTrust SiteMinder Configured for More Than One User Directory**

If you configured eTrust SiteMinder for more than one user directory, you must use the Netegrity SiteMinder namespace. After configuring the Netegrity SiteMinder namespace in IBM Cognos, you must also add a corresponding LDAP, Active Directory Server, or NTLM namespace to the IBM Cognos configuration for each user directory defined in eTrust SiteMinder.

When configuring a corresponding LDAP namespace, ensure that the External identity mapping property is enabled and that you include the token REMOTE_USER in the value for the property. This does not mean that you must configure eTrust SiteMinder to set REMOTE_USER. The IBM Cognos Netegrity SiteMinder namespace passes user information internally to the corresponding LDAP namespace when it receives successful user identification from the eTrust SiteMinder environment.

When configuring a corresponding Active Directory namespace, ensure that the singleSignOnOption property is set to IdentityMapping. The IBM Cognos Netegrity SiteMinder namespace passes user information internally to the corresponding LDAP namespace using the REMOTE_USER environment variable when it receives successful user identification from the eTrust SiteMinder environment. For more information, see "Enabling Single Signon Between Active Directory Server and IBM Cognos Components using REMOTE_USER" on page 226.

**eTrust SiteMinder Configured With Only One User Directory**

If eTrust SiteMinder is configured with only one user directory, the Netegrity SiteMinder namespace is not required. You can use the user directory as your authentication source by configuring the appropriate namespace, or you can configure the eTrust SiteMinder provider with one user directory. For example, if the eTrust SiteMinder user directory is NTLM, you can configure IBM Cognos components with an NTLM namespace or configure IBM Cognos components with one Netegrity SiteMinder namespace, referring to one user directory that is an NTLM namespace.
If the eTrust SiteMinder user directory is Active Directory, you can use an Active Directory namespace or an LDAP namespace that is configured for use with Active Directory.

If you want to use the user directory as your authentication source directly instead of configuring a Netegrity SiteMinder namespace, configure the appropriate LDAP (for more information, see “Configure an LDAP Namespace” on page 233), Active Directory (for more information, see “Configure an LDAP Namespace for Active Directory Server” on page 234), or NTLM (for more information, see “Configuring IBM Cognos Components to Use an NTLM Namespace” on page 249) namespace. In this case, verify the Agent Configuration Object properties in eTrust SiteMinder Policy Server. Ensure that SetRemoteUser is activated.

**Note:** When configuring the LDAP namespace, in this case, ensure that the External identity mapping property is enabled and that you include the token REMOTE_USER in the value for the property.

**Note:** When configuring the Active Directory namespace, in this case, ensure that the singleSignOnOption property is set to IdentityMapping. For more information, see “Enabling Single Signon Between Active Directory Server and IBM Cognos Components using REMOTE_USER” on page 226.

**Procedure**
1. Configure IBM Cognos components to use a Netegrity SiteMinder namespace
2. Enable secure communication to the eTrust SiteMinder user directory if required
3. Enable single signon between eTrust SiteMinder and IBM Cognos
4. Protect the IBM Cognos Web alias

**What to do next**

You can hide the namespace from users during login. For more information, see “Hide the Namespace from Users During Login” on page 231.

**Configure a Netegrity SiteMinder Namespace**

If you configured eTrust SiteMinder for more than one user directory, you must use the Netegrity SiteMinder namespace. After adding the Netegrity SiteMinder namespace, you must also add a corresponding LDAP or NTLM namespace for each user directory.

You can also configure a Netegrity SiteMinder namespace if users are stored in

- an LDAP server
- an NTLM server
- an Active Directory server

**Procedure**
1. In the location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click the Netegrity SiteMinder namespace and then click OK.
The new authentication provider resource appears in the Explorer window, under the Authentication component.

5. In the Properties window, for the NamespaceID property, specify a unique identifier for the namespace.

   **Tip:** Do not use colons (:) in the Namespace ID property.

6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.

7. In the Explorer window, under Security > Authentication, right-click the namespace and click New resource > SiteMinder Policy Server.

8. In the Name box, type a name for the policy server and click OK.

9. In the Properties window, specify the Host property and any other property values you want to change.

10. In the Explorer window, right-click the new SiteMinder Policy Server and click New resource > User directory.

   **Tip:** Configure a user directory for each user directory in the SiteMinder policy server.

11. In the Name box, type a name for the user directory and click OK.

    The name of the user directory must match the name that appears on the policy server.

12. In the Properties window, type a value for the Namespace ID reference property.

13. From the File menu, click Save.

14. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

15. Configure a corresponding LDAP, Active Directory, or NTLM namespace for each LDAP, Active Directory, or NTLM user directory.

    Ensure that you use the same value for the Namespace ID property that you use for the Namespace ID property for the Netegrity SiteMinder namespace.

### Enabling Secure Communication to the eTrust SiteMinder User Directory

If you use an SSL connection to the directory server, you must appropriately configure the Cognos namespace for the user directory.

For more information, see “Configure an LDAP Namespace” on page 233.

### Enable Single Signon Between eTrust SiteMinder and IBM Cognos

By configuring single signon, you are not prompted to reenter authentication information.

IBM Cognos components automatically refer to the eTrust SiteMinder session cookie for user session data.

If the eTrust SiteMinder user directory is LDAP or Active Directory, you must configure the eTrust SiteMinder user directory to use external identity mapping to the REMOTE_USER environment variable.
If the eTrust SiteMinder user directory is NTLM, integrated authentication on Microsoft Windows operating system is used for single signon and no additional configuration is required.

**Protecting the IBM Cognos Web Alias**

Ensure that eTrust SiteMinder is configured correctly to protect the IBM Cognos Web alias.

Use the test tool provided with eTrust SiteMinder to verify that the resource is protected, authenticated, and authorized. For more information, see your eTrust SiteMinder documentation.

**Hide the Namespace from Users During Login**

You can hide namespaces from users during login. You can have trusted signon namespaces without showing them on the namespace selection list that is presented when users login.

For example, you may want to integrate single signon across systems but maintain the ability for customers to authenticate directly to IBM Cognos without being prompted to choose a namespace.

**Procedure**

1. In each location where you configured an eTrust SiteMinder authentication provider, open IBM Cognos Configuration.
2. In the **Explorer** window, under **Security**, > **Authentication**, click the Netegrity Siteminder authentication provider.
3. In the **Properties** window, click the box next to **Selectable for authentication** and then click **False**.
4. From the **File** menu, click **Save**.

**Results**

The namespace is not shown on the selection list that is presented at login.

**Configuring IBM Cognos Components to Use an NTLM Namespace**

You can configure IBM Cognos components to use the Microsoft Windows operating system native security, NT LAN Manager (NTLM), as the authentication source.

If you are not using NTLM in your IS environment, you cannot use an NTLM namespace.

If you want to use an NTLM user directory as your authentication source with eTrust SiteMinder, you must verify the Agent Configuration Object properties in the eTrust SiteMinder Policy Server. Ensure that **SetRemoteUser** is activated.

To use NTLM and to set up single signon, do the following:

1. **configure an NTLM namespace**
2. **enable single signon between NTLM and IBM Cognos components**
Configure an NTLM Namespace

You can configure IBM Cognos components to use an NTLM namespace when users are stored in an NTLM user directory. The NTLM user directory may also be accessed using an eTrust SiteMinder authentication provider.

Procedure
1. In the location where you installed Content Manager, open IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication, and click New resource > Namespace.
3. In the Name box, type a name for your authentication namespace.
4. In the Type list, click NTLM and click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
5. In the Properties window, for the NamespaceID property, specify a unique identifier for the namespace.
   Tip: Do not use colons (:) in the NamespaceID property.
6. Specify the values for all other required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.
7. From the File menu, click Save.
8. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

Results
IBM Cognos loads, initializes, and configures the provider libraries for the namespace.

Enable Single Signon Between NTLM and IBM Cognos Components

By default, the IBM Cognos NTLM provider integrates with the IIS Web server for single signon if integrated authentication (formerly named NT Challenge Response) on Microsoft Windows operating system is enabled on the IIS Web server.

If Windows integrated authentication is enabled, you are not prompted to reenter authentication information when accessing IBM Cognos content that is secured by the NTLM namespace.

Procedure
1. Set up Windows integrated authentication on the IIS Web server.
2. Install Content Manager in a location that is part of the domain, for the active and standby Content Managers.
3. Set up the computers, or the user account under which Content Manager runs, to be trusted for delegation.
4. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.
Results

IBM Cognos loads, initializes, and configures the provider libraries for the namespace.

Configuring IBM Cognos to Use a RACF Provider for Authentication

If you use a Resource Access Control Facility (RACF) provider for authentication in your enterprise environment, you can also use it for authentication in IBM Cognos products.

Procedure

1. **Configure IBM Cognos components to use a RACF namespace**
2. Configure secure communication
3. **Enable single signon between the RACF provider and IBM Cognos components**

Configuring a RACF Namespace

You can configure a Resource Access Control Facility (RACF) namespace using IBM Cognos Configuration.

Before you begin

Before you configure the RACF namespace, you must do the following:

- You must be running Tivoli Directory Server.
- Tivoli Directory Server must be configured for LDAP, to access the SDBM (RACF) database.

For more information, see the topic about configuring Tivoli Access Manager for LDAP in the IBM Information Center.

Procedure

1. In the location where you installed Content Manager, open IBM Cognos Configuration.
2. To create the namespace, do the following:
   - In the Explorer window, under Security, right-click Authentication, and click New resource > Namespace.
   - In the Name box, type a name for your authentication namespace.
   - In the Type list, click RACF and then click OK.
   
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
3. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
   Do not use colons (:) in the Namespace ID property.
4. For the Host and port property, type the value that corresponds to the Tivoli Directory Server.
5. For the Base Distinguished Name property, type the value that matches the suffix that is configured for SDBM in the Tivoli Directory Server.
6. If you are using an SSL connection to the RACF provider, set the Enable SSL property to true.
7. To map to RACF account properties such as email and phone number, for the Base segment DATA and the TSO segment USERDATA properties under Account mappings, click in the value column and select the value from the drop-down list.

8. From the File menu, click Save.

9. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

Enabling Single Signon Between RACF and IBM Cognos

Enable single signon between the Resource Access Control Facility (RACF) provider and IBM Cognos components to simplify the authentication process for users, avoid the need for multiple signons, and simplify user identity management across the network.

You achieve single signon by configuring identity mapping in IBM Cognos Configuration, configuring IBM WebSphere Application Server to set the REMOTE_USER, and then configuring WebSphere to authenticate against RACF.

When a RACF namespace is configured to use identity mapping for authentication, the RACF namespace binds to the RACF provider using the binding credentials or using anonymous if no binding credentials are specified. All users who log on to IBM Cognos using identity mapping see the same users, groups, and folders as the binding user.

Procedure

1. In every location where you installed Content Manager, open IBM Cognos Configuration.

2. In the Explorer window, under Security, right-click Authentication, and then click the RACF namespace.

3. In the Resource properties window, change Enable identity mapping to True.

4. Click the value column for Binding credentials and then click the edit button.

5. In the Value - Binding credentials dialog box, specify the User ID and Password.

6. In IBM Cognos Configuration, restart the service:
   • In the Explorer window, expand IBM Cognos services, and select the service.
   • From the Actions menu, click Restart.

7. Using the WebSphere documentation, configure WebSphere to set REMOTE_USER.

8. Using the WebSphere documentation, configure WebSphere to authenticate using the RACF provider.

Configure IBM Cognos to use SAP

To use an SAP server as your authentication provider, you must use a supported version of SAP BW.

To review an up-to-date list of environments supported by IBM Cognos products, such as operating systems, patches, browsers, Web servers, directory servers, database servers, and application servers, see Software Environments for Cognos Planning 10.2.0 (www.ibm.com/support/docview.wss?uid=swg27048523).
In SAP BW, you can assign users to user groups or roles or both. The SAP authentication provider uses only the roles.

The authorization rights required by the SAP user depend on who uses IBM Cognos components: users or administrators.

**SAP Authorization Settings for IBM Cognos Users**

The authorization objects in the following table are required for any IBM Cognos user.

*Table 61. SAP authorization settings for IBM Cognos users*

<table>
<thead>
<tr>
<th>Authorization object</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_RFC</td>
<td>Authorization check for RFC access</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Activity</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Name of RFC to be protected</td>
<td>RFC1 RS_UNIFICATION, SDTX, SH3A, SU_USER, SYST, SUSO</td>
</tr>
<tr>
<td></td>
<td>Type of RFC to be protected</td>
<td>FUGR</td>
</tr>
<tr>
<td>S_USER_GRP</td>
<td>User Master Maintenance: User Groups</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Activity</td>
<td>03</td>
</tr>
<tr>
<td></td>
<td>Name of user group</td>
<td>*</td>
</tr>
</tbody>
</table>

Some of the values shown, such as *, are default values that you may want to modify for your environment.

**SAP Authorization Settings for IBM Cognos Administrators**

If users will perform administrative tasks and searches for users and roles, the values from the following table must be added to the S_RFC authorization object in addition to the values listed above for IBM Cognos users.

*Table 62. SAP authorization settings for IBM Cognos administrators*

<table>
<thead>
<tr>
<th>Authorization object</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_RFC</td>
<td>Authorization check for RFC access</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Activity</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>RFC_NAME</td>
<td>PRGN_J2EE, SHSS, SOA3</td>
</tr>
<tr>
<td></td>
<td>Type of RFC object to be protected</td>
<td>FUGR</td>
</tr>
</tbody>
</table>

Some of the values shown, such as *, are default values that you may want to modify for your environment.
Configure an SAP Namespace

You can configure IBM Cognos components to use an SAP server as the authentication source.

Before you begin

If you installed your IBM Cognos product on a 64-bit server, you must also manually copy the SAP RFC library files to the IBM Cognos installation directory.

Procedure

1. If running on a 64-bit server, do the following:
   • Go to the SAP installation directory on the 64-bit server.
   • Copy all 64-bit SAP RFC library files to \c10_64_location\bin64, where \c10_64_location is the directory where you installed the IBM Cognos server.
   • Copy all 32-bit SAP RFC library files to \c10_64_location\bin.
2. If running on a 32-bit server, copy all 32-bit SAP library files from the SAP installation directory to the \c10_location\bin directory.
3. In the location where you installed Content Manager, open IBM Cognos Configuration.
4. In the Explorer window, under Security, right-click Authentication, and click New resource > Namespace.
5. In the Name box, type a name for your authentication namespace.
6. In the Type list, click SAP and then click OK.
   The new authentication provider resource appears in the Explorer window, under the Authentication component.
7. In the Properties window, for the Namespace ID property, specify a unique identifier for the namespace.
   Tip: Do not use colons (:) in the Namespace ID property.
8. Specify the values for all required properties to ensure that IBM Cognos components can locate and use your existing authentication provider.
   Depending on your environment, for the Host property, you may have to add the SAP router string to the SAP host name.
9. If the SAP system encodes the contents of cookies, enable the decode tickets feature:
   • In the Properties window, for Advanced properties, click the Value and then click the edit button.
   • Click Add.
   • Enter the name URLDecodeTickets and enter the value true
   • Click OK.
   All SAP logon tickets will be decoded by the SAP namespace before establishing a connection.
10. From the File menu, click Save.
11. Test the connection to a new namespace. In the Explorer window, under Authentication, right-click the new authentication resource and click Test.

Enable Single Signon Between SAP and IBM Cognos

You can enable single signon between SAP Enterprise Portal and IBM Cognos components as well as when using the external namespace function of the SAP BW data source connections.
To do so, ensure that you set the following system parameters on the SAP BW server:

- `login/accept_sso2_ticket = 1`
- `login/create_sso2_ticket = 1`
- `login/ticket_expiration_time = 200`

---

**Delete an Authentication Provider**

If they are no longer required, you can delete namespaces that you added, or unconfigure namespaces that IBM Cognos components detected.

You must not delete the Cognos namespace. It contains authentication data that pertains to all users and is required to save the configuration.

When you delete a namespace, you can no longer log on to the namespace. Security data for the namespace remains in Content Manager until you permanently delete it in the portal. For more information, see the *Administration and Security Guide*.

**Procedure**

1. In each location where you installed Content Manager, open Cognos Configuration.
2. In the Explorer window, under Security > Authentication, right-click the namespace and click **Delete**.
3. Click **Yes** to confirm.
   - The namespace disappears from the Explorer window and you can no longer log on to the namespace in that location.
4. From the **File** menu, click **Save**.
5. Repeat steps 1 to 4 for each location where you installed Content Manager.
   - You must now log on to the portal and permanently delete the data for the namespace. For more information, see the *Administration and Security Guide*.

**Results**

After you delete a namespace, it appears as Inactive in the portal.
Chapter 14. Configuring IBM Cognos for an SAP Environment

IBM Cognos Planning accesses SAP BW using the same OLAP interface as IBM Cognos Business Intelligence components. However, to optimize performance for your planning applications, you can also create a detailed fact query subject in Framework Manager. This optimization allows a high volume of data for planning applications. The OLAP interface is optimized for reporting.

If your environment uses SAP components, you must configure it for IBM Cognos to be able to access data or to administer users access.

Follow this process:
1. Verify the system requirements.
2. Set access permissions to model and run reports using SAP BW as a data source.

If you want to improve performance, install IBM Cognos SAP gateway functions and set additional access permissions.

You can also use SAP components for authentication and as the application server running IBM Cognos processes. For example, you can do the following:
- Enable single signon for Portal Services with the SAP logon ticket or with the user mapping.
- Enable secure communication between SAP EP and IBM Cognos Components.
- Configure an SAP server as your authentication provider.

Verify System Requirements

You must ensure that your environment meets the minimum requirements for IBM Cognos components to use SAP as a data source.

Procedure

Ensure that the following are installed on each IBM Cognos server computer:
- SAP GUI version 6.40 or later
- BW Add-on
  The BW Add-on is needed for SAP GUI to communicate with a BW server. It is selected when you install SAP GUI.

Set Access Permissions for Modeling and Reporting Access

For IBM Cognos products to be able to access SAP BW as a data source, the user accounts used to connect to SAP must have specific permissions. These permissions are required for the OLAP interface to SAP BW and are therefore relevant to both reporting and planning activities.

Incorrect permissions may result in run time errors. For more information, see "Problems Creating a Module in Framework Manager Using a SAP BW Data Source" on page 310.
### Procedure

Use the following table to ensure that the SAP accounts accessing the data source have the correct permissions:

*Table 63. Modeling and reporting permissions requirements for SAP accounts*

<table>
<thead>
<tr>
<th>Authorization object</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_RFC</td>
<td>Activity</td>
<td>16 (Execute)</td>
</tr>
<tr>
<td></td>
<td>RFC_NAME</td>
<td>RFC1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RSAB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RSOB</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RS_UNIFICATION</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RSNDI_SHIE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RZX0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SDTX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SUGU</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SYST</td>
</tr>
<tr>
<td></td>
<td>RFC_TYPE</td>
<td>FUGR (Function Group)</td>
</tr>
<tr>
<td>S_TABU_DIS</td>
<td>Activity</td>
<td>03 (Display)</td>
</tr>
<tr>
<td></td>
<td>Authorization Group</td>
<td>&amp;NC&amp;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>SS</td>
</tr>
<tr>
<td>S_RS_COMP</td>
<td>Activity</td>
<td>03 (Display)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>16 (Execute)</td>
</tr>
<tr>
<td></td>
<td>InfoArea</td>
<td><em>All values</em></td>
</tr>
<tr>
<td></td>
<td>InfoCube</td>
<td><em>All values</em></td>
</tr>
<tr>
<td></td>
<td>Name (ID) of reporting component</td>
<td><em>All values</em></td>
</tr>
<tr>
<td></td>
<td>Type of reporting component</td>
<td><em>All values</em></td>
</tr>
<tr>
<td>S_RS_COMP1</td>
<td>Activity</td>
<td>03 (Display)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>16 (Execute)</td>
</tr>
<tr>
<td></td>
<td>Name (ID) of reporting component</td>
<td><em>All values</em></td>
</tr>
<tr>
<td></td>
<td>Type of reporting component</td>
<td><em>All values</em></td>
</tr>
</tbody>
</table>
Table 63. Modeling and reporting permissions requirements for SAP accounts (continued)

<table>
<thead>
<tr>
<th>Authorization object</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Owner for</td>
<td>All values</td>
</tr>
<tr>
<td>S_RS_HIER</td>
<td>Activity</td>
<td>71 (Analyze)</td>
</tr>
<tr>
<td></td>
<td>InfoObject</td>
<td>All values</td>
</tr>
<tr>
<td></td>
<td>Hierarchy name</td>
<td>All values</td>
</tr>
<tr>
<td></td>
<td>Hierarchy version</td>
<td>All values</td>
</tr>
<tr>
<td>S_RS_ICUBE</td>
<td>Activity</td>
<td>03 (Display)</td>
</tr>
<tr>
<td></td>
<td>InfoCube Subobject</td>
<td>AGGREGATE, DATA, DEFINITION</td>
</tr>
<tr>
<td></td>
<td>InfoArea</td>
<td>All values</td>
</tr>
<tr>
<td></td>
<td>InfoCube</td>
<td>All values</td>
</tr>
</tbody>
</table>

Notes:
- *All values* indicates objects specific to your SAP environment to which you want to limit or permit access.
- &NC& represents any table that does not have an authorization group. For security reasons, create a new authorization group as a customization in the SAP BW system and assign the table RSHIEDIR to it. The new authorization group restricts the user's access to the previous table only, which is needed by Framework Manager.

Install and Configure IBM Cognos SAP Gateway Functions

To be able to create detailed fact query subjects in Framework Manager for IBM Cognos Planning, you must install gateway function modules on your SAP server. You must also set additional permissions for the SAP account that will access the data.

The SAP gateway functions use Advanced Business Applications Programming (ABAP) function modules that interface with the SAP environment. The gateway functions must be installed on each SAP server that you want to use as a data source and should be installed by a SAP system administrator.

The module files are located in the `c10planning_location\transports` directory. A separate directory is created for each version of SAP that is supported.

If you are using SAP ERP Core Components versions ECC5 or ECC6, you must use the ABAP function modules in the `c10_location\transports\v47` directory.
Install gateway functions on Windows

Complete the following steps to install IBM Cognos SAP gateway functions on Windows.

**Procedure**

1. Copy the file named Knn.ext from the c10_location\transports\SAP_version directory to the SAP_home\trans\cofiles directory on the SAP server.
2. Copy the file named Rnn.ext from the c10_location\transports\SAP_version directory to the SAP_home\trans\data directory on the SAP server.

**Results**

You can now apply the functions.

Install gateway functions on UNIX

Complete the following steps to install IBM Cognos SAP gateway functions on UNIX.

**Procedure**

1. Copy the gateway functions from the Windows computer where you installed IBM Cognos Planning to the UNIX computer where SAP is running.
2. Use file transfer protocol (FTP) in ASCII mode to copy the file named Knn.ext from the c10_location\transports\SAP_version directory to the SAP_home\trans\cofiles directory on the SAP server.
3. Use FTP in binary (bin) mode to copy the file named Rnn.ext from the c10_location\transports\SAP_version directory to the SAP_home\trans\data directory on the SAP server.

**Results**

You can now apply the functions.

Apply the SAP Gateway Functions

After you install the SAP gateway functions, you must apply them using SAP GUI. Applying the functions should be performed by a SAP system administrator.

**Procedure**

1. In the SAP GUI, start an STMS transaction.
2. Click Imports, and then double-click the queue name.
3. If a message appears prompting you to add to the import queue, click Yes and, if required, type your password.
4. In the queue, select the transport request name matching the name in the TRnames.txt file.
5. From the Request menu, click Import and type the target client number.
6. Click Start Import, and then click Yes. If required, type the password.
7. If you want to check the result, click Logs.

**Results**

You can now install the IBM Cognos Compression Utility.
Install the IBM Cognos Compression Utility

The IBM Cognos compression utility is required for data compression on a SAP server. The corresponding decompression function is included in the SAP gateway functions.

Install the compression utility on Windows

Complete the following steps to install the IBM Cognos compression utility on Windows.

Procedure

1. Go to the c10planning_location\bin directory, and locate the files named udacompr.exe and zlib1.dll.
2. Copy these files to the DIR_EXECUTABLE directory on all Windows SAP servers.
   The DIR_EXECUTABLE directory is usually defined as SAP_instance\SYS\exe\run.

Install the compression utility on UNIX

Complete the following steps to install the IBM Cognos compression utility on UNIX.

Procedure

1. Using binary transfer mode, FTP the files from the zipfiles\UNIX_platform directory on the IBM Cognos Planning Server CD to the DIR_EXECUTABLE directory on all UNIX SAP Servers.
   The DIR_EXECUTABLE directory is usually defined as SAP_instance/SYS/exe/run.
2. Set execute privileges on each of the files.

Set Access Permissions for the IBM Cognos SAP Gateway Functions

For IBM Cognos SAP gateway functions to access SAP BW data, you must assign specific permissions to the user accounts that connect to the SAP server.

Incorrect permissions may result in run time errors. For more information, see "Authorization Errors Using the IBM Cognos SAP Gateway" on page 312.

If your SAP security standards do not allow you to assign IBM Cognos permissions for all files on your SAP server, you can restrict the directories to which the permissions apply. For more information, see "Configuring a Logical Path to Manage SAP Temporary Files" on page 262.

Procedure

Use the following table to ensure that the SAP accounts accessing the data source have the correct permissions:

<table>
<thead>
<tr>
<th>Authorization object</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>S_RFC</td>
<td>Activity</td>
<td>16 (Execute)</td>
</tr>
</tbody>
</table>
Table 64. Gateway permissions requirements for SAP accounts (continued)

<table>
<thead>
<tr>
<th>Authorization object</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFC_NAME</td>
<td>ZCOGNOS_80A</td>
<td></td>
</tr>
<tr>
<td>S_BTCH_JOB</td>
<td>Job Operations</td>
<td>RELE (Release Jobs)</td>
</tr>
<tr>
<td></td>
<td>Job Group</td>
<td>RELE (Release Jobs)</td>
</tr>
<tr>
<td>S_DATASET</td>
<td>Activity</td>
<td>06 (Delete)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>33 (Read)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>34 (Write)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A7 (Write with Filter)</td>
</tr>
<tr>
<td></td>
<td>Physical file name</td>
<td>All values</td>
</tr>
<tr>
<td></td>
<td>Program Name</td>
<td>All values</td>
</tr>
</tbody>
</table>

Notes:

- *All values* indicates objects specific to your SAP environment to which you want to limit or permit access.
- S_DATASET must be assigned Delete permissions so that temporary files (.tmp) can be deleted. For more information, see "Configuring a Logical Path to Manage SAP Temporary Files."

**Configuring a Logical Path to Manage SAP Temporary Files**

By configuring a logical path on your SAP server, you can manage SAP temporary files without compromising the security standards of your SAP environment.

When IBM Cognos SAP gateway functions extract SAP data, they create temporary files (.tmp) on the SAP server. The operating system of the SAP server does not delete the .tmp files because it does not recognize them as temporary. The temporary files can grow very large unless an IBM Cognos function deletes them.

To allow the IBM Cognos SAP gateway functions to create and delete temporary files, you must assign Delete, Read, Write, and Write with Filter permissions to the S_DATASET object. "Set Access Permissions for the IBM Cognos SAP Gateway Functions" on page 261. However, your SAP security standards may not allow you to apply these permissions for all files on your SAP server. You can restrict IBM Cognos user permissions only to files in a specific directory. To specify this directory, you configure a logical path on your SAP server.

To configure a logical path, do the following:

**Procedure**

1. In your SAP application, call the transaction code FILE.
2. Define a logical file path for IBM Cognos temporary files.
3. Assign a physical path, including the directory where temporary files will be stored, to the logical path that you defined previously.
4. Define a logical file name that follows a predefined naming standard.
Results

For more information, see your SAP documentation.
Chapter 15. Configuring Portal Services

Portal Services provides a set of IBM Cognos portlets that you can use in IBM Cognos Connection and in other portals. You can use the portlets to navigate, search, and view IBM Cognos reports in your working environment. Other users can view IBM Cognos information without needing to know how to use IBM Cognos products.

For more information, see the Administration and Security Guide.

Portal Services is installed automatically with IBM Cognos components. In a distributed environment, it is included with the Application Tier Components. The installation includes the deployment files for
- SAP Enterprise Portal (SAP EP)
- IBM WebSphere Portal
- Oracle WebCenter Interaction Portal
- SharePoint Portal

For some deployments of Portal Services, you must modify some Portal Services property settings and prepare the IBM Cognos environment to support the other portal.

When used in another portal, Portal Services can authenticate users in only one namespace. If IBM Cognos components are configured with more than one namespace, you must install a separate gateway for each namespace that will be used to authenticate portal users. You must configure each gateway to use the appropriate namespace and then configure the deployed portlets to use that gateway.

After you configure the required properties, you must deploy the Cognos portlets to the other portal. For more information, see the Administration and Security Guide.

To use Portal Services with IBM Cognos components, do the following:
- Specify the location of the applications.xml file if required.
- Install and test the portlets on the other portal.
  For more information, see the Administration and Security Guide.
- Configure security for the other portal environment.

Specify the Location of the Applications.xml File

If you use the applications.xml file as part of a custom application portlet, all Application Tier Components computers in a distributed environment must reference the same applications.xml file. If you have multiple instances of the applications.xml file, they must be identical.

Note: The steps are required only if you want to use the Extended Applications portlet, which is included with the IBM Cognos Business Intelligence software development kit.
Procedure

1. On the Application Tier Components computer, start IBM Cognos Configuration.
2. In the Explorer window, under Environment, click Portal Services.
3. In the Properties window, click the Value next to Location of 'applications.xml'.
4. Replace localhost with a valid host name or IP address and, if necessary, replace the default port number.
5. From the File menu, click Save.

Results

You can now deploy the IBM Cognos portlets to your portal server. For instructions, see the Administration and Security Guide.

Configuring Security for Portal Services

When using Portal Services in another portal, you must enable single signon to provide seamless integration between the other portal and IBM Cognos components.

Portal Services uses single signon to authenticate users. This means that users do not have to log on to other applications separately through the portal.

You must configure a URI into IBM Cognos components for each portlet in Portal Services.

To enable security between IBM Cognos components and the other portal, do the following:

- Disable anonymous access to IBM Cognos components.
  - If your security infrastructure requires you to use another method for single signon, use one of the following methods:
    - Enable single signon for the other portal using shared secret.
      - If your security infrastructure requires you to use another method for single signon, use one of the following methods:
        - “Enable Single Signon for WebSphere Portal Using the Application Server” on page 274
        - “Enable Single Signon for Oracle WebCenter Interaction Portal Using Basic Authentication” on page 274
        - “Enable Single Signon for Oracle WebCenter Interaction Portal Using SiteMinder” on page 275
    - Configure IBM Cognos components for SSL access, if required.

Disable Anonymous Access to IBM Cognos Components

Portal Services uses single signon for authentication. If anonymous logon is enabled in IBM Cognos components, Portal Services logs all portal users as anonymous. You must ensure that anonymous access is disabled in IBM Cognos components for single signon in Portal Services to be successful. However, you can test the Portal Services connections using anonymous logon to ensure that the portlets are working in the other portal.
If Portal Services fails to authenticate a user, the user receives an error message at the other portal.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window, under **Security > Authentication**, click **Cognos**.
3. In the **Properties** window, ensure that **Allow anonymous access** is set to **False**.
4. From the **File** menu, click **Save**.
5. Repeat steps 1 to 4 on all servers where you installed IBM Cognos components.

**Enable Single Signon Using Shared Secret**

You can use shared secret for single signon between IBM Cognos portlets and IBM Cognos components. The Cognos portlets send a message that contains an encrypted version of the portal user ID. The encryption key is determined by the value of a secret character string shared between the portlets and the custom Java security provider on the IBM Cognos server.

You can use shared secret for the other portal only if portal user IDs can be looked up in an NTLM, LDAP, or IBM Cognos Series 7 authentication namespace that is shared by IBM Cognos components.

IBM Cognos components must have access to a directory server that contains user IDs for all your portal users. Using IBM Cognos Configuration, you must configure an authentication namespace so that the portal and IBM Cognos components share the same authentication source.

You must also create a Custom Java Provider namespace to register the shared secret Java provider that is provided with IBM Cognos components. Within the portlets or iViews, you must link the portlets or iViews to the Custom Java Provider namespace within your respective portal:

- Cognos iViews (SAP EP)
- Cognos Portlet Application (WebSphere Portal)
- remote server (Oracle WebCenter Interaction Portal)
- Cognos WebPart (SharePoint Portal)

You are not required to configure access to the Portal Services Web content. However, if you deploy the portlets to another portal, you can configure access to an alternate URI for Portal Services images and Web content.

**Configure the Required Namespaces**

IBM Cognos components must have access to a directory server that contains user IDs for all your portal users. Using IBM Cognos Configuration, you must configure an authentication namespace so that the portal and IBM Cognos components share the same authentication source.

**Procedure**

1. In IBM Cognos Configuration, configure a namespace to authenticate portal users.
2. For an LDAP namespace, configure the following properties:
   - For the **Use external identity** property, change the setting to **True**.
   - For the **External identity mapping** property, set it to
     \( \text{(uid=${environment("REMOTE_USER")})} \)
For SharePoint Portal, if SharePoint is on a different machine from the LDAP server, set **External identity mapping** to

\[ uid=${replace(${environment("REMOTE_USER")},"SharePoint_Server\","")}) \]

3. For an IBM Cognos Series 7 namespace, map the portal user IDs to IBM Cognos Series 7 user IDs using OS signons.
For more information, see the IBM Cognos Series 7 documentation.
4. In IBM Cognos Configuration, create and configure a Custom Java Provider namespace.
   - For the **Namespace ID** property, specify any new ID.
     For example, **cpstrusted**
     This new ID must be used in the portlet configuration settings.
   - For the **Java class name** property, type
     `com.cognos.cps.auth.CPSTrustedSignon`
     Java class names are case-sensitive.
5. In IBM Cognos Configuration, under **Environment > Portal Services**, configure the following properties:
   - For **Trusted Signon Namespace ID**, type the namespace ID of the LDAP, NTLM, or IBM Cognos Series 7 namespace that you configured in step 1.
     **Tip:** The trusted signon namespace acts as an intermediary and must be attached to a real directory-based namespace of type LDAP, NTLM, or IBM Cognos Series 7.
   - For **Shared Secret**, type the key to be used for single signon.
     This parameter represents the authorization secret that must be shared between the Cognos portlets and the IBM Cognos server. Consider this as a secret password. You must use the same character string when you configure the portlet application. You must use a single word as the key.
     For security reasons, specify a non-null value.
6. Under **Environment**, for **Gateway Settings**, set the **Allow Namespace Override** property to **true**.
7. From the **File** menu, click **Save**.
8. Restart the IBM Cognos service.

**Configure Access to the Portal Services Web Content**

After creating the required namespaces, you must configure access so that users can access the Web content.

**Procedure**
1. On the computer where you installed the Application Tier Components, start IBM Cognos Configuration.
2. In the **Explorer** window, under **Environment**, click **Portal Services**.
3. In the **Properties** window, click the **Value** box next to **Web Content URI**.
4. Specify the host name or IP address of the gateway and a port number using the format
   `host_or_IP_address:port`
5. From the **File** menu, click **Save**.
Configure the Cognos iViews for SAP EP
Within the iViews, you must link the iViews to the Custom Java Provider namespace within your respective portal.

Procedure
1. Open the iView editor for each Cognos iView.
2. In the Property Category box, select Show All.
3. For the cpsauthsecret: CPS Authorization Secret property, enter the secret character string that you used for the Shared Secret property when you configured the Custom Java Provider namespace.
4. For the cps: authentication namespace ID property, enter the Custom Java Provider namespace ID.
5. For the cpsserver: CPS Connection Server property, enter the URL path to access Portal Services components through the gateway.

The format of the URL is as follows:
- For Cognos content portlets
  Gateway_URI/wsrp/cps4/portlets/nav?wsdl&b_action=cps.wsd1
  Example for a CGI gateway:
  http://myserver/ibmcognos/cgi-bin/cognos.cgi/wsrf/cps4/portlets/nav?wsdl&b_action=cps.wsd1
  Example for a servlet gateway:
  http://172.0.16.1:9500/wsrp/cps4/portlets/nav?wsdl&b_action=cps.wsd1
- For Cognos Extended Applications
  Gateway_URI/wsrf/cps4/portlets/sdk?wsdl&b_action=cps.wsd1
  Example for a CGI gateway:
  http://myserver/ibmcognos/cgi-bin/cognos.cgi/wsrf/cps4/portlets/sdk?wsdl&b_action=cps.wsd1
  Example for a servlet gateway:
  http://172.0.16.1:9500/wsrp/cps4/portlets/sdk?wsdl&b_action=cps.wsd1
- For Metrics Manager Watchlist portlets
  Gateway_URI/wsrf/cps4/portlets/cmm?wsdl&b_action=cps.wsd1
  Example for a CGI gateway:
  http://myserver/ibmcognos/cgi-bin/cognos.cgi/wsrf/cps4/portlets/cmm?wsdl&b_action=cps.wsd1
  Example for a servlet gateway:
  http://172.0.16.1:9500/wsrp/cps4/portlets/cmm?wsdl&b_action=cps.wsd1

Configure the Cognos Portlets for WebSphere Portal
Within the portlets, you must link the portlets to the Custom Java Provider namespace within your respective portal.

Procedure
1. For each Cognos portlet application, click the edit value icon.
2. For the cps_auth_secret property, enter the secret character string that you used for the Shared Secret property when you configured the Custom Java Provider namespace.
3. For the cps_auth_namespace property, enter the Custom Java Provider namespace ID.
4. For the **CPS Endpoint** property, enter the URL path to access Portal Services components through the gateway.

The format of the URL is as follows:

- For Cognos content portlets
  
  \[Gateway:\_URI/\text{wsrp/cps4/portlets/nav}\?\text{wsdl}\&b\_action=\text{cps.wsdl}\]

  Example for a CGI gateway:
  
  \[http://\text{myserver/ibmcognos/cgi-bin/cognos.cgi/\text{wsrp/cps4/portlets/nav}\?\text{wsdl}\&b\_action=\text{cps.wsdl}}\]

  Example for a servlet gateway:
  
  \[http://172.0.16.1:9500/\text{wsrp/cps4/portlets/nav}\?\text{wsdl}\&b\_action=\text{cps.wsdl}\]

- For Cognos Extended Applications
  
  \[Gateway:\_URI/\text{wsrp/cps4/portlets/sdk}\?\text{wsdl}\&b\_action=\text{cps.wsdl}\]

  Example for a CGI gateway:
  
  \[http://\text{myserver/ibmcognos/cgi-bin/cognos.cgi/\text{wsrp/cps4/portlets/sdk}\?\text{wsdl}\&b\_action=\text{cps.wsdl}}\]

  Example for a servlet gateway:
  
  \[http://172.0.16.1:9500/\text{wsrp/cps4/portlets/sdk}\?\text{wsdl}\&b\_action=\text{cps.wsdl}\]

- For Metrics Manager Watchlist portlets
  
  \[Gateway:\_URI/\text{wsrp/cps4/portlets/cmm}\?\text{wsdl}\&b\_action=\text{cps.wsdl}\]

  Example for a CGI gateway:
  
  \[http://\text{myserver/ibmcognos/cgi-bin/cognos.cgi/\text{wsrp/cps4/portlets/cmm}\?\text{wsdl}\&b\_action=\text{cps.wsdl}}\]

  Example for a servlet gateway:
  
  \[http://172.0.16.1:9500/\text{wsrp/cps4/portlets/cmm}\?\text{wsdl}\&b\_action=\text{cps.wsdl}\]

**Configure the Remote Server for Oracle WebCenter Interaction Portal**

Within the portlets, you must link the portlets to the Custom Java Provider namespace within your respective portal.

**Procedure**

1. Using a plain ASCII editor, such as Notepad, edit the cpsalui.properties file in the \texttt{c10\_location/cps/oracle/webapps/gadgets/WEB-INF/classes} directory.

2. Configure the settings shown in the following table.
Table 65. Settings for the cpsalui.properties file

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>cps_endpoint</td>
<td>The URL to connect to the Application Tier Components and extract the WSDL information. Specify the URI to the gateway. For a servlet or ISAPI gateway, replace the localhost/ibmcognos/cgi-bin/cognos.cgi portion with the values to target the gateway. For example, http://host_name/ibmcognos/cgi-bin/cognosisapi.dll/wsrp/cps4/portlets/[package]?wsdl&amp;b_action=cps.wsdl</td>
</tr>
<tr>
<td>forward_cookies=</td>
<td>The names of the cookie that should be sent to the Application Tier Components for single signon. Leave blank.</td>
</tr>
<tr>
<td>cps_auth_secret</td>
<td>The shared secret code IBM Cognos uses to encrypt an HTTP header variable that carries the user identity. This parameter represents the authorization secret that must be shared between the Cognos portlets and the IBM Cognos server. Consider this as a secret password. Use the same value that you used for Shared Secret in IBM Cognos Configuration. For security reasons, specify a non-null value.</td>
</tr>
<tr>
<td>cps_auth_namespace</td>
<td>The namespace ID for the Custom Java Provider.</td>
</tr>
</tbody>
</table>

3. Go to the `c10_location/cps/oracle` directory and run the following build file:
   - On UNIX or Linux operating systems, `build.sh`
   - On Microsoft Windows operating system, `build.bat`
   This creates a `cps-wci.war` file in the `c10_location/cps/oracle/gadgets` directory.
4. Copy the `cps-wci.war` file to the application server.
   For instructions, see the administration guide for your application server.

**Results**

Single signon is configured.

**Configure Properties for the Cognos WebPart for SharePoint Portal**

Within the portlets, you must link the portlets to the Custom Java Provider namespace within your respective portal.
Procedure

1. Using a plain ASCII editor, such as Notepad, edit the web.config file in the
   `drive\Program Files\Common Files\Microsoft Shared\web server
   extensions\12\CONFIG` directory.

2. Find the following string:
   ```xml
   <SSO cps_auth_namespace="" cps_auth_secret="" />
   ```

3. Set `cps_auth_namespace` to the namespace ID for the Custom Java Provider
   namespace.

4. Set `cps_auth_secret` to the value that you used for Shared Secret in IBM
   Cognos Configuration.

Enable Single Signon for SAP EP with the SAP Logon Ticket

If you enable single signon with the SAP Logon Ticket, you must configure IBM
Cognos components with an SAP namespace that links to an SAP BW server.

Then you must copy the certificate that was generated during SAP EP installation
to the SAP BW personal security environment.

Users must have the same user ID in all SAP systems that are accessed through
single signon.

Before you start, ensure that you have
- configured IBM Cognos components to use an SAP authentication source
- enabled single signon between IBM Cognos components and SAP BW
- installed the latest service packs on the SAP BW server
  Service packs can be downloaded from SAPNET.
- installed the latest hot patches for the SAP portal
- installed the Enterprise Portal plug-in that corresponds to the SAP EP release or
  SAP BW server
  For SAP releases earlier than 6.2, on SAPNET, download EP50_PLUG-IN for
  Basis 620 (SAPKINE32A). Using transaction SAINT, install SAPKINE32A.
- installed the SAP Security Library on the SAP BW servers
  From sapservX, under `/general/misc/security/SAPSECU/platform`, download
  sapsecin and sepsecu.dll and place both files in the `/run` directory of the SAP
  BW server.

To enable SSO for SAP EP, complete the procedures for single signon with SAP

You can now use the Cognos iViews in the SAP Enterprise Portal. For more
information, see the Administration and Security Guide.

Enable Single Signon for SAP EP with User Mapping

If you enable single signon with user mapping, you define an IBM Cognos data
source in SAP EP. Individual users or an administrator can enter the user IDs and
passwords for IBM Cognos components in the data source. You must map the
users logon credentials in the data source to an LDAP or IBM Cognos Series 7 or
NTLM namespace. Portal Services iViews transmit the logon credentials to IBM
Cognos components using HTTP Basic Authentication.
Prepare the Environment
Before you map user logon credentials, you must perform certain tasks in the security environment.

Procedure
1. Configure the gateway URI that will be used by Portal Services to require authentication using HTTP Basic Authentication.
   For information about configuring a URL to use HTTP Basic Authentication, see the documentation for the gateway or for your Web server.
2. Adjust the iView configuration to access the secure URL.
   For information, see the documentation for your Web server.
3. In IBM Cognos Configuration, configure a namespace to authenticate portal users.
4. If you use an LDAP namespace, configure the following properties:
   - For the Use external identity property, change the setting to True.
   - For the External identity mapping property, set it to (uid=${environment("REMOTE_USER")})

Create the Data Source and Map the Users
You must set up the logon credentials and define the user mappings for the Cognos iViews.

Procedure
1. In the SAP portal, ensure that the following properties are configured for the data source in the /PortalContent/other_vendors/every_user/com.cognos.pct.c8/systems/Cognos directory:
   - Logon Method = UIDPW
   - server name = the name of the IBM Cognos server
   - port number = port number of the gateway
   - Protocol of Target system = HTTP
   - User Mapping Type = admin,user
   - system alias (Create a system alias)
   For more information, see the SAP Enterprise Portal Administration Guide.
2. For each Cognos iView, enable user mapping for the data source by entering the name of the system alias at the iView level, in an attribute called CPS: User Mapping Datasource.
   For more information, see the SAP Enterprise Portal Administration Guide.
3. For each Cognos iView, set the CPS: Authentication Namespace ID property to the namespace that you want to use for authentication.
4. Register the IBM Cognos credentials for the portal users.
   Users can enter their own user IDs and passwords.
   For more information, see the SAP Enterprise Portal Administration Guide.
5. Enable secure communication between SAP EP and IBM Cognos.

Results
You can now use the Cognos iViews in the SAP Enterprise Portal. For more information, see the Administration and Security Guide.
Enable Secure Communication Between SAP EP and IBM Cognos Components

A secure connection, using SSL, is not required between SAP EP and IBM Cognos components. It is more important if you enabled single signon with user mapping.

To enable SSL between SAP EP and IBM Cognos components, see your SAP EP security documentation.

After SSL is enabled, edit properties for the all iViews so that the cpsserver: CPS Connection Server property uses https instead of http.

You can now use the IBM Cognos portlets in the SAP Enterprise Portal. For more information, see the *Administration and Security Guide*.

Enable Single Signon for WebSphere Portal Using the Application Server

The Portal Services portlets can use the Active Credentials objects provided by WebSphere Portal to connect to IBM Cognos components. Portal Services supports the following Active Credentials objects: HttpBasicAuth, LtpaToken, SiteMinderToken, and WebSealToken.

Credentials for the portal user are passed to the gateway using this object. For more information about Active Credential objects, see the documentation for IBM WebSphere Portal.

To use application server single signon, see the documentation for IBM WebSphere Application Server.

After single signon is set up, you can use the IBM Cognos portlets in the WebSphere Portal. For more information, see the *Administration and Security Guide*.

Enable Single Signon for Oracle WebCenter Interaction Portal Using Basic Authentication

You can configure a portlet in WebCenter Interaction Portal to send the username and password as an HTTP Basic authentication header. The header can be used with an NTLM, LDAP, or IBM Cognos Series 7 authentication namespace to provide single signon.

Procedure

1. In IBM Cognos Configuration, configure a namespace to authenticate portal users.
2. Install an alternate CGI or ISAPI or servlet gateway in IBM Cognos.
3. Configure the gateway.
4. In the administration console of the Web server, configure the virtual directories to access the gateway.
   For more information, see the documentation for your Web server.
5. Configure the WebCenter Interaction remote server to access IBM Cognos BI:
   - Edit the cpsalui.properties file in the `c10_location/cps/oracle/webapps/gadgets/WEB-INF/classes` directory.
   - Change the `cps_endpoint` property to indicate the URL of the gateway.
For a CGI gateway, you can use the default setting if the gateway and the remote server are on the same computer. Otherwise, replace the localhost portion with `host_name:port`.

For a servlet or ISAPI gateway, replace the `localhost/ibmcognos/cgi-bin/cognos.cgi` portion with the values to target the gateway.

For example,

```
http://host_name:port/ibmcognos/cgi-bin/cognosisapi.dll/wsrp/cps4/portlets/[package]?wsdl&b_action=cps.wsd1
```

- Set the `cps_auth_namespace` property to the namespace that you want to use for authentication.

### Enable Single Signon for Oracle WebCenter Interaction Portal Using SiteMinder

If you use eTrust SiteMinder to provide single signon in your security infrastructure, you can also use it for single signon with WebCenter Interaction Portal.

You must configure a SiteMinder authentication namespace in IBM Cognos BI. WebCenter Interaction Portal sends the SiteMinder active authentication token to the remote server, which sends the token to the IBM Cognos gateway.

#### Procedure

1. In IBM Cognos Configuration, configure a SiteMinder authentication namespace.
   
   For instructions, see "Configuring IBM Cognos Components to Use eTrust SiteMinder" on page 246.

2. Configure the remote server to forward the authentication token:
   - Edit the `cpsalui.properties` file in the `c10_location/cps/oracle/webapps/gadgets/WEB-INF/classes` directory.
   - Change the `forward_cookies` property to include the name of the active authentication token that SiteMinder provides.
   - Change the `cps_endpoint` property to indicate the URL of the gateway.
     
     For a CGI gateway, you can use the default setting if the gateway and the remote server are on the same computer. Otherwise, replace the localhost portion with `host_name:port`.
     
     For a servlet or ISAPI gateway, replace the `localhost/ibmcognos/cgi-bin/cognos.cgi` portion with the values to target the gateway.
     
     For example,
     
     ```
     http://host_name:port/ibmcognos/cgi-bin/cognosisapi.dll/wsrp/cps4/portlets/[package]?wsdl&b_action=cps.wsd1
     ```
     
     - Change the `cps_auth_namespace` property to the namespace that you want to use for authentication.
Chapter 16. Setting Up the Samples for Contributor

The IBM Cognos Planning installation includes both IBM Cognos Planning Analyst and IBM Cognos Planning Contributor samples to help you get started using the product. These samples are installed in the $C10_location\samples\Planning$ directory.

The Analyst samples require no further setup if an Analyst user wants to access the samples in the language that you selected when you installed IBM Cognos Planning Server or IBM Cognos Planning Administration. However, if an Analyst user wants to access the samples in a different language than the one you selected during installation, you must change the language of the samples.

The Contributor samples must be configured before they can be used in IBM Cognos Planning - Contributor. Use this checklist to set up the go_contributor samples. Detailed information follows for each of these tasks:

1. "Install IBM Tivoli Directory Server."
2. Import the authentication data from great_outdoors.ldif to a IBM Tivoli Directory Server
3. "Configure IBM Cognos Planning to Use Your IBM Tivoli Directory Server” on page 278.
4. "Configure Contributor Administration” on page 279.
5. “Create Contributor Applications” on page 283.

Install IBM Tivoli Directory Server

The sample authentication data is provided in a format used by the IBM Tivoli Directory Server. You must install the directory server and setup a DB2 instance before you can import the authentication data to use the IBM Cognos Planning samples.

When you create the directory server for the sample authentication data, ensure that the Base Suffix value or base domain is $dc=grtd123,dc=com$. This is the domain used in the sample authentication data.

You can download the IBM Tivoli Directory Server from the IBM web site. For licensing information and instructions about installing the directory server, see the Tivoli product documentation.

Import the Sample Authentication Data

The authentication data used for the IBM Cognos Planning samples is provided in LDAP data interchange format (LDIF). To use the authentication data, you must import it into IBM Tivoli Directory Server.

The LDIF file is named great_outdoors.ldif and is located in the $C10_location\webcontent\samples\datasources\cubes\security$ directory, where $C10_location$ represents the path where the samples are installed.
Before you begin

Ensure that you log on as a DB2 administrator that can manage the database instance where you want to import the sample authentication data.

About this task

The following steps assume that IBM Tivoli Directory Server Version 6.3 is installed and configured. If you use a different version of Tivoli Directory Server, refer to that version of the Tivoli product documentation for information on how to import the LDIF file.

Procedure

1. Open the IBM Tivoli Directory Server Instance Administration tool.
2. Select the DB2 instance where you want to import the sample authentication data and click the Manage button. The IBM Tivoli Directory Server Configuration tool opens.
3. Click the Manage suffixes option.
4. In the Suffixes pane, specify the base DSN suffix domain by adding a value of dc=grtd123,dc=com for the directory server in Suffix DN.
5. Click the OK button.
6. Click the LDIF tasks option, then the Import LDIF data choice.
7. In Path and LDIF file name, specify the location of the great_outdoors.ldif file. For example, C:\Program Files\ibm\cognos\c10\webcontent\samples\datasources\cubes\security\great_outdoors.ldif

   Keep the Standard import default setting.
8. Click the Import button.
9. When the import operation is done, click the Close button.

Configure IBM Cognos Planning to Use Your IBM Tivoli Directory Server

To use IBM Cognos Planning, you must configure your IBM Tivoli Directory Server as an authentication source and you must disable anonymous access for users.

If you have installed IBM Cognos Planning components on different computers, you must configure the directory server information on the computer where Content Manager is installed.

Procedure

1. Start IBM Cognos Configuration.
2. In the Explorer window, under Security, Authentication, click Cognos.
3. In the Properties window, ensure that Allow anonymous access is set to False.
5. Type a Name, and click LDAP in the Type box.
6. In the Resource Properties window, enter the following information:
   • In Namespace ID, type a name for the samples namespace. The name can be anything you choose.
• In Host and Port, enter the computer name and port number for your IBM Tivoli Directory Server.
• In Base Distinguished Name, type:
  dc=grtd123,dc=com
• In User Lookup, type:
  (uid=${userID})

7. From the File menu, click Save.
8. In the Explorer window, click Local Configuration.
9. From the File menu, click Action, Restart.

Configure Contributor Administration

If you are opening Contributor Administration for the first time, you must create the planning tables in the planning store and add a planning datastore server.

For instructions about configuring the Contributor Administration, see the Contributor Administration Guide.

GO Contributor Sample

The GO IBM Cognos Planning Contributor sample consists of applications that can be linked together. These applications are named go_capex_contributor, go_personnel_contributor, and go_expenses_contributor. A flowchart is provided in IBM Cognos Planning Manager in the go_expenses_contributor library.

Each application uses its own e.list, which is typical in a planning environment. The following table describes the e.lists used in the Cognos Planning Contributor sample.

Table 66. e.Lists descriptions for the sample libraries

<table>
<thead>
<tr>
<th>Library</th>
<th>e.List</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>go_capex_contributor</td>
<td>2 Divisions (elist)</td>
<td>Depreciation</td>
</tr>
<tr>
<td>go_personnel_contributor</td>
<td>2 EList (Departments)</td>
<td>Payroll</td>
</tr>
<tr>
<td>go_expenses_contributor</td>
<td>2 EList (Departments)</td>
<td>Expenses</td>
</tr>
</tbody>
</table>

D-Lists and formats used by the libraries in the table above are stored in the go_common_contributor library.

The go_capex_contributor Application

The go_capex_contributor application is designed to capture details of planned capital purchases and calculate the depreciation charge on those items. This depreciation is then added to the depreciation on the existing items that is imported from external systems to determine the total depreciation charge. The application consists of the following cubes.

• Asset Purchases
  This cube captures the description, asset type, value, target department, date of purchase, and, month to start depreciation by version. There is also an item that highlights any invalid target department.
• Deprecation
This cube calculates the depreciation to be charged to each department.

• Depn Policy
This cube holds the life and depreciation charge for each type of asset. It is provided only for information purposes and users cannot change the data in this cube. Because it does not have an e.List dimension, this cube is known as an assumption cube. Data for assumption cubes must be input in Analyst and moved into Contributor by synchronizing the application and performing Go to Production.

• Valid Departments
Because not all departments operate in the same geographic region, only valid target departments may be entered in Asset Purchases. This cube shows which departments are valid for the division.

The following table provides information about the go_capex_contributor data files.

<table>
<thead>
<tr>
<th>Table 67. go_capex_contributor data files</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation in console</td>
</tr>
<tr>
<td>----------------------</td>
</tr>
<tr>
<td>e.List</td>
</tr>
<tr>
<td>Rights</td>
</tr>
<tr>
<td>User Classes</td>
</tr>
<tr>
<td>Access Tables</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Help Text</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Administration Links</td>
</tr>
<tr>
<td>Data</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

The go_personnel_contributor Application

The go_personnel_contributor application is designed to capture payroll-related items and to ensure the required levels of separation of responsibilities. The data is then fed into the go_expenses_contributor application. Viewing cubes is controlled by access tables. The application consists of the following cubes:

• Salaries
This cube captures each employee's grade, percent raise, and month raise if applicable. The base salary is determined from the Salary by Grade cube based on the selected grade. The monthly salary is calculated to include the base and the raise. If the month that the raise is to be applicable is missing, a warning message appears. An access table is available for this cube to ensure that employees are visible only in the correct departments.

- Benefits
  This cube determines additional employee costs by country and version. The appropriate benefit percentages are applied by country.

- Salary by Grade and Band
  Because it does not have an e.List dimension, this cube is known as an assumption cube that holds Salaries by Grade and Band by Country. This cube should be hidden.

- Benefit %s
  This is an assumption cube that holds benefit percentages by Country. The benefit percent data is not necessarily indicative of current rates. That this cube should be hidden.

The following table provides information about the go_personnel_contributor data files.

Table 68. go_personnel_contributor data files

<table>
<thead>
<tr>
<th>Operation in console</th>
<th>Data file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>e.List</td>
<td>Personnel_elist.txt</td>
</tr>
<tr>
<td>Rights</td>
<td>Personnel_rights.txt</td>
</tr>
<tr>
<td>User Classes</td>
<td>Personnel_rights.txt</td>
</tr>
<tr>
<td>Access Tables</td>
<td>Access_Table_Salaries.txt</td>
</tr>
<tr>
<td></td>
<td>Access_Table_Employees.txt</td>
</tr>
<tr>
<td></td>
<td>Access_Table_Benefits.txt</td>
</tr>
<tr>
<td></td>
<td>Access_Table_Countries.txt</td>
</tr>
<tr>
<td></td>
<td>Access_Table_Versions.txt</td>
</tr>
<tr>
<td>Administration Links</td>
<td>Go_personnel.cal</td>
</tr>
<tr>
<td>Data</td>
<td>Salaries.txt</td>
</tr>
<tr>
<td></td>
<td>Salaries_Band_Grade.txt</td>
</tr>
<tr>
<td></td>
<td>Benefits.txt</td>
</tr>
</tbody>
</table>

The go_expenses_contributor Application

The go_expenses_contributor application is designed to capture expenses and create an expense summary. The application consists of the following cubes.

- Travel Costs
Users are asked to consider their travel plans in terms that they understand. Rather than just providing an amount for the key expenditure items, they are asked to provide lower-level details that are likely to be more relevant to them, such as hotel cost per night.

- **Comm Costs**
  Users are asked to consider communication costs at a lower level of detail, including number of lines, handsets, and terminal blocks.

- **Supply Costs**
  Users are asked to input an amount for expenditure items at a high level, such as computer costs and office costs.

- **Marketing**
  This cube is the subject of an access table, which means that it is available only to the Marketing department. All other departments do not see this cube. Users are asked to consider their marketing plans in terms that they understand. Rather than just providing an amount for the key expenditure items, they are asked to provide lower-level details which are likely to be more relevant to them.

- **Corporate Expenses**
  This cube summarizes all the detail that was captured by the other cubes and captures expense items that do not require greater detail. Information also comes from the go_capex_contributor and go_personnel_contributor applications.

The following table provides information about the go_expenses_contributor data files.

*Table 69. go_expenses_contributor data files*

<table>
<thead>
<tr>
<th>Operation in console</th>
<th>Data file name</th>
</tr>
</thead>
<tbody>
<tr>
<td>e.List</td>
<td>Expenses_Elist.txt</td>
</tr>
<tr>
<td>Rights</td>
<td>Expenses_rights.txt</td>
</tr>
<tr>
<td>User Classes</td>
<td>Expenses_rights.txt</td>
</tr>
<tr>
<td>Access Tables</td>
<td>Access_Actual.txt</td>
</tr>
<tr>
<td></td>
<td>Access_Depreciation.txt</td>
</tr>
<tr>
<td></td>
<td>Access_Marketing.txt</td>
</tr>
<tr>
<td></td>
<td>Access_Divisons.txt</td>
</tr>
<tr>
<td></td>
<td>Access_Countries.txt</td>
</tr>
<tr>
<td>Data</td>
<td>Communications.txt</td>
</tr>
<tr>
<td></td>
<td>Supplies.txt</td>
</tr>
<tr>
<td></td>
<td>Travel.txt</td>
</tr>
<tr>
<td></td>
<td>Corporate expenses.txt</td>
</tr>
</tbody>
</table>
Create Contributor Applications

When importing data, ensure that the database code page parameter reflects the underlying data being imported.

For example, when you are importing non-Western European language data or data containing non-ASCII characters, you must set the Import Options parameter to -C1252 (the Microsoft Windows default code page) for the import load routine to complete successfully.

For more information about using Contributor Administration, see the Contributor Administration Guide.

The data files are stored in the c10_location\samples\Planning\Contributor\language\Data directory.

Procedure

1. In Contributor Administration, specify the application ID that was set for each sample application, as follows:
   • application ID for go_capex_contributor: 90040011
   • application ID for go_expenses_contributor: 90040012
   • application ID for go_personnel_contributor: 90040014
   Otherwise, when you import the sample administration links, you are prompted to reselect the source and target applications.

2. For each application, do the following:
   • Import the e.List and rights text files.
   • Set Navigation (optional).
   • Set Orientation (optional).
   • Import access tables (optional).
   • Make appropriate cubes hidden or read only (optional).
   • Run Go to Production.
   Tip: You do not need to use cut-down models.

3. Import administration links.

4. Expand Datastores, data store name, Applications, application name, Development, Application Maintenance, and click Admin Options.

5. In Import Options, enter the parameter value.
   If you are importing non-Western European language data or data containing non-ASCII characters, enter -C1252.

Cube Settings

The following are settings that you should use for each of the sample cubes. You apply the settings in Contributor Administration.

The go_capex_contributor Cube
For the go_capex_contributor cube, there are specific settings that you should use.
Web-Client Configuration

The **Navigation** and **Orientation** settings are shown in the following table:

*Table 70. Navigation and Orientation settings*

<table>
<thead>
<tr>
<th>Cube</th>
<th>Pages</th>
<th>Rows</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset purchases</td>
<td>2 Divisions (elist)</td>
<td>3 ID number</td>
<td>1 Asset purchases</td>
</tr>
<tr>
<td></td>
<td>5 Versions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Depreciation</td>
<td>2 Divisions (elist)</td>
<td>2 Asset types</td>
<td>4 Months</td>
</tr>
<tr>
<td></td>
<td>1 Depreciation</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 Departments</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 Versions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Depreciation Policy</td>
<td>N/A</td>
<td>2 Asset types</td>
<td>3 Depn policy</td>
</tr>
<tr>
<td>Valid departments</td>
<td>N/A</td>
<td>3 Departments (Yes)</td>
<td>2 Divisions (elist)</td>
</tr>
</tbody>
</table>

Other settings include:

- For **Grid Options**, use the default settings.
- For the **Application Options**, use the default settings.
  It may be appropriate to allow **Reviewer Edit** and **Bouncing**.
- Clear the **Planner Only Cubes** options.
- For the **Contributor Help Text** options, two files are provided. The text in `Simple_help.txt` can be copied into the **Simple Cube Help** box. The html code in `Capex_detailed_help.txt` can be copied into the **Detailed Cube Help** box.

Application Maintenance

The settings for **Application Maintenance** include:

- For **Admin Options**, select **Yes** for **Act As System Link Source**.
- For **Go To Production Options**, use the default settings.

Access Tables and Selections

The following table describes the **Access Tables** that are provided.

*Table 71. Access table information*

<table>
<thead>
<tr>
<th>File Name</th>
<th>Dimensions</th>
<th>Cubes</th>
<th>eList?</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access_Valid Departments .txt</td>
<td>2 Departments</td>
<td>Depreciation</td>
<td>Yes</td>
<td>Restricts the departments visible to users to those valid in their country.</td>
</tr>
<tr>
<td>Access_Viability check.txt</td>
<td>1 Asset Purchases</td>
<td>Asset Purchases</td>
<td>No</td>
<td>Hides the data used for the validity check.</td>
</tr>
</tbody>
</table>
Note that cut down models were not used, but hide functionality was used extensively.

The following table shows which cubes are without access tables:

**Table 72. Cubes without access tables**

<table>
<thead>
<tr>
<th>Cube</th>
<th>Access Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assumption Cube</td>
<td>Depn Policy</td>
</tr>
<tr>
<td></td>
<td>Read</td>
</tr>
</tbody>
</table>

**The go_expenses_contributor Cube**

For the go_expenses_contributor cube, there are specific settings that you should use.

**Web-Client Configuration**

The recommended **Navigation** and **Orientation** settings are shown in the following table:

**Table 73. Navigation and Orientation settings**

<table>
<thead>
<tr>
<th>Cube</th>
<th>Pages</th>
<th>Rows</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Travel Costs</td>
<td>2 Elist (Departments)</td>
<td>1 Travel Costs</td>
<td>4 Months</td>
</tr>
<tr>
<td></td>
<td>2 Divisions</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 Versions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supply Costs</td>
<td>2 Elist (Departments)</td>
<td>1 Supply Cost</td>
<td>4 Months</td>
</tr>
<tr>
<td></td>
<td>2 Divisions</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 Versions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comm Costs</td>
<td>2 Elist (Departments)</td>
<td>1 Comm Costs</td>
<td>4 Months</td>
</tr>
<tr>
<td></td>
<td>2 Divisions</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 Versions</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table 73. Navigation and Orientation settings (continued)

<table>
<thead>
<tr>
<th>Cube</th>
<th>Pages</th>
<th>Rows</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marketing</td>
<td>2 Elist (Departments)</td>
<td>1 Marketing</td>
<td>4 Months</td>
</tr>
<tr>
<td></td>
<td>2 Campaigns</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 Divisions</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 Versions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Corporate Expenses</td>
<td>2 Elist (Departments)</td>
<td>1 Accounts</td>
<td>4 Months</td>
</tr>
<tr>
<td></td>
<td>2 Divisions</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 Versions</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Other settings include:
- For **Grid Options**, use the default settings.
- For the **Application Options**, use the default settings.
  It may be appropriate to allow **Reviewer Edit** and **Bouncing**.
- Clear the **Planner Only Cubes** options.
- For the **Contributor Help Text** options, use the default settings.

**Application Maintenance**

The settings for **Application Maintenance** include:
- For **Admin Options**, use the default settings.
- For **Go To Production Options**, use the default settings.

**Access Tables and Selections**

The following table describes the **Access Tables** that are provided.

Table 74. Access table information

<table>
<thead>
<tr>
<th>File Name</th>
<th>Dimension</th>
<th>Cube</th>
<th>eList?</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access_actual.txt</td>
<td>5 Versions</td>
<td>Corporate Expenses</td>
<td>No</td>
<td>Ensures that the actual data is read only</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Marketing Travel</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access_depreciation.txt</td>
<td>1 Accounts</td>
<td>Corporate Expenses</td>
<td>No</td>
<td>Ensures that the Depreciation amount imported from capex</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Marketing Travel</td>
<td></td>
<td>application cannot be overwritten</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Access_marketing.txt</td>
<td>1 Marketing</td>
<td>Marketing</td>
<td>Yes</td>
<td>Ensures that the Marketing tab is hidden from all but the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Marketing Travel</td>
<td></td>
<td>Marketing department</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Costs</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

286 IBM Cognos Planning Version 10.2.0: Installation and Configuration Guide
Table 74. Access table information (continued)

<table>
<thead>
<tr>
<th>File Name</th>
<th>Dimension</th>
<th>Cube</th>
<th>eList?</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access_divisions.txt</td>
<td>2 Divisions</td>
<td>Corporate Expenses</td>
<td>Yes</td>
<td>Allows write access to the correct departments by division</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Marketing Travel Costs</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note that cut down models were not used, but hide functionality was used extensively.

The go_personnel_contributor Cube
For the go_personnel_contributor cube, there are specific settings that you should use.

Web-Client Configuration
The recommended Navigation and Orientation settings are shown in the following table:

Table 75. Navigation and Orientation settings

<table>
<thead>
<tr>
<th>Cube</th>
<th>Pages</th>
<th>Rows</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salaries</td>
<td>2 Elist (Departments)</td>
<td>2 Employees</td>
<td>1 Salaries</td>
</tr>
<tr>
<td>Benefits</td>
<td>2 Elist (Departments)</td>
<td>1 Benefits</td>
<td>4 Months</td>
</tr>
<tr>
<td></td>
<td>3 Countries</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 Versions</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Salary by Grade and Band</td>
<td>2 Bands</td>
<td>3 Countries</td>
<td>3 Grades</td>
</tr>
<tr>
<td>Benefit %s</td>
<td>N/A</td>
<td>3 Countries</td>
<td>3 Benefit %s</td>
</tr>
</tbody>
</table>

Other settings include:
• For Grid Options, use the default settings.
• For the Application Options, use the default settings.
  • It may be appropriate to allow Reviewer Edit and Bouncing.
• Clear the Planner Only Cubes options.
• For the Contributor Help Text options, use the default settings.

Application Maintenance
The recommended settings for Application Maintenance include:
• For Admin Options, use the default settings.
• For Go To Production Options, use the default settings.
Access Tables and Selections

The following table describes the Access Tables that are provided.

Table 76. Access table information

<table>
<thead>
<tr>
<th>File Name</th>
<th>Dimension</th>
<th>Cube</th>
<th>eList?</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access_Table_Salaries.txt</td>
<td>1 Salaries</td>
<td>Salaries</td>
<td>No</td>
<td>Ensures appropriate data entry</td>
</tr>
<tr>
<td>Access_Table_Employees.txt</td>
<td>2 Employees</td>
<td>Salaries</td>
<td>Yes</td>
<td>Allows employees to be visible in the correct departments</td>
</tr>
<tr>
<td>Access_Table_Benefits.txt</td>
<td>1 Benefits</td>
<td>Benefits</td>
<td>No</td>
<td>Ensures appropriate data entry</td>
</tr>
<tr>
<td>Access_Table_Countries.txt</td>
<td>3 Countries</td>
<td>Benefits</td>
<td>Yes</td>
<td>Allows write access to the correct departments by country</td>
</tr>
<tr>
<td>Access_Table_Versions.txt</td>
<td>5 Versions</td>
<td>Benefits</td>
<td>No</td>
<td>Ensures that the actual data is read only</td>
</tr>
</tbody>
</table>

Note that cut down models were not used, but hide functionality was used extensively.

The following table shows which cubes are without access tables:

Table 77. Cubes without access tables

<table>
<thead>
<tr>
<th>Assumption</th>
<th>Cube</th>
<th>Access Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assumption</td>
<td>Salary by grade</td>
<td>Hidden</td>
</tr>
<tr>
<td>Assumption</td>
<td>Benefit %s</td>
<td>Hidden</td>
</tr>
</tbody>
</table>
Chapter 17. Troubleshooting

Use the troubleshooting reference information and solutions as a resource to help you solve specific problems you may encounter during or after the installation of IBM Cognos components.

For more information about troubleshooting resources, see the Troubleshooting Guide.

Problems are characterized by their symptoms. Each symptom can be traced to one or more causes by using specific troubleshooting tools and techniques. After being identified, each problem can be fixed by implementing a series of actions.

When you are troubleshooting, log files can help you. Another valuable troubleshooting tool is the IBM Cognos Resource Center [http://www.ibm.com/software/data/support/cognos_crc.html].

When you cannot resolve a problem, the final resource is your technical support representative. To analyze a problem, your technical support representative requires information about the situation and the symptoms that you are experiencing. To help isolate the problem, collect the necessary data before you contact your representative.

Troubleshooting a problem

Troubleshooting is a systematic approach to solving a problem. The goal of troubleshooting is to determine why something does not work as expected and how to resolve the problem.

The first step in the troubleshooting process is to describe the problem completely. Problem descriptions help you and the IBM technical-support representative know where to start to find the cause of the problem. This step includes asking yourself basic questions:

- What are the symptoms of the problem?
- Where does the problem occur?
- When does the problem occur?
- Under which conditions does the problem occur?
- Can the problem be reproduced?

The answers to these questions typically lead to a good description of the problem, which can then lead to a resolution of the problem.

What are the symptoms of the problem?

When starting to describe a problem, the most obvious question is “What is the problem?” This question might seem straightforward; however, you can break it down into several focused questions that create a more descriptive picture of the problem. These questions can include:

- Who, or what, is reporting the problem?
- What are the error codes and messages?
• How does the system fail? For example, is the problem a loop, hang, crash, performance degradation, or incorrect result?

Where does the problem occur?

Determining where the problem originates is not always easy, but it is one of the most important steps in resolving a problem. Many layers of technology can exist between the reporting and failing components. Networks, disks, and drivers are only a few of the components to consider when you are investigating problems.

The following questions help you to isolate the problem layer:

• Is the problem specific to one platform or operating system, or is it common across multiple platforms or operating systems?
• Is the current environment and configuration supported?

If one layer reports the problem, the problem does not necessarily originate in that layer. Part of identifying where a problem originates is understanding the environment in which it exists. Take some time to completely describe the problem environment, including the operating system and version, all corresponding software and versions, and the hardware. Confirm that you are running within an environment that is supported; many problems can be traced back to incompatible levels of software that are not intended to run together or have not been fully tested together.

When does the problem occur?

Develop a detailed timeline of events leading up to a failure, especially for cases that are one-time occurrences. You can most easily develop a timeline by working backward: Start at the time an error was reported (as precisely as possible, even down to the millisecond), and work backward through the available logs and information. Typically, you need to look only as far as the first suspicious event that you find in a diagnostic log.

To develop a detailed timeline of events, answer these questions:

• Does the problem happen only at a certain time of day or night?
• How often does the problem happen?
• What sequence of events leads up to the time that the problem is reported?
• Does the problem happen after an environment change, such as an upgrade or an installation of software or hardware?

Under which conditions does the problem occur?

Knowing which systems and applications are running at the time that a problem occurs is an important part of troubleshooting. These questions about your environment can help you to identify the cause of the problem:

• Does the problem always occur when the same task is being performed?
• Does a certain sequence of events need to occur for the problem to occur?
• Do any other applications fail at the same time?

Answering these types of questions can help you explain the environment in which the problem occurs and correlate any dependencies. Remember that just because multiple problems might have occurred around the same time, the problems are not necessarily related.
Can the problem be reproduced?

Problems that you can reproduce are often easier to solve. However, problems that you can reproduce can have a disadvantage. If the problem as a significant business impact, you do not want it to recur. If possible, re-create the problem in a test or development environment, which typically offers you more flexibility and control during your investigation. Answer the following questions:

- Can the problem be re-created on a test system?
- Are multiple users or applications encountering the same type of problem?
- Can the problem be re-created by running a single command, a set of commands, or a particular application?

Searching knowledge bases

You can often find solutions to problems by searching IBM knowledge bases. You can optimize your results by using available resources, support tools, and search methods.

About this task

You can find useful information by searching the information center for IBM Cognos Planning, but sometimes you need to look beyond the information center to resolve problems.

Procedure

To search knowledge bases for information that you need, use one or more of the following approaches:

- Find the content that you need by using the IBM Support Portal (IBM Cognos Planning Support Portal).
  
  The IBM Support Portal is a unified, centralized view of all technical support tools and information for all IBM systems, software, and services. The IBM Support Portal lets you access the IBM electronic support portfolio from one place. You can tailor the pages to focus on the information and resources that you need for problem prevention and faster problem resolution. Familiarize yourself with the IBM Support Portal by viewing the demo videos (https://www.ibm.com/blogs/SPNA/entry/the_ibm_support_portal_videos) about this tool. These videos introduce you to the IBM Support Portal, explore troubleshooting and other resources, and demonstrate how you can tailor the page by moving, adding, and deleting portlets.

- Search for content about IBM Cognos Planning by using one of the following additional technical resources:
  - IBM Cognos Planning APARs (problem reports)
  - IBM Cognos Planning Support web site
  - IBM Cognos Planning forums and communities

- Search for content by using the IBM masthead search. You can use the IBM masthead search by typing your search string into the Search field at the top of any ibm.com page.

- Search for content by using any external search engine, such as Google, Yahoo, or Bing. If you use an external search engine, your results are more likely to include information that is outside the ibm.com domain. However, sometimes you can find useful problem-solving information about IBM products in newsgroups, forums, and blogs that are not on ibm.com.
Tip: Include “IBM” and the name of the product in your search if you are looking for information about an IBM product.

Getting fixes
A product fix might be available to resolve your problem.

Procedure
To find and install fixes:
1. Determine which fix you need (Fix Central).
2. Download the fix. Open the download document and follow the link in the “Download package” section.
3. Apply the fix by following the instructions in the “Installation Instructions” section of the download document.
4. Subscribe to receive weekly email notifications about fixes and other IBM Support information.

Contacting IBM Support
IBM Support provides access to a variety of IBM resources for help with software questions.

Before you begin
After trying to find your answer or solution by using other self-help options such as technotes, you can contact IBM Support. Before contacting IBM Support, your company must have an active IBM maintenance contract, and you must be authorized to submit problems to IBM. You should also have the following information at hand:

- Your customer identification number
- Your service request number, if it is an ongoing service request
- The phone number where you can be reached
- The version of the software you use
- The version of the operating environment you use
- A description of what you were doing when the problem occurred
- The exact wording of any error messages that display
- Any steps you took to attempt to solve the problem

For information about the types of available support, see the Support portfolio topic in the Software Support Handbook.

Procedure
Complete the following steps to contact IBM Support with a problem:
1. Define the problem, gather background information, and determine the severity of the problem. For more information, see the Getting IBM support topic in the Software Support Handbook.
2. Gather diagnostic information.
3. Submit the problem to IBM Support in one of the following ways:
• Using IBM Support Assistant (ISA): Use this feature to open, update, and view an Electronic Service Request with IBM. Any data that has been collected can be attached to the service request. This expedites the analysis and reduces the time to resolution.
• Online through the IBM Support Portal: You can open, update, and view all your Service Requests from the Service Request portlet on the Service Request page.
• By phone: For the phone number to call, see the Directory of worldwide contacts web page.

Results

If the problem that you submit is for a software defect or for missing or inaccurate documentation, IBM Support creates an Authorized Program Analysis Report (APAR). The APAR describes the problem in detail. Whenever possible, IBM Support provides a workaround that you can implement until the APAR is resolved and a fix is delivered. IBM publishes resolved APARs on the IBM Support Web site daily, so that other users who experience the same problem can benefit from the same resolution.

Exchanging information with IBM

To diagnose or identify a problem, you might need to provide IBM Support with data and information from your system.

In other cases, IBM Support might provide you with tools or utilities to use for problem determination.

Sending information to IBM Support

To reduce the time that it takes to resolve your problem, you can send trace and diagnostic information to IBM Support.

Procedure

To submit diagnostic information to IBM Support:
1. Open a problem management record (PMR). You can use the IBM Support Assistant or the IBM Service Request tool.
2. Collect the diagnostic data that you need. Diagnostic data helps reduce the time that it takes to resolve your PMR. You can collect the diagnostic data manually or automatically.
3. Compress the files by using the TRSMAIN or AMATERSE program. Download the free utility from the IBM to the IBM Cognos BI system and then install the utility using the TSO RECEIVE command.
4. Transfer the files to IBM. You can use one of the following methods to transfer the files to IBM:
   • The Service Request tool
   • Standard data upload methods: FTP, HTTP
   • Secure data upload methods: FTPS, SFTP, HTTPS
   • Email

If you are using an IBM Cognos product and you use ServiceLink / IBMLink to submit PMRs, you can send diagnostic data to IBM Support in an email or by using FTP.

All of these data exchange methods are explained on the IBM Support site.
**Receiving information from IBM Support**

Occasionally an IBM technical-support representative might ask you to download diagnostic tools or other files. You can use FTP to download these files.

**Before you begin**

Ensure that your IBM technical-support representative provided you with the preferred server to use for downloading the files and the exact directory and file names to access.

**Procedure**

To download files from IBM Support:

1. Use FTP to connect to the site that your IBM technical-support representative provided and log in as anonymous. Use your email address as the password.
2. Change to the appropriate directory:
   a. Change to the /fromibm directory.
      `cd fromibm`
   b. Change to the directory that your IBM technical-support representative provided.
      `cd nameofdirectory`
3. Enable binary mode for your session.
   `binary`
4. Use the `get` command to download the file that your IBM technical-support representative specified.
   `get filename.extension`
5. End your FTP session.
   `quit`

**Subscribing to Support updates**

To stay informed of important information about the IBM products that you use, you can subscribe to updates.

**About this task**

By subscribing to receive updates, you can receive important technical information and updates for specific Support tools and resources. You can subscribe to updates by using one of two approaches:

**RSS feeds and social media subscriptions**

The following RSS feeds and social media subscriptions are available for IBM Cognos Planning:

- [RSS feed for Cognos Planning developerWorks® forum](#)
- [Subscription to Cognos Support notebook blog](#)
- [RSS feed for the Support site for IBM Cognos Planning](#)

For general information about RSS, including steps for getting started and a list of RSS-enabled IBM web pages, visit the [IBM Software Support RSS feeds](#) site.

**My Notifications**

With My Notifications, you can subscribe to Support updates for any IBM product. You can specify that you want to receive daily or weekly email
announcements. You can specify what type of information you want to receive, such as publications, hints and tips, product flashes (also known as alerts), downloads, and drivers. My Notifications enables you to customize and categorize the products that you want to be informed about and the delivery methods that best suit your needs.

**Procedure**

To subscribe to Support updates:

1. Subscribe to the *Product* RSS feeds.
2. To subscribe to My Notifications, begin by going to the [IBM Support Portal](https://www.ibm.com/support) and clicking **My Notifications** in the **Notifications** portlet.
3. If you have already registered for My support, sign in and skip to the next step. If you have not registered, click **Register now**. Complete the registration form using your email address as your IBM ID and click **Submit**.
4. Click **Edit profile**.
5. Click **Add products** and choose a product category; for example, **Software**.
6. In the second list, select a product segment; for example, **Data & Information Management**.
7. In the third list, select a product subsegment, for example, **Databases**.
8. Select the products that you want to receive updates for.
9. Click **Add products**.
10. After selecting all products that are of interest to you, click **Subscribe to email** on the **Edit profile** tab.
11. Select **Please send these documents by weekly email**.
12. Update your email address as needed.
13. In the **Documents list**, select the product category; for example, **Software**.
14. Select the types of documents that you want to receive information for.
15. Click **Update**.

**Results**

Until you modify your RSS feeds and My Notifications preferences, you receive notifications of updates that you have requested. You can modify your preferences when needed (for example, if you stop using one product and begin using another product).

**Log Files**

Log files can help you troubleshoot problems by recording the activities that take place when you work with a product.

Operations performed in IBM Cognos BI are recorded in various log files for tracking purposes. For example, if you experienced problems installing IBM Cognos BI, consult the transfer log file to learn what activities the installation wizard performed while transferring files.

Before you begin viewing log files, ensure that they contain the information that you need. The number of log files and the information they contain are set by parameters in IBM Cognos Connection and in IBM Cognos Configuration.
Use IBM Cognos Administration to learn about logging categories and how to set the level of detail to log for each category.

For more information, see the IBM Cognos BI Administration and Security Guide.

Use IBM Cognos Configuration to specify the size, number, and location of log files, and to configure the properties of the log server.

When troubleshooting, the following files can assist you:

**The Transfer Log File**

This file records the activities that the installation wizard performed while transferring files.

The transfer log file is located in the c10_location\instlog directory. The file name identifies the product name, version, and build number, and includes a time stamp. The following is an example of the file name format:

`tl-BISRVR-8.1-0.0-20080901_1122.txt`

**The Transfer Summary-Error Log File**

This file records the components you installed, disk space information, the selections you made in the transfer dialogs, and any errors the installation wizard encountered while transferring components.

The transfer summary-error log file is located in the c10_location/instlog directory. The file name identifies the product name, version, and build number, and includes a time stamp. The following is an example of the file name format:

`tl-BISRVR-8.1-0.0-20080901_1122_summary_error.txt`

**The Startup Configuration File**

This file records your configuration choices each time you save your property settings. The file name is cogstartup.xml.

If you are unable to save your configuration, or are having problems you can revert to a previously saved configuration file. The backup configuration files are located in the c10_location/configuration directory. The following is an example of the file name format for backup configuration files:

`cogstartup_200811231540.xml`

**The Startup Configuration Lock File**

This file is created each time you open IBM Cognos Configuration. It prevents you from opening more than one IBM Cognos Configuration window.

If you experience problems opening IBM Cognos Configuration, you can check the c10_location/configuration directory for the cogstartup.lock file. If the file exists and IBM Cognos Configuration is not open, it means that IBM Cognos Configuration did not shut down properly the last time you used it. You can delete the lock file and then open IBM Cognos Configuration.
The Locale Configuration File

This file records the configuration choices you make in IBM Cognos Configuration for product and content locales, locale mapping, and currency support.

If you experience problems with language support in the user interface or in reports, use these files to track your changes. The backup configuration files are located in the c10_location/configuration directory. The following is an example of the file name format:

coglocale_200811231540.xml

The Runtime Log File

The default IBM Cognos log file, named cogserver.log file, or other log files that you configure to receive log messages from the log server, record information after you start the IBM Cognos BI service. They are located in the c10_location/logs directory. If you configured another destination for log messages, check the appropriate file or database.

Some log messages indicate problems. Most messages provide information only, but others can help you to diagnose problems in your runtime environment.

The Gateway Log File

The gateways record errors in the gateway log file, which is located in the c10_location/logs directory.

You can use the gateway log file to troubleshoot problems that prevent the gateway from processing requests or from using encryption. Symptoms of these problems are as follows:

- User IDs and passwords do not work
- Single signon does not work
- The dispatcher is running but users receives an error message advising that the IBM Cognos BI server is not available

The gateway log file uses the following naming format, where gateway_interface is cgi, mod (Apache 1.3 module), mod2 (Apache 2.0 module), or isapi.

gateway_interface.log (for example, gw/cgi.log)

The Uninstallation Log File

This file records the activities that the Uninstall wizard performed while uninstalling files. The log file is named cognos_uninst_log.htm and is located in the Temp directory. You can use the log file to troubleshoot problems related to uninstalling IBM Cognos BI components.

The Silent Mode Log File

This file records the activities that IBM Cognos Configuration performed while running in silent mode. This log file is named cogconfig_response.csv and is located in the c10_location/logs directory.
The ReportNet to IBM Cognos BI Upgrade File

This file contains a summary of the results of an upgrade from ReportNet to IBM Cognos BI. The log file is named upgradeLog.xml and is located in the c10_location/logs directory. The file is in xml format and references an xslt stylesheet. You can double-click the file to have it display in your browser.

Problems starting IBM Cognos Business Intelligence

You can perform the following tasks when encountering problems starting IBM Cognos Business Intelligence.

You may encounter problems when you try

• to start the IBM Cognos BI service
• to open the Welcome page for the IBM Cognos BI portal for the first time
• to start an application server, such as WebLogic or WebSphere

The following table shows some common symptoms and their solutions.

<table>
<thead>
<tr>
<th>Symptoms</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You do not see the splash screen for the IBM Cognos BI portal when you start IBM Cognos BI.</td>
<td>Check your Web server configuration.</td>
</tr>
<tr>
<td>The service starts, but no tables are created in the content store database.</td>
<td>Check your content store configuration.</td>
</tr>
<tr>
<td>The service does not start.</td>
<td>Ensure that you wait a few moments before submitting a request.</td>
</tr>
<tr>
<td>The application server does not start.</td>
<td>Check the file permissions and directory names of the application server installation location.</td>
</tr>
</tbody>
</table>

Ensure that you use other software that is supported by IBM Cognos components. You can view an up-to-date list of environments, such as operating systems, patches, browsers, Web servers, directory servers, and database servers on the IBM Cognos Customer Center [http://www.ibm.com/software/data/cognos/customercenter/](http://www.ibm.com/software/data/cognos/customercenter/).

CFG-ERR-0106 error when starting the IBM Cognos service in IBM Cognos Configuration

When you start the IBM Cognos Business Intelligence service, you may receive the following error message:

CFG-ERR-0106 IBM Cognos Configuration received no response from the IBM Cognos service in the allotted time. Check that IBM Cognos service is available and properly configured.

There are two possible causes for this problem:

• The IBM Cognos service needs more time to start.
• A standby Content Manager computer may be configured incorrectly.
The IBM Cognos service needs more time

By default, IBM Cognos Configuration checks the progress of the start request every half second for three minutes. If IBM Cognos Configuration does not receive a response within this time, the error message displays.

The amount of time that IBM Cognos Configuration waits to receive a response from the IBM Cognos service is controlled by the ServiceWaitInterval and ServiceMaxTries properties.

The ServiceWaitInterval property represents the time interval, in milliseconds, at which IBM Cognos Configuration checks the progress of the start request. By default, its value is 500, which is equivalent to half a second.

The ServiceMaxTries property represents the number of times that IBM Cognos Configuration checks the progress of the start request. By default, its value is 360.

Content Manager Is configured incorrectly

If the error message displays on a standby Content Manager computer, the setting for storing the symmetric keys may be incorrect.

Changing the wait time for the IBM Cognos service

If you received the CFG-ERR-0106 error because the IBM Cognos service needs more time to start, change the amount of time that IBM Cognos Configuration waits to receive a response from the IBM Cognos service.

Procedure
1. Using IBM Cognos Configuration, stop the IBM Cognos service.
2. Open the c10_location/configuration/cogconfig.prefs file in an editor. This file is created automatically the first time you open IBM Cognos Configuration.
3. Add the following code to the file:
   
   ```
   ServiceWaitInterval=number of milliseconds
   ServiceMaxTries=number of times
   ```
   
   Tip: Add the numeric values that correspond to your configuration needs.
4. Save the file.
5. Using IBM Cognos Configuration, start the IBM Cognos service.

Changing the location where symmetric keys are stored

If you received the CFG-ERR-0106 error on a standby Content Manager computer, configure the computer to store the symmetric keys locally.

Procedure
1. On the standby Content Manager computer, start IBM Cognos Configuration.
2. In the Explorer window, under Security, click Cryptography.
3. In the Properties window, under CSK settings, set Store symmetric key locally to True.
4. From the File menu, click Save.
5. From the Actions menu, click Start.
This action starts all installed services that are not running. If you want to start a particular service, select the service node in the Explorer window and then click Start from the Actions menu.

**Unable to start the IBM Cognos service because the port is used by another process**

You may not be able to start the IBM Cognos Business Intelligence service or process if one of the default ports is used by another process.

**Tip:** To view the current network TCP/IP network connections, use the netstat command.

Use IBM Cognos Configuration to change the default port that IBM Cognos BI uses.

When you change the port used by the local dispatcher, you must change the value of the Dispatcher URI properties. Because the change affects all the URIs that are based on the local dispatcher, you must change the URIs of all local components. By default, local components contain localhost in the URI.

For example, if you install all components on one computer and you want to change the dispatcher port, replace 9300 in all dispatcher and Content Manager URIs with the new port number.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window, click the appropriate group or component:
   - To access the port number in the dispatcher and Content Manager URIs, click Environment.
   - To access the port number for the local log server, under Environment, click Logging.
   - To access the shutdown port number, under Environment, click IBM Cognos services > IBM Cognos BI.
   - To access the port number for the location of the applications.xml file used by Portal Services, under Environment, click Portal Services.
3. In the Properties window, click the Value box next to the property that you want to change.
4. Change the value from 9300 to the new value.
   Ensure that you change the ports in all URIs that contain localhost:9300.
5. From the File menu, click Save.
6. From the Action menu, click Start.

**IBM Cognos Business Intelligence server not available when starting IBM Cognos BI**

After you configure IBM Cognos components and start the IBM Cognos services, when you connect to the IBM Cognos Business Intelligence portal, the following error message may display:

*The Cognos Gateway is unable to connect to the Cognos BI server.*

*The server may be unavailable, or the gateway may not be correctly configured.*
Check the IBM Cognos server log file for more information. By default, the cogserver.log file is located in the c10_location/logs directory. If you configured another destination for log messages, check the appropriate file or database.

Content Manager may not be able to connect to the content store if the content store is not configured properly. This may occur if
• the content store uses an unsupported character encoding
• the content store uses a database collation sequence that is case sensitive
• the configuration settings you specified in IBM Cognos Configuration are not valid

Unsupported character encoding

If the following messages display in the log file, the database you created for the content store does not use a supported character encoding:
• For Oracle:
  CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.
  CM-SYS-5121 Content Manager cannot start because the database character set for the content store is not supported.
  CM-SYS-5126 The content store database server uses the character set US7ASCII.
  CM-SYS-5125 The content store database client uses the character set US7ASCII.
• For DB2:
  CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.
  CM-SYS-5121 Content Manager cannot start because the database character set for the content store is not supported.
  CM-SYS-5124 The content store database server uses the code page 1252.
• For Sybase:
  CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.
  CM-SYS-5121 Content Manager cannot start because the database character set for the content store is not supported.

For Content Manager to connect to the content store, the content store must use the appropriate character encoding, as listed in the following table.

<table>
<thead>
<tr>
<th>Database</th>
<th>Character encoding</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle</td>
<td>AL32UTF8</td>
</tr>
<tr>
<td></td>
<td>AL32UTF16</td>
</tr>
<tr>
<td>DB2 for Linux, UNIX and Windows</td>
<td>Codeset UTF-8</td>
</tr>
<tr>
<td>Sybase ASE</td>
<td>UTF-8</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>UTF8</td>
</tr>
<tr>
<td></td>
<td>UTF16</td>
</tr>
</tbody>
</table>
To resolve this problem, you must recreate the content store database using the correct character encoding, or convert the character encoding. For more information, see the database documentation.

**Case-sensitive collation sequence**

If the following messages are in the log file, the database you created for the content store uses a database collation sequence that is case sensitive:

CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.

CM-SYS-5122 The content store database has a default collation that is case-sensitive. Content Manager requires a content store that has a case-insensitive collation.

CM-SYS-5123 The content store database server uses the collation <parameter>.

CM-SYS-5007 Content Manager build @cm_build_version@ failed to start! Review the Content Manager log files and then contact your system administrator or customer support.

To resolve this problem, you must recreate the content store database using a database collation sequence that is not case sensitive. For more information, see the database documentation.

**Invalid configuration settings**

If the following or similar messages are in the log file, you did not configure the content store correctly in IBM Cognos Configuration.

- For Microsoft SQL Server:
  CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.
  CM-CFG-5036 Content Manager failed to connect to the content store. The connection string is “jdbc:JSQLConnect://localhost:1433/cm”.
- For DB2:
  CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.
  CM-SYS-5003 Content Manager is unable to access the content store. Verify your database connection parameters and then contact your database administrator.
  [IBM] [CLI Driver] SQL1013N The database alias name or database name “CM123” could not be found.
- For Oracle:
  CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.
  CM-CFG-5036 Content Manager failed to connect to the content store. The connection string is “jdbc:oracle:thin:@localhost:1521:pb1”.
  ORA-01017: invalid username/password; logon denied.
- For Sybase:
  CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.
CM-CFG-5036 Content Manager failed to connect to the content store. The connection string is “jdbc:sybase:Tds:localhost:5000/cm”.

JZ006: Caught IOException: java.net.ConnectException: Connection refused: connect.

If you are using an Oracle database, do not use illegal characters, such as an underscore in IBM Cognos Configuration for the Service Name property. If the Service Name includes illegal characters, tables are not created in the content store database when the IBM Cognos service is started.

**Configuring a Microsoft SQL Server, Oracle, DB2, Informix, or Sybase content store in IBM Cognos Configuration**

If you received a CM-CFG-5036 or CM-CFG-5063 error code, the content store might not be configured correctly. To resolve the issue, reconfigure the content store.

**Procedure**

1. On the computer where you installed Content Manager, start IBM Cognos Configuration.
2. In the Explorer window, under Data Access > Content Manager, right-click Content Store and click Delete.
   This deletes the default resource. Content Manager must be configured to access only one content store.
3. Right-click Content Manager, and then click New resource > Database.
4. In the Name box, type a name for the resource.
5. In the Type box, select the type of database and click OK.

**Tip:** If you want to use Oracle Net8 keyword-value pair to manage the database connection, select Oracle database (Advanced).

6. In the Properties window, provide values depending on your database type:
   - If you use a Microsoft SQL Server database, type the appropriate values for the **Database server with port number or instance name** and **Database name** properties.
     For the **Database server with port number or instance name** property, include the port number if you use nondefault ports. Include the instance name if there are multiple instances of Microsoft SQL Server.
     To connect to a named instance, you must specify the instance name as a JDBC URL property or a data source property. For example, you can type `localhost\instance1`. If no instance name property is specified, a connection to the default instance is created.
     Note that the properties specified for the named instance, along with the user ID and password, and database name, are used to create a JDBC URL. Here is an example:
     `jdbc:JSQLConnect://localhost\instance1/user=sa/more properties as required`
   - If you use a DB2 database, for the **Database name** property, type the database alias.
   - If you use an Oracle database, type the appropriate values for the **Database server and port number** and **Service name** properties.
   - If you use an advanced Oracle database, for the **Database specifier** property, type the Oracle Net8 keyword-value pair for the connection.
     Here is an example:
     `(description=(address=(host=myhost)(protocol=tcp)(port=1521)(connect_data=(sid=(orcl)))));

Chapter 17. Troubleshooting  303
• If you use a Sybase database, type the appropriate values for the Database server and port number and Database name properties.

7. If you want to change the logon credentials, specify a user ID and password:
   • Click the Value box next to the User ID and password property and then click the edit button when it displays.
   • Type the appropriate values and click OK.

8. From the File menu, click Save.
The logon credentials are immediately encrypted.

9. Test the connection between Content Manager and the content store.

   Tip: In the Explorer window, right-click the new database and click Test. Content Manager connects to the database, checks the database permissions, and creates and populates a table. The table is not deleted and is used each time that the test is repeated.

Cannot log on to a namespace when using IBM Cognos Connection

You open IBM Cognos Business Intelligence through IBM Cognos Connection. However, when you attempt to create a data source and log on to a namespace, the following error messages display:

• PRS-CSE-1255 Exception error encountered in data decryption.

• CAM-CRP-1064 Unable to process the PKCS #7 data because of an internal error. Reason: java.lang.IndexOutOfBoundsException.

This issue may occur if you do not have the necessary permissions for the following directories:

• c10_location/configuration
• c10_location/configuration/csk
• c10_location/configuration/encryptkeypair
• c10_location/configuration/signkeypair

Enable the read and execute permissions on these directories for anyone who must start the IBM Cognos service.

IBM Cognos services fail to restart after a network outage

The IBM Cognos Bootstrap Service restarts IBM Cognos services after a network outage.

For installations where you use the default WebSphere Application Server Liberty Profile and where a network IP address is specified in the internal dispatcher URI, the IBM Cognos services might not initialize successfully during the restart. In this case, manually restart the services after the network is restored.

Procedure

To resolve the problem, configure the Internal dispatcher URI property in IBM Cognos Configuration to use localhost or the network host name.
No warning that installing a later version of IBM Cognos Business Intelligence will automatically update the earlier version of the content store

You have a version of ReportNet or IBM Cognos BI installed on your computer. You install a later version into a new location. You use the same database for the content store for both versions. After you configure the later version and start the IBM Cognos service, the earlier version of ReportNet or IBM Cognos BI no longer works because all content is automatically upgraded.

If you want to use different versions of ReportNet and IBM Cognos BI after you upgrade, ensure that before you install the later version, you

- back up the database you use for the content store
- restore the backup to a new location

Alternatively, you can choose to use the deployment tool to import the entire content store from an earlier version to the later version. All existing content in the content store database is replaced by the imported content. You receive a warning message about this.

Content Manager error when starting IBM Cognos Business Intelligence

After starting IBM Cognos BI, no BIBUSTKSERVMA process is started. There are errors listed in the pogo******.log and cogserver.log files. Users receive errors in the browser when connecting to the IBM Cognos BI portal.

In the pogo******.log file, an error related to Content Manager displays.

In the cogserver.log file, the following error displays:

*An attempt to register the dispatcher in Content Manager was unsuccessful. Will retry periodically.*

When connecting to http://computer name/ibmcognos, the following error messages display in the browser:

- DPR-ERR-2058 The dispatcher cannot service the request at this time. The dispatcher is still initializing
- SoapSocketException: Connection Refused

IBM Cognos Configuration uses a user ID to bind to the LDAP database. If this user ID is moved to another group, IBM Cognos Configuration can no longer locate it.

Procedure

To correct the problem, move the user ID back to the original group.

The page cannot be found when starting IBM Cognos Business Intelligence in Windows 2003

Installing IBM Cognos Business Intelligence on Microsoft Windows operating system 2003 may cause an error message when you try to start IBM Cognos BI.
The following error is caused by a security feature in Windows 2003 Internet Information Services (IIS). This security feature does not allow unknown cgi file extensions.

The page cannot be found. The page you are looking for might have been removed, had its name changed, or is temporarily unavailable. HTTP Error 404 - File or Directory not found.

Procedure

To resolve this problem, add a new file extension in IIS for the cognos.cgi file. For more information, see the IIS documentation.

The page is not shown when opening a portal after installing IBM Cognos Business Intelligence

After you install and configure IBM Cognos Business Intelligence, you are unable to connect to the Cognos BI portal.

This may be because the Web server is not properly configured. For example, the virtual directories required for IBM Cognos BI may not exist or they may point to the wrong physical folders.

For information about configuring the Web server, see the Installation and Configuration Guide.

DPR-ERR-2058 Error Displays in Web Browser When Starting IBM Cognos Business Intelligence

After you start the services in IBM Cognos Configuration and then try to open the portal, a message similar to one of the following may display:

DPR-ERR-2058 The dispatcher encountered an error while servicing a request. XTS handler must be initialized before being invoked.

DPR-ERR-2058 The dispatcher cannot service the request at this time. The dispatcher is still initializing. Please try again or contact your administrator.

These error messages usually occur when the dispatcher cannot communicate with Content Manager. To help you determine the specific cause, look in the cogserver.log file in the c10_location/logs directory. The most common causes are listed in this section, with solutions.

IBM Cognos Services are Not Done Initializing

After you start the services in IBM Cognos Configuration and the configuration tool shows that the services are running, wait a few minutes for all services to start before you open the portal.

Content Manager is Not Available

In a distributed installation, ensure that Content Manager is installed, configured, and running. Ensure also that the other IBM Cognos computers are configured with the correct Content Manager URI.

The Content Store is Not Available or is Not Configured Properly

Ensure that the content store database was created and that you configured it correctly in IBM Cognos Configuration.
Tables are Not Created in the Content Store
Ensure that you are using a version of DB2, Microsoft SQL Server, Oracle, or Sybase that is supported by IBM Cognos components.

The Logon Credentials for the Content Store Are Incorrect
Check whether the information changed. For example, DB2 reads information from the NT user management. If the password for the NT account changed, you must also change the logon credentials for the content store in IBM Cognos Configuration.

Check for special characters in the logon password. Occasionally, the JDBC driver does not accept characters that are reserved for xml, such as %, !, <, and >.

The User Does not Have Appropriate Permissions
Ensure that the user has the appropriate permissions.

Out of Memory on HP-UX
If you are using Tomcat, you can determine the issue is related to HP-UX server configuration. You may be exceeding the expected maximum number of simultaneously active threads per process.

Increasing the maximum number of threads per process on HP-UX:
If you are exceeding the expected maximum number of simultaneously active threads per process on HP-UX, increase the number of active threads.

Procedure
1. Have your system administrator change the Kernel parameter as follows:
   - max_thread_proc = 512
   - nkthread = 1024
2. Ensure that the ulimit settings are unlimited.

Content Manager Cannot Connect to the Content Store on Oracle
If you are using an Oracle database as a content store, the DPR-ERR-2058 error may be generated when logging onto the portal. All tables are created on the database.

You may also receive the following error messages:
- CM-CFG-5036 Content Manager failed to connect to the content store.
- ORA-01017: invalid username/password; logon denied

Setting the Oracle database server name:
The Content Manager might fail to connect to an Oracle database because of inconsistencies between the Oracle server name in IBM Cognos Configuration and the server name in the tnsnames.ora file.

Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer window, click Data Access, Content Manager, Content Store.
3. Change the Oracle database server name to a fully qualified name such as host_name.companyname:1534 to match the name in the tnsnames.ora file.
DPR-ERR-2022 error displays in Web browser when starting IBM Cognos Business Intelligence

After you start the services in IBM Cognos Configuration and then try to open the portal, a message similar to the following may display:

*DPR-ERR-2022 No response generated. This may be due to an incorrect configuration, a damaged installation, or the dispatcher not having finished initializing.*

This problem can occur if
- You try to open the portal before IBM Cognos services are initialized.
- A system.xml file has been edited.
  
  In this case, replace the edited system.xml file in the appropriate subdirectory in `c10_location\templates\ps` with a copy from backup or use an XML editor to edit it.
  
  There are many instances of system.xml in the directories in `c10_location\templates\ps`. Ensure that you replace the correct file.

**Application server startup script fails**

You may have problems running the startup scripts for an application server to deploy the IBM Cognos application if IBM Cognos Business Intelligence components are installed in a directory with a name that includes spaces.

**Procedure**

1. Reinstall to a new directory and do not include spaces in the new name.
2. If this solution is not easily handled by the startup scripts, try adding quotation marks around the directory name that includes spaces or use the 8.3 DOS naming convention.

**Permission Problems Using Contributor Administration or Analyst**

You are using IBM Cognos Planning Contributor Administration or IBM Cognos Planning Analyst and receive errors indicating that you do not have the correct permissions when you perform such tasks as creating an application, adding user rights, or using Go To Production.

This can occur if you are using fully qualified domain names (FQDN) in the gateway URI in IBM Cognos Configuration for your Planning Administration clients and you are using a Microsoft Internet Information Services (IIS) 6.0 Web server and have Integrated Windows authentication enabled.

For example, you may see these errors if the Planning Administration client computer is configured to use a gateway value such as:

http://servername.domain.com/ibmcognos/cgi-bin/cognos.cgi

You can resolve this problem by using only the server name in the gateway URI value on your Planning Administration client computers, rather than the fully qualified domain name. For example, you can change your gateway URI value to something like:

http://servername/ibmcognos/cgi-bin/cognos.cgi
If you have configured your Planning Server components to use the fully qualified domain name, you must install the Planning Administration clients on a different computer, and ensure that you use only the server name for the gateway, rather than the fully qualified domain name.

**Problems Integrating IBM Cognos Business Intelligence and IBM Cognos Planning**

If you are using IBM Cognos Business Intelligence and IBM Cognos Planning in an integrated environment, you may encounter problems.

**Page Not Found Error When Trying to Open Analysis Studio**

You have IBM Cognos Business Intelligence and IBM Cognos Planning installed on separate computers sharing the same content store. You try to open Analysis Studio from the IBM Cognos Planning gateway and a Page Not Found error message appears.

To avoid this problem, install the gateway components of both IBM Cognos products into both the install location of IBM Cognos Business Intelligence and the install location of IBM Cognos Planning.

**Failed to Load the Pluggable Shared Library When Using Analysis Studio**

You have IBM Cognos Business Intelligence and IBM Cognos Planning installed on separate computers sharing the same content store. You open Analysis Studio from the IBM Cognos Planning gateway and select a package that was created from an IBM Cognos Planning Contributor application. The following error message appears:

Failed to load the pluggable shared library.

To avoid this problem, start IBM Cognos Configuration on the planning server computer, disable the batch report service and the report service, then restart the IBM Cognos and planning services.

**Problems Using Contributor Administrator Caused by Incorrect Database Configuration**

If a database client is not installed or configured correctly, an administrator may encounter problems when using IBM Cognos Planning Contributor Administration.

**Problems Creating an Application in an SQL Environment**

When using IBM Cognos Planning Contributor Administration to create an application in an SQL Environment, the following error message appears:

Unable to connect to computername using SQL Server Data Manipulation Objects (SQLDMO).

Unable to create the object with ProgID 'SQLDMO.SQLServer'
To avoid this problem, install Microsoft SQL Server client tools on the computer where the Planning server is installed. For SQL Server 2005, you must have the full SQL Client installed (available with SQL Express), otherwise the required .dll files will still be missing.

**Problems Creating an Application in a DB2 Environment**

When using IBM Cognos Planning Contributor Administration to create an application using a DB2 datastore, the following error message appears:

Unable to execute the statement.~~~The SQL was:~~CREATE TABLE

The row length of the table exceeded a limit of "4005" bytes.

To fix this problem, configure the DB2 tablespace size to be 8k instead of 4k.

**Problems Importing Data in an SQL Environment**

When using IBM Cognos Planning Contributor Administration to import data, the following error messages appear:

There was a problem during the load.

The error details have been recorded in the error log.

Unable to Bulk Load the data.

To avoid this problem, install Microsoft SQL Server client tools on the computer where the planning server is installed.

**Problems Running Go to Production in an SQL Environment**

When using IBM Cognos Planning Contributor Administration to run the Go to Production process, the process fails and following error message appears in the log file:

Unable to execute the statement.Could not find database ID 22. Database may not be activated yet or may be in transition.

To avoid this problem, install Microsoft SQL Server on the computer where the planning server is installed.

**Problems Creating a Module in Framework Manager Using a SAP BW Data Source**

If you set access permissions incorrectly to model and run reports using SAP BW as a data source, run time error messages may appear.

**The BAP-ERR-0002 BAPI Error**

When using IBM Cognos Business Intelligence with an SAP BW data source, the following error message may appear:

_BAPI_MDDATASET_CHECK_SYNTAX. Error occurred when starting the parser._

This error usually occurs because the SAP BW server is overloaded.
To resolve this problem, restart the IBM Cognos Business Intelligence server or close all open connections from the SAP BW Administrator Workbench.

**The BAP-ERR-0002 BAPI Authorization Error for Function Group RSOB**

When using IBM Cognos with an SAP BW data source, the following error message may appear:

BAP-ERR-0002 BAPI error occurred in function module BAPI_MDPROVIDER_GET_KEY_DATE. User COGNOS has no RFC authorization for function group RSOB.

To resolve this problem, provide the user COGNOS access to the function group RSOB.

**The BAP-ERR-0002 BAPI Authorization Error for RFC_READ_TABLE**

When using IBM Cognos with an SAP BW data source, the following error message may appear:

BAP-ERR-0002 BAPI error occurred in function module RFC_READ_TABLE. NOT_AUTHORIZED.

This error occurs because displaying or editing table content is not authorized.

To resolve this problem, add the authorization object S_TABU_DIS with the activity field value set to DISPLAY and the Authorization Group value set to SS.

**Authorization Error for Component**

When using IBM Cognos with an SAP BW data source, the following error message may appear:

<Message Name="CCLMessage" Severity="Error" Nesting="0">. <MessageParm Name="CCLMessageParm" Type="string" Value="You do not have authorization for component IDES_APO_PUMP_1"/>

This error occurs because access to infoqueries is not authorized.

To resolve this problem, provide access to S_RS_COMP and S_RS_COMP1.

**Authorization Error for InfoCube**

When using IBM Cognos with an SAP BW data source, the following error message may appear:

<Message Name="CCLMessage" Severity="Error" Nesting="0">. <MessageParm Name="CCLMessageParm" Type="string" Value="You do not have authorization for InfoCube OAPO_C02"/>

This error occurs because access to infocubes is not authorized.

To resolve this problem, provide access to S_RS_ICUBE.
Authorization Error for Hierarchy

When using IBM Cognos with an SAP BW data source, the following error message may appear:

SBW-ERR-0020 Querying the SAP BW cubes's failed. SAP error code: BAP-ERR-002
A BAPI error has occurred in the function module
BAPIMDDADataSet_GET_AXIS_DATA. No authorization for evaluation along
hierarchy 01011.

This error occurs because access to the infocube hierarchy is not authorized.

To resolve this problem, provide access to S_RS_HIER.

Authorization Error for Temporary File

When performing a Detailed Fact Query that contains a large number of items, the following error message may appear:

RQP-DEF-0177 An error occurred while performing operation 'sqlScrollBulkFetch'
status='-232'. UDA-SQL-0107 A general exception has occurred during the
operation "No authorization to open the file /tmp/
ES1DEV03000807584_C.TMP.SYSTEM_FAILURE".UDA-CUR-0000 Unable to fetch
the row.

This error occurs because access to temporary files is not authorized.

To resolve this problem, provide access to S_DATASET.

Authorization Errors Using the IBM Cognos SAP Gateway

If you install and configure IBM Cognos SAP gateway functions incorrectly,
authorization error messages may appear.

Unable to Identify Required SAP Permissions

You may encounter errors using SAP BW because your SAP user signon does not
have sufficient permissions. To identify the permissions needed, use the ST01
transaction.

Procedure

1. In SAP R/3, type /ST01 in the command window.
2. Under Trace components, select Authorization check.
3. Select Change trace.
4. In the Options for Trace Analysis Field, under General Restrictions, enter the
user name of the IBM Cognos account you are tracing.

Unable to Identify SAP BW Version and Corrections

You must use supported versions and patch levels of SAP BW, so you must be able
to see a list of patches (correction notes) that have been applied.

For more information about supported versions, see the IBM Cognos Center Web
site [http://www.ibm.com/software/data/cognos/customercenter/].

To see a list of correction notes that have been applied, you can run one of two
transactions in R/3: SE95, or SNOTE.
In all cases, you must be authorized to run these transactions. In some cases, you may need to run the transactions using the same account that was used to apply the correction notes.

**Procedure**
1. In SAP R/3, type /SE95 in the command window.
2. Enter an asterisk (*) in the Last Changed By field, to view all notes.
3. Select the type of modification in the Modifications tab.

**Error Messages in SAP Log When Using Data Manager Connector for SAP R/3**

You are using Data Manager Connector for SAP R/3 and the following error message appears in the SAP log:

```
DATASET_CANT_CLOSE
```

To resolve this problem, on computers where you have Data Manager components installed, create a system level environment variable named SAPCOMPRESSION and set the value to OFF.

**Fact Table Does Not Include Any Data**

When using IBM Cognos with an SAP BW data source, the following error message may appear:

```
BMT-MD-5076 The fact table exists in the database but it does not contain any data. This may happen because this is a multi-provider cube.
```

This error can occur if you do not have `udacompr.exe` zlib1.dll on Microsoft Windows or LIBZ on UNIX installed in the SAP server RUN directory.

To resolve this problem, in the SAP server RUN directory, install `udacompr.exe` and `zlib1.dll` (on Windows) or LIBZ (on UNIX).
Appendix A. Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products.

See the IBM Accessibility Center (http://www.ibm.com/able) for more information about the commitment that IBM has to accessibility.

Keyboard Shortcuts for the Installation Wizard

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster method of navigating and using software.

The installation wizard uses standard Microsoft Windows operating system navigation keys in addition to application-specific keys.

Note: The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the installation wizard on the Windows operating system.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next configuration step</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Return to the previous configuration step</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the License Agreement page of the installation wizard.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the license agreement</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Decline the license agreement</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Quit the installation wizard</td>
<td>Alt+x</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in IBM Cognos Configuration on a Windows operating system.

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the current configuration</td>
<td>Ctrl+S</td>
</tr>
</tbody>
</table>
### Table 80. List of keyboard shortcuts for IBM Cognos Configuration on a Windows operating system (continued)

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close IBM Cognos Configuration</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Rename the selected item</td>
<td>F2</td>
</tr>
<tr>
<td>Display the File menu</td>
<td>Alt+F</td>
</tr>
<tr>
<td>Display the Edit menu</td>
<td>Alt+E</td>
</tr>
<tr>
<td>Display the View menu</td>
<td>Alt+V</td>
</tr>
<tr>
<td>Display the Actions menu</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Display the Help menu</td>
<td>Alt+H</td>
</tr>
</tbody>
</table>
Appendix B. Command Line Options

Use command line options with the configuration command to modify the behavior of IBM Cognos Configuration when it starts.

The command line option you specify sets the mode of operation of IBM Cognos Configuration. If you run IBM Cognos Configuration in interactive mode, you use a graphical user interface to configure IBM Cognos BI components. If you start IBM Cognos Configuration in silent mode, it runs silently in the background.

By default, IBM Cognos Configuration runs in interactive mode.

You can use the following command line options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>-s</td>
<td>Runs IBM Cognos Configuration in silent mode. Uses property values specified in the cogstartup.xml file to configure installed components and then starts all services.</td>
</tr>
<tr>
<td>-stop</td>
<td>Runs IBM Cognos Configuration in silent mode and stops all IBM Cognos services.</td>
</tr>
<tr>
<td>-test</td>
<td>Tests configuration settings in silent mode. Uses property values specified in the cogstartup.xml file to do the test.</td>
</tr>
<tr>
<td>-utf8</td>
<td>Saves the configuration in UTF-8 encoding when used with -s to run IBM Cognos Configuration in silent mode.</td>
</tr>
<tr>
<td>-l language ID</td>
<td>Runs IBM Cognos Configuration using the language specified by the language ID.</td>
</tr>
<tr>
<td>-e filename.xml</td>
<td>Exports the current configuration settings to the specified file in silent mode.</td>
</tr>
<tr>
<td>-log</td>
<td>Runs IBM Cognos Configuration and creates an error log named cogconfig timestamp.log in Cognos_location/logs.</td>
</tr>
</tbody>
</table>
| -java:{local|env} | Runs IBM Cognos Configuration on Microsoft Windows operating system using the Java Runtime Environment version that is defined as either  
  • env: environmentally in the JAVA_HOME environment variable  
  • local: locally in the Cognos_location/bin/jre directory  
  If you do not set this flag, IBM Cognos BI uses the JAVA_HOME environment variable. |
You can use more than one command line option at a time. For example, you can run IBM Cognos Configuration in silent mode and send all error messages to a log file.

**Run IBM Cognos Configuration in Silent Mode**

Run IBM Cognos Configuration in silent mode to apply configuration settings on UNIX or Linux computers that do not support the XWindows system, or to apply similar configuration settings to multiple computers.

Some configuration settings are not saved in the cogstartup.xml file unless you use the graphical user interface. For example, the server time zone is not set for your IBM Cognos components when you modify the cogstartup.xml file directly and then run IBM Cognos Configuration in silent mode. In this case, other user settings that rely on the server time zone may not operate as expected.

Before you run IBM Cognos Configuration in silent mode, you must export a configuration from another computer that has the same installed IBM Cognos components and then copy it to the computer that you want to configure. You cannot just copy a saved cogstartup.xml file from one computer to another.

**Procedure**

1. Copy the exported configuration file from the source computer or network location to the Cognos_location/configuration directory on the computer you want to configure.
2. Rename the file to cogstartup.xml.
3. Go to Cognos_location/bin.
4. Type the appropriate configuration command:
   - On Microsoft Windows operating system, type `cogconfig.bat -s`
   - On UNIX or Linux, type `/cogconfig.sh -s`

   **Tip:** To view messages that were generated and determine when the processing is complete, see the cogconfig_response.csv file in the Cognos_location/logs directory.

IBM Cognos Configuration applies the configuration settings specified in the local copy of cogstartup.xml, encrypts credentials, creates certificates, and, if applicable, starts all services or processes for your IBM Cognos component. The results of the activity are stored in the file Cognos_location/logs/cogconfig_response.csv.

**Stop the IBM Cognos Service in Silent Mode**

If you want to stop the IBM Cognos service, you can run IBM Cognos Configuration using the stop option. This option starts IBM Cognos Configuration in silent mode.

**Procedure**

1. Go to Cognos_location/bin.
2. Type the appropriate configuration command:
   - On Microsoft Windows operating system, type
IBM Cognos Configuration runs in silent mode and stops all services or processes for your IBM Cognos component.

**Test IBM Cognos BI Configuration**

If you want to test the current configuration settings, you can run IBM Cognos Configuration using the test option. This option starts IBM Cognos Configuration in silent mode.

**Procedure**

1. Go to `Cognos_location/bin`.
2. Type the appropriate configuration command:
   - On Microsoft Windows operating system, type `cogconfig.bat -test`
   - On UNIX or Linux, type `./cogconfig.sh -test`

IBM Cognos Configuration runs in silent mode and tests the IBM Cognos components using the property values specified in the cogstartup.xml file. During the test, IBM Cognos Configuration checks the CSK availability and tests the connections to the content store and to the mail server.

**Save the Configuration in UTF-8 Encoding**

You can save the current configuration in UTF-8 encoding when you run IBM Cognos Configuration in silent mode. If you do not specify this option, the configuration is saved in the default encoding of your computer.

You cannot use this option when running IBM Cognos Configuration in interactive mode. Use the menu command to save the configuration in UTF-8 encoding.

**Procedure**

1. Go to `Cognos_location/bin`.
2. Type the appropriate configuration command:
   - On Microsoft Windows operating system, type `cogconfig.bat -s -utf8`
   - On UNIX or Linux, type `./cogconfig.sh -s -utf8`

IBM Cognos Configuration applies the configuration settings specified in the local copy of cogstartup.xml, encrypts credentials, creates certificates, and, if applicable, starts the service or process for your IBM Cognos component.

**Run IBM Cognos Configuration in Another Language**

You can run IBM Cognos Configuration in interactive mode and view the user interface in a supported language that is different from the one selected in the installation wizard.
The language option does not control the specification for the character encoding. If you use more than one language for the local configuration properties, ensure that you save the configuration in UTF-8 encoding.

**Procedure**

1. Go to `Cognos_location/bin`.
2. Type the appropriate configuration command, where `language ID` is the product locale such as en (English) or zh-cn (Simplified Chinese).
   - On Microsoft Windows operating system, type
     `cogconfig.bat -l language ID`
   - On UNIX or Linux, type
     `./cogconfig.sh -l language ID`

For example,

```
cogconfig.bat -l zh-cn
```

IBM Cognos Configuration starts, and the interface uses the specified language. If the language that you specify is invalid or not supported, English is used.

---

**Export Configuration Settings in Silent Mode**

You can export the current configuration to a specified XML file using the export option. You can then use the XML file to configure another computer in an unattended configuration.

The export option starts IBM Cognos Configuration in silent mode.

**Procedure**

1. Go to `Cognos_location/bin`.
2. Type the appropriate configuration command:
   - On Microsoft Windows operating system, type
     `cogconfig.bat -e filename.xml`
   - On UNIX or Linux, type
     `./cogconfig.sh -e filename.xml`

**Create an Error Log**

You can create a log file that records configuration errors. Use this log file for troubleshooting.

**Procedure**

1. Go to `Cognos_location/bin`.
2. Type the appropriate configuration command:
   - On Microsoft Windows operating system, type
     `cogconfig.bat -log`
   - On UNIX or Linux, type
     `./cogconfig.sh -log`

The `cogconfig_timestamp.log` file is created in `Cognos_location/logs`. 
Run IBM Cognos Configuration on Windows using Specified JVM

On Microsoft Windows operating system, you can specify which Java Virtual Machine (JVM) IBM Cognos Configuration uses.

By default, IBM Cognos BI uses the JVM defined by the JAVA_HOME environment variable. For example, if you use an application server such as WebSphere, you may have set up this environment variable.

If you do not set this environment variable, IBM Cognos Configuration uses the local JVM. The local JVM is installed in the Cognos_location/bin/jre directory.

Procedure
1. Go to Cognos_location/bin.
2. Type the appropriate configuration command:
   • To run IBM Cognos Configuration in interactive mode, using the local JVM, type:
     cogconfig.bat - java:local
   • To run IBM Cognos Configuration in interactive mode, using the JVM defined in the JAVA_HOME environment variable, type:
     cogconfig.bat
Notices

This information was developed for products and services offered worldwide.

This material may be available from IBM in other languages. However, you may be required to own a copy of the product or product version in that language in order to access it.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service. This document may describe products, services, or features that are not included in the Program or license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr.
Ottawa, ON
K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
This Software Offering does not use cookies or other technologies to collect personally identifiable information.

Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

• Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States, and/or other countries.

• Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

• Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

• UNIX is a registered trademark of The Open Group in the United States and other countries.

• Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.
Index

Special characters
   xml configuration files  26

Numerics
   32-bit installation
      requirement for 32-bit library files  32
   64-bit Cognos gateway
      new feature description version 10.2  2
   64-bit installation
      requirement for 64-bit library files  32

A
   access
      enabling authentication  220
   accessibility features  315
   Active Directory Server
      advanced properties  224
      authenticating in multiple domains  224
      enabling single signon  225
      enabling SSL  224
      using for authentication  221
      with an LDAP namespace  234
   active scripting
      enabling in Web browsers  37
   additional fonts
      installing  211
   administration
      27
      IBM Cognos Connection  27
   administration components
      default settings  162
      installing  161
   AIX
      support for RACF namespace  251
   aliases
      configuring on Apache Web Server  198
      configuring on Web servers  66, 90, 133
   Analysis Studio problems  309
   Analyst
      accessing IBM Cognos Planning outside a firewall  163
      configuring  163
      configuring on different computer  163
   anonymous logon
      disabling  220
   Apache gateways
      configuring  198
   Apache Tomcat
      no longer default application server  1
   Apache Web servers
      configuring aliases  66, 90, 133
      configuring as gateways  198
      apache_mod file
      configuring for gateways  163, 176, 177
   application servers
      startup script fails  308
   authentication
      Active Directory Server  221
      configuring IBM Cognos Series 7 namespace  227
      custom authentication providers  231

authentication (continued)
   custom properties for Active Directory Server  223
   custom user properties for LDAP  243
   deleting namespaces  255
   disabling anonymous logon  220
   domain trees for Active Directory Server  224
   enabling  220
   eTrust SiteMinder  247, 249
   LDAP  232, 233
   LDAP using Active Directory Server  234
   LDAP using IBM Directory Server  237
   LDAP using Novell Directory Server  239
   LDAP using Oracle Directory Server  240
   NTLM  249
   requirements for single signon with Microsoft Analysis Server or Microsoft SQL Server  222
   SaferAPIGetTrustedSignon function  229
   SAP  252
   single signon for NTLM  250
   single signon using Active Directory Server  225
   single signon using eTrust SiteMinder  248
   single signon using IBM Cognos Series 7 namespace  228
   single signon using LDAP  244
   single signon using RACF  252
   single signon using SAP  255
   SSL for eTrust SiteMinder  248
   SSL using LDAP  243
   trusted signon plug-ins for IBM Cognos Series 7  229
   using namespaces  219
   authentication provider
      configuring IBM Cognos 8 to use security  60
      configuring IBM Cognos Planning to use security  80, 122

B
   backslashes appear instead of currency  212
   BAP-ERR-0002 error  311, 312, 313
   BAP-ERR-0002 errors  310
   Bind user DN and password property
      special characters for LDAP namespace  232
   Business Insight approved domains  188

C
   CA,
      See certification authority
   certificate authority
      configuring  204
      certificate signing requests
      generating  205
   certification authority
      configuring the service  204
   changing
      default configuration settings  181
      IBM Cognos BI gateway  197
      URIs  182
   characters
      encoding not supported  300
   chase_referred files  224
cipher suites
  setting a priority for SSL connections 196
Classic Contributor Web Client 169
client components
  installing 169
client setup
  DB2 databases 58, 117
  code pages for data sources 39, 174
cogconfig.bat 318, 319
cogconfig.sh 318, 319
coglocale.xml files 26
Cognos Business Intelligence 10.2.2 1
Cognos namespace 27
Cognos service
  See IBM Cognos service
cogstartup.lock file 296
cogstartup.xml 318
cogstartup.xml files 26
collation sequence 32
collation sequences
case-sensitive 300
command line
  test option 319
command line options 317
commands
  export option 320
  common gateway interface
  replacing 197
common symmetric key 183
components
  Composite Information Server 6
  Content Manager 91, 136
  content store 7
  Framework Manager 7
gateways 91, 136
  installing 9, 91, 136
  planning store 7
  report server 91, 136
  startup configuration 26
  used by IBM Cognos Planning 5
Composite Information Server
  component description 6
Confidentiality algorithm 185
configuration
  automating 213
  changing defaults settings 181
  default settings 181
  lock file 296
  recording errors 320
requirements for single signon with Microsoft Analysis
  Server or Microsoft SQL Server 222
  saving in silent mode 319
  security 27
  settings for IBM Cognos BI 181
  startup 26, 318
  unable to open IBM Cognos Configuration 296
  unattended 213, 216
  UNIX 318
workflows 25
configuration files 26
  applications.xml for Portal Services 266
  exporting 216
configuring
  Active Directory namespace 222
  Analyst 163
  Analyst on different computer 163
  apache_mod for the gateway 163, 176, 177
  configuring (continued)
certificate authority service 204
custom authentication providers 231
eTrust SiteMinder namespace 247
Framework Manager on different computer 176
IBM Cognos BI 36
IBM Cognos Planning 181
IBM Cognos to work with other IBM Cognos products 204
ISAPI for the gateway 163, 176, 177
LDAP namespace 233
LDAP namespace for Active Directory Server 234
LDAP namespace for IBM Directory Server 237
notification databases 192
NTLM namespace 250
Portal Services 265
RACF namespace 251
SAP namespace 254
  servlets for the gateway 163, 176, 177
  shared trust with other servers 195
SSL protocol 192
standby Content Manager 61, 76, 119
transfer specification files (.ats) 213
unattended 216
Web browsers 37
Web server 66, 90, 133
Content Manager
  attempt to register the dispatcher 305
  configuring on multiple computers 61, 76, 119
  installing 12, 91, 136
  requirements if using IBM Cognos Transformer with Series
  7 namespace 227
  setting up a content store 31
Content Manager URLs 61, 76, 119
content store
  component description 7
  connection management 61, 80, 122
  creating 31, 35, 161
  creating on Oracle 34
  DB2 JDBC drivers 57
  deploying 47
  invalid settings 300
  upgrading 305
Contributor Administration problems 309
Contributor for Microsoft Excel
  installing 170
Contributor Web Client 165, 166
  CognosRCP.msi installation 168
  Command line installation 167
  Contributor Administrator Console installation
  options 166
  contributor.msi installation 168
  Installing 166
  uninstall 169
  Web link installation 167
cookies
  enabling in Web browsers 37
  creating
  content store 55, 161
cross-script checking
  configuring in IBM Cognos Application Firewall 188
cryptographic keys
  generating for other certificate authorities 205
currency
  fonts required for Yen or Won character 211
  won 212
  yen 212
D 2

data 2
IBM Cognos samples 277
importing 49
data source connections 2
setting 61, 80, 122
data sources 2
accessing SAP BW 257
for Framework Manager 174
database connection strings 2
IBM DB2 61, 65, 80, 83, 97, 103, 108, 122
Microsoft SQL Server 61, 65, 80, 83, 97, 103, 108, 122
Oracle 61, 65, 80, 83, 97, 103, 108, 122
database connections 2
planning store 65, 83, 97, 103, 108
database connections, See data source connections
database connectivity 2
content store 58
database drivers 2
DB2 58, 117
Informix 59
OLED8 60
Oracle 59, 118
Sybase 60
databases 2
content store 31
IBM Cognos samples 277
planning store 31
dataset errors 2
troubleshooting 313
DB2 2
cient setup 58, 117
code pages 39, 174
database connectivity 60
database drivers 58, 117
JDBC drivers 57
DB2 content store 209
default settings 2
administration components 162
deploying 2
content store 47
exporting 48
importing 49
moving archives 48
testing 50
deployment 2
permissions 47
planning 46
deployment archives 2
moving 48
deployments 2
creating an export specification 48
description of product xi
directory not found error 306
distributed installation 2
large environment 15, 71, 113
medium environment 15, 71
small environment 14
distributed installations 2
configuring Analyst 163
distributed installations (continued) 2
configuring Framework Manager 176
domains 2
Active Directory Server domain trees 224
approved for Business Insight 188
E 2
enabling 2
IBM Cognos Application Firewall 188
services 190
environment variables 2
content store 31
for Oracle data source 172
environments 2
supported 29
error logs 320
error messages 2
BAP-ERR-0002 310, 311, 312, 313
BAPI-MDDATASET_CHECK_SYNTAX 310, 311, 312, 313
CAM-CRP-1064 304
CFG-ERR-0106 Cognos Configuration received no response 298
DPR-ERR-2022 No response generated 308
DPR-ERR-2058 305, 306
HTTP Error 404 306
page not found 306
PRS-CSE-1255 304
SoapSocketException 305
eTrust SiteMinder 2
configuring namespaces 247
cross-script checking in IBM Cognos Application Firewall 188
enabling single signon 248
protecting the IBM Cognos BI Web alias 249
SSL 248
using for authentication 247
exporting 2
configuration files 216
creating a specification 48
exporting configuration data 2
silent mode 320
external identity mapping property 2
editing for an LDAP namespace 245
External identity mapping property 2
special characters for LDAP namespace 232
F 2
features 2
new features in version 10.2.0 1
files 2
not found 306
Firefox 2
browser settings 37
firewalls 2
access between Analyst and IBM Cognos 8 Planning servers 163
access between Framework Manager and IBM Cognos BI 176, 177
Framework Manager installation 18
Framework Manager 2
accessing IBM Cognos BI outside a firewall 176, 177
component description 7
configuration requirements 17
configuring on different computer 176
Index 329
Framework Manager (continued)
installation options 17
installing 170
setting up data sources 174
system requirements 171
testing installation and configuration 178
uninstalling 67, 180

G
gateways
configuring a servlet 163, 176, 177
configuring apache_mod 163, 176, 177
configuring ISAPI 163, 176, 177
configuring to use a namespace 190
IBM Cognos BI 10
installing 10, 91, 136
log file 297
Great Outdoors
samples 277

H
histories
deployment 50
HTTP Error 404 306

I
IBM Cognos
configuring 26
default settings 55, 161
installing 25, 91, 136
logging in 60, 80, 122
system requirements 31
troubleshooting installations 289
uninstalling 67
IBM Cognos 8 Planning
modeling components 6
IBM Cognos 8 service
requirements for the user account that is used for the service 131
IBM Cognos Application Firewall
configuring 188
IBM Cognos BI
configuring 36
IBM Cognos Business Intelligence
installing with IBM Cognos Planning 19
IBM Cognos Configuration 26
invalid settings 300
problems opening 296
unattended mode 216
IBM Cognos Connection
unable to open 306
IBM Cognos Planning
components 5
configuring 181
server components 5
third-party components 7
IBM Cognos Series 7
enabling single signon 228
enabling SSL 228
trusted signon plug-ins 229
using for authentication 227
IBM Cognos service
requirements for the user account that is used for the service 181
server not available 300
stopping 318
IBM DB2
creating connection strings 61, 65, 80, 83, 97, 103, 108, 122
IBM Directory Server
with an LDAP namespace 237
IBM Support
contacting 292
sending and receiving information 293
IBM WebSphere Application Server
single signon with RACF 252
IBM WebSphere Portal
configuring 265
IIS Web servers
single signon using Active Directory 225
implementation preparation 25
importing
  data into target environment 49
InfoCubes
  accessing using OLAP 257
Informix
  database drivers 59
installation
  checklist 55, 161
  components 25
Content Manager 12
Framework Manager 17
gateways 10
options 9
Planning Server 12
testing Framework Manager 178
unattended 213
with IBM Cognos Business Intelligence 19
workflows 25
installation kits
  improvements 2
Planning Complete 2
Planning Gateway 2
Planning Server 2
installations
  large environment 15, 71, 113
  medium environment 15, 71
  small environment 14
installing
  additional fonts 211
administration components 161
  clients on Windows Vista 169, 170
Framework Manager 170
gateway functions for SAP BW 257
IBM Cognos 55, 91, 136, 161, 213
IBM Cognos Planning client components 169
Supplementary Language Documentation 210
testing 84, 91, 127, 134
unattended 26
unattended install 213
using transfer specification file (.ats) 213
using transfer specification files (.ats) 213
Integrated Windows Authentication
configuring 164
Internet Explorer
browser settings 37
invalid settings
  content store 300
IBM Cognos Configuration 300
ISAPI
accessing IBM Cognos BI 197
configuring for gateway 163, 176, 177
ISAPI gateway
recommended with multiple Content Managers 197

J
Japanese currency 212
Japanese Yen
font requirements 211
jar file 58, 173
Java
upgrading runtime environments 173
Java Archive files, See jar file
Java scripts
enabling in Web browsers 37
Java System Web Server
configuring aliases 66, 90, 133
JDBC
database connectivity for content store 58
JDBC drivers 57
JREs
upgrading 173
JVM
copying security provider files 173

K
keyboard shortcuts 315
Korean currency 212
Korean Won
font requirements 211

L
LDAP
Active Directory Server 234
configuring a namespace 233
custom properties 243
editing the External identity mapping property 245
enabling single signon 244
enabling SSL 243
IBM Directory Server 237
Novell Directory Server 239
Oracle Directory Server 240
using for authentication 232
library files
for 32-bit versus 64-bit installation 32
Linux
system requirements 55, 161
Linux on System Z
support for RACF namespace 251
load balancing 36
enabling and disabling services 190
log files 295, 320
gateway errors 297
locale configuration 297
run-time 297
silent mode 297
startup configuration 296
transfer 296
transfer summary 296
uninstallation 297

log messages
enabling for IBM Cognos Application Firewall 188
logging database
creating using DB2 32
creating using Microsoft SQL Server 35
creating using Oracle 34
creating using Sybase 36
logging in
configuring security 60, 80, 122
hiding namespaces during 232, 249

M
Microsoft Analysis Server
namespace requirement 222
Microsoft Analysis Services
setting up the data source environment 39, 174
single signon to MSAS data sources 225
Microsoft Office 2016 2
Microsoft SQL Server
creating connection strings 61, 65, 80, 83, 97, 103, 108, 122
database connectivity 60
namespace requirement 222
modeling components 6
moving
deployment archives 48
Moving from trial upgrade to production environment 51
MSAS,
See Microsoft Analysis Services
multi_domain_tree 224
multiple languages 320

namespace
RACF 251
namespaces
authentication 219
cannot log on 304
configuring custom authentication providers 231
configuring for a gateway 190
deleting 255
hiding during login 232, 249
requirements for Content Manager if using Transformer
with Series 7 namespace 227
Netegrity SiteMinder
See eTrust SiteMinder
network outage
services fail to start 304
no response generated 308
notification database
configuring 192
creating 191
Novell Directory Server
with an LDAP namespace 239
NTLM 249
configuring 250
enabling single signon 250
NTLM, 249

OLAP
accessing SAP BW 257
OLEDB
database drivers 60

Index 331
Oracle
creating connections strings  61, 65, 80, 83, 97, 103, 108, 122
database connectivity  60
database drivers  59, 118
environment variables for data source  172
multilingual support  39, 174
Oracle Directory Server
with an LDAP namespace  240
Oracle WebCenter Interaction Portal
configuring  265

page not found error
starting IBM Cognos BI in Windows 2003  306
page not found error in Analysis Studio  309
permanence
BAPI error  311, 312, 313
permissions
deployment  47
for the user account that is used for the IBM Cognos 8 service  131
for the user account that is used for the IBM Cognos service  181
planning administration components
installing  161
planning an upgrade  44
planning client components
installing  169
Planning Server
installing  12
planning store
component description  7
creating  31
setting connection properties  65, 83, 97, 103, 108
pluggable shared library not loaded  309
portal
tests in starting  306, 308
portal problems
unable to open  306
Portal Services  265
specifying the applications.xml file  266
ports
changing  182
ports already in use  300
preparation
implementation  25
problem determination
exchanging information with IBM Support  293
problems creating an application  310
problems running Go to Production  310
purpose of document  xi

quality of protection in SSL connections  196

RACF
authentication settings for IBM Cognos BI administrators  251
connectivity  251
enabling single signon  252

RACF account properties
mapping to RACF namespace  251
RACF namespace  251
release notes
reviewing before you install  29
report servers
installing  91, 136
ReportNet
to IBM Cognos BI upgrade file  298
reports
testing before an upgrade  45
Resource Access Control Facility
See also RACF  251
response.ats file  213
reviewing the release notes before you install  29
RSS feeds
troubleshooting  294

S
SaferAPIGetTrustedSignon function
using for authentication  229
sample files
IBM Tivoli Directory Server  3
samples
setting up  277
SAP
enabling single signon  255
using for authentication  252
SAP BW
accessing as a data source  257
accessing using OLAP  257
authorization settings for IBM Cognos BI administrators  254
authorization settings for IBM Cognos BI users  252
connectivity  254
unable to identify SAP permissions  312
unable to identify version  313
using as a data source  257
SAP Enterprise Portal
configuring  265
saving
configuration in silent mode  319
secure LDAP communication  243
Secure Sockets Layer,
See SSL protocol
security
configuration  27
enabling  60, 80, 122
settings for Web browsers  31
security provider files
copying to application server JVM  173
server components  5
service
stopping  318
services
enabling and disabling  190
fail to start after network outage  304
unable to start  300
uninstalling  67
setting
data source connections  61, 80, 122
setting up
samples  277
shared trust
setting up between IBM Cognos BI and other servers  195

332  IBM Cognos Planning Version 10.2.0: Installation and Configuration Guide
testing IBM Cognos configuration
  silent mode 319
testing the installation 84, 91, 127, 134
third-party components 7
transfer specification files (.ats)
  configuration 213
Transformer
  requirements for Content Manager if using Series 7
  namespace 227
trial upgrade 45
  planning the move to the production environment 51
troubleshooting 289
  contacting IBM Support 292
  Contributor Administration problems 309
  creating an application 310
  dataset errors 313
  exchanging information with IBM Support 293
  fixes
    getting 292
    getting fixes 292
    identifying problems 289
    importing data 310
    knowledge bases
      searching for troubleshooting solutions 291
      running Go to Production 310
    searching knowledge bases 291
    subscribing to support 294
troubleshooting Analysis Studio 309
tuning
  DB2 content store 209

U
unable to open IBM Cognos Configuration 296
unattended configuration 318
  setting up 213
unattended installation 26
  setting up 213
unattended mode 213
uninstalling
  Framework Manager 67, 180
  IBM Cognos 67, 180
UNIX
  environment variables for Oracle data source 172
  system requirements 55, 161
UNIX AIX
  support for RACF namespace 251
unsupported characters 300
updating
  java environment 173
upgrade
  Contributor 55
upgrading
  content store 305
  create test environment 46
  from Planning 41
  planning the move from test to production environment 51
  preparation 44
  process 42
  resources 44
URI
  changing 182
User account
  requirements to run the IBM Cognos 8 service 131
  requirements to run the IBM Cognos service 181
User lookup property  
  special characters for LDAP namespace  232  
  using multiple languages  319, 320  
  UTF-8  319

V  
  virtual directories  
    IBM Cognos  66, 90, 133

W  
  Web aliases  
    IBM Cognos  66, 90, 133  
  Web browsers  
    configuring  37  
    errors in starting the Web portal  308  
    errors when starting the web portal  306  
    security settings  31  
  Web servers  18  
    configuring  66, 90, 133  
    enabling SSL  197  
    single signon using Active Directory and IIS Web server  225  
  WebLogic  
    startup script fails  308  
  WebSphere Application Server  
    startup script fails  308  
  WebSphere Liberty Profile  
    application server  1  
  Windows  
    system requirements  55, 161  
    Windows integrated authentication  225  
    Windows native security (NTLM)  
      enabling single signon  250  
      using for authentication  249  
    Windows Vista  
      installing clients on  169, 170  
    won character  212  
    Won character  
      font requirements  211  
    workflows  
      installation and configuration  25

X  
  XML configuration files  26  
  XML files  
    exporting configuration settings to an XML file  320

Y  
  yen character  212  
  Yen character  
    font requirements  211